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Player

Overview of the QALoad Player

The QALoad Player simulates one or more virtual-users running C-based scripts. These scripts mimic user
activitiesto load test the application, network, and server components of a client-server system.

The QALoad Player simulates multiple clients sending middleware calls back to a server. Generally, these
are database QL calls— although other types of middleware layers can also be tested. When running
virtual user simulation, QALoad Player can emulate multiple users from a single platform using the multi-
tasking features of 32-bit Windows. The number of usersthat a single hardware system can emulateis
determined by the processor speed, main memory size, middleware layer, and simulated transaction rate.
Please contact your QALoad distributor for further sizing information.

Once started, QALoad Player functionsentirely in the background without any direct user interaction. All
commandsto QALoad Player come from the QALoad Conductor. In fact, once QALoad Player has been
started, the only interaction you may have with it isto change startup parameters or to save the contents
of the display window to afile. When the Conductor process closes for any reason during aload test, the
associated Player processesterminate.

Citrix and SAP 6.20/6.40 scripts play back in a virtual user window on the desktop. For SAP, it ispossible to
enable or disable the VU window from the Conductor's Custom middleware options dialog box. Citrix
replay sessions are minimized by default, but can be restored on the desktop.

QALoad Player menus

The following menus are available from the QALoad Player:
Filemenu

Edit menu

View menu

Optionsmenu

Help menu

Installing UNIX Players

For information about installing UNIX Players, please refer to the QACenter Performance Edition
Installation and Configuration Guide.

You can access this guide by clicking
Start>Program s>Compuware>QALoad>Documentation>Installation and Configuration Guide.

Tuning QALoad Player for use with Oracle

Oracle version 7 SQL*NET putssignificant demandson the system running QALoad Player by demanding
at least 1M B of physical memory and approximately 3MB of virtual memory per simulated user.
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Compuware recommendsyou follow these guidelineswhen using Oracle to optimize QALoad Player
performance:

I Set the Executing Threads Sartup Interval parameter on the Player Configuration dialog box’s
Sartup Parameterstab to between 2,000 and 4,000 milliseconds.

I Unlessyour application continually logsin and out of Oracle, move the logon commands
(DO_olog and its associated DO_ologof) outside the Begin_Transaction/End_Transaction loop,
where the Oracnvrt program placesthem by default.

Dialog Box and Field Description

QALoad Player Main Window

The QALoad Player Main Window isdivided into two parts:

! Thetop portion containsfields, buttons, and optionsthat help you configure the Player for script
validation. When an actual load test isin progress, thisarea displaysthe following information:

Version: The version of the QALoad Player.
Player Name: The network name assigned to the Player workstation.

Player Address: The network address of the Player workstation.

o O o o

Player Port: The port number on this Player workstation being monitored by the QALoad
Conductor.

o Player isrunning... thetype of virtual usersthis Player isrunning.
0 Thenumber of virtual usersand transactionsthis Player isrunning.
I Thebottom portion of the Player Main Window displays Player messages while a script isrunning.

This section describesthe configuration optionson thetop portion of the Main Window.

Felds and Buttons

Compiled cript

Navigate to the compiled script (.dll) to validate.
Users

Typethe number of usersto emulate when validating the selected script. Compuware recommends one
user for script validation.

Transactions

Type the number of transactionsto run when validating the selected script. Compuware recommendsone
transaction for script validation.

Sart

Click the Sart button to begin script validation. Player messages will display below.
Abort

Click the Abort button to stop all virtual usersimmediately.

Bxit

Click the Exit button to exit the load test gracefully, when each virtual user isfinished.

2
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Debug Data

Select thischeck box to have the Player display a debug message indicating which command the script is
executing and to generate WWW replay log files.

RR _FailedMsg

Select thischeck box to view, in the Player window, the point where a middleware command within your
script fails.

Check Points

Select thischeck box if you want to display the Check Point command response timesin the Player
window.

Auto Clear

Select thischeck box to automatically clear any messages from the bottom portion of the window before
running anew script.

Abort on Etror
Select thischeck box to abort script execution when an error isencountered.
Create Timing Hle

Select thischeck box to create and save a Player timing file for this Player to the default QALoad timing file
directory (normally \ Program Fi | es\ Compuwar e\ QALoad\ Ti m ngFi | es).

Run As

Slect if this Player should run scriptsasthread- or process-based.

Save As

Use thisdialog box to save a text file of the messages reported by Player during atest, or to save an existing
buffer with adifferent name.

Accessthis dialog box from the File menu by selecting Save Buffer or Save Buffer As.

Player configuration

Use thisdialog box to set startup parametersfor Player. The default startup parameters are saved in the
player section of the QALOAD.INI file.

Accessthisdialog box from the Options menu by selecting Player Configuration.

Runtime tab

Player Name: Thisisthe namethat the Player will report to the QALoad Conductor during arequest. It
may be any string of alphanumeric characters, provided that the length does not exceed 10 characters and
there are no embedded spaces.

Compiled Scripts: Thisfield pointsto the directory which will hold the compiled scripts. When atest is
started, Player looks for scriptsin thisdirectory. The configuration screen will verify that the directory
exists.

Compuware recommendsthat you use adirectory on anetworked drive to hold the compiled scripts.
Otherwise you will need to manually copy the script filesto each Player system whenever a script changes.

Local Datapool: Thisfield pointsto the directory which will hold the local datapool file referenced by this
Player workstation.
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Timing File: Thisfield pointsto the default directory wherethe timing files are located.

Java tab

jvm.dll directory: (optional) Thisisthe directory wherethe WM.DLL fileislocated. If specified, this
JVM.DLL will be used to run the Java scripts from a standalone Player; otherwise, the entry specified in the
Compiler Settingstab of the Configure QALoad Script Development Workbench dialog box will be used.

Installing UNIX Players

For information about installing UNIX Players, please refer to the QACenter Performance Edition
Installation and Configuration Guide.

You can access thisguide by clicking
Start>Program s>Com puware>QALoad>Documentation>Installation and Configuration Guide.

Transferring scriptsto a UNIX Player

Normally, the appropriate script is automatically uploaded from the QALoad Conductor to the Players and
compiled at runtime. However, if it isever necessary to manually transfer a script, use the procedure that
follows.

Note: The machine where the QALoad Script Development Workbench is installed must have Winsock-
based TCP/IP to transfer a script to the UNIX machine where you wish to run it.

To transfer a script:

The following procedure describes how to transfer a script file from the Windows workstation where the
QALoad <cript Development Workbench residesto the system running the QALoad Player.

1. Accessthe Script Development Workbench.

2. From the Session menu, choose the middleware session you want to start.

3. IntheWorkspace Pane, click the Scriptstab.

4. On the Scriptstab, select the script you want to transfer.

5. From the Tools menu, choose FTP to open the FTP Transfer dialog box. Note that the file name
you selected to transfer appearsin the File to Transfer field.

6. Enter the Host Name, User Name, Password, and Destination Directory.

7. Click Transfer to send the fileto the system where your QALoad Player isinstalled.

8. If you want to savetheinformation you have entered for subsequent transfers, click Save Settings.

9. Click Close/ Abort to exit the FTP Transfer dialog box.

Validating Scriptsin the Player

Before adding a script to a load test, validate it to ensure that it runswithout problems. The following
procedureisonly valid for Win32 scripts. To validate a UNIX script, see Validating a UNIX script.

=] Note: During validation of SAP scripts, do not minimize the SAP window. If the window isminimized,
the validation may fail. This problem doesnot occur if you select the Hide Graphical User Interface for
SAP Usersoption by clicking Browse [...] in the Type column of the Script Assignment tab in the
Conductor. This SAPGUI option runs SAP on an alternate desktop that isnot visible.
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To configure the Player for validation:

1.

8.

In the Script Development Workbench, click Options>Workbench and select the Script
Validation tab.

Select the Automatically Recompile check box if you want QALoad to compile a script before
attempting to validate it. QALoad listsany compilation errorsin the editor after compiling.

(For Java and OFS) select Ask for Automatic Validation of Java and OFS Scripts.

Select the Only Display Player Output on Script Failure check box to view only Player messages
upon script failure, if applicable.

Type avaluein the Wait up to field. Thisisthe number of secondsthat the QALoad <cript
Development Workbench should wait for a script to execute before timing out.

In the Player Settings area, select the Abort on Error check box for QALoad to stop script execution
upon encountering an error.

Select the Debug Data check box for the script to display a debug message indicating which
command the script is executing.

In the Run As area, indicate whether the transaction should berun asthread- or process-based.

=l Note: Oracle Forms Server, Citrix, Java, and Uniface scripts are limited to process-based validation only.

9.

10.

11.

12.

In the Number of usersfield, type a number of virtual usersto run this script for validation. The
default is 1.

Enter avaluein the Transactionsfield. For validation, Compuware recommendsthat you accept
the default value of 1 transaction.

In the Sleep Factor % field, type the percentage of each DO_S EEP (pause in the script) to
maintain. For validation, you may not need to run every pausein the script at itsfull length. The
value can be a percentage between 0 and 100. The default isO.

Click OK to save your changes.

To validate a script in the Player:

1.

In the Compiled Script field, browse for the compiled script DLL you want to validate. Compiled
scriptsare usually located in the directory \ Program Fi | es\ Conpuwar e\ QALoad\ Scri pt s.

Type avaluein the Number of Usersfield. Compuware recommends one user for script validation.

Type avaluein the Transactionsfield. Compuware recommends one transaction for script
validation.

Select any appropriate optionsto theright of the Compiled <ript field. These optionsdetermine
thetype and amount of datathat will display in the Player Main Window. For descriptions of each
options, seethe topic QALoad Player Main Window.

In the Run Asarea, select whether the transaction should run asthread- or process-based.

Click Start to run the script. The Player Main Window will show the script's progress. If the script
runssuccessfully, it isvalid to usein aload test.
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Script Development Workbench

Overview of the Script Development Workbench

The QALoad Script Development Workbench isthe QALoad component used to develop load test scripts. It
containsthe facilities you need for recording transactions such asfunction calls or request/response
interactions placed by your Windows application. The recorded transaction, called a capture file, contains
raw datathat must be converted to an editable test script based on C, C++, or Java, depending upon which
middleware environment isunder test.

After converting the recorded transaction to a script, you can use the Script Development Workbench's
script editor and other functionality to make any necessary modificationsto your script. For example,
maybe you had to sign on to aWeb server with auser name and password as part of your recorded
transaction. At test time, when multiple virtual usersare running your test script, you might want each
user to have a different user name/password combination. You can usethe Script Development Workbench
to create are-usable pool of user name/password combinations, saved as a datapool file, and edit your
script to extract values from that file at test time. QALoad provides scripting commands for situationslike
that, and provides a Function Wizard and online language reference, both available right from the editor,
to help you locate and insert the right commands.

When you are satisfied with your test script, you can compile it directly from the Script Development
Workbench. And, finally, add it to aload test in the QALoad Conductor.

In short, to produce a usable test script you:

1. Record atransaction into a capture file (.cap).
2. Convert the capturefile to an editable script.
3. Edit the script.
4

Compile the script.

The Script Development Workbench Main Window

The QALoad Script Development Workbench main window isdivided into dynamic panesthat you can
hide or show as needed by selecting commandsfrom the View menu.

4 Hint: Clickon a pane in the following graphic for a description of that pane. Use your scroll barsto see the
rest of the graphic.
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Menus and Toolbar Buttons

The QALoad Script Development Workbench menus and buttons change depending on whether you have
an EasyScript Session open.

Menus and Toolbars without an Open EasyScript Session
The following menus and toolbars are available when an EasyScript Session isnot open.

File

View

Options

Session

Tools

Help

Toolbar Buttons

Menus and Toolbars with an Open EasyScript Session
The following menus and toolbars are available when an EasyScript Session isopen.

File
Edit
View
Options
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Session

Tools

Window

Help

Toolbar Buttons
Recording Toolbar

Accessing the QALoad Script Development
Workbench

To accessthe Script Development Workbench:

1. From the Windowstaskbar, click the Start button.

2. Choose Programs>Compuware>QALoad>Script Development Workbench.

Configuring the Script Development Workbench

Thefirst time you use the QALoad Script Development Workbench, you should set optionsto determine a
working directory QALoad can use for temporary files, compiler settings, and other general optionsrelated
to the behavior of the QALoad Script Development Workbench.

To set a working directory:

1. Accessthe Script Development Workbench.

2. From the Session menu, choose the session you want to start.
3. From the Options menu, choose Workbench.
4

Set any appropriate options. For a description of the available options, press F1 from the Configure
Script Development Workbench dialog box.

Note: Compuware recommendsthat you always select Automatically Convert Capture on the
Workbench Configuration tab and Automatically Compile Scripts on the Compiler Settings tab.

5. Click OK to save your settings.

Sessions

EasyScript Sessions

When you first open the Script Development Workbench, you can set general optionsrelated to which
panesto display, your compiler, and so on, but you cannot begin any middleware-specific activities, such
asrecording atransaction, until you open an EasyScript Session. Opening an EasyScript Session tailorsthe
Script Development Workbench to a specific middleware environment, providing you with all the
appropriate options and functions for your scripting needs.

To open an EasyScript Session, choose your middleware type from the Session menu, or click the
appropriate toolbar button. Once a session isopen, the Workbench interface changes.

You can also open a Universal session to record calls from multiple middlewares within a single session.

8
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Opening a Middleware Session

To accessthe Script Development Workbench and open a middleware session:

1. Click Start>Programs>Compuware>QALoad\ Script Development Workbench.

2. Choosethe middleware name from the Session menu or by click the appropriate button on the toolbar. The
Default Session Prompt opens.

El Note: If this middleware type should be the default every time you open the Script Development
Workbench, select the check box Make this my default session. If you do not want to be prompted to set a
default middleware, clear the Enable default session checking check box. You can also turn default session
checking on or off from the Configure Script Development Workbench dialog box at any time.

3. Click OK.

Using the Universal Session

The Universal session allowsyou to record callsfrom multiple middleware applicationswithin asingle
Script Development Workbench session. You might use the Universal session in cases where your
application accesses an additional application that uses a different protocol.

For example, your browser might download and open a Java applet which then communicateswith a
Winsock server. If you recorded that activity using a ssimple WWW session, the Script Development
Workbench would only record the HTTP requests that downloaded and opened the Java applet. Recording
that transaction with the Universal session ensuresthat you record the HTTP requests from the browser as
well asthe Winsock-based communication between the Java applet and the Winsock server — all within a
single script.

You start and record from a Universal session exactly like a single middleware session with one difference
— after starting a Universal session you must select which middleware applicationsto record.

Developing a Test Script

Recording a Transaction

Recording Middleware Calls

QALoad beginsrecording before starting your application, ensuring that any early startup activity is
recorded.

' Hint: You can save yourself some steps later by setting options now to automatically convert your
recorded capture file and compile it into a script.

To record a middleware call:

(WWW only) If you arerunning your application on Windows XP SP2, Compuware recommendsyou turn
the 'pop-up blocker' feature off before recording atransaction. The feature can be disabled via the browser
window's Toolsmenu in Internet Options>Privacy.

1. Open an appropriate middleware session in the QALoad Script Development Workbench.

2. (Oracle Forms Server only) Choose Options>Workbench, then click the Compiler Settingstab. In
the Java section of the dialog box, set the location of your Java files for recording.
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Select Session>Record>Start. QALoad launchesyour application and any proxies, if necessary, and
beginsrecording any calls.

Run the desired user operationsusing your application.

(WWW only) If you are capturing S requests using Easy Script for Secure WWW, the browser
generates one or more promptsindicating the following:

= |t doesnot recognize the authority who signed the server certificate.
= The server certificate presented by the Web site does not contain the correct site name.

When you receive these prompts, click the browser’s Next or Continue button so you can connect to
and exchange information with the desired Web site.

(Optional) At any time during the recording process, you can insert any necessary commands or
commentsinto the capture file.

When you have recorded a complete transaction, stop the application from which you are
recording.

When you finish, click Stop Record. You are prompted to save your capture file. By default,
capture files (.cap) are saved in the QALoad\ M ddl ewar es\ <ni ddl ewar e_nane>\ capt ur es
directory.

El Note: If QALoad is not able to record from your application, try QALoad’s alternate procedure for
recording.

The Script Development Workbench automatically converts a capture file to a script file when you stop the
recording process. You are prompted if a script by the same name already exists, so that you can decide
whether to overwrite an existing script or to save your script under a different name.

Inserting Commands/ Commentsinto a Capture Fle

You can insert commands or commentswhile recording a capture file.

To insert commands/ commentsinto a capture file:

1.

On the Recording toolbar, click Insert Command. The toolbar expandsinto awindow where you
can select optionsfor inserting commandsinto your capture file.

IntheCommand Type area, select whether you want to insert acomment or a begin/end
checkpoint.

In theCommand Info area, type your comment or a description of the checkpoint.

Do one of the following:

I Click Insert to insert your comment or checkpoint command into your capture file.

I Click Insert Command again to close the expanded window without inserting a command.

Continue recording your transaction as usual.

Recording with Manual Program Startup

Use this procedure to manually start your application and the Record facility. You can start your
application at any time before or after starting to record.

This procedure only appliesto Winsock, SAP, and Tuxedo. Do not use this procedure if you are recording a
Tuxedo application that uses PeopleSoft certificates.

10
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To record with manual program startup:

1. Accessthe QALoad Script Development Workbench. Details

Choose the appropriate session from the Session menu.

From the Options menu, choose Record to open the Record Optionswizard.

On your middleware tab, select the User Started Program option. Click OK.

WWW Only: Sart your browser.

Click Start Record.

Sart your application (SAP only: start QALSAP.EXE, which islocated in the\ QALoad directory).

© N o g b~ w D

Run the user operationsyou want to record. Asyou execute the operations, QALoad recordsthe
operationsin a capture file (.cap).

9. (Optional) At any time during the recording process, you can insert any necessary commands or
commentsinto the capture file. Details

10. When you finish, click Stop Record. You must stop recording before you shut down the application
from which you are recording. QALoad promptsyou to save your capture file. By default, capture
filesare saved in the QALoad\ M ddl ewar es\ <m ddl ewar e_nane>\ Capt ur es directory .

Converting a Transaction to a Script

Converting

A capture file contains all the raw data that wasrecorded, but it needsto be converted into an editable
script file before you can proceed. The script file can then be open in the Sript Development Workbench
editor and edited as needed.

To convert a capture file to a script:

1. Accessthe QALoad Script Development Workbench. Details.
From the Session menu, choose the session you want to start.
If you have not already done so, set conversion options.

In the Workspace Pane, click the Capturestab.

o~ 0N

Click the capture file you want to convert and click Options>Convert. The capture file is converted
to ascript. In the Workspace Pane, click the Scriptstab to view thelist of scriptsyou have
converted.

Note: If an BEror/Warning Summary opensin the Output Pane, resolve any errors.

6. Compilethe script.
Note: You can set an option to automatically convert your recorded transactionsinto scripts. How?

Set Up Automatic Conversion and Compilation of a Script

The ript Development Workbench automatically converts a capture file when you stop the recording
process and compile the resulting script. You are prompted if a script by the same name already exists, so
that you can decide whether to overwrite an existing script or to save your script under a different name.

11
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If the default settingsto automatically convert a capture file have been changed, follow the steps below to
reset the automatic conversion and compilation.

To set up automatic conversion and compilation:

1. From the Script Development Workbench menu, choose Options>Workbench.

2. On the Workbench Configuration tab, in the Record Options area, select the check box
Automatically Convert Capture.

Click the Compiler Settingstab.
4. Select the check box Automatically compile scripts.

Select the check box Prom pt before overwriting script to ensure that a script isnot overwritten
accidentally.

6. Click OK to save your settings.

Editing a Script

Editing a Script

The Function Wizard allows you to quickly and easily edit your script by choosing from the QALoad
commands available to your script and inserting them with a click of your mouse.

The Function Wizard islocated in the Script Development Workbench in apane on theright side of the
window. You can enable or disable the Function Wizard from the View menu or by clicking the Show or
Hide Function Wizard button on thetoolbar.

The Function Wizard listsall functionsthat are valid to use in your open script. Functions are grouped in
logical sectionswithin the top window of the wizard. When you highlight a function in the top window of
the wizard, the lower window lists a description of that function and its parameters.

To insert afunction into your script, locate it in the Function Wizard and then simply drag-and-drop the
function into your script.

The function will be written into your script at the point you chose. When you insert afunction using the
wizard, atext box opensshowingthe proper syntax and parameter options. (The text box may not appear
if an associated variable or object has not been declared in the script.) Asyou edit the function's
parameters, the text box highlightsthe parameter that is currently being edited.

El Note for ADO scripts: After inserting an ADO method, change the # sign to the appropriate object
number.

Using Custom Counters and M essages

QALoad allows you to define your own countersand insert messagesinto your script, wherethey are
written to your timing file and are viewable in Analyze or at runtime in the Conductor.

Counters can be either cumulative or instance. Thisdetermines how they are graphed in Analyze:

I For acumulative counter, Analyze keepsarunning sum of the counter while graphing verses
elapsed time. Thistype of counter isused for all the WWW error counters. Each time a WWW error
occurs, avalue of 1 (one) iswritten for that counter. When looking at a detailed view in Analyze,
you can see at what timesthat error occurred. When you graph a counter in Analyze, the graph
showsthe total number of occurrencesversesthe elapsed time.

12
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I For an instance counter, Analyze graphs each value directly. No summing of previousvaluesis
done.

Countersmust be added manually using the QALoad commands DEFINE_ COUNTER and
COUNTER _VALUE. Messages must be added manually using the QALoad command SCRIPT_MESSAGE.
The following sample script illustrates both script counters and messages:

#i ncl ude <stdi o. h>
#i ncl ude "smacro. h"
#i ncl ude "do_www. h"

int rhobot _script( PLAYER INFO *s_info )
{

char buf 1] 256] ;

i nt idl, id2, id3, id4;

DEFI NE_TRANS_TYPE( "ScriptCounters " );

DO InitHttp(s_info);

/1 "Counter Group", "Counter Nane", "Counter Units (Optional)",
/1 Data Type, Counter Type.

i d1 = DEFI NE_COUNTER( " Cumul ative G oup", "Cunulative |ong",
0, DATA LONG COUNTER_CUMULATI VE);

i d2 = DEFI NE_COUNTER( " Cumul ative G oup", "Cumul ative float",
0, DATA FLOAT, COUNTER CUMULATI VE);

i d3 = DEFI NE_COUNTER( "Instance G oup", "Instance |ong",
0, DATA LONG, COUNTER_| NSTANCE) ;

i d4 = DEFI NE_COUNTER( "Instance G oup", "Instance float",

0, DATA FLOAT, COUNTER | NSTANCE);

SYNCHRONI ZE( ) ;
BEG N_TRANSACTI ON() ;

/! add value to cumul ative counter 1
COUNTER_VALUE( id1, 1);
DO SLEEP( 2 );

/! add value to cumul ative counter 2
COUNTER _VALUE( id2, 1.5 );
RND _DELAY( 6 );

/!l add value to instance counter 1
COUNTER_VALUE( id3, s_info->nRndDel ay );

/1 add custom message for this user

wsprintf( bufl, "User %l slept for %d m|liseconds during transaction %",
s_i nf o- >nAbsVUNum s_i nf o- >nRndDel ay, s_info->s_trans_count );

SCRI PT_MESSAGE( "User Messages", bufl );

DO SLEEP( 2 );

/1 add value to instance counter 2
/1 relative user nunber plus pi tinmes the current transaction number
COUNTER _VALUE( id4, s_info->nRel VUNum + ( 3.14159 * s_info->s_trans_count ) );

END_TRANSACTI ON() ;
DO FreeHttp();
REPORT( SUCCESS) ;
EXI T();

}

Defining Checkpoints

Checkpoint statements collect timings of events, such asthe execution of SQL statements. If you manually
insert checkpoint statementsinto your capture file during the recording process, or if you select the

13
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Include Default Checkpoint Statements conversion option before converting a script, your script
includes checkpoints.

Otherwise, you must manually insert checkpointsin your scriptsto collect timings.

Defining Transaction Loops

If you did not insert begin-and end-transaction commandsinto your capture file, QALoad’s Convert facility
automatically places begin-and end-transaction commands at the start and end of the recorded sequence.
QALoad scripts execute the code between the begin-and end-transaction commandsin aloop according to
the number of timesyou specify in the QALoad Conductor when setting up a test.

Depending on how you completed your recording, you may want to move one or both of these transaction
commandsto another place in the script to more accurately define the transaction that runsduring the
load test.

For example, let's say during the recording processyou log in and log out as part of the procedure.
However, during the load test you do not want to log in and log out as part of every transaction. To avoid a
login and logout with every procedure, move the begin- and end-transaction commands so the login and
logout commands are outside of the transaction loop.

Simulating User-Entered Data

When you create a script, you probably have some constant data embedded in the script, for example, an
employee number, that automatically entersyour application’sinput fieldswhile recording. If you run a
load test using this script, the script usesthe same data for each transaction. To run arealistic test, you can
modify the script to use variable data from a datapool file. By varying the data input over the course of a
test, the behavior more realistically emulates the behavior of multiple users. You can use the QALoad Script
Development Workbench to create, maintain, and use datapool files (.dat) to insert variable datainto your
scripts.

A datapool can be defined as either central or local:

I Central: adatapool that resides on the same workstation asthe QALoad Conductor, and is
availableto any Player system on the network that requestsit from the QALoad Conductor. A
central datapool iscontrolled by the QALoad Conductor, and you use the QALoad Conductor to set
any optionsrelating to a central datapool.

I Local: adatapool that resides on a Player workstation, and isonly available to that Player. Because
alocal datapool resideslocally and isonly available to the local Player, it does not generate any
network traffic. Use the QALoad Script Development Workbench to insert local datapoolsinto a
script.

The following sections describe how to create and use central and local datapools.
Creating a Datapool Fle

You can create a datapool fileusing the Script Development Workbench.

To create a datapool file:

1. Open amiddleware session in the QALoad Script Development Workbench.
2. From theFile menu, choose New.

3. On the New dialog box that opens, select New from the Datapoolstreeitem.
4

In the Filename field, type aunique name for your datapool file.
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5. In the Rows: and Cols: fields, type the number of rowsand columnsyour new datapool should
have.

6. Click OK.

7. Enter your datapool recordsin the grid that opensin the Workbook Pane.

8. When you arefinished entering datapool records, click File>Save Asto name your datapool file.

9. Click OK to save thefile. QALoad savesthefilein your \ QALoad\ Dat apool s directory.
Modifying a Datapool Fle

You can modify a datapool file using the Script Development Workbench.

To modify a datapool file:

1. In the Workspace Pane, click the Datapoolstab.
2. Double-click the datapool file you want to modify. The datapool file opensin the Workbook pane.
3. Makethe appropriate changes and save thefile.

Using a Central Datapool Fle in a Script

You assign a central datapool file to a specific script by selecting the datapool file and setting any
appropriate optionsusing the Conductor. Each script can use asingle central datapool. The central
datapool isavailable to all Player workstationsrunning the test. The following procedures describe how to
assign and extract data from a central datapool. These procedures assume you have already created the
datapool file as described above.

To assign a central datapool file:

1. With asession ID file open in the QALoad Conductor, click the Script Assignment tab.
2. In the External Data column for the selected script, click Brow se.

3. IntheExternal Data dialog box, navigate to the datapool you wish to use. Select it and click
Open.

4. If you wish to re-use the datapool records when the script reachesthe end of the file, select
Rewind. To only use each record once, and then discard it, select Strip.

5. When you are done, click OK.

Using Data Records from a Central Datapool File

To use data from a central datapool in your load test, you will have to modify your script. Typically, you
will read one record per transaction.

To add datapool statementsto your script:

1. With your script open in the QALoad Script Development Workbench, navigate to the place where
you want to insert a datapool variable and highlight the text to replace.

2. From the Session menu, choose Insert>Datapool. The Insert New Datapool dialog box appears.

3. Select adatapool from the list and click OK, or click Add to open the Select Datapool dialog box
where you can choose a datapool file to add to your test.

4. When you arefinished, the QALoad Script Development Workbench places several datapool
functionsinto your script, denoting them with markers so you can easily identify them.
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Using Local Datapool Flesin a Script

You assign alocal datapool file to a specific script by selecting the datapool file and setting any appropriate
optionsusing the QALoad Script Development Workbench. Each script can use up to 64 local datapools.
Use the following proceduresto assign and extract data from alocal datapool file. These procedures assume
you have created a datapool as described above.

To assign a local datapool:

1. Open asession in the QALoad Script Development Workbench.

2. In the Workspace pane, click the Scriptstab.

3. On the Scriptstab, double-click on the appropriate script name to open it in the Workbook pane.
4

From the Session menu, choose Insert>Datapool. The Insert Datapool Commands dialog box
appears.

On thelnsert Datapool Commandsdialog box, click Add. The Select Datapool dialog box opens.

o

In the Type field, select Local. Note that you can also choose to insert a central datapool from this
dialog box. If you choose to insert a central datapool from here, the QALoad Script Development
Workbench placesthe Conductor command GET_DATA into the script just after the

BEA N_TRANSACTI ONcommand, bookmarksthe command in the margin of the script, and uses
any optionsset for the specified datapool in the QALoad Conductor.

7. InthelD field, give the datapool aunique identifier. The name can contain alphanumeric
charactersonly. Use underscores ( _) for spaces. This ID will help you identify the datapool in your
script, for example “ACCOUNT _NUMS”.

8. In theFlenamefield, type (or browse for) the fully qualified path of your datapool file. For
example: c: \ Program
Fi | es\ Conpuwar e\ QALoad\ Wr kbench\ <ni ddl ewar e_nane>\ Scri pt s\ dat apool . dat

9. If you wish to re-use the datapool recordswhen the script reachesthe end of the file, select Rewind
at End of File. To only use each record once, and then discard it, clear thisoption.

10. When you are finished, click OK. The selected datapool isdisplayed on the Insert New Datapool
dialog box.

11. Click OK. The QALoad Script Development Workbench will place a#def i ne statement identifying
the datapool file near the beginning of your script, and place the datapool commands
OPEN_DATA POOL, READ DATA RECORD, and CLOSE DATA POQL at the default locationsin the
script. These statementswill be bookmarked in the margin for easy identification.

12. When you are finished modifying the script, save any changes.
For detailed information about any of these commands, refer to the Language Reference section.
Using Data Records from a Local Datapool FHle

To use data from alocal datapool file you will have to modify your script to read data records and fields at
the appropriate placein the script. Datapool files should typically be opened with the statement
OPEN_DATA _POOL just beforethe BEG N_TRANSACTI ON statement, then datapool fields can be called into
the script to replace variable strings. The OPEN_DATA POOL statement isautomatically inserted into your
script when you use the QALoad Script Development Workbench to insert your datapool.

1. Read arecord from the datapool file using the following command, which reads a single record
from thelocal datapool file you specify:
READ DATA RECORD( <LOCAL DATAPOOL | D>);
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2. To accessthe fields of thisrecord, substitute GET_DATA_FI ELD( ACCOUNT_NUMS, n) expressionsin
place of variable strings.

After the END_TRANSACTI ON statement, close the local datapool file by using the following
statement:
CLOSE_DATA POCL( LOCAL DATAPOCL ID);

Notethat thisstatement isadded automatically if you use the QALoad Script Development Workbench to
insert your datapool.

For detailed information about any of these commands, refer to the Language Reference section.

Inserting Variable Data with ActiveData Substitution

The QALoad Script Development Workbench allows you to transform string data from quoted constants or
substringsinto variables. ActiveData variable substitution letsyou identify and right-click on a string to
declare the selected string a variable within the QALoad script. This facility also letsyou select or edit
datapool entries more dynamically, making script development easier and more efficient.

To substitute a datapool value or a variable in place of a selected string in your script:

1.
2.
3.

Sart the appropriate session in the QALoad Script Development Workbench.

In the Workspace pane, click the Scriptstab.

On the Script tab, double-click the script you wish to open. The script opensin the Workbook

pane.

In the script, highlight the string you wish to replace.

Right-click anywhere in the highlighted string.

I To substitute avalue from a datapool:

(0]

Click ActiveData>Datapool Substitution in the shortcut menu that opens. The
ActiveData Datapool Substitution dialog box opens.

In the Datapool(s) area, highlight the datapool to use. The contents of the datapool file
display below. If the datapool you want to useisnot listed, click the Add button to add it
to thelist of available datapools.

In the Field: ID field, type the field number of the specific value to use from the datapool.

When you are finished, click OK. The QALoad <cript Development Workbench will place a
#def i ne statement identifying the datapool file at the beginning of your script. It will also
insert the datapool commands OPEN_DATA POCL, READ DATA RECORD, GET_DATA FIl ELD
and CLOSE_DATA PQOOL at the default locationsin the script, and bookmark them in the
margin for easy identification. Refer to the Language Reference section for detailed
information about any of those commands.

I To substitute avariable:

(0]

Click ActiveData>Variable Substitution from the shortcut menu that appears. The
ActiveData Variable Substitution dialog box opens.

Assign avariable name for the selected string in the Variable Name field.

Click OK. The QALoad Script Development Workbench will declare the variable at the
beginning of your script and substitute the named variable for the selected string. It will
also bookmark both locationsfor easy identification.

6. When you are finished, save your script changes. Compuware recommendsthat you also compile
your script to check for any errors.
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Middleware Scripting Techniques
Citrix
Handling Citrix Server Farms

Citrix serverscan be grouped in farms. When load testing, you may want to connect to a Citrix server farm
rather than to a specific server. Load testing requirements may include connecting to a Citrix server farm,
where the load balancing feature supports dynamic redirection to a given server at connection time. This
load teststhe server farm and Citrix load balancing rather than a single server, which can provide amore
realistic load test.

To record a script that connectsto afarm, you must use an ICA file to connect. However, when a capture
takes place, a specific server (in the farm) must have a connection. Specify the correct ICA file to connect
to the server farm as well as a specific server within that server farm.

To verify that your script isconnecting to a server farm and not a specific server, assign the server name to
one blank space when validating the script. In order to record a script that connectsto afarm, you must
use an ICA file specified in the Citrix Record Optionsdialog. Snce the ICA file should contain all the
necessary connection information, the server field should be left blank when recording.

When converted, the CitrixServer variable has a blank space:

/* Declare Variables */
const char *CitrixServer

const char *CitrixUsername = "citrix";
const char *Citri xPassword = "~encr~657E06726F697206" ;
const char *CitrixDomain = "gacitrix2";

const int CitrixQutputhMde OUTPUT_MODE_NORVAL;

SET_ABORT_FUNCTI ON( abort _functi on);
DEFI NE_TRANS_TYPE(" Or ders. cpp");
Citrixlnit(4);

[* Citrix replay settings */

Ct xSet Connect Ti meout (90) ;

Ct xSet Di sconnect Ti neout (90) ;

Ct xSet W ndowTi meout ( 30) ;

Ct xSet Pi ngTi neout (20) ;

Ct xSet Wai t Poi nt Ti neout (30) ;

Ct xSet W ndowVeri fi cati on( TRUE) ;

Ct xSet Donmai nLogi ninfo(CitrixUsernane, CitrixPassword, Citrix-Domain);
Ct xSet | CAFi | e(" PRD desktop.ica");
Ct xSet Enabl eCount er s( TRUE) ;

Ct xSet W ndowRet ri es(5, 5000);

Ct xSet Enabl eW | dcar divat chi ng( TRUE) ;

SYNCHRONI ZE() ;
The Citrix client ignoresthisvalue and usesthe ICA file to dynamically retrieve the server name at
playback time.

Conclusion
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When you use these techniquesto set up a Citrix server farm test script, you allow for dynamic server
redirection at playback as part of testing aload balanced Citrix server farm.

Handling Dynamic Window Titles

Some applications create windows whose titles vary depending on the state of the window. For example,
Microsoft Word creates atitle based on the default document name at the time of the window creation.

During replay, thisdynamic title can differ from the window title that wasrecorded, and the window is

not recognized. If thisoccurs, try the following stepsto modify the script:

1. Ensurethat the Enable Wildcard Title Match check box isselected in the Citrix conversion
optionsprior to converting the recording.
In the Window Verification group of the Citrix Convert Optionsdialog box, ensurethat the
Enable Wildcard Title Match check box isselected. Thischeck box is selected by default. If you
are working with a previously-converted script, ensure that a CtxSetEnableWildcardMatching
command existsin the script prior to the BEGIN_TRANSACTION command and that the parameter
isset to TRUE.

2. Verify whether thereisan issue with dynamic window titles.
When a script failson validation because the run time window title isdifferent than the expected
window title from therecording, it islikely that you are dealing with adynamic title issue that can
be handled by thisscripting technique. In this case, the script failson the
CtxWaitForwindowCreate call.

3. ldentify amatch “pattern” for thedynamic window title.
Note the error message that isreturned during validation (or replay). The message indicatesthe
expected window title versusthe window title from script playback. Examine the differencesin the
window titlesto create a“match pattern” that recognizesthe window title, while ignoring other
windows. A match pattern can be asimple substring of the window title or a pattern string using
wildcard characters such as ? (to match any single character) or * (to match any number of
characters). The examples below illustrate the different match patterns.

4. Insert a CtxSetWindowMatchTitle command prior to the CtxWaitForWwindow Create call for
thedynamic window.
When adding the CtxSetWindowMatchTitle command, ensure that the first parameter containsthe
correct window object and the second parameter containsthe match string in double-quotes.

5. Validatethe script to ensure the CtxWaitForwindow Create command recognizesthe dynamic
window name.
Run the revised script through validation to ensure that the script succeeds. If the script does not
validate successfully, go to step 3 to determine if the match pattern is correct.

Example 1: Using a substring match

In thisexample, the Microsoft Word application generatesa dynamic title when the script isreplayed. The
dynamic nameisa concatenation of the default document that Word creates at application startup with
the name of the application. The script is altered to reflect the fact that the string “Microsoft Word” is
always part of the window title:

/1 Wndow CW _13 ("M crosoft Wrd") created

Ct xSet W ndowivat chTitle( CW _13, “Mcrosoft Wrd” );
Ct xWai t For W ndowCr eat e( CW _13) ;

Example 2: Using a wildcard match with the* character

In thisexample, the SampleClientApp application generates a dynamic title when the script isreplayed.
The dynamic nameisthe name of the application followed by the name of the user, beginning with the
word “User”. The asterisk (*) wildcard is substituted for a given username, reflecting the pattern of
“SampleClientApp — User:” as part of the window title followed by an arbitrary user name:
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/1 Wndow CW _13 ("Sanpl ed ientApp — User: John") created
Ct xSet W ndowivat chTitl e(CW _13, “Sanpl ed i ent App - User: *~7 );
Ct xWai t For W ndowCr eat e( CW _13) ;

Example 3: Using a wildcard match with the ? character

In thisexample, the RandomValue application generatesa dynamic title when the script isreplayed. The
dynamic nameisthe application followed by arandom single digit. The question mark character is
substituted for the single digit to reflect the pattern that begins“RandomValue: ", followed by single digit:

/1 Wndow CW _13 ("RandonVal ue: 0") created
Ct xSet W ndowivat chTitle( CW _13, “Sanple Application: ?7 );
Ct xWai t For W ndowCr eat e( CW _13) ;

Handling Dynamic Windows

During conversion, CtxWaitForWwindowCreate calls are added to the script for each named window
creation event. During replay, some dynamic windowsthat were in the capture may not appear, which
causesthe script to fail because a wait point times out. To avoid script failure in thiscircumstance,
comment out the CtxWaitForWindowCreate commandsthat may be referencing dynamic windows.

Handling Dynamic Windows that Require User Interaction

Some windowsthat require user action before normal script processing can proceed may appear
intermittently during replay. One example commonly encountered with Citrix isthe ICA Seamless Host
Agent window. Thiswindow, if it appears, requires user action or the script may fail.

To work around thisissue, follow these steps:

1. Captureasession in which the dynamic window appears and the user performsthe action to
dismissthe window. Thismay require multiple attemptsto capture the window. Once thisis
captured in arecording, save the script as atemporary script.

2. If thewindow did not appear in the primary script, extract the code snippet from the temporary
script that actson the dynamic window and insert it into thereal script. The code usually consists
of a CtxPoint command and a CtxClick command for thiswindow. Insert the commands after the
CtxWaitForwindowCreate command for the dynamic window. In addition, extract and insert the
Citrix window information object constructor call and delete call to therelevant parts of the script,
changing the object name to avoid conflicting with existing window objects. Ensure that the
additional code isnot inserted between a CtxPoint command and a CtxClick command in the
primary script.

3. Add aspecial CtxSetWindowMatchTitle command immediately before the
CtxWaitForWwindowCreate command. The first parameter of the CtxSetWindowMatchTitle
command should be the correct window object. The second parameter contains a special wildcard
match “*” that enablesthe CtxClick command to accept any window title, which ensuresthat even
if the matching window does not appear, the command still executes successfully.

4. If thewindow appearsin the primary script, comment out the CtxWaitForwWindowCreate
command for the dynamic window. Because the window itself may not appear, the
CtxWaitForwindowCreate command should be commented out.

5. Validate the script. If the validation isnot successful, ensure that steps 2-4 were performed
correctly.

In the following example’'s scenario, the ICA Seamless Window Agent window does not appear in the
primary script, but appearsintermittently when the primary script isreplayed, causing those replay
sessionsto fail. A second Citrix script, which includesthe window appearance, isrecorded and the
CtxPoint and CtxClick commands are extracted from thisscript and inserted into the primary script, with
the window object changed to match the object in the primary script. In addition, the Citrix window
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object constructor call and delete call are added in the appropriate placesin the script, and the CtxClick
command ischanged to refer to thisobject. In the following example, the text in bold represents code that
was manually inserted into the location in the primary script where the window appearsin the secondary
script.

G xW *CW _99 = new Ct xW (0x10052, "ICA Seanl ess Host Agent", 0, 0, 391, 224);

Ct xSet W ndowivat chTitle( CW _99, “*7 );
Ct xPoi nt (190, 203);

CtxCdick(CwW_99, 0, L_BUTTON, NONE);
Ct xPoi nt (300, 400);

deI ete CW _99; // "ICA Seanl ess Host Agent"

Handling Unexpected Eventsin Citrix

The CtxWindowEventExists and CtxScreenEventExists commands can be used to handle unexpected
window and screen eventsin Citrix scripts. When there isa possibility of unexpected dialogs appearing or
unexpected screen events occurring, you must modify the script to respond to the changes and continue
theload test.

For example, if ascript opensa Microsoft Word document that resideson anetwork, and that document is
already open by another network user, an unexpected dialog box appearsthat promptsthe user to choose
between continuing to open the document in read-only mode or to cancel it. To prevent script failure,
modifications can be madein the script to handle the dialog boxes that appear in thissituation.

Generally, to handle unexpected events, you record two scripts. The first script contains a recording of the
expected events. The second script should include the unexpected events. Using the
CtxWindowEventExists and CtxScreen EventExists functions, create a conditional block of code that
handlesthe dialogsthat may appear.

Example

The following script example showsthe additional script linesthat were added to handle a Word
document that isalready open by another user on anetwork. The added lines appear in boldface type.

/*
* capSavelllll-2.cpp
*
* Script Converted on June 21, 2004 at 01:04:17 PM
* CGenerated by Compuware QALoad convert nodul e version 5.2.0 build 50
*
* This script contains support for the follow ng niddl ewares:
* - Gtrix
*

~

/* Converted using the follow ng options:
* Ceneral :
* Line Split : 132 characters
* Sl eep Seconds 1
* Auto Checkpoints : No
* Citrix
*  CGeneral Options :
* W ndow Verification : Yes
* Sessi on Ti meouts . Yes
* Connect Ti meout (S) : 60
* Di sconnect Ti meout (s) : 60
* W ndow Creation Tineout (s) : 30
* Pi ng Tineout (s) ;20
* Wait Point Tinmeout (S) : 30
* Include Wait Points . Yes
* Enabl e Counters : No
* I ncl ude Unnamed W ndows . Yes
* Qut put Mode : Nor mal
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* | nput Options
* Conbi ne Keyboard | nput
Conbi ne Mouse | nput

Yes

Yes
*/

#define Cl TRI X_CLI ENT_VERSI ON " 8. 00. 60000"

#define Cl TR X_| CO_VERSI ON "2.4"

#defi ne SCRI PT_VER 0x00000205UL

#i ncl ude <stdi o. h>
#i ncl ude "smacro. h"

#include "do_citrix.h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O

#endi f
extern "C'" int rhobot _script (PLAYER | NFO *s_i nfo)
{

/* Declare Variables */

const char *CitrixServer = "gaccitrix";

const int CitrixQutput Mode = QUTPUT_MODE_NORMAL;

[* Citrix Wndow I nformation Objects */

G xW *CW _1 = new C xW (0x1001lc, "Warning !!", 107, 43, 427, 351);

G xW *CW _2 = new C xW (0x2001c, "Log On to Wndows", 111, 65, 418, 285);

G xW *CW _3 = new C xW (0x5001c, "Please wait...", 111, 112, 418, 145);

G xW *CW _4 = new C xW (0x30030, "Citrix License Warning Notice", 125, 198,
397, 127);

CGxW *CW _5 = new C xW (0x40030, "Citrix License Warning Notice", 125, 198,
397, 127);

G xW *CW _6 = new C xW (0x4002e, "UsrLogon.Cnd", 0, 456, 161, 25);

CxW *CW _7 = new CtxW (0x1003a, "", -2, 452, 645, 31);

G xW *CW _8 = new Ct xW (0x10066, "ICA Seam ess Host Agent", 0, 0, 391, 224);

G xW *CW_9 = new C xW (0x10052, "Program Manager", 0, 0, 641, 481);

CxW *CW_10 = new CtxW (0x1008c, "", 115, 0, 405, 457);

G xW *CW _11 = new Ct xW (0x1005a, "", 2, 49, 205, 408);

CGxW *CW _12 = new CtxW (0x2006a, "", 200, 186, 156, 287);

G xW *CW _13 = new Ct xW (0x10138, "", 112, 116, 416, 248);

G xW *CW _14 = new Ct xW (0x50036, "M crosoft Word", -4, -4, 649, 461);

G xW *CW _15 = new Ct xW (0x1017e, "Open", 19, 23, 602, 387);

G xW *CW _16 = new Ct xW (0x20174, "*Mcrosoft Wrd", -4, -4, 649, 461);

G xW *CW _17 = new Ct xW (0x10058, "", 113, 114, 305, 26);

G xW *CW _18 = new Ct xW (0x2013e, "Calculator", 66, 66, 261, 253);

G xW *CW _19 = new Ct xW (0x1005a, "", 2, 49, 205, 408);

G xW *CW _20 = new Ct xW (0x3006a, "Shut Down W ndows", 111, 96, 418, 193);

CxW *CW _117 = new Ct xW (0x20172, "File In Use", 144, 127, 352, 179);

CGxW *CW _118 = new Ct xW (0x30172, "11111111 (Read-Only) - Mcrosoft Wrd", -4,
-4, 649, 461);

SET_ABORT_FUNCTI ON( abort _functi on);

DEFI NE_TRANS_TYPE( " capSavel1111- 2.
Citrixlnit(1);

[* Citrix replay settings */

Ct xSet Connect Ti meout (60) ;

Ct xSet Di sconnect Ti meout ( 60) ;
Ct xSet W ndowTi neout ( 30) ;
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Ct xSet Pi ngTi neout (20) ;

Ct xSet Wai t Poi nt Ti meout ( 30) ;

Ct xSet W ndowVeri fi cati on( TRUE) ;

Ct xSet Enabl eCount er s( FALSE) ;

Ct xSet W ndowRet ri es(5, 5000);

Ct xSet Enabl eW | dcar divat chi ng( TRUE) ;
SYNCHRONI ZE() ;

BEG N_TRANSACTI ON() ;

DO _Set TransactionStart();

Ct xConnect (CitrixServer, CitrixQutputMde);
/1 Wndow CW _1 ("Warning !!") created 1087837356. 454
Ct xWai t For W ndowCr eat e(CW _1, 2125);

DO_MBLEEP(1891) ;
Ct xPoi nt (246, 267); //1087837358. 797

DO_MBLEEP( 453) ;
Ct xMouseDown(CW _1, L_BUTTON, NONE, 246, 267); // 1087837358.797

Ct xMbuseUp(CW _1, L_BUTTON, NONE, 247, 267); //1087837359.032

DO_MSLEEP( 63) ;
/1 Wndow CW _14 ("M crosoft Wrd") created 1087837397. 390

Ct xWai t For W ndowCr eat e( CW _14, 141);

DO_MSLEEP( 78) ;
CW _14->setTitl e("Documentl - Mcrosoft Wrd"); //1087837397. 468

/1 Wndow CW _13 ("") destroyed 1087837397. 468

DO _MBLEEP( 2468) ;
Ct xPoi nt (37, 50); //1087837400. 218

DO_NMBLEEP( 282) ;
CtxOick(CW _14, 203, L_BUTTON, NONE); //1087837400.421

/1 Wndow CW _15 ("Open") created 1087837400. 764
Ct xWai t For W ndowCr eat e( CW _15, 344);

DO_MSLEEP( 1656) ;

Ct xPoi nt (132, 99); //1087837402.671

DO_MSLEEP( 250) ;
Ct xDoubl eCl i ck(CW _15); // 1087837402. 874

DO _MBLEEP( 109) ;
DO MBLEEP( 1953) ;
Ct xPoi nt (247, 197); //1087837404. 827

/1 Wndow CW _15 ("Open") destroyed 1087837404. 827
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i f(CtxW ndowEvent Exi st s( EVT_STR_CTXW NDOACREATE, 3000, CW _16))
Begi nBl ock() ;
Ct xPoi nt (337, 265); //1087837404.905

/1 Wndow CW _16 ("11111111 - Mcrosoft Wrd") created
1087837404. 905

Ct xWai t For W ndowCr eat e( CW _16, 31);

/1 Wndow CW _14 ("Documentl - M crosoft Word") destroyed
1087837404. 905

DO _MBLEEP( 7547) ;
CtxPoi nt (628, 9); //1087837414.592

DO_MBLEEP(2141) ;
Ctxdick(CW _16, 281, L_BUTTON, NONE); //1087837414.873

DO_MBLEEP( 234) ;
/1l Wndow CW _16 ("11111111 - Mcrosoft Wrd") destroyed
1087837415. 108
Ct xPoint (113, 93); //1087837418.779

/1 Wndow CW _17 ("") created 1087837418. 779
EndBI ock()

/1]l ReadOnly Code Start

el se
Begi nBl ock() ;

/1 Wndow CW _117 ("File In Use") created 1087840076. 599
Ct xWai t For W ndowCr eat e( CW _117, 578);

DO_MSLEEP( 2360) ;

Ct xPoi nt (358, 283); //1087840079.068

DO_MSLEEP( 125) ;
Ctxdick(CW _117, 281, L_BUTTON, NONE); //1087840079. 365

DO_MSLEEP( 109) ;
/1 Wndow CW _117 ("File In Use") destroyed 1087840079. 458

/1 Wndow CW _118 ("11111111 (Read-Only) - Mcrosoft Wrd") created
1087840079. 521

Ct xWai t For W ndowCr eat e(CW _118, 63);

/1 Wndow CW _115 ("Docunentl - Mcrosoft Wrd") destroyed
1087840079. 521

DO _MBLEEP( 4766) ;
CtxPoi nt (631, 3); //1087840084. 490

DO_NMBLEEP( 203) ;
CtxOick(CW _118, 250, L_BUTTON, NONE): //1087840084. 740

DO_MSLEEP( 93) ;
/1 Wndow CW _118 ("11111111 (Read-Only) - Mcrosoft Word")
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destroyed 1087840084. 833

/1] ReadOnly

}

DO_MBLEEP( 2407) ;

Ct xPoi nt (34, 465);

EndBl ock();

Code End

DO _MBLEEP( 1063) ;

DO_MSLEEP( 484) ;

Ct xPoi nt (112, 93);

DO_MSLEEP( 406) ;

Ct xDoubl el i ck(CW _9);

/1 Wndow CW _9 ("Program Manager") destroyed 1087837440. 122

/11087837419. 654

/1 1087837419. 904
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//1087840087. 333

/1 Wndow CW _7 ("") destroyed 1087837440. 138

DO _Set Transacti onC eanup();

Ct xDi sconnect ();

END_TRANSACTI ON() ;

delete CW _1; //
delete CW _2; //
delete CW _3; //
delete CW _4; [/
delete CW _5; //
delete CW _6; //
delete CW _7; //
delete CW _8; //
delete CW _9; //
delete CW _10; /
delete CW _11; /
delete CW _12; /
delete CW _13; /
delete CW _14; /
del ete CW _15; /
delete CW _16; /
delete CW _17; /
delete CW _18; /
delete CW _19; /
del ete CW _20; /

delete CW _117;
del ete CW _118;

CitrixUninit();
REPORT( SUCCESS) ;

EXI T();
return(0);

"Warning !'!"

"Log On to W ndows"
"Please wait..."
"Citrix License Warning Notice"
"Citrix License Warning Notice"
"Usr Logon. Crrd"

"I CA Seanl ess Host Agent"

11
11

" Program Manager "

"M crosoft Word"
" Qpen”

"11111111 - Mcrosoft Wrd"

"Cal cul ator"
"Shut Down W ndows"

"File In Use"
"11111111 (Read-Only)

voi d abort_functi on(PLAYER | NFO *s_i nf 0)

{

M crosoft Word"
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RR_printf("Virtual User ABORTED.");
CitrixUninit();

EXI T();
}

Moving the Citrix Connect and Disconnect Outside the Transaction Loop

If your load testing requirements for Citrix include creating extended logon sessions, in which the user
remains connected to the Citrix server between transactions, review the following tipsfor recording and
script development.

Recording

Perform the following steps during the recording processin order to prepare for moving the connect and
disconnect actions outside the transaction loop:

1. Insert acomment such as“Logged in to Citrix” after the Citrix logon but before any windows have
been opened.

2. Ensurethat all application windows are closed before disconnecting from the Citrix session.

3. Insert acomment such as“Ready to log off Citrix” before the Citrix logoff sequenceisinitiated.
Ensure that the first comment isadded after the user haslogged on and closed all login-related
dialog boxes, but before any applications are started. Smilarly, the second comment must be
placed after all applications have been closed, but before the user logs off.

Scripting

Comment out the BEGIN_TRANSACTION and END_TRANSACTION callsand add new
BEGIN_TRANSACTION and END_TRANSACTION calls at the location where the comments from steps 1
and 3 above were placed. Comment out the callsinstead of deleting them so that the original location of
these commands can be determined for debugging purposes.

Also comment out the DO_SetTransactionSart and DO_SetTransactionCleanup calls.

Using the CtxWaitForScreenUpdate Command

In some situations, awindow may vary in how long it takesto refresh on the screen. For example, the
Windows Sart menu isan unnamed window that can take varying amounts of time to appear, depending
on system resource usage. To prevent playback problemsin which a mouse click does not synchronize with
itsintended window, insert the CtxWaitForScreenUpdate command in the script after the action that
causesthe window to appear. The parameters for the CtxWaitForScreenUpdate command correspond to
the X and Y coordinates and the width and height of the window. Thiscommand ensuresthat the window
hasenough time to display before the mouse click.

OFS

Understanding the C++ Script

Oracle Forms Server scripts are produced for Oracle Forms, 6.0, 6i, and 9i (Release 2 and later) recordings.
The C++ script executes OFSrelated statements by passing the statementsin the script DLL to the OFS Java
enginethat performstheclient activitiesand the client communication with the server. Because the C++
script statements are directly tied to corresponding methodsin the OFSJava engine, modificationsto the
script statementsare limited to changing the property parameter values through variablization.

An OFSC++ script containsthree main sections: Connection, Application Body, and Disconnect. The
QALoad transaction loop includes all three sections by default. The transaction loop can be moved using
the guidelines described in Moving the OFStransaction loop. An internal auto checkpoint iscreated during
connection statementsand transmission statements.
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The C++ script statements are a condensed version of the Java-style script statements. The C++ script
statements show the GUI controlsin the OFSapplication and the control properties, which are either
control attributes or activities. For example:

of sClickButton( "BUTTON', 52, OFS_ENDMSG 325 );

In thisexample, the user clicks (property 325) a button ( control ID 52). OFS ENDMSG isaflag that
indicatesthat the GUI activity endsthe current OFS M essage.

QALoad also allows OFSand WWW statements from a Universal session to be scripted in the C++ script,
providing the ability to play back WWW and OFSstatements. QALoad automatically extracts ICX tickets
and any necessary cookies from the WWW middleware traffic and passesthem to the OFSmiddleware.

Connection Statements

The connection script linesin the C++ script vary depending on the type of Forms connection mode that is
active. You choose the Forms connection mode on the Oracle Forms Server Recording Options dialog box.
Formsconnection modesinclude server-side recording, HTTP, HTTPS, or socket.

Server-side recording islimited to applicationsthat use Forms 9i (applicationsrunning in Oracle 9iAS
Release 2 and above). HTTP connection mode is available for applicationsusing Forms 9i and for
applicationsusing the patched Forms 6i version configured with the HTTP servlet. HTTPS connection
mode isstrictly for SS_-enabled applicationsthat use Forms 9i. Socket connection mode isfor applications
that use Forms 6i and lower versions, such as Oracle 11i.

Server-side recording connections

Server-side recording mode containsonly one connection statement. The function that isused —
ofsSetServletM ode — containsthe listener servlet value that you entered on the Oracle Forms Server
Recording Optionsdialog box. The first parameter definesthe HTTP or HTTPS configuration of the
application environment. The second parameter definesthe name of the Forms Listener Servlet used by the
application. To connect, QALoad internally invokes Oracle’s dispatch callsusing the two parameters.
Oracle’'s proprietary classes provide the implementation for the HTTP or HTTPS connection. For example:

of sSet Ser vl et Mode( OFS_HTTP, "http://ntsap45b: 7779/ f orns90/ 1 90servl et" );

HTTP connections
HTTP connection mode contains multiple connection statements. To connect, QALoad internally performs
Java callsto accomplish the following tasks:

! DefineHTTP header properties

I Connect to the Forms Servlet (an HTTP-GET request)

I Set the parameters of the Forms Listener Servlet

I Connect to the FormsListener Servlet (an HTTP-GET request)

I Set additional HTTP header property for the Listener Servlet

I Connect to the FormsListener Servlet (an HTTP-POST request). The last connection statement also
initiatesthe required Forms“handshake” and determinesthe Forms encryption used by the
application environment.

For example:

of SHTTPSet Hdr Pr operty(" User-Agent”, "Javal.3.1.9" );
of sHTTPSet Hdr Pr operty("Host", "ntsap45b: 7779" );
of SHTTPSet Hdr Property(" Accept”, "text/htm , inmage/gif, image/jpeg, *; q=.2, "*/*;

)

of sSHTTPSet Hdr Pr operty(" Connecti on", "Keep-alive" );

of sHTTPConnect ToFor nsSer vl et (

"http://ntsap45b: 7779/ f or 690/ f 90ser vl et ?i f cnd=st art sessi on" );

of SHTTPSet Li st ener Servl et Par ns( " ?i f cnd=get i nf 0& f host =C104444D01&i fi p= "192. 168. 234. 1"
)
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of sHTTPConnect ToLi st ener Servl et ( "http:// ntsap45b: 7779/ f orms90/ 1 90servl et");
of SHTTPSet Hdr Pr operty(" Content-type", "application/x-ww-formurl encoded" );
of SHTTPI ni ti al For nrsConnect () ;

HTTPSconnections

HTTPSconnection mode usesthe same connection statementsas HTTP mode. To connect, QALoad
internally performsthe same tasksasthe HTTP connection mode plusit performsthe SS. connection
when the ofsHTTPSDoSSL.Handshake function iscalled. This statement is positioned in the script before
the ofsHTTPConnectToFormsServlet function.

Socket connections

Socket mode containsonly one connection statement. The function that isused —ofsConnectToSocket —
containsthe port number and the URL you entered on the OFSRecording Optionsdialog box to start OFS
capture. The port value isthe port on which the Forms Server directly listens for Formstraffic. To connect,
QALoad uses Java callsto open a Java socket using the parameters, initiate the required Forms "handshake”,
and determine the Formsencryption used by the application environment. For example:

of sConnect ToSocket (" 10. 10. 0. 167", 9002 );

Application Statements

The application statementsin the C++ script consist of property statementsand transmission statements.
Property statements describe the attributes and activities of GUI controlsin the application. Transmission
statements send the GUI controlsand their properties as Forms Message datato the server. Thereisonly
onetransmission statement: ofsSendRecv. QALoad creates an internal auto checkpoint when this statement
isexecuted. In the following example, the first two (property) statements set the location and size of a
FormWindow GUI control. The ofsSendRecv statement sendsthe GUI control propertiesto the server.

of sSet W ndowLocat i on( " FORMA NDOW, 6, OFS_ENDMSG 135, 0, 0); /1 Property
of sSet W ndowSi ze( " FORMA NDOW, 6, OFS_ENDVMSG 137, 650, 500); /1 Property
of sSendRecv(1 ); //Transni ssion

Parameters of a property statement:
The parameters of a property statement are arranged in the following sequence:

1. Captured control name. If the nameisnot available, thisvalueisthe classnameto which the
control belongs.

2. Captured control ID.

3. Action type. Thisflag indicatesif the property isto be added to the current Forms Message or if the
property endsthe current Forms Message. During playback, each control istreated asa Forms
Message. When the current Message ends, QALoad translatesthe control and its propertiesto
binary format. The valid values are:

! OFS ADD - add the property to the current Message.
! OFS ENDMSG —add the property to the current Message and end the Message.

! OFS STARTSUBM SG — add the property of the succeeding nested Message to the current
M essage.

4. Property ID. The Formsversion-specific ID of the property.
5. Property value. Captured value of the property (optional)
6. Property value. Captured value of the property (optional)

For example:
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of sSet W ndowSi ze( " FORMA NDOW, 6, OFS_ENDVSG 137, 650, 500);

In thisexample, control ID 6, which belongsto GUI class FORMWINDOW, isresized (PROPERTY
137) to have coordinates 650 and 500. Thismarksthe end of the current M essage.

Forms environment statements:

Theinitial set of statementsin the Forms script describesthe Forms application environment. In this set,
the"version” and the “cmdline” propertiesare the most important. The version property showsthe Forms
Builder version used by the application. The version indicates the capabilities of the application. For
example, some versions cannot support HTTP connections. The cmdline property showsthe Forms
configuration parameters passed to the server by the Forms applet. The parameter “record=names’
indicatesthat the application enables GUI control namesto be captured. Control names are preferred in
multi-threaded playback. The “ICX” parameter indicatesthat the application uses a Personal Home Page.

In the sample script below, the Forms builder version is 90290 (the version used in Oracle 9iAS Release 2,
unpatched). The cmdline property shows “record=forms” which defaults “record=names’. The cmdline
property does not havethe “ICX” ticket parameter.

of sSetlnitial Version( "RUNFORM', 1, OFS_ADD, 268, "90290" );

of sSet Scr eenResol ution( "RUNFORM', 1, OFS_ADD, 263, 96, 96);

of sSet Di spl aySi ze( "RUNFORM', 1, OFS_ADD, 264, 1024, 768);

of sl nit Sessi onCndLi ne(" RUNFORM', 1, OFS_ADD, 265,

"server nodul e=testl.fnx userid= sso_userid= debug=no buffer_records=no debug "
"messages=no array=no query_onl y=no qui et=yes render=no host=ntsap45b. prodti.cont
"puwar e. com port= record=forns tracegroup=debug | og=runl term=" );

of sSet Col or Dept h( "RUNFORM', 1, OFS_ADD, 266, "256" );

of sCol or Add( "RUNFORM', 1, OFS_ADD, 284, "0" );

of sCol or Add( "RUNFORM', 1, OFS _ADD, 284, "8421504" );

of sSet Font Nane( "RUNFORM', 1, OFS_ADD, 383, "Dialog" );

of sSet Font Si ze( "RUNFORM', 1, OFS_ADD, 377, "900" );

of sSet Font Styl e( "RUNFORM', 1, OFS_ADD, 378, "0" );

of sSet Font Wi ght ( "RUNFORM', 1, OFS_ADD, 379, "0" );

of sSet Scal el nfo( "RUNFORM', 1, OFS_ADD, 267, 8, 20);

of sSet NoRequi r edVALi st ( "RUNFORM', 1, OFS_ADD, 291 );

of sSet PropertyString( "RUNFORM', 1, OFS _ENDVMSG, 530, "Anerical/ New _York" );

of sSendRecv(1 );

/1 dient SeqNo=1| CapTi mre=1086884188. 281| MsgCount =1

Sending messages to the server:

The ofsSendRecv statement sendsthe accumulated GUI controlsand their propertiesto the Forms Server as
binary data. This statement representsthe point at which theclient sendsa Forms Terminal Message to the
server. In Oracle Forms, the client and the server must end each data block with a Terminal Message before
any transmission occurs.

Internally, QALoad variesthe binary data transmission depending on the connection mode:

! For server-side recording mode, QALoad sendsthe binary data by invoking Oracle’'s dispatch calls.
Oracle’'s own classes provide theimplementation for the HTTP transmission.

I For HTTP or HTTPSmode, QALoad wrapsthe binary datainside an HTTP stream and invokes Java's
HTTP calls.

! For socket mode, QALoad sendsthe binary data directly to the Java socket opened at the
connection point.

The ofsSendRecv statement has one parameter: the response code of the captured Terminal Message. The
possible values for this parameter are 1 (add), 2 (update), and 3 (close). Typically, when the response code
is 3, the Forms Server reacts by removing the GUI controls associated with the client message from the
server cache.

A comment line appears after each ofsSendRecv statement that contains script-tracking information. The
information on the comment lineisalso found in the capture file in each ofsSendRecv capture line. The
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comment line showstherelative sequence of each client request, as represented by a Terminal M essage,
from the start of the application (e.g. ClientSegNo=1). The comment line also showsthe timing mark of
the captured Terminal Message (e.g. CapTime=1086884188.281) and the number of Forms messages
contained in therequest (e.g. MsgCount=1). The number of Messages can be verified by counting the
preceding ENDMSG and STARTSUBM SG flagsin the request block. The comment line is useful for
debugging playback issues because it readily showsthe client request sequence number where theissueis
occurring.

Getting the server reply:

During the execution of ofsSendRecv, QALoad also obtainsthe server'sreply and translatesthe binary
Formsdatainto Formscontrol values and control properties. The values are also written to the playback
log file (in capture file format) if script logging isenabled. The following sampleisa server reply:

VU O : MS|2/0]1

VU 0 : P| S| 322| j ava. | ang. I nt eger| 0] 151000320

VU 0 : P| S| 279] j ava. | ang. Bool ean| 0| f al se

VU 0 : P| S| 525] j ava. | ang. St ri ng| AVERI CAN_AMERI CA. VESVBW N1252
VU 0 : T| S| 1] Ser ver SeqNo=1| MsgCount =76

Thefirst lineindicatesthe start of a Forms Message from the server (M|S). The third parameter isan action
code (1= add, 2= update, 3= delete, 4= get property value). The fourth parameter isthe Class Code of the
control (0 =root class). The fifth parameter isthe Control ID (1= RunForm).

The second, third and fourth lines are property linesrelated to the above Forms Message from the server
(P|S). Thethird parameter of each lineisthe property ID (322). The fourth parameter isthe data type of
this property (java.lang.Integer). The fifth parameter isthe data value. If the value is 0, the data valueisin
asixth parameter (false).

Thethird lineisthe terminal message line from the server (T|S. The third parameter isthe response code
associated with the terminal message (1= add, 2= update, =close). The fourth parameter istherelative
sequence of the server reply, asrepresented by a Terminal Message, from the start of the application (e.g.
ServerSeqNo= 1). Thefifth parameter isthe number of Forms messages contained in the reply (e.g.
MsgCount = 1). The number of Messages may be verified by counting the preceding M|Sflagsin thereply
block. The fourth and fifth parameters are script-tracking information, which can be useful for debugging
aplayback issue. If logging isenabled, the log file shows the tracking information, which can make the
comparison between server responses and captured responses easier.

Processing large data and delayed response scenarios:

When HTTP or HTTPSconnection modeisused, Forms dataiswrapped insidethe HTTP reply stream.
QALoad checksthe HTTP header of the reply before processing the Formsdata. The HTTP header
sometimesindicatesthat the client needsto perform additional HTTP POST requeststo obtain the
complete Formsdata. Thisindication occurswhen the content-length of the reply is 64000 (a large data
scenario), or the content-type is "text/plain” and the HTTP header contains an “iferror: ” string (a delayed
response/re-post scenario). QALoad performsthe necessary POST requeststo obtain the complete reply
data, and then translates the accumulated reply datato Formscontrols and properties.

Disconnect statements
The disconnect script lines vary depending on the Forms connection mode.

I In server-side recording mode, the ofsServerSdeDisconnect script statement internally invokes
Oracle’'s dispatch callsto disconnect.

I In HTTP mode, the ofsHTTPDisconnect statement internally makes Java callsto disconnect the
main URL connection from the servlet.

I In socket mode, the ofsSocketDisconnect statement closesthe socket on which the Forms Server
listens for traffic.
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Using Script Logging asa Debugging tool

You can debug a playback issue in a C++ script by enabling replay logging. The option for enabling replay
logging islocated on the Script Assignment tab of the Conductor. For more information about enabling log
file generation, see Debugging a script.

In Java-based scripts, logging is not enabled by default. To enable logging, change the parameter of the
Logging method to truein the script. For example:

oracl eForns. Loggi ng( true );

When logging isenabled, QALoad writesthe client requests and server repliesto the playback log filein the
same format asthe capture file. The playback log file isfound in the\ QALoad\ LogFi | es directory. When
thereisan issue during playback, such asthe server not responding to aclient request, you can compare
the capture filesand check the differencesin the server reply data. Both the capture file and the log file
contain tracking information appended to the server'sterminal messages. The tracking data containsthe
relative sequence number of the server reply from the start of the Forms session and the timing mark. The
tracking data also showsthe number of Forms messages contained in the reply block. The number of
messages are based on the number of “M|S’ lines prior to the “T|S’ lines.

In the following example, the first set of statementsshowsthe logged statementsand the second set of
statements showsthe captured statements. The ServerSeqNo value showsthat thisisthe 8th reply from the
server. The MsgCount value of 1 showsthat only one Forms Messageisincluded in thisreply block.

1087419810. 000| of sShowwW ndow] W NDOW START_APP| 11| OFS_ENDMSG 173| PROPERTY_VI SI BLE| j ava. | ang. B
ool ean|true
1087419810.
1087419810.

000| of sSendRecv| 1] d i ent SeqNo=8| CapTi ne=1087419810. 000| MsgCount =1
000| M S| 2| 0] 30

1087419810.
1087419810.
1087419810.
1087419810.

1087402349.
ool ean| true
1087402349.
1087402349.
1087402349.
1087402349.
1087402349.
1087402349.

000| P| S| 135| j ava. awt . Poi nt | 0| j ava. awmt . Poi nt [ x=0, y=0]
000| P| S| 137| j ava. awt . Poi nt| 0| j ava. awt . Poi nt [ x=706, y=464]
000| P| S| 139| j ava. awt . Poi nt | 0| j ava. awmt . Poi nt [ x=0, y=0]
000T| S| 1| Ser ver SeqNo=8| CapTi me=1087419810. 000| MsgCount =1

296| of sShowwW ndow] W NDOW START_APP| 11| OFS_ENDVSQ 173| PROPERTY_VI SI BLE| j ava. | ang. B

296| of sSendRecv| 1| d i ent SeqNo=8| CapTi me=1087402349. 296| MsgCount =1
296| M S| 2] 0] 30

296| P| S| 135| j ava. awt . Poi nt | O] j ava. awt . Poi nt [ x=0, y=0]

296| P| S| 137| j ava. awt . Poi nt | O] j ava. awt . Poi nt [ x=706, y=464]

296| P| S| 139| j ava. awt . Poi nt | O] j ava. awt . Poi nt [ x=0, y=0]

296| T| S| 1| Ser ver SeqNo=8| CapTi me=1087402349. 296| MsgCount =1

Moving the OFS Transaction Loop

To enable movement of the QALoad transaction loop in the C++ script, you must first record a full business
transaction and a partial businesstransaction. The businesstransaction isthe activity that you would like
to repeat during QALoad playback. Insert QALoad capture comments (using the Insert Command button
on the Recording toolbar) at the start and end of a business transaction. These commentswill help you

find the spotsin the script where you would like to reposition the BEGIN_TRANSACTION() and
END_TRANSACTION() statements. Then re-start the business transaction.

QALoad's OFSscript presents a sequence of Forms GUI objects. The GUI objects contain context
dependencies. For example, when awindow isopened, the buttons, text fieldsand edit boxesinside that
window are logically dependent on the state of that window. When only one businesstransaction is
captured and the corresponding script’stransaction loop is moved, the sequence of the GUI objectsis
broken during the second iteration of the transaction loop. The broken sequence resultsin a broken
context, which causesthe server to respond unpredictably during playback on the second and subsequent
iterations of the transaction loop. When the businesstransaction isrestarted during capture, the Forms
GUI objectsthat compose the new transaction are used to anchor into the new transaction loop without
breaking the context dependencies of GUI objects.
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When modifying the script, use the comment linesas guidesin moving the END_TRANSACTION() and
BEGIN_TRANSACTION() statements. Ensurethat thereisacontextual flow from the new position of the
END_TRANSACTIONY() statement to the new position of the BEGIN_TRANSACTION() statement. The set of
GUI objectsthat belong to the ofsSendRecv() statement just before the new END_TRANSACTION()
statement must be the same asthe set of GUI objectsthat belong to the ofsSendRecv() statement prior to
the new BEGIN_TRANSACTION() statement.

During playback, modify the Conductor setting for Transaction Pacing on the Script Assignment tab to
allow the database to process each new business transaction.

The following example shows a modified OFStransaction loop:

New position of the BEGIN_TRANSACTION statement

/ *
NewSal es
*/

DO _SLEEP(13) ;

of sEdi t ( "ORDER _SOLD TO 0", 562, OFS ADD, 131, "B" );

of sSet Sel ecti on( "ORDER SOLD TO 0", 562, OFS _ADD, 195, 1, 1);

of sSet Cur sor Posi ti on( "ORDER _SOLD TO 0", 562, OFS_ENDMSG 193, "1" );
of sl ndexKey( "ORDER SOLD TO 0", 562, OFS_ENDMSG, 175, 97, 0);

DO_SLEEP(6) ;
of sSendRecv(1); //dientSeqNo=31| MsgCount =2| 1093981339. 921
BEG N_TRANSACTI O\() ;

of sEdit ( "ORDER _SOLD TO 0", 562, OFS_ADD, 131, "Business Wrld" );

of sSet Sel ection( "ORDER _SOLD TO 0", 562, OFS_ADD, 195, 14, 14);

of sSet Cur sor Posi ti on( "ORDER SOLD TO 0", 562, OFS_ENDMSG 193, "14" );

of sRenpveFocus( "ORDER _SCLD TO 0", 562, OFS_ENDMBG, 174 );

of sSet Sel ecti on( " ORDER_CUSTOVER _NUMBER 0", 564, OFS_ADD, 195, 0, 0);

of sSet Cur sor Posi ti on( "ORDER_CUSTOVER_NUMBER_ 0", 564, OFS_ENDMSG, 193, "0" );
of sFocus( " ORDER_CUSTOMER NUMBER 0", 564, OFS ENDMBG, 174 );

DO _SLEEP( 6) ;
of sSendRecv(1); //dientSeqNo=32| MsgCount =4| 1093981347. 296

New position of the END_TRANSACTION statement

/*
EndTr ans
*/

DO_SLEEP( 39) ;
of sSendRecv(1); //dientSeqNo=61| MsgCount =4| 1093981458. 031

of sSet Cur sor Posi ti on( “ORDER SOLD TO 0", 562, OFS_ENDMSG 193, "14" );
of sSel ect Menulten{ "Sal es Orders", 257, OFS_ENDMSG 477, "MENU_11059" );

DO_SLEEP( 26) ;
of sSendRecv(1); //dientSeqNo=62| MsgCount =2| 1093981485. 265

of sEdit ( "ORDER _SOLD TO 0", 562, OFS_ADD, 131, "B" );

of sSet Sel ecti on( "ORDER_SOLD TO 0", 562, OFS_ADD, 195, 1, 1);

of sSet Cur sor Posi ti on( "ORDER_SOLD TO 0", 562, OFS_ENDMBG, 193, "1" );
of sl ndexKey( "ORDER SOLD TO 0", 562, OFS_ENDMSG, 175, 97, 0);

DO_SLEEP(3);
of sSendRecv(1); //dientSeqNo=63| MsgCount =2| 1093981488. 437
END_TRANSACTI ON( ) ;

of sEdit ( "ORDER _SOLD TO 0", 562, OFS_ADD, 131, "Business Wrld" );

of sSet Sel ection( "ORDER _SOLD TO 0", 562, OFS_ADD, 195, 14, 14);

of sSet Cur sor Posi ti on( “ORDER_SOLD TO 0", 562, OFS_ENDMSG 193, "14" );
of sl ndexSKey( "ORDER SOLD TO 0", 562, OFS ENDMSG, 176, 10, 0);
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DO _SLEEP(13);
of sSendRecv(1); //dientSeqNo=64| MsgCount =2| 1093981502. 640

OFSand WWW Universal Sessions

QALoad now automatically extracts ICX ticket information from WWW middleware traffic and passesit to
the OFSmiddleware.

If you are using an older version of a script (prior to 5.5.1), you should modify the script manually. Record
with a Universal session to capture both the OFSand WWW transactions and merge the two sets of
transactionsinto one script. The captured WWW statements contain non-servlet, non-Formsdata such as
GIF objects, while the captured OFS statements contain the Forms data.

When an Oracle Applicationslogin is captured, it is scripted using the ofsSetICXTicket statement. The
WWW login executes, extractsthe ICX ticket from the server reply, and passesthe ICX ticket to the Forms
session.

To capture an Oracle Applicationslogin with ofsSetICXTicket, modify the script.

To capture an Oracle Applicationslogin with ofsSetICXTicket:

1. Addthefollowing variable declaration statementsto the top of the script:
char * pTi cket =NULL;

2. Inthe*. post capweb file, find the HTTP request that returnsthe ICX ticket. The reply should
contain astring that indicatesthe ICX ticket value, such as" 1 CX_TI CKET=". Note the left and
right charactersthat delimit the ICX ticket value. In the examplein step 4, the left delimiter is
"icx_ticket="" and theright delimiteris""'".

In the script, find the matching request line for the HTTP request.

After the matching HTTP request line, add the DO_GetUniqueString statement using your chosen
delimiters. For example:
pTi cket = DO _Get Uni queString( "icx_ticket="", "'");

5. (optional) Verify the ICX ticket value.
RR__printf("ICX _Ticket=\"%\"\n", |ICX_ Ticket);

6. Add thescript line of sSet | CXTi cket (&oTi cket); beforethe ofslnitSessionCmdLine. This passes
thevalue of the ICX ticket to the ofsinitSessionCmdLine statement.

7. Freethememory allocated by DO_GetUniqueString and ofsSetICXTicket before the end of the
transaction:
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if (pTicket !'=NULL)
{

free(pTicket);
pTi cket =NULL;

}
SAP

Required Commands

Certain commands must be present in an SAP script for it to run successfully. These commands are created
automatically during the conversion process. Most of the commands exist before the
BEGIN_TRANSACTION statement. The required commandsinclude:

SET_ABORT_FUNCTI ON( abort function);
DEFI NE_TRANS_TYPE(" capture. cpp");
HRESULT hr = Colnitialize(0);

i f( hr !'= ERROR _SUCCESS )
RR__Fail edMsg(s_info, "ERROR initializing COM);

SAPGui Set CheckScreenW | dcard( ‘*");
SYNCHRONI ZE() ;

Required commands for transaction restarting
When transaction restarting isenabled in the Conductor for an SAP script, the following commands,
which are automatically added by QALoad during script conversion, must exist for the script to run:

SAPGui Appl i cati on(Regi st er ROT) ;
SAPGui Appl i cati on( RevokeROT) ;
SAPGui _error_handl er(s_info, buffer);

The SAPGuiApplication command properly registers and removes the script's SAP GUI usage on the
Runtime Object Table (ROT). If atransaction fails, these actions are taken to start and clean up the SAP
environment.

El Note: Do not call RR _FailedMsg in an SAP script if the script includes a restart transaction operation.
SAPGui_error_handler can be called with the same parametersas RR _FailedM sg to output a fatal error
message while still allowing a proper clean up of the current transaction before restarting the transaction.

Error Handling and Reporting

A try/catch block isautomatically generated for the commands between the BEGIN_TRANSACTION and
END_TRANSACTION statements. This construct provides error handling and reporting from the script.

BEG N_TRANSACTI ON() ;

try{

SAPGui Connect ( s_i nfo, "qacsapdb2");
SAPGui Ver CheckStr (" 6204. 119. 32");

/1 Set SapApplication = CreateObject("Sapgui.ScripingCrl.1")
/| SapAppl i cati on. OpenConnection ("qgacsapdb")
/1 Set Session = SapApplication. Children(0). Children(0)

DO _SLEEP(3) ;

SAPGui Propl dStr("wnd[0]");
SAPGUi Cmd3( Gui Mai nW ndow, Resi zeWr ki ngPane, 83, 24, false);

DO_SLEEP(6) ;
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SAPGui Propl dStr ("wnd[ 0] / usr/t xt RSYST- BNAME") ;
SAPGui Crd1( Gui Text Fi el d, Put Text, "qgal oadl1");

SAPGui Propl dStr ("wnd[ 0] / usr/ pwdRSYST- BCODE" ) ;
SAPGUi Cmd1Pwd( Gui Passwor dFi el d, Put Text, "~encr~1211616261");

SAPGuUi CndO( Gui Passwor dFi el d, Set Focus) ;
SAPGui Crd1( Gui Passwor dFi el d, Put Car et Posi tion, 3);

SAPCui Propl dStr ("wnd[ 0] ") ;
SAPGui Crd1( Gui Mai nW ndow, SendVKey, 0) ;
SAPGuUi CheckScreen(" S000", " SAPMSYST", " SAP") ;

DO_SLEEP( 10) ;

SAPGuUi Propl dStr ("wnd[ 0] /usr/cnt| | MAGE_CONTAI NER/ shel | cont/shel | /shell cont[0]/shell");
SAPGuUi Cd1( Gui Ctrl Tree, ExpandNode, "0000000003");

SAPGuUi Cd1( Gui Crl Tree, Put Sel ect edNode, "0000000004");

SAPGUi Crd1(Gui Ctrl Tree, Put TopNode, "Favo");

SAPGuUi Cnd1(Gui Crl Tree, Doubl ed i ckNode, "0000000004");

SAPCQui CheckScreen(" SESSI ON_MANAGER', " SAPLSMIR_NAVI GATI ON', "SAP Easy Access");
SAPGui Propl dStr ("wnd[ 1] / usr/ bt nSPOP- OPTI ON1") ;

SAPGui CdO( Gui Butt on, Press);

SAPCui CheckScreen(" SESSI ON_MANAGER", " SAPLSPOL", "Log O f");

} // end try

catch (_comerror e){
char buffer[1024];
sprintf (buffer,” EXCEPTION Ox% % for VU(%)\n",e.Error(),
(char *)e.Description(), S task_id);
RR__Fai |l edMsg(s_i nfo, buffer);

} // end catch
END_TRANSACTI ON( ) ;

To include thelog on within thetransaction loop, move the SAPGuiConnect call inside the try block as
shown in the following example:

SET_ABORT_FUNCTI ON( abort _functi on);
DEFI NE_TRANS_TYPE(" capture. cpp");
RESULT hr = Colnitialize(0);

i f( hr !'= ERROR _SUCCESS )
RR__Fail edMsg(s_info,"ERROR initializing COM);

SAPGui Set CheckScreenW | dcard('*");
SYNCHRONI ZE() ;
BEG N_TRANSACTI ON() ;

try{

SAPGui Connect ( s_info, "qacsapdb2");
SAPGui Ver CheckStr (" 6204. 119. 32");

SAPGui Propl dStr ("wnd[ 1] / usr/ bt nSPOP- OPTI ON1") ;
SAPGuUi CndO( Gui Button, Press);
SAPGui CheckScr een(" SESSI ON_MANAGER', " SAPLSPOL", "Log O f");

} I/ end try
catch (_comerror e){

char buffer[1024];

sprintf(buffer,” EXCEPTION Ox% % for VU(% )\n",e.Error(),
(char *)e.Description(), S task_id);

RR__Fai | edMsg(s_info, buffer);
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} I/ end catch
END_TRANSACTI ON() ;

To include thelog on outside the transaction loop, move the log off section so that it followsthe
END_TRANSACTION statement. However, ensure that the recording within the transaction loop begins
and endsin the same location in the menu system. For example:

SET_ABORT_FUNCTI ON( abort _function);
DEFI NE_TRANS_TYPE( " capt ure. cpp");
HRESULT hr = Colnitialize(0);
if( hr !'= ERROR_SUCCESS )
RR__Fail edMsg(s_info,"ERROR initializing COM);
SAPGui Set CheckScreenW | dcard('*");
SYNCHRONI ZE() ;
SAPGui Connect ( s_i nfo, "qacsapdb2");

SAPGui Propl dSt r ("wnd[ 0] / usr/t xt RSYST- BNAME") ;
SAPGuUi Cnd1( CGui Text Fi el d, Put Text, "qal oad1");

SAPGui Propl dSt r (" wnd[ 0] / usr/ pwdRSYST- BCODE") ;

SAPGuUi Cnd1Pwd( Gui Passwor dFi el d, Put Text, " ~encr~1211616261") ;
SAPGui CdO( Gui Passwor dFi el d, Set Focus) ;

SAPGui Cnd1( Gui Passwor dFi el d, Put Car et Posi tion, 3);

SAPGui Propl dStr("wnd[ 0] ") ;
SAPGuUi Cnd1( Gui Mai nW ndow, SendVKey, 0) ;
SAPCui CheckScreen(" S000", " SAPMSYST", " SAP") ;

BEG N_TRANSACTI ON() ;

try{
SAPGui Ver CheckStr (" 6204. 119. 32");

Y /1 end try

catch (_comerror e){
char buffer[1024];
sprintf(buffer,” EXCEPTION Ox% % for VU(% )\n",e.Error(),
(char *)e.Description(), S task_id);
RR__Fai | edMsg(s_i nfo, buffer);

} I/ end catch
END_TRANSACTI ON() ;

SAPGui Propl dSt r ("wnd[ 1] / usr/ bt nSPOP- OPTI ON1") ;
SAPGuUi CndO( Gui Button, Press);
SAPGui CheckScreen(" SESSI ON_MANAGER', " SAPLSPOL", "Log O f");

Handling Multiple Logons

You may need to modify your script to handle multiple logonswhen therecording scenario differs from
therun-time scenario. For example, if when you record, no users are logged on to the SAP environment
and when you run the script, users are already logged on, the script may fail. To work around thisissue,
you can use the SAPGuiPropldSrExists and SAPGuiPropldStrExistsEnd commandsto handle either
scenario. Thistechnique works by checking for the multiple logon dialog box from SAP and selecting the
Continue option.

The following example demonstrates the usage of the SAPGuiPropldStrExists and
SAPGuiPropldStrExistsEnd commandsto handle multiple logons:

SAPGui CheckScreen(" S000", " SAPMSYST", " SAP") ;
SAPGui Propl dSt r Exi st s("wnd[ 1]/ usr/radMJLTI _LOGON_OPT2");
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DO_SLEEP( 24) ;

SAPGui CrdO( Gui Radi oButt on, Sel ect) ;

SAPCui Cnd0( Gui Radi oBut t on, Set Focus) ;

SAPGuUi Propl dStr("wnd[ 1] /tbar[0]/btn[0]");

SAPCui CdO( Cui Butt on, Press);

SAPCui CheckScreen(" S000", " SAPMSYST", "Li cense Information for Miultiple Logon");

SAPGuiPropldStrExistsEnd("wnd[1]/usr/radMULTI_LOGON_OPT2");

Checking the SAP Status Bar

The SAP status bar displays error and status messages, as shown in the following figure.

Maintain PO Supplement : initlal Screen

You can use the SAPGuiCheckSatusbar command to test for certain statusresponsesin the SAP
environment.

The SAPGuiCheckSatusbar command isused in the following script example:

SAPCui PropldStr("wnd[0]");

SAPGui Cmd1( Gui Mai nW ndow, SendVKey, 0);

SAPGui CheckScreen("S000", "SAPMSYST", "SAP");

SAPGui Cd3( Gui Mai nW ndow, Resi zeWor ki ngPane, 94, 24, fal se);

/| SAPCui CheckSt atusbar returns TRUE if the nessage is found
//and FALSE if not found

BOOL bRet Sts = SAPCui CheckSt at usbar ("wnd[ 0] /sbar", "E: Make an entry in all required
fields");

if (bRetSts)
RR__printf(" True\n");

el se
RR__printf(" False\n");

Object Life Span

Whenever ascript isrun, all objectson the SAP GUI window are deleted and re-created. These objects,
which are created in the SAP environment and can disappear without user interaction, can cause script
failure if the script references the objects after they have disappeared.
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For more troubleshooting information, refer to SAP's publication titled “ SAP GUI Sripting API for the
Windows and Java Platforms”.

Winsock

Understanding Data representation in the Script

This section describeshow datathat issent and received is displayed in a Winsock script. Use this section
as areference when you examine a script.

During the conversion process, QALoad determines how to represent each character in the script. This
conversion process usesthe following rules:

1.

cots | v || osans | o |
@ 000 0
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The character iscompared to the “space” character in the ASCII table, which hasadecimal value of
32. If the character’'svalueislessthan 32, the following steps are taken:

I If thecharacteris“\r”, “\'n”, “\t”", or “\ ", it isrepresented in the script asanormal C escape
character.

I If thecharacter iseither “*\ " or “~" it isrepresented in the script as an octal character. For
example, the values would be “\ 034" and “\ 036", respectively.

I If thecharacter'svalueislessthan 32 and it doesnot meet the descriptionsin a) and b) above,
it isrepresented in the script as a control character. For example, if the character isanull
character, it isrepresented in the script as“ @' .

If the character’'sdecimal valueisbetween 32 (the “space” character) and 126 (~), it displaysin the
script as a standard readable ASCII character, with the following exceptions:

I If thecharacter is“\”, which hasadecimal value of 92, it isrepresented as“\\” in the script.
I If thecharacter is““", which hasadecimal value of 34, it isrepresented as“\”” in the script.
I If thecharacter is“"", which hasadecimal value of 94, it isrepresented as“~"" in the script.

If the character hasa decimal value of 127, which correspondsto Delete (DEL), it isrepresented as
“A" in the script.

The following table summarizesthe results of rules 1-3.

NUL
~A 001 1 SOH
"B 002 2 STX
nC 003 3 ETX
"D 004 4 EOT
~E 005 5 ENQ
"F 006 6 ACK
"G 007 7 BEL
“H 010 8 BS
\t 011 9 HT




\n

K
\ f

\r

AN
~O
AP
"Q
AR
rS
AT
U
"V
W
X
Y
4
il

\ 034

g

\\

N2

012

013

014

015

016

017

020

021

022

023

024

025

026

027

030

031

032

033

034

035

037

040

042

134

136

177

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

31

32

34

92

94

127

LF

VT

FF

CR

S E

DC2

DC3

DC4

NAK

SYN

ETB

CAN

EM

SB

ESC

FS

GS

us

DEL
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If the character isnot included in the groups defined in steps 1-3, it isrepresented as an octal
character in the script. These characters are often referred to ashigh ASCII characters (those with a
decimal value greater than 128), and arerepresented in the script as“\ O0O”, where OOO isthe
octal value for the ASCII character.
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Handling Winsock application data flow

Frequently, server programsreturn unique values (for example, a session ID) that vary with each execution
of the script and may be vital to the success of subsequent transactions. To create scriptsthat include these
values, you need to substitute the hard-coded valuesreturned by the server with variables. The following
original and modified code examples demonstrate thistechnique.

Original code

In thisscript, the server sendsa session ID in response to a connection by the client. Thissession ID is
required to successfully complete subsequent transactions.

/*

* wsk- AdvancedTechni ques_original .c

* This script contains support for the follow ng
* m ddl ewar es:

* - Wnsock

*/

/* Converted using the follow ng options:

* CGeneral :

* Line Split : 80 characters

* Sleep Seconds : 1

* Auto Checkpoints : Yes
*/

#defi ne SCRI PT_VER 0x00000005UL
#i ncl ude <stdi o. h>
#i ncl ude "smacro. h"
#i ncl ude "do_wsk. h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O
#endi f

int rhobot_script(s_info)
PLAYER | NFO *s_i nf o;
{

/* Declare Variables */

SET_ABORT_FUNCTI ON( abort _function);
DEFI NE_TRANS_TYPE( "wsk- AdvancedTech_1.c");

/| Checkpoi nts have been included by the convert process

Def aul t Checkpoi nt sOn() ;

DO WBK I nit(s_info);

Set Ti neout (20); /* WAit up to 20 seconds for each expected pattern */
SYNCHRONI ZE( ) ;

BEG N_TRANSACTI ON() ;

DO WSK_Socket (S1, AF_I NET, SOCK_STREAM | PPROTO | P);
DO WSK_Bi nd(S1, ANY_ADDR, ANY_PORT);
DO WSK_Connect (S1, "172.22.24.125", 2100, AF_INET);

FEETILLL b r i
/1l The session id returned by the server is

/1 unique to each connection

FEEEEEEE b r i irrrrrirrng

[* 21bytes: SessionlD=jrt90847\r\n */
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DO WBK_Expect (S1, "\n");
NNy

/1 This unique id is then used for subsequent

/'l requests

NNy

[* 34 bytes */

DO WBK_Send(S1, "SessionlD=jrt90847\r\n: "Br@@@B @@@A @@@);
[* 15 bytes: | D Accepted# @r\n */

DO WBK_Expect (S1, "\n");
DO WSK_d osesocket (S1) ;

END_TRANSACTI ON() ;
REPORT( SUCCESS) ;
EXIT() ;

return(0);

voi d abort_functi on(PLAYER | NFO *s_i nf o)
{

RR_printf("Virtual User % :ABORTED.", S task_id);
EXI T();

Modified code

If the original script (wsk-AdvancedTechniques_original.c shown above) isreplayed, it will fail because the
session ID will not be unique; rather, it will bethe session ID that iscoded in the script. To use the unique
session ID received from the server, variable substitution must be used.

/*

* wsk- AdvancedTechni ques_nodi fi ed. c
*

* This script contains support for the follow ng
* m ddl ewar es:

* - Wnsock

*/

/* Converted using the follow ng options:
* Ceneral :

* Line Split : 80 characters

* Sleep Seconds : 1

* Aut o Checkpoints : Yes

*/

#defi ne SCRI PT_VER 0x00000005UL

#i ncl ude <stdio. h>

#i ncl ude "snacro. h"

#i ncl ude "do_wsk. h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O
#endi f

int rhobot_script(s_info)
PLAYER_I NFO *s_i nf o;

{

/* Declare Variables */
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char Buffer[64];
char SendBuffer[64];
i nt nBytesReceived = 0;

SET_ABORT_FUNCTI ON( abort _functi on);

DEFI NE_TRANS_TYPE( "wsk- AdvancedTech_1.c");

/1 Checkpoi nts have been included by the convert process

Def aul t Checkpoi nt sOn();

DO WBK I nit(s_info);

Set Ti neout (20); /* Wait up to 20 seconds for each expected pattern */
SYNCHRONI ZE() ;

BEG N_TRANSACTI ON( ) ;

DO WSK_Socket (S1, AF_I NET, SOCK_STREAM | PPROTO | P);
DO WSK_Bi nd(S1, ANY_ADDR, ANY_PORT);
DO WSK_Connect (S1, "172.22.24.125", 2100, AF_INET);

FEETTLLL i b r i irrrrrrirrri
/1l The reply fromthe server is read into

/1l the Buffer variable. W will then have

/1 the unique Session ID for this connection.

/1l Also need to null-term nate the buffer

/1 after receiving.

TEETILLL i b r i irrrrrrirrri

DO WK _Recv(S1, Buffer, 64, 0, &nnBytesReceived);
Buf f er[ nByt esReci eved] = '\0';

[* 21lbytes: SessionlD=jrt90847\r\n */
/1 DO_WBK_Expect (S1, "\n");

FHOTEEEEEEE i irirrrrirg
/1 Finally, substitute the Session ID received from
/1l the server with the one coded in the script.
FHLEEELEE bbb iririrrir

sprintf(SendBuffer, "%:"Br@@@B @@ @A @@@, Buffer);
DO WBK_Send( S1, SendBuffer);

[* 34 bytes */
/1 DO_WBK_Send( S1, "SessionlD=jrt90847: '"Br@@ @B @@ @A @@@);
/* 15 bytes: |D Accepted# @r\n */

DO WBK_Expect (S1, "\n");
DO WSK_C osesocket (S1) ;

END_TRANSACTI ON() ;

REPORT( SUCCESS) ;

EXI T();

return(0);

}

voi d abort_functi on(PLAYER | NFO *s_i nf 0)

{
RR_printf("Virtual User % :ABORTED.", S task_id);

EXI T();
}

Modifying QALoad'sfunctionsto incorporate dynamic data
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If you need to use dynamic data with your scripts, you can modify some QALoad functionsto handle
dynamic data. The two scenarios below describe specific situationsin which you might need dynamic data,
and how to achievethat in the script.

Scenario 1:

One method of accessing dynamic datais by using a datapool file. However, you might need to read in
datathat isnot in the format of an ASCII string, which isrequired for datapool files.

For example, if the string “\ 121\ 101\ 114\ 157\ 141\ 144" isread in from a datapool file with one of the
datapool functions, the output would be “\\ 121\\ 101\ \ 114\\ 157\ \ 141\ \ 144", which isincorrect. To
work around this problem, you can use the OctalToChar() command to convert any octal sequencesinto
their binary representation. The following examplesillustrates the use of the OctalToChar() command for
this purpose:

Example

In thisexample, the string “\ 121\ 101\ 114\ 157\ 141\ 144" isread in from a central datapool file and
converted to itsbinary representation.

/* Declare variables */
char tenp[40];

BEG N_TRANSACTI ON() ;
GET_DATA() ;

DO WBK_Socket (S1, AF_I NET, SOCK_STREAM | PPROTO | P);
DO WBK_Bi nd(S1, ANY_ADDR, ANY_PORT);
DO WBK_Set sockopt (S1, SOL_SOCKET, SO OOBI NLINE, 1);

strcpy(tenp, VARDATA(1));

Cct al ToChar (tenmp); //used to convert octal strings
//to their binary format

DO WBK_Send( S1, tenp) ;
/1 DO_WBK_Send( S1, "\ 121\ 101\ 122\ 165\ 156" ) ;
DO WSK_d osesocket (S1) ;

The DO_WSK _Send() command above sendsthe string “121\ 101\ 114\ 157\ 141\ 144" to the server. This
string isthe octal representation of the string “ QALoad ".

Scenario 2:

You might find that your capture dataisnot the same datayou need for running atest. For example, you
might need to change the value of auser ID during replay. One method of changing the value isto change
the value through the DO_WSK_Send() command, but that resultsin the value being static only within the
function. To substitute a different value each time, create a dynamic variable, such as a datapool value, to
replace the user ID.

Example

In thisexample, the script includesaDO_WSK_Send() command that sends“name=Jm” to the server as
theuser ID. Then avariableisused to changethe nameto “Mark”.

/* Declare variables */
char buffer[65];
char sendbuffer[65];

BEG N_TRANSACTI ON() ;
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DO WBK_Socket (S1, AF_I NET, SOCK _STREAM | PPROTO | P);
DO WSK_Bi nd( S1, ANY_ADDR, ANY_PORT) ;

DO WSK_Set sockopt (S1, SOL_SOCKET, SO OOBI NLI NE, 1);
DO WSK_Connect (S1, "127.0.0.1", 90, AF_INET);

[l original DO WK Send(S1, "nane=Jin');

strcpy( buffer, "Mark");
sprintf( sendbuffer, "name=%", buffer);
DO WSK_Send(S1, sendbuffer);

[* 2 bytes: ok */

DO WSK_Expect (S1, "ok");
DO WSK_d osesocket (S1) ;

The buffer beforethe DO_WSK_Send() command is modified and a new buffer is passed asthe second
parameter of the DO_WSK_Send() command. This effectively sends“name=Mark” to the server instead of
"name=Jm”.

Saving server replies

There are two methods for saving the entirereply that a server sends back. The following paragraphs
describe each method.

Using the Response() and ResponseLength() commands

The Response() command can be called directly after the DO_WSK_Expect() command. It returns a pointer
to the datathat has been received by DO_W SK_Expect(). To also receive the length of thereplay, call the
ResponseLength() command, which returnsthe number of charactersthat were received. The following
example usesthe Response() and ResponseLength() commands.

Example

In thisexample, variables are declared to store the results from the two functions. Both functions are also
used to save the buffer that isreceived within the DO_W SK_Expect() command.

/* Declare Variables */
int x = 0;
char *tenp;

BEG N_TRANSACTI ON() ;

DO WBK_Socket (S1, AF_I NET, SOCK _STREAM | PPROTO | P);
DO WSK_Bi nd(S1, ANY_ADDR, ANY_PORT);

DO WSK_Set sockopt (S1, SOL_SOCKET, SO OOBI NLI NE, 1);
DO WSK_Connect (S1, "127.0.0.1", 90, AF_INET);

/* 21 bytes: You are now connected */
DO WSK_Expect (S1, "d");

/1l Used to store the data that was received by the
/1 DO _WBK_Expect

tenp = Response();

/1 Used to get the size of the response that was received
/'l so far

x = ResponseLengt h();

/* The line beloww Il print the length of the response and the actual response */
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RR__printf(*length = %, and response= %", x, tenp);
DO WBK_Cl osesocket (S1) ;

The message “length=21 response=You are now connected” displaysin the Player buffer window.

Usingthe DO_W SK_Recv() command

To save aresponse based on itssizeinstead of aunique character string that isused within the
DO_WSK_Expect() command, usethe DO_W SK_Recv() command. Thiscommand enablesyou to specify
how much datato receive and where to store the data.

You can also usethe DO_WSK_Recv() command to storethe reply that isreturned from the server. This
strategy is useful when you need to retrieve the buffer that isreturned from the server, even though the
returned dataistoo dynamic and causesthe DO_W SK_Expect() command to fail every time.

Example

In thisexample, the DO_WSK Recv() command isused to save a server reply based on size. Two variables
are declared to store the results from the DO_W SK_Recv() command.

/* Declare Variables */
int size = 0;
char tenp[45];

BEG N_TRANSACTI ON() ;

DO WSK_Socket (S1, AF_| NET, SOCK_STREAM | PPROTO | P);
DO WSK_Bi nd( S1, ANY_ADDR, ANY_PORT);

DO WSK_Set sockopt (S1, SOL_SOCKET, SO OOBI NLINE, 1);
DO WSK_Connect (S1, "127.0.0.1", 90, AF_INET);

/* 21 bytes: You are now connected */
nmenset (tenp, '\ 0", 45);
DO WBK_Recv( S1, t enp, 45, 0, &si ze) ;

RR_printf("size=% string=%", size,tenp);
DO WBK_Cl osesocket (S1) ;

The message “size=21 string=You are now connected” displaysin the Player buffer window.

El Note: If you use this method as a substitute for the DO_WSK_Expect() command, ensure that you receive
the correct information prior to calling the next function in the script.

Parsing server replies for values

To parse a buffer for a particular value, you can write a parsing routine that searchesthe entire buffer for
the value. However, you can also use one of QALoad 's Winsock helper commands. The following scenarios
describe two situationsin which you could use the Winsock commandsto solve a parsing problem.

Scenario 1:

To find astring in a server reply, you can use the ipExpr() and ScanExpr() commands. SkipExpr()
searches for the first occurrence of astring in theinternal buffer that containsthe response that was
received within the DO_W SK_Expect() command. Then, use the ScanExpr() command to search for
another string. ScanExpr() saves the buffer from the first occurrence of the string that was used with
XKipExpr() up to and including the string used within ScanExpr(). The first parameter of ScanExpr() isa
UNIX-style regular expression. The following table liststhe most common expressions:

Matchesthe end of astring.
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* Matches any number of characters.

? Matches any one character.

Example In thisexample, the buffer contains “sessionid=1234567890abc”, and the goal isto retrieve
everything after the “=", up to and including “abc”.

/* Declare Variables */
char tenp[35];
int size = 0;

BEG N_TRANSACTI ON() ;

DO WBK_Socket (S1, AF_I NET, SOCK_STREAM | PPROTO | P);
DO WBK_Bi nd(S1, ANY_ADDR, ANY_PORT);

DO WBK_Set sockopt (S1, SOL_SOCKET, SO OOBI NLINE, 1);
DO WBK_Connect (S1, "127.0.0.1", 90, AF_INET);

/* 23 bytes: sessioni d=1234567890abc */

DO WSK_Expect (S1, "c");

Ski pExpr (" sessi oni d=");

si ze=ScanExpr (".*abc" , tenp);

RR_printf("length = % string = %", size, tenp);
DO WSK_d osesocket (S1) ;

The message “length=13 string=1234567890abc” displaysin the Player buffer window.

Scenario 2:

You may have data returned from the server that istoo dynamic, that is, you are not able to base parsing
on actual characters. The solution isto base the parsing on character positionsinstead.

For example, to save the characters 20 through 25, you could use the Scanip() and ScanSring()
commands. ScanSkip() skips a specified number of charactersin the internal buffer that storesthe response
that was received within the DO_W SK_Expect() command. ScanSring() scans a number of charactersfrom
the current position within the buffer into a character string.

Example

In thisexample, a buffer containing “xxx123456789yyy” isreturned from the server. The value between
“xxx” and “yyy” isreturned.

/* Declare Variables */

char tenp[15];
BEG N_TRANSACTI ON() ;

WBK_Socket (S1, AF_I NET, SOCK_STREAM | PPROTO | P);
WBK_Bi nd(S1, ANY_ADDR, ANY_PORT);

DO WBK_Set sockopt (S1, SOL_SOCKET, SO OOBI NLINE, 1);
DO WBK_Connect (S1, "127.0.0.1", 90, AF_INET);

[* 16 bytes: xxx0123456789yyy */

DO_
DO_

menset (tenp, '\0', 15);

DO WBK_Expect (S1, "yyy"):
ScanSki p(3);
ScanString(10,tenp);
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RR_printf("string=%",tenp);
DO WSK_d osesocket (S1) ;

The message “string=0123456789” displaysin the Player buffer window.
WWW

Simulating Variable IP Addresses

While QALoad can simulate multiple virtual usersfrom asingle system, it generally does so using asingle
source IP address. In most testing situationsthisisn’t a problem, but with a small set of HTTP-based
applications, it may not be the best way to simulate real-life activity. For QALoad Player machines with
more than one static IP address, QALoad can direct each virtual user to use a different source IP address.

To accomplish this, alocal datapool file containing alist of local static IP addresses must be created on
each QALoad Player machine. When you enable IP spoofing in the QALoad Conductor, the QALoad
Conductor instructs each QALoad Player to create the appropriate datapool file at run time. The QALoad
Player uses these addresses for connectionsto HTTP and SSL servers. Each virtual user receives one address
for use with all itsconnections. If there are more virtual usersthan addresses, |P addresses are re-used
starting from the beginning of the datapool file.

Modifying a Script to Use Variable IP Addresses

QALoad usesthe DO_IPSpoofEnable command to insert IP addresses from the datapool into the script.
When thiscommand is executed, the script opensthe datapool file located on the QALoad Player, reads
thefirst available data record, and storesthat record for use on all subsequent DO_Http and DO_Https
calls. If there are more virtual usersthan IP addressesin the datapool file, IP addresses are reused. You can
automatically generate the DO_IPSpoofEnable command in your script during conversion by selecting the
IP Spoofing option from the QALoad Script Development Workbench’s WWW Advanced dialog box.
Accessthis dialog box from the Convert Optionswizard’s WWW tab by clicking the Advanced button.
Thisoption insertsthe DO_IPSpoofEnable command directly in the script during conversion, beforethe
first DO_Http or DO_Httpscommand.

Creating a Datapool of IP Addresses

Use the following procedure to create a datapool of valid IP addresses from the QALoad Conductor. This
fileisautomatically created on the QALoad Player workstations (Windows and UNIX) at run time.

To create a datapool of IP addresses:

1. Sart QALoad Conductor.

Click the Machine Assignment tab.

Select a script in the Script field.

Click Manager Players. The Manage Player Machines and Groups dialog box appears.

Double-click the Player machinenamein thelist. The Properties dialog box appears.

I e

Select the Generate IP Spoof Data (machineswith multiple IP addresses only) option in the
Player Machine settingsfield.

7. Click OK.

At run time, the QALoad Conductor sendsa command to each QALoad Player Agent to create the datapool
file of IP addresses, and the script issent to the server using the different IP addresses.

The Generate |P Spoof Data check box isvalid only for WWW scripts.

El Note: The machine on which the QALoad Conductor resides must have static IP addresses assigned to it. If
no static IP addresses are found, the QALoad Conductor displays a warning and the datapool file is not
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generated. The datapool file isnamed ipspoof.dat, and is saved in the \ Compuwar e\ QALoad\ Dat apool s
directory.

Handling error messages from the Web server

When a server returnsan error message, it returnsit in one of two ways. It either returns an error message
with aresponse code (for example, 404 Not Found) or returnsan HTML page that containsan error
message. The following sections provide examples of code that you can usein your script to handle errors
that the Web server returnsto the browser.

Handling error messages with response codes

The example below demonstrates how to write code to handle error messages that include response codes
that the Web server returnsto the browser. The code performsthe following actions:

! Checksfor an error code using the DO_GetLastHttpError command

I Abortsor continues script execution, based on the WWW _FATAL_ERROR statement

Example

int error;
char errorString[30];

DO Http("CGET http://ww. host.com HTTP/1.0\r\n\r\n");
if((error = DO GetlLastH tpError()) > 399)
{

sprintf(errorString, "Error in response: %\n", error);
WNWV FATAL _ERROR( " Request-host", errorString);

}

Handling error messages returned in an HTML page

The examples below demonstrate how to write code to handle error messages that the Web server returns
to the browser in an HTML page.

Using DO _VerifyDocTitle to verify page requests

By inserting the DO_VerifyDocTitle command into your script, you can compare the HTML document
titlesin your load test script with the document titlesyou originally captured. The code performsthe
following actions:

I CallsDO_Http to request an HTML page from the Web server

I CallsDO_VerifyDocTitle with the original HTML document title. If thetitlesdo not match,
DO _VerifyDocTitle exits the script

Example

DO Http("GET http://ww. host.com HTTP/1.0\r\n\r\n");
DO VerifyDocTitl e("Wel come to The Main Page", TITLE);

Searching response text for error messages

In some scripts, error messages are displayed astext in an HTML page. The following example
demonstrates how to detect these messagesin ascript. The code performsthe following actions:

I Searchesfor errorsreturned asHTML from the Web server

! Branchesto error handling code

48



Script Development Workbench

Example

i nt response;

response = DO Http("CGET http://ww. host.coml HTTP/1.0\r\n\r\n");

if (strstr (response, "200 OK") == NULL)

WAV FATAL_ERROR("host", "Response did not have 200 OK");
Simulating JavaScript
Javascript ishandled by the following process:
1. Thebrowser makes a page request to a server for a page that contains JavaScript.
2. Because Javascript issimply uncompiled code, the browser downloads and immediately executes
this code upon receipt of the page.

Supported Objects
QALoad supportsthe built-in JavaScript objects (global, object, function, array, string, boolean, number,
math, date, regexp, and error), document objects, and image objects.
Supported Properties
The only document propertiesthat QALoad supports are cookies, title, and the images array. The only
image property that QALoad supportsissrc.
Evaluation Errors
If an object, property, or function used within a block of JavaScript code isnot defined, it causes a
JavaScript exception. The exception stops evaluation of that block.
Example W eb Page

The following Web page containsthe Javascript function and an onLoad tag that callsthe scrollit function.
The onLoad tag tellsthe browser to execute the JavaScript immediately after loading the page. The scrollit
function displays a scrolling banner region on the Web page.

<HTM_>
<HEAD>
<TI TLE>Java Script Exanpl e</ Tl TLE></ HEAD>

<SCRI PT LANGUAGE="JavaScript" src="js_do_nothing.js">

function scrollit_r2l(seed)

{

var nl =" Welcome to Conmpuware's QALoad honepage."”;
var n2 = dad to see you.";

var nB = " Thanks for conming. “;

var msg = mlL + n2 + nB;

var out =" ";

var ¢ = 1;

if (seed > 100) {

seed- -;

var cmd="scrollit_r2l (" + seed + ")";
ti mer Two=wi ndow. set Ti meout ( cnd, 100) ;

}

else if (seed <= 100 && seed > 0) {
for (c=0; c < seed ; c++) {

out +="

}

out +=nsgQ;

seed- -;

var cnd="scrollit_r2l (" + seed + ")"
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wi ndow. st at us=out ;
ti mer Two=wi ndow. set Ti meout ( cnd, 100) ;

}

else if (seed <= 0) {

if (-seed < nsg.length) {

out +=nsg. substri ng(-seed, nsg. | engt h) ;
seed- -;

var cmd="scrollit_r2l (" + seed + ")";
w ndow. st at us=out ;

ti mer Two=wi ndow. set Ti meout ( cnd, 100) ;

}

el se {
wi ndow. st at us="
ti mer Two = wi ndow. set Ti meout ("scrollit_r2l(100)", 75);

}

}

}

</script>

<BODY onLoad="ti nmer ONE=wi ndow. set Ti meout (' scrol lit_r2l (100)', 500);">
<!-- End scrolltext -->

<cent er ><h2>Java Scri pt Exanpl e</ h2><hr >Check out the browser's scrolling status
bar . <br ><br>
</ center>

</ BODY></ HTM_>

Example script
The following script featuresa DO_Http call to retrieve the JavaScript page.

How It Works: QALoad evaluates the Javascript in the context of script blocks, onLoad tags, and src and
then executesthem.

DO InitHttp(s_info);

BEG N_TRANSACTI O\() ;
DO_Aut omat i cSubRequest s( TRUE) ;

DO Http("GET http://ww. host.com js.htm HTTP/ 1. 0\r\n\r\n");
DO VerifyDocTitle("Java Script Exanple", TITLE);

END_TRANSACTI ON() ;

Simulating Cookies
This section describes how QALoad handles cookies. Cookies are handled by the following process:
1. Thebrowser makesa CGlI request to a server for adynamic page.

2. When the server sendsthe page back to the browser, the page includes a cookiein the header. The
browser savesthe cookie along with information that tiesit to the Web server.

3. On all subsequent requeststo that Web server, the browser passes the cookie along with the
request.
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Example Web page
The following CGI Perl script generates a Set-Cookie header as a part of subsequent HTTP requests.

Set - Cooki e: Sanel D=172. 22. 24. 180- 4728804960004
Set - Cooki e: S| TESERVER=I D=f 0544199a6¢5970a7d087775f 83b23af

<htm >

The cookies for this site are: <br><br>

<B>Sanel D=172. 22. 24. 180- 4728804960004; S| TESERVER=I D=f 0544199a6c¢5970a7d087775f 83b23af
</ B><P>

<b>Next cookie for this URL will be : 1</b><br>
<br >RELOAD PAGE TO | NCREMENT COUNTER<br ><br ><A HREF=htt p://wwv. host. conii ndex. ht nPReturn to
previ ous homepage. </ A>

Example script when Dynamic Cookie Handling isturned on

Thisisthe default method by which QALoad handles cookies. The example script featuresthe following
elements:

I Two CGI requeststhat return dynamic pages

I Cookiesare handled by thereplay engine

BEG N_TRANSACTI O\() ;
DO _Dynani cCooki eHandl i ng( TRUE) ;

/* Request: 1 */
DO Http("GET http://ww. host.com cgi - bi n/ cooki es5. pl "
"HTTP/ 1. 0\r\n\r\n");

/* Request: 2 */
DO Http("GET http://ww. host.com cgi -bi n/ cooki es5. pl "
"HTTP/ 1. 0\r\n\r\n");

END_TRANSACTI ON() ;

Example script when Dynamic Cookie Handling isturned off
The example script featuresthe following elements:
I ACGI request that returnsadynamic page
I Two DO_GetCookieFromReply callsto retrieve the cookie from reply
I Two DO_SetValue callsto set the cookie
I Afreecookie

How It Works: For cookiesthat are set with CGI scripts, the script storesincoming cookiesin avariable
and passesthem back to the Web browser in the reply from the CGI script. The script handlesthese
cookies by executing a DO_GetCookieFromReply command after the CGI request.
DO_GetCookieFromReply storesthe cookie valuesin variables, which the script then passes back to
subsequent CGI requestsusing the DO_SetValue command.

int i;

char *Cooki e[ 4];
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for(i=0;i<4;i++)
Cooki e[ i ] =NULL;
DO InitHttp(s_info);

BEG N_TRANSACTI ON( ) ;
DO _Dynam cCooki eHandl i ng( FALSE) ;

/* Request: 1 */
DO Http("GET http://ww. host. cont cgi - bi n/ cooki es5. pl
"HTTP/ 1.0\r\n\r\n");

[ *Set - Cooki e: NUMF1 */
DO_Cet Cooki eFronRepl yEx("NUM', &Cookie[O0], '*');

[ *Set - Cooki e: SQUARE=1 */
DO_Get Cooki eFr onmRepl yEX( " SQUARE", &Cookie[1], '*');

/* Request: 2 */
DO_Set Val ue(" cooki e000", Cookie[0]); /* NUMEL */
DO _Set Val ue( " cooki e001", Cookie[1]); /* SQUARE=1 */
DO Http("GET http://ww. host. cont cgi - bi n/ cooki es5. pl
"HTTP/ 1. 0\r\ n"
"Cooki e: {*cooki e000}; {*cookie001}\r\n\r\n");

DO Htt pd eanup();
for(i=0; i<4; i++)

{
free(Cookie[i]);
Cooki e[ i ] =NULL;
}

END_TRANSACTI ON() ;

Executing a Visual Basic script
QALoad does not evaluate a Visual Basic script. However, any Visual Basic script request that occursis
inserted into the script asa main request.
Simulating Frames
Frames are handled by the following process:
1. Thebrowser makesamain pagerequest to a Web server for a page that contains frames.
2. The browser parsesthe frame pages and placesthem in sub-windowswithin the browser, each of
which displaysthe frame content.
Example Web Page

The following Web page contains four frames.

<HTM_>

<HEAD>

<Tl TLE>FRAME Exanpl e</ Tl TLE>

</ HEAD>

<! -- Here is the FRAME information for browsers with franes -->
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<FRAMESET Rows="*,*"><!-- Two rows, each equal height -->
<FRAMESET Col s="*,*"><!l-- Two columms, equal width -->
<FRAME Src="findex. htn Name="ul -frane">
<FRAME Src="findex.htnl Nanme="ur-franme">
</ FRAMESET>

<FRAMESET Col s="*,*"><!-- Two colums, equal width -->
<FRAME Src="findex. htnm Name="II|-frane">
<FRAME Src="findex.htnml Name="Ir-franme">
</ FRAMESET>
</ FRAMESET>

</ HTM.>

Example ript

QALoad automatically generates all constructs necessary to request frames. The example script featuresthe
following element:

I ADO_Http call to retrieve the main page.

How It Works: The frames are treated as sub-requests and are evaluated and requested by QALoad .

BEG N_TRANSACTI O\() ;
DO_Aut omat i cSubRequest s( TRUE) ;

DO Http("CGET http://ww. host.com franeset. ht m HTTP/ 1. O\r\n\r\n");
DO VerifyDocTitl e(" FRAVE Exanpl e", TITLE);

END_TRANSACTI ON( ) ;

Simulating Browser Caching
Browser caching ishandled by the following process:

1. When the browser makes arequest for static HTML pages, it may include an option to retrieve the
page only if it isnewer than the one held in the browser’s cache.

2. If browser caching isenabled, the server returns only newer versions of the page. If browser caching
isnot enabled, the server always returnsthe page.

How It Works: The QALoad Script Development Workbench disables browser caching while recording,
which meansapage isawaysretrieved.
Requesting Password-protected Directories

Web developers use password-protected directoriesto protect accessto some pages. When the browser
requests a page in a password-protected directory, the server returns a special response that specifiesthe
page is password-protected. When the browser receivesthistype of reply, it gathersthe user ID and
password, encryptsthem, and passesthem back to the server in a subsequent request.

Example Script

QALoad automatically generates all the constructsthat are necessary to execute arequest of a password-
protected directory.

The example script featuresthe following elements:
! DO_BasicAuthorization, which takesthe user ID and password as parameters

I DO_Http request to the password-protected directory
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BEG N_TRANSACTI O\() ;
DO Basi cAut hori zation("frank", "~encr~557A2549474E57444A");

DO Http("GET http://ww. host.com access_control | ed/ secure. htm HTTP/ 1. O\r\n\r\n");
DO VerifyDocTitl e("Successful Test of a Secured Page", TITLE);

END_TRANSACTI ON( ) ;

Example ript
QALoad also handles Windows Domain Authentication (NTLM).
The example script featuresthe following elements:
I ADO_NTLMAuthorization call, which takesthe domain, user ID, and password as parameters

I DO_Http request to the NTLM protected directory

BEG N_TRANSACTI ON( ) ;
DO _NTLMAut hori zati on("doml\\ frank", "~encr~557A2549474E57444A");

DO Http("GET http://ww. host.com ntl mcontrolled/secure. htmHTTP/ 1. 0\r\n\r\n");
DO VerifyDocTitl e("Successful Test of a NTLM Page", TITLE);

END_TRANSACTI ON() ;

Reuse SSL session ID

Thisoption isavailable only on an S installation of QALoad . By default, this option isnot selected and
SSL session IDs are not re-used, which reflects standard browser behavior. If your application re-uses SSL
session IDs, consider selecting this option.

The Reuse SA. session |ID option isused by the replay engine at replay time and the current session’s D is
re-used for all the requests within the transaction.
Script example with the Reuse SS. Session ID option selected

The following example hasthe Reuse SSL session ID check box selected.

SYNCHRONI ZE( ) ;

/* Select followi ng statement for reuse of Session IDwth */
[* SSL. If session ID needs only to be reused within */

/* a transaction insert after the BEA N_TRANSACTI ON */

/* statement */

/* DO_SSLReuseSessi on( TRUE); */
BEG N_TRANSACTI ON( ) ;

/* Request: 1 */
DO Http("GET http://ww. host.com subs. ht m HTTP/ 1. O\r\n\r\n");
DO VerifyDocTitl e("Page O Subs", TITLE);
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END_TRANSACTI ON() ;

Script example with the Reuse SS. Session ID not selected

The following example hasthe Reuse SSL session ID check box cleared.

SYNCHRONI ZE( ) ;

/* Select followi ng statenent for reuse of Session ID */

/* with SSL. If session ID needs only to be reused within */
/* a transaction, insert after the BEG N_TRANSACTI ON */

/* statement */

/* DO _SSLReuseSessi on( FALSE); */
BEG N_TRANSACTI ON( ) ;

/* Request: 1 */

DO Http("GET http://ww. host.com subs. ht m HTTP/ 1. O\r\n\r\n");
DO VerifyDocTitl e("Page O Subs", TITLE);

END_TRANSACTI ON() ;

CGI Requests

Smulating CGl Requests

The following topics describe strategies for ssimulating CGI requests:
CGI Parameter Encoding

CGI Get Requests

CGlI Post Requests

CGI Forms

CGI Parameter Encoding

Common Gateway Interface (CGl) iswidely used on World Wide Web sitesto provide the ability to run
server-side scriptsthat can take variable input from a Web browser. QALoad recognizes when the browser
hascommunicated to a CGl site and automatically creates variables for parameterswhenever necessary. For
example, many CGI submission formscontain hidden parametersthat the user cannot modify, but are
always sent in the WWW request. Because these values can contain variable data, QALoad inserts
statementsinto the script to store these hidden parametersin variables and append them automatically to
CGl requests.
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CGlI requests also include parametersthat the browser has allowed the user to modify. For example, a CGl
form might require a user to enter aname and address and click a submit button to continue. QALoad does
not automatically store these types of parametersin variables, but instead provides an easy way to modify
the content of the parametersthat are being sent in the CGI request using the DO_SetValue command.

When you modify parametersthat are passed into a QALoad CGI request, ensure that all CGl parameters
containing charactersthat are not alphanumeric (a-Z, 0-9) are encoded before being sent to the server. CGl
encoding entailsinserting the ASCII value of a character, prefixed with the “%” character, into the
parameter. QALoad automatically CGl-encodes any valuesthat it detectsduring the recording and
conversion process; however, to manually add or modify any CGI parameter strings after your script is
created, you must manually encode special charactersto ensure that the CGI parameter dataissent to the
Web server properly. For example, to insert the “=" character into a CGIl parameter, first determine its
ASCII hexadecimal value (3D), and insert that value into the CGI parameter prefixed with “%”. In the CGlI
parameter string, “%3D” would replace “=". All CGI parameter encoding ishandled by thismethod, except
for spaces. Blank spaces must be specified in the encoded CGI string by the character “+”, rather than the
ACII value.

QALoad provides an automatic way of performing thisencoding using the DO_EncodeSring command.

CGI Get Requests
Get requests are handled by the following process:

1. Thebrowser makesarequest to a server for a URL that containsa call to a Common Gateway
Interface (CGI) program.

2. Theserver callsthe CGI program, which usually returnsaWeb page. Thereturned page iscalled a
dynamic page becauseiit is created by the CGI program.

3. The browser acceptsthe resulting dynamic page and displaysiit.

Example W eb Page

The following Web page containsan anchor (link) that references a CGI program. The referenceresultsin a
CGI Get request.

The anchor callsthe CGI program named perl_1.pl with some parameters. In perl_1.pl?name=FRANK, the
question mark (?) denotesthe start of parametersthat need to be passed to the program. The name/value
pair being passed to the perl_1.pl program is name=FRANK.

When you click the anchor text (dynamic HTML page), the browser makes a CGl Get request. A Get
request, when executed by the server, passes parametersin an environment variableto the CGI program.
Thistype of parameter handling islimited to 255 characters.

<HTM.>

<HEAD>

<TI TLE> QALoad WA Capt ure Exanpl es</ Tl TLE>

</ HEAD>

<BODY>

<A HREF="/cgi - bi n/ perl _1. pl ?nane=FRANK" >Dynanmi ¢ HTM. Page</ A>
</ BODY>

</ HTML>

Example ript

QALoad automatically generates all constructsthat are necessary for a CGI Get request. The following
script usesa DO_Http call for the CGI Get request.

How It Works: The script processes a CGl Get request the same way it processes URL linksto a page. In the
example script below, note that the parameters passed to the Web server on the CGI call are recorded
unchanged. The parameters do not change unlessthe page isdynamically generated.
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char *Anchor[ 1];
for(i=0;i<1;i++)
Anchor [i]=NULL;

DO InitHttp(s_info);

SYNCHRONI ZE( ) ;
BEG N_TRANSACTI ON() ;

DO Http("CGET http://ww. host.com HTTP/1.0\r\n\r\n");

/*

* Anchor 'http://ww. host. contf cgi-bin/perl_1.pl ?name=FRANK'
* ' Dynam ¢ HTML Page’

*/

DO_Get Anchor HREF( " Dynanmi ¢ HTM. Page", &Anchor[0]);
DO _Set Val ue(" Anchor 000", Anchor[O0]);

DO Http("GET {*Anchor 000} HTTP/1.0\r\n\r\n");

DO VerifyDocTitl e("Perl Exanple Page", TITLE);

for(i=0; i<l; i++)

{
free(Anchor[i]);
Anchor [i]=NULL;

END_TRANSACTI ON() ;

CGI Post Requests
Post requests are handled by the following process:

1. Thebrowser makes arequest to a server for an HTML page that containsaform that uses an action
statement with a Post call to a CGI program.

2. When you click the Submit button on a CGI form, the browser makes a Post request and the server
returnsa Web page.

3. The browser acceptsthe dynamic page and displaysit. Because it isa CGI Post request, the browser
passes the parameters of the program to the CGI script ascommand line options.

Example W eb Page

The following Web page containsaform that callsa CGI script with a Post Request.

<htm >

<head><titl e> QALoad's Perl Exanple Page</title>

</ head><body><cent er> QALoad's Per| Exanpl e Page</center>
<form nanme = nyform nethod = POST action = perl_1.pl>

<i nput type = text name = yournanme size = 50><br>
<input type = submt value = "Submt Request">

<i nput type = reset>

</form

</ body></ ht nl >

Example ript
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QALoad automatically generates all the constructsthat are necessary for a CGl Post request. The following
script featuresa DO_HTTP request that executes a CGl Post request :

char *ActionURL[ 1];

for(i=0;i<1;i++)
ActionURL[i]=NULL;

BEG N_TRANSACTI O\() ;

/* Request: 1 */

DO _Set Val ue("nane", "FRANK");

DO Http("GET http://ww. host.com cgi -bin/perl_1.pl ?{nane} "
"HTTP/ 1. 0\r\n\r\n");

DO VerifyDocTitle(" QALoad's Perl Exanple Page", TITLE);
[* ActionURL[O]="http://wwm. host.confcgi-bin/perl_1.pl" */
DO _Get For mActi onSt at enent (FORM 1), &ActionURL[0]);

/* Request: 2 From QALoad's Perl Exanple Page */

DO _Set Val ue("action_statenent0", ActionURL[O0]);

DO _Set Val ue("your name", "PostFrank");

DO _Set Val ue("function", "View the log of previous visitors.");

DO Http("POST {*action_statenent0} HTTP/1.0\r\n"
"Content - Type: application/x-ww-formurl encoded\r\n"
"Content-Length: {*content-length}\r\n\r\n"
"{yournane} & function}");

DO VerifyDocTitle(" QALoad's Perl Exanple Page", TITLE);

for(i=0; i<l; i++)

{
free(ActionURL[i]);
ActionURL[i]=NULL;
}

END_TRANSACTI ON( ) ;

CGI Forms
Common Gateway Interface (CGIl) formsare handled by the following process:

1. Thebrowser requests a page that containsa CGI form. It displaysthe page and providesthe
interaction for input fieldsthat the CGI form specifies.

2. Auser entersdatainto the CGI form and clicksthe submit button. This action causes the browser
to processthe CGI form’s action statement.

3. The browser processesthe action statement, gathersall input fieldsasname value pairs, and passes
them to a CGl call contained in the action statement.
Example W eb page
The following Web page contains a CGI form with:
! An action statement
I Input fields
! Hidden fields
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<HTM>

<HEAD><TI TLE>For ns Exanpl e</ Tl TLE>

</ HEAD>

<BODY>

<FORM ACTI ON="ht t p: / / www. host . coni cgi - bi n/perl _9. pl" met hod=post >

<TABLE>

<TR>

<TD>Nane:

<TD><I| NPUT NAME="nane" S| ZE="20" MAXLENGTH=20>

<TR>

<TD>Passwor d:

<TD><I NPUT TYPE =password NAME="password" S| ZE="20" MAXLENGTH=20>

There is a hidden field containing data here: <INPUT TYPE=hi dden NAME="hi dden" VALUE="Thi s
rocks!">

Here is another hidden field: <INPUT TYPE=hi dden NAVE="hi ddenl" VALUE="Wb testing is fun">
</ FORW>
</ BODY>
</ HTM.>
Example script
QALoad automatically generates all the constructsthat are necessary to make a CGI form request.
The exampleincludesthe following features:
I ADO_Http call to retrieve the forms page.
I Commented description of the input fields on the page.
I GetFormValueByName commandsto retrieve the values of the hidden fields from the form.
I DO_SetValuecallsto storethe field names and their user-entered values.
! ADO_Http call for the CGI get request.

char *Field[2];
char *ActionURL[ 1];

for(i=0;i<2;i++)
Fi el d[i]=NULL;

for(i=0;i<1;i++)
ActionURL[i]=NULL;

BEG N_TRANSACTI ON() ;

/* Request: 1 */

DO Http("GET http://ww. host.com forns. ht m HTTP/ 1. 0\r\n\r\n");
DO VerifyDocTitl e("Forns Exanple", TITLE);

/* ActionURL[O]="http://ww.host.confcgi-bin/perl_9.pl" */
DO _Get For mAct i onSt at enent (FORM 1), &ActionURL[0]);

/* Form1l text Nane: nanme, Value: , Desc: */
/* Form1l text Nanme: password, Value: , Desc: */
/* Form 1 hidden Nane: hidden, Value: This rocks! */
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DO_Get For nval ueByName( FORM 1), "hi dden", "hidden", 1, &Field[0]);
/* Form 1 hidden Nane: hiddenl, Value: Wb testing is fun */
DO_Get For nVval ueByName( FORM 1), "hi dden", "hiddenl", 1, &Field[1]);
/* Request: 2 From Forms Exanple */

DO _Set Val ue("acti on_statenent0", ActionURL[O0]);

DO _Set Val ue("nane", "formnane");

DO _Set Val ue("password", "form password");

DO _Set Val ue("hi dden", Field[0]);

DO _Set Val ue("hi ddenl", Field[1]);

DO Http("POST {*action_statement0} HTTP/1.0\r\n"
"Cont ent - Type: application/x-ww-formurl encoded\r\n"
"Content-Length: {*content-length}\r\n\r\n"
"{nane} & password}");

DO VerifyDocTitl e("Forns Exanple - Results", TITLE);

for(i=0; i<2; i++)

{
free(Field[i]);
Fi el d[i]=NULL;
}

for(i=0; i<l; i++)

{
free(ActionURL[i]);
ActionURL[i]=NULL;
}

END_TRANSACTI O\() ;

Compiling a Script

Compiling a Test Script

A QALoad script isareal C-, C++-, or Java-based script, and therefore needsto be compiled before it can be
used. QALoad works with your existing compiler to compile usable test scripts. If you make changesto an
existing script, you must re-compile it before you can successfully useit in atest. If you add an uncompiled
or out-of-date script to aload test, the QALoad Conductor will prompt you to compile the script.

Set Up Automatic Conversion and Compilation of a Script

The ript Development Workbench automatically converts a capture file when you stop the recording
process and compile theresulting script. You are prompted if a script by the same name already exists, so
that you can decide whether to overwrite an existing script or to save your script under a different name.

If the default settingsto automatically convert a capture file have been changed, follow the steps below to
reset the automatic conversion and compilation.

To set up automatic conversion and compilation:

1. From the Script Development Workbench menu, choose Options>Workbench.

2. On the Workbench Configuration tab, in the Record Options area, select the check box
Automatically Convert Capture.
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Click the Compiler Settingstab.
Select the check box Automatically compile scripts.

Select the check box Prom pt before overwriting script to ensure that a script isnot overwritten
accidentally.

Click OK to save your settings.

Testing a Script

Validating Scriptsin Workbench

Before

adding a script to aload test, validate it to ensure that it runswithout problems. The following

procedureisonly valid for Win32 scripts. To validate a UNIX script, see Validating a UNIX script.

2l Note: During validation of SAP scripts, do not minimize the SAP window. If the window isminimized,
the validation may fail. This problem does not occur if you select the Hide Graphical User Interface for
SAP Usersoption by clicking Browse [...] in the Type column of the Script Assignment tab in the
Conductor. This SAPGUI option runs SAP on an alternate desktop that isnot visible.

To configure the Script Development Workbench for validation:

1.
2.

8.

9.

10.

11.

12

Click Options>Workbench and select the Script Validation tab.

Select the Automatically Recompile check box if you want QALoad to compile a script before
attempting to validate it. QALoad listsany compilation errorsin the editor after compiling.

(For Java and OFS) select Ask for Automatic Validation of Java and OFS Scripts.

Select the Only Display Player Output on Script Failure check box to view only Player messages
upon script failure, if applicable.

Type avaluein the Wait up to field. Thisisthe number of secondsthat the QALoad <cript
Development Workbench should wait for a script to execute before timing out.

In the Player Settings area, select the Abort on Error check box for QALoad to stop script execution
upon encountering an error.

Select the Debug Data check box for the script to display a debug message indicating which
command the script is executing.

In the Run As area, indicate whether the transaction should berun asthread- or process-based.
Note: Oracle Forms Server, Citrix, Java, and Uniface scripts are limited to process-based validation only.

In the Number of usersfield, type a number of virtual usersto run this script for validation. The
default is 1.

Enter avaluein the Transactionsfield. For validation, Compuware recommendsthat you accept
the default value of 1 transaction.

In the Sleep Factor % field, type the percentage of each DO_S_ EEP (pause in the script) to
maintain. For validation, you may not need to run every pausein the script at itsfull length. The
value can be a percentage between 0 and 100. The default isO.

. Click OK to save your changes.
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To validate a script in Workbench:

1. In the Workspace Pane, click the Scriptstab.
2. Double-click on the appropriate script name to open the script.
3. From the Session menu, choose Validate Script.

You receive a message and trace information in the Output pane. When the script executes successfully,
you receive a confirmation message. If it does not execute successfully, use the trace information to help
you identify errors.

Debugging a Script

Log files

Log files can be generated for Oracle, Oracle Forms Server, Citrix, WWW, Uniface, ODBC, SAP, and
Winsock scriptsonly.

If you encountered errorswhile validating or testing a script, you can view any log files generated during
thetest from the Script Development Workbench's LogFilestab. Log files are generated during a test if you
set debug optionswhile setting up your test in the Conductor. Each virtual user for which you enabled
Logfile Generation will have created a file containing information about its performance. When atest
finishesrunning, all log files are saved in the directory \ Progr am Fi | es\ Conpuwar e\ QALoad\ LogFi | es.
Log files are named <scriptname>_<middleware>_vu<AbsoluteVirtualUserNumber>.<ext>, where:

I <scripthame> isthe name of the script the virtual user ran
I <middleware> isthe name of your middleware application
I <AbsoluteVirtualUserNumber> isthe identification number assigned to the virtual user

I <.ext>isthefile extension, dependent upon which middleware application you are testing. File
extensionsare listed in the following table:

| Middleware File Extension

Oracle .rip — Alog file generated by afailed Player. At the end of atest, all
WWW .rip filesare sent from the Playersto the\ QALoad\ LogFi | es
Citrix directory and added to the merged timing file for your analysis.
Uniface .cap — A standard log file containing information about all
WWWw statements executed during a test.

Citrix .log— A standard log file containing information about all
ODBC statements executed during a test.

Oracle

Forms Server

SAP

Winsock

WWW

Verifying script checkpoints

You can quickly verify the syntax of the checkpoint commands BeginCheckpoint() and EndCheckpoint()
in your script every time you compile your script by setting a single option, or on-the-fly with asingle
menu command.
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To automatically verify script checkpoints, every time you compile a script:

1. From the Script Development Workbench'smain menu, click Options>Workbench.

2. On the Configure Script Development Workbench dialog box, click the Compiler Settingstab.
3. Select the Verify Checkpoints option.

4. Click OK.

Every time you compile your script, the Script Development Workbench verifiesthe syntax of your
checkpoint statements, and ensuresthe parameters passed in each pair match. If any errors are
encountered, an error message displaysin the Output pane. You can click on any error line to go directly
to that linein the script.

To manually verify script checkpoints, for the open script only:

With your script open in the Workbook pane, click Session>Verify Checkpoints.

The Script Development Workbench verifiesthe syntax of your checkpoint statements, and ensuresthe
parameters passed in each pair match. If any errors are encountered, an error message displaysin the
Output pane. You can click on any error line to go directly to that linein the script.

Using EasyScript

EasyScript Sessions

When you first open the Script Development Workbench, you can set general optionsrelated to which
panesto display, your compiler, and so on, but you cannot begin any middleware-specific activities, such
asrecording atransaction, until you open an EasyScript Session. Opening an EasyScript Session tailorsthe
Script Development Workbench to a specific middleware environment, providing you with all the
appropriate options and functionsfor your scripting needs.

To open an EasyScript Session, choose your middleware type from the Session menu, or click the
appropriate toolbar button. Once a session isopen, the Workbench interface changes.

You can also open a Universal session to record calls from multiple middlewares within asingle session.

ADO

ADO Recording Options

User Started: Select thisoption to start your application manually for recording, either before or after you
start recording. Because this method may fail to record your application’sinitial calls, Compuware
recommendsyou select the Automatic option instead. Select the User Started option when you do not
know the full application startup name and command option parameters or when the application spawns
off processesthat generate traffic that you want recorded.

Note: If you choose this option and the application under test generates traffic before the first Windows
screen displays, you must also select the Capture Initialization Phase check box in the Workbench
Configuration tab of the Configure QALoad Script Development Workbench dialog box.

Automatic: Select thisoption for QALoad to automatically start your application for recording, allowing
you to record early application startup activity. Thisisthe recommended method of recording calls,
because it takes advantage of QALoad’s enhanced abilitiesto handle various multi-threaded programming
techniques. Choose this option to record traffic from just one application. This option limitsthe recording
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output to just the traffic generated by the application, not including the traffic that is generated by
processes spawned by the application.

Command Line: If you chose Automatic Program Sartup, enter the command line of your application.
You can also use the browse button to locate your application.

Working Directory: Enter the working directory of your application.

ADO Conversion Options

Field Retrieval: Select thisoption to include all instances of the ADO CARecordset->GetFelds (represented
in a QALoad script as ADO_Recordset(#)->GetFields( ADOFeldSet[#] ); in the converted script.

Clearing thisfield removes a number of different elements from the script that may not be necessary for
playback because they are processed on the client side rather than the server side. Removing them can
greatly decrease the size of your script without affecting your load test results.

@ Caution: Clear this option only if you are certain that ADO_Recordset(#)->GetHelds( ADOReldSet[#] ); is
not integral to your script.

For more information about thisoption, see Using the Feld Retrieval option.

ADO Method Reference

QALoad provides descriptions and examples of the various methods that are available for an ADO script.
For details, refer to the Language Reference Help section for ADO.

Citrix

Overview
Use QALoad's Citrix middleware to load test systemsthat run Citrix MetaFrame or Citrix MetaFrame XP.
What is Citrix?

Citrix middlewareisacommunication layer that provides remote accessto Windows systems. The remote
system appearsin awindow on thelocal system.

Connecting to the remote system

Once connected to amachine that isrunning the MetaFrame server, log into the remote system and run
applications. Alternatively, specify an application in addition to a user name and password, which provides
access only to the specified application and minimizes user input that is necessary to access the application
under test. Test the environment using the Window Citrix Client to start a Citrix session.

Testing in load-balanced environments

If testing an environment that includes a server farm, use Citrix ICA filesto support thistype of
configuration. Specify the ICA file on the Citrix Record Optionsdialog box. ICA files are also necessary for
encryption. ICA files are generated on the MetaFrame server and can be obtained from your MetaFrame
administrator. For more information about using ICA files, see Using ICA files.

When ICA filesare not provided by an application, specify connection information using the Published
Applicationsor the Sngle Server optionsin the Citrix Record Options dialog box. These options also
enable you to specify lists of published applications and serversto invoke when you log on to the Citrix
client session.

Testing using the Citrix Web Interface
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When you initiate Citrix-published applicationsusing a web browser, you can capture and playback scripts
in QALoad using the Citrix Web Interface. The Citrix Web Interface starts a Universal session with the
Citrix and WWW middlewares selected. The WWW middleware interceptsthe ICA file created by the web
server. It passesdatato and from the Citrix Server during the capture process, enabling you to test the
performance of applicationsthat are available through internet connections.

About the Citrix Web Interface

Capture and playback scripts for Citrix applications accessed through aweb browser using the Citrix Web
Interface. This startsa Universal session for both the Citrix and WWW middlewares, which enablesthe
WWW middleware to passinformation to and from the Citrix server.

When selecting a published application through a web browser, the request is sent to the web server. The
web server creates an ICA file for the requested application and returnsit to the web browser. When the
web browser finds an associated application to handle the ICA file, the Citrix client startsthe published
application requested. The ICA file used during the capture processis saved in

QALoad\ M ddl ewar es\ Tenp.

Note: Only the first ICA file received by the web browser isrecorded.

The converted script contains both Citrix and WWW functions. A new variable, char *
strl CAFi | eNane[ N] , isdeclared at the top of the script. All allocated memory isreleased at the end of the
script.

Accessing a Citrix Session

Use one of the following methodsto begin recording a Citrix session.

To access a Citrix Client session:

! From the Session menu, click Citrix>Windows Client.
OR

I On thetoolbar, select the down arrow next to the Citrix button on the toolbar, then select
Windows Client.

To accessthe Citrix Web Interface when selecting a Citrix session:

! From the Session menu, click Citrix>Web Interface.
OR
I On thetoolbar, click the down arrow next to the Citrix button, then select Web Interface.

The Universal session startswith both the Citrix and WWW middlewares selected. In the Citrix tab,
Web Interface is selected in the Type field.

To access the Citrix Web Interface from a Universal session:

1. On thetoolbar, click Session>Universal or click the Universal button on the toolbar.

2. Click Options>Record. The Universal Record Options dialog box appears.
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3. Inthe Middleware Selection pane, select WWW, then select Citrix. The Universal Record dialog
box displaysboth a WWW tab and a Citrix tab. In the Citrix tab, Web Interface is selected in the
Type field.

Recording a Citrix Session

To begin recording a Citrix session, select the down arrow next to the Citrix button on thetoolbar, then
do one of the following procedures below.

AL Tips: Uppercase characters are not captured when the CAPS Lock key is on. Manually modify the script to
use uppercase characters or hold down the SHIFT key during recording.

Smilarly, the Windows Logo key is not supported. Do not use the Windows Logo key to start applications
while recording a Citrix script.

To begin recording a Citrix session:

1. Select Windows Client to activate a new Citrix session.

2. Click Record on the Session toolbar.

The Citrix capture application appears, as shown in the following image. Click the three sections of the
imageto learn more about the fieldsand the information that isdisplayed in each area.
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To begin recording using the Citrix Web Interface:

1. Select Web Interface to activate Universal session for the Citrix Web Interface.
2. Click Record on the Session toolbar. The Universal Record Optionsdialog box displays.
3. Select the appropriate options, then click Start Record.

Citrix Recording Options for a Client Session

To set recording options, choose Options>Record in the Script Development Workbench.

El Note: When testing in the Citrix Web Interface environment, use the Citrix Recording Options for Web
Interface.

Set the following options for recording Citrix applications:

Type: Select thetype of application used for the script. Required information dependson the
application type selected. Choose:

= |CAFle- Enter the Application and Connection information for the ICA file.

= Published Application - Enter the Application, Connection, and Logon information for the
application.

= Sngle Server - Enter the Application, Connection, and Logon information for the server.

ICA FHle

Application Information

ICA File: Click Browse to select a Citrix ICA file. Thisfile, which islocated on the MetaFrame
server, contains configuration optionsfor the Citrix client. For more information about ICA files,
consult your Citrix administrator.

Resolution: Choose awindow size for the Citrix connection. To ensure that the entire Citrix
interface isvisible during recording, set the Resolution field to alower value than that of the
desktop. Also, the screen resolution must be the same asthe screen resolution specified in the Citrix
ICA file.

Connection Information

Port: Typethe port number over which Citrix ICA traffic travels. This port isalso the port on which
the MetaFrame server islistening. The default port is 1494.

Gracefully disconnect session: Select to specify that alogoff isissued beforeissuing a disconnect. If
you do not select thisoption, configure the Citrix server to properly handle clean-up sessions.

Published Application

Application Information

Resolution: Choose awindow size for the Citrix connection. To ensure that the entire Citrix
interface isvisible during recording, set the Resolution field in the Citrix Record Optionsdialog box
to alower value than that of the desktop.

Server List: Select the server that the Citrix capture application will connect to during initial startup,
then click Retrieve. Add a new server by double-clicking the list box and typing the server name.

Application: Select the startup application.

Logon Information

Username: Type the username for the server logon prompt.
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Password: Typethe password for the server logon prompt.

Domain: Typethe domain for the server logon prompt.

Connection Information

Port: Typethe port number that the Citrix capture usesto connect to the server. The default port is
1494,

Gracefully disconnect session: Select to specify that alogoff isissued beforeissuing a disconnect. If
you do not select thisoption, you may need to configure the Citrix server to properly handle clean-
up sessions.

Single Server

Application Information

Resolution: Choose awindow size for the Citrix connection. To ensure that the entire Citrix interface
isvisible during recording, set the Resolution field to alower value than that of the desktop.

Server: Type the name of the server that the Citrix capture application will connect to during initial
startup.

Application: Typethe path and the file name of an application to start upon a successful log on.

Directory: Type the working directory for the application that was specified in the Application field.
Soecifying aworking directory is optional even if you have specified an application in the Application
field.

Logon Information

Username: Type the username for the server logon prompt.
Password: Type the password for the server logon prompt.

Domain: Typethedomain for the server logon prompt.

Connection Information

Port: Typethe port number that the Citrix capture usesto connect to the server. The default port is
1494.

Gracefully disconnect session: Select to specify that alogoff isissued beforeissuing adisconnect. If
you do not select thisoption, you may need to configure the Citrix server to properly handle clean-
up sessions.

Citrix Recording Options for Web Interface

To set recording options, choose Options>Record in the Script Development Workbench. The Universal
Record Optionsdialog box displayswith both Citrix and WWW selected.

Note: When testing in a Citrix Client environment, use the Citrix Recording Options for a Client Session.

Citrix Tab

Application Information
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Resolution: Choose awindow size for the Citrix connection. To ensure that the entire Citrix
interface is visible during recording, set the Resolution field to alower value than that of the
desktop. Also, the screen resolution must be the same asthe screen resolution specified in the Citrix
ICA file.
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Connection Information

Port: Typethe port number over which Citrix ICA traffic travels. This port isalso the port on which
the MetaFrame server islistening. The default port is 1494.

Gracefully disconnect session: Select to specify that alogoff isissued beforeissuing a disconnect. If
you do not select thisoption, configure the Citrix server to properly handle clean-up sessions.

WWW Tab

Automatic Startup of Internet Explorer: Select thisoption to have QALoad automatically launch Internet
Explorer, and configure the proxy and port entries for the browser and the QALoad cript Development
Workbench. If you do not select thisoption, you must manually configure your proxy options before
recording.

User Started Application: Select thisoption to configure the application manually, then set the
appropriate optionsfrom those that follow.
Proxy Settings for User Started Application

Direct Connection: Select thisoption if you have a direct connection to the host from which you are
recording.

Manual Proxy Configuration: Select this option to specify a proxy through which to connect to the host.
Then set the following proxy options:

HTTP: Type the address of the HTTP proxy server. Thisfield hasa 255 character limit. Then enter
the port number in the Port field. QALoad accepts numbers from 0-65535.

Secure: Typethe address of the secure proxy server. Thisfield isonly available if you are licensed to
use EasyScript for Secure WWW. Thisfield has a 255 character limit. Then enter the port number in
the Port field. QALoad accepts numbers from 0-65535.

Exceptions: Type the addresses of any hosts for which QALoad should not use the specified proxies.
Proxy Automatic Configuration Script: Select thisoption if the proxy should use an automatic
configuration script located on your local area network. Then typethe script'sURL in the URL field.
Advanced Options

Advanced Options: Thisarea displaysthe settings for several options. To change any of these settings,
click the Change Advanced Optionsbutton to open the Advanced Options dialog box.

Citrix Conversion Options

To set conversion optionsfor Citrix Client and Citrix Web Interface sessions, choose Options>Convert in
the Script Development Workbench.

El Note: During the conversion process, callsto the Ct xSet W ndowTi t | e method are sometimes
placed at an incorrect line in the script. Determine the correct line by inspecting the capture file and
moving the call to that position in the script.

The Ct xSet W ndowTi t| e method isadded by QALoad during conversion and should otherwise not
be modified or manually added to a script.

Set the following optionsfor Citrix conversions:

Citrix Tab

General

Replay Output Mode: Choose the playback mode to use during replay.
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I Normal modeisnormal headlessreplay.

I Renderlessmode maximizesthe number of possible client sessions (and minimizes CPU usage) by
discarding all graphic dataimmediately after receipt. However, you cannot take snapshotsin
renderless mode.

I Windowless mode reduces CPU usage by allowing the client to skip drawing the screen image.
Rendering still exists off-screen, which makes session snapshots possible.

Enable Counters: Select to enable the middleware countersthat are built in to CtxConnect(),
CtxDisconnect(), and CtxPing() calls. Enabling these counters can affect load test performance.

Keyboard/Mouse Input

Combine consecutive key charactersinto a string: Select to combine consecutive ASCII character key
actions. Thisoption combinesindividual callsto type charactersinto one call for the entire string.

Convert consecutive mouse commandsinto points/clicks: Select to consolidate consecutive
CtxMouseMove commandsinto a CtxPoint() command and to convert matching
CtxMouseDown/CtxMouseUp command pairsinto CtxClick() commands.

Timeout Options

Connect: Typethe number of secondsto wait for the connection to complete.

Disconnect: Typethe number of secondsto wait for the disconnection to complete.

Window events: Type the number of secondsto wait for window creation and destruction eventsto occur.
Wait Point: Typethe number of secondsto wait for wait pointsto complete.

Restore Defaults: Click to set all timeout optionsto the default settings.

Window

Enable verification: Select to enable window verification. When thisoption isenabled, awindow must be
active for an action to beissued. Also choose the number of timesto re-try for verification if an active
window isnot found, and the number of millisecondsto wait between each try.

Enable Wildcard Title Match: Select to enable wildcard comparisonsfor matching Citrix window creation
events. For moreinformation about wildcard comparisons, see Handling dynamic window titles.

WWW Tab (Web Interface Only)

Comments

Form field ascomments: Select thischeck box to include acomment block in your script that shows each
valid field that isencountered after a CGI form has been requested. Thisoption isnot available if the
Visual Navigator isenabled. Following isan example of a form field comment block:

/* Form1l text Nane: nanme, Value: , Desc: */

/* Form1l text Nane: e-nmil, Value: , Desc: */

/* Form1l text Nane: Address, Value: , Desc: */

/[* Form1l text Nanme: city, Value: , Desc: */

/* Form1l text Nane: state, Value: , Desc: */

/[* Form 1l text Nane: zip, Value: , Desc: */

/* Form 1l check box Nane: echo, Value: , Desc: Echo a copy of HTM. page to email */
/* Form1l radio Nane: test, Value: capture, Desc: Capture */

/* Form 1l radio Nane: test, Value: replay, Desc: Replay */

/* Form 1 hidden Name: hidden, Value: This rocks!, Desc: */

Anchorsascomments: Select thischeck box to include acomment block in your script that shows all the
anchorsencountered in arequested HTML document. If it isnot selected, no anchorswill beincluded in
the script. Thisoption isnot available if the Visual Navigator isenabled. The following isan example of an
anchorscomment block:
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/* Anchors: ' http://playbackl/standard. html' ' Standard Exanple' */

/* Anchors: ' http://playbackl/fornms. htm' 'Forms Exanple' */

/* Anchors: ' http://playbackl/dynamc.htm' 'Dynam ¢ HTM. Exanple' */
/* Anchors: ' http://playbackl/cgi.htm"' 'CE Exanple' */

/* Anchors: ' http://playbackl/ cookies.htm' 'Cookies Exanple’ */

/* Anchors: ' http://playbackl/ssl.htm"' 'SSL Exanple' */

/* Anchors: ' http://playbackl/javascript.htm' 'Java Script Exanple' */

Client Image Maps as Comments: If selected, the command DO_GetClientMapHREF will be inserted into
your script followed by a comment block denoting client image maps. Thisoption isnot availableif the
Visual Navigator isenabled.

DO Get O i ent MapHREF( MAP(1), REG ON(1), &C i ent MapURL[0]);

/* dient Map: 1l Region:2 HREF: http://ww.ethnicgrocer.comeg/cp/cr.jsp?FOLDERYBC */
[* 9BEf ol der _i d=169991 &ASSORTMENTYBCY¥8East _i d=153827&si t e=EG&bnUJI D= */

/* 1005685611375&WebLogi cSessi on=0LGLayxDvTfj Lt hL65xY6X1cdQ VdCej WCT8wm */

[* DAPLs29z9H/WC wx| kr 8f 21K1aKoLSM 4HM 603| 6518173674514870389/ */

/* 167838850/ 5/ 80/ 80/ 443/ 443/ - 1| - 8250053020002903791/ 167838870/ 5/ 80 */

[* 180/443/ 443/ -1| 6518173674514872679CI i ent Map: 1 Regi on: 3 HREF: */

[* http://ww.ethnicgrocer.comeg/cp/cr. */

You can search for DO_GetClientMapHREF in the script to help locatethe DO_Get and DO_SetValuesin
the script, aswell aswhere the array of DO_GetClientMapHREF isinitialized and freed.

Debug comments: When thisoption isenabled, commentswill beinserted into the converted script to
denote repliesfrom the server, anchors, and so on. Thisoption isnot availableif the Visual Navigator is
enabled. For example:

/* Received reply:

URL: <htt p: // abcweb. anywher e. com caf e/ default. ht n> */

Compare HTML Document Title

Document Title Verification: Periodically, the HTML page title found in aload tested script does not
match the HTML page title found in your recorded text. Select this check box to comparethe HTML page
title contentsin your load tested script with the HTML page title contentsin your capture file. You can
enable the comparison based on prefix- or suffix-specified character match or entire string match.

Entire Document Title: Select thisoption to compare the entire length of the HTML page title.

Prefix: Select thisoption to compare the prefix (left-most specified characters) of the HTML page title.
Soecify the number of charactersto match in the Charactersto Match field.

Suffix: Select thisoption to compare the suffix (right-most specified characters) of the HTML page title.
Secify the number of charactersto match in the Charactersto Match field.

Charactersto match: After you select the Prefix or Suffix options, use thisfield to specify the number of
charactersto match from the HTML page title.

Baud Rate Emulation

Baud Rate: Select thischeck box to download web pages and images at a rate representing the speed of
connection, then enter aconnection speed in the Baud Rate field. Thisenablesyou to simulate modem
speed.

Refresh Timeouts

Refresh Timeout: Select thischeck box and type atimevaluein the field (in seconds) to comparethe
specified time value against a Web page's META Refresh value (e.g. <META HTTP- EQUI V=Ref r esh
CONTENT="10"; URL="http://ww. conpuwar e. coni ">). If the META Refresh tag's CONTENT field
valueislessthan thetime value you specify, the page istreated as aredirected page. If the CONTENT field
value is greater than the time you specify, the page istreated as a regular page.
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L Tip: Select this option to avoid infinite loopsin the script. Infinite loops can occur if a page refreshes
periodically to update data.

Represent CJK as Octal Characters: Slect this check box to enable the encoding of captured data from
Web applications containing Double Byte Character Sets (DBCS) such as Chinese, Japanese, or Korean.
Enabling thisoption encodes all native charactersand isused when native character support cannot be
used. Data staysin encoded format throughout the load test: from capture, through convert and replay, to
the analysis of the timing file. By leaving this option clear (default), CXK native characterswill be used
within test scripts, error messages, and timing files, making script editing easier and timing file analysis
quicker.

El Note: Native character support can only be used on the same CXK language OS as the application under
test. For further information on CXK Support, see CK Support in QALoad .

Advanced button: Accessesthe WWW Advanced dialog box, allowing you to set advanced conversion
options.

Using ICA files

ICA files, which are generated on the MetaFrame server, contain configuration optionsfor Citrix. You can
specify an ICA file on the Citrix Record Optionsdialog box.

ICA files are specified in the script with the CtxSetICAFle command. If an ICA fileis specified, thecall is
generated with an unqualified file name. For example:

Ct xSet | CAFi | e(" cust omapp.ica");

El Note: The file name is not fully-qualified because the file may not exist in the same location among the
remote Player machines.

To validate the script on the same machine on which it was captured, copy the ICA fileto the
QALoad\ Bi nar yFi | es directory.

To usethe ICA file on remote Player machines, the ICA file should be specified as an attached filein the
External Data column of the Script Assignment tab in the Conductor.

Inserting Screenshotsin the Citrix Script

During the Citrix session, you can take a screenshot of the contents of the connection window. Thisinserts
await point in the script for the screenshot you select and savesthe image as a bitmap. You can select:

I Insert Wait for Full Screenshot - Inserts await point based on afull screenshot of the current
display.
I Insert Wait for Partial Screenshot - Inserts await point based on a partial screenshot of the current
display.
I Save Current Screenshot - Saves a screenshot of the current display to a bitmap file.
&l Note: Imagesare saved to\ QALoad \ M ddl ewar es\ Ci tri x\ Capt ur es\ scr eenshot .

To insert a full screenshot into the Citrix script:

1. In the Citrix Capture dialog box, click Screenshots>Insert Wait for Full Screenshot. The Screen
Capture Preview screen displaysthe image.

2. Click Finish to confirm the screenshot. The Specify Screenshot Name dialog box displays with alist
of all previously saved screenshots.
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3. IntheName field, type a descriptive name for the image.

4. Click OK. Theimage issaved as a bitmap and await point for the screenshot isinserted into the
script.

To insert a partial screenshot into the Citrix script:

1. In the Citrix Capture dialog box, click Screenshots>Insert Wait for Partial Screenshot. The
selected screen displays with the message "Select a rectangular region of the screenshot you want to
insert."

2. Hold down the left mouse button and drag the cursor acrossthe screen to select the region to save.
The Screen Capture Preview screen appears with the image you selected.

3. Click Finish. The Secify Screenshot Name dialog box appears with alist of all previously saved
screenshots.

4. In the Name field, type a descriptive name for the image.

5. Click OK. Theimage issaved as a bitmap and a wait point for the screenshot isinserted into the
script.

To save the current screen:

1. In the Citrix Capture dialog box, click Screenshots>Save Current Screenshot. The Screen Capture
Preview screen displays.

2. Click Finish. The Secify Screenshot Name dialog box displayswith alist of all previously saved
screenshots.

In the Name field, type a descriptive name for the image.

Click OK. Theimage is saved as a bitmap.

Clearing Events from the Internal Queue

In response to mouse and keyboard input, the Citrix server sends screen update events of the updated
screen image to the Citrix client application. You can synchronize these screen update eventswith the text
or graphic updatesin the application by using CtxWaitForScreenUpdate to insert waitpointsin the Citrix
script.

When numerous matching screen update events occur, such asthe flashing edit cursor, they stay in the
internal queue indefinitely. This can cause the CtxWaitForScreenUpdate function to complete prematurely
by matching eventswith previously stored screen updates. You can clear theinternal queue by using the
CtxScreenEventExists function in asimple loop. Thisflushesall past screen update eventsfrom the
internal queue, so afollowing CtxWaitForScreenUpdate can successfully wait for the next occurrence of
the desired screen update event.

Citrix command reference

QALoad provides descriptions and examples of the various commands available for a Citrix script. For
details, refer to the Language Reference Help section for Citrix.

73



Script Development Workbench

Advanced Scripting Techniques for Citrix
Handling Citrix Server Farms

Citrix serverscan be grouped in farms. When load testing, you may want to connect to a Citrix server farm
rather than to a specific server. Load testing requirements may include connecting to a Citrix server farm,
where the load balancing feature supports dynamic redirection to a given server at connection time. This
load teststhe server farm and Citrix load balancing rather than a single server, which can provide amore
realistic load test.

To record a script that connectsto afarm, you must use an ICA fileto connect. However, when a capture
takes place, a specific server (in the farm) must have a connection. Secify the correct ICA file to connect
to the server farm as well as a specific server within that server farm.

To verify that your script isconnecting to a server farm and not a specific server, assign the server name to
one blank space when validating the script. In order to record a script that connectsto afarm, you must
use an ICA file specified in the Citrix Record Optionsdialog. Snce the ICA file should contain all the
necessary connection information, the server field should be left blank when recording.

When converted, the CitrixServer variable has a blank space:

/* Declare Variables */
const char *CitrixServer

const char *CitrixUsername = "citrix";
const char *Citri xPassword = "~encr~657E06726F697206" ;
const char *CitrixDomain = "gacitrix2";

const int CitrixQutputhMde OUTPUT_MODE_NORVAL;

SET_ABORT_FUNCTI ON( abort _functi on);
DEFI NE_TRANS_TYPE(" Or ders. cpp");
Citrixlnit(4);

[* Citrix replay settings */

Ct xSet Connect Ti meout (90) ;

Ct xSet Di sconnect Ti neout (90) ;

Ct xSet W ndowTi meout ( 30) ;

Ct xSet Pi ngTi neout (20) ;

Ct xSet Wai t Poi nt Ti meout ( 30) ;

Ct xSet W ndowVeri fi cati on( TRUE) ;

Ct xSet Domai nLogi nl nfo(CitrixUsernane, CitrixPassword, Citrix-Domain);
Ct xSet | CAFi | e("PRD desktop.ica");
Ct xSet Enabl eCount er s( TRUE) ;

Ct xSet W ndowRet ri es(5, 5000);

Ct xSet Enabl eW | dcar divat chi ng( TRUE) ;

SYNCHRONI ZE() ;
The Citrix client ignoresthisvalue and usesthe ICA file to dynamically retrieve the server name at
playback time.

Conclusion

When you usethese techniquesto set up a Citrix server farm test script, you allow for dynamic server
redirection at playback as part of testing aload balanced Citrix server farm.
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Handling Dynamic Windows

During conversion, CtxWaitForwindowCreate calls are added to the script for each named window
creation event. During replay, some dynamic windowsthat were in the capture may not appear, which
causesthe script to fail because a wait point times out. To avoid script failure in thiscircumstance,
comment out the CtxWaitForWindowCreate commandsthat may be referencing dynamic windows.

Handling Dynamic Window Titles

Some applications create windows whose titles vary depending on the state of the window. For example,
Microsoft Word creates atitle based on the default document name at the time of the window creation.

During replay, thisdynamic title can differ from the window title that wasrecorded, and the window is

not recognized. If thisoccurs, try the following stepsto modify the script:

1. Ensurethat the Enable Wildcard Title Match check box isselected in the Citrix conversion
options prior to converting the recording.
In the Window Verification group of the Citrix Convert Optionsdialog box, ensurethat the
Enable Wildcard Title Match check box isselected. Thischeck box is selected by default. If you
are working with a previously-converted script, ensure that a CtxSetEnableWildcardMatching
command existsin the script prior to the BEGIN_TRANSACTION command and that the parameter
isset to TRUE.

2. Verify whether thereisan issue with dynamic window titles.
When a script failson validation because the run time window title is different than the expected
window title from therecording, it islikely that you are dealing with adynamic title issue that can
be handled by thisscripting technique. In thiscase, the script failson the
CtxWaitForwindowCreate call.

3. ldentify amatch “pattern” for thedynamic window title.
Note the error message that isreturned during validation (or replay). The message indicatesthe
expected window title versusthe window title from script playback. Examine the differencesin the
window titlesto create a“match pattern” that recognizesthe window title, while ignoring other
windows. A match pattern can be asimple substring of the window title or a pattern string using
wildcard characters such as ? (to match any single character) or * (to match any number of
characters). The examples below illustrate the different match patterns.

4. Insert a CtxSetWindowMatchTitle command prior to the CtxWaitForWwindow Create call for
the dynamic window.
When adding the CtxSetWindowMatchTitle command, ensure that the first parameter containsthe
correct window object and the second parameter containsthe match string in double-quotes.

5. Validatethe script to ensure the CtxWaitForwindow Create command recognizesthe dynamic
window name.
Run the revised script through validation to ensure that the script succeeds. If the script does not
validate successfully, go to step 3 to determine if the match pattern is correct.

Example 1: Using a substring match

In thisexample, the Microsoft Word application generatesa dynamic title when the script isreplayed. The
dynamic nameisaconcatenation of the default document that Word creates at application startup with
the name of the application. The script is altered to reflect the fact that the string “Microsoft Word” is
always part of the window title:

/1 Wndow CW _13 ("M crosoft Wrd") created

Ct xSet W ndowivat chTitle( CW _13, “Mcrosoft Wrd” );
Ct xWai t For W ndowCr eat e( CW _13) ;

Example 2: Using awildcard match with the * character

In thisexample, the SampleClientApp application generates a dynamic title when the script isreplayed.
The dynamic nameisthe name of the application followed by the name of the user, beginning with the
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word “User”. The asterisk (*) wildcard is substituted for a given username, reflecting the pattern of
“SampleClientApp — User:” as part of the window title followed by an arbitrary user name:

/1 Wndow CW _13 ("Sanpl ed ientApp — User: John") created
Ct xSet W ndowivat chTitl e(CW _13, “Sanpl ed i ent App - User: *~7 );
Ct xWai t For W ndowCr eat e( CW _13) ;

Example 3: Using awildcard match with the ? character

In thisexample, the RandomValue application generatesadynamic title when the script isreplayed. The
dynamic nameisthe application followed by arandom single digit. The question mark character is
substituted for the single digit to reflect the pattern that begins“RandomValue: ", followed by single digit:

/1 Wndow CW _13 ("RandonVal ue: 0") created
Ct xSet W ndowivat chTitl e( CW _13, “Sanple Application: ?7 );
Ct xWai t For W ndowCr eat e( CW _13) ;

Handling Dynamic Windows that Require User Interaction

Some windows that require user action before normal script processing can proceed may appear
intermittently during replay. One example commonly encountered with Citrix isthe ICA Seamless Host
Agent window. Thiswindow, if it appears, requires user action or the script may fail.

To work around thisissue, follow these steps:

1. Captureasession in which the dynamic window appears and the user performsthe action to
dismissthewindow. Thismay require multiple attemptsto capture the window. Once thisis
captured in arecording, save the script asatemporary script.

2. If thewindow did not appear in the primary script, extract the code snippet from the temporary
script that actson the dynamic window and insert it into thereal script. The code usually consists
of a CtxPoint command and a CtxClick command for thiswindow. Insert the commands after the
CtxWaitForwindowCreate command for the dynamic window. In addition, extract and insert the
Citrix window information object constructor call and delete call to the relevant parts of the script,
changing the object name to avoid conflicting with existing window objects. Ensure that the
additional code isnot inserted between a CtxPoint command and a CtxClick command in the
primary script.

3. Add aspecial CtxSetWindowMatchTitle command immediately before the
CtxWaitForWindowCreate command. The first parameter of the CtxSetWindowMatchTitle
command should be the correct window object. The second parameter contains a special wildcard
match “*” that enablesthe CtxClick command to accept any window title, which ensuresthat even
if the matching window does not appear, the command still executes successfully.

4. If thewindow appearsin the primary script, comment out the CtxWaitForWindowCreate
command for the dynamic window. Because the window itself may not appear, the
CtxWaitForwindowCreate command should be commented out.

5. Validate the script. If the validation isnot successful, ensure that steps 2-4 were performed
correctly.

In the following example’'s scenario, the ICA Seamless Window Agent window does not appear in the
primary script, but appearsintermittently when the primary script isreplayed, causing those replay
sessionsto fail. A second Citrix script, which includesthe window appearance, isrecorded and the
CtxPoint and CtxClick commands are extracted from thisscript and inserted into the primary script, with
the window object changed to match the object in the primary script. In addition, the Citrix window
object constructor call and delete call are added in the appropriate placesin the script, and the CtxClick
command ischanged to refer to thisobject. In the following example, the text in bold represents code that
was manually inserted into the location in the primary script where the window appearsin the secondary
script.
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G xW *CW _99 = new Ct xW (0x10052, "I CA Seaml ess Host Agent", 0, 0, 391, 224);

Ct xSet W ndowivat chTitle( CW _99, “*~ );
Ct xPoi nt (190, 203);

Cxdick(Cw _99, 0, L_BUTTON, NONE);
Ct xPoi nt (300, 400);

deI ete CW_99; // "ICA Seanl ess Host Agent"
Handling Unexpected Eventsin Citrix

The CtxWindowEventExists and CtxScreenEventExists commands can be used to handle unexpected
window and screen eventsin Citrix scripts. When there isa possibility of unexpected dialogs appearing or
unexpected screen events occurring, you must modify the script to respond to the changes and continue
the load test.

For example, if a script opensa Microsoft Word document that resideson anetwork, and that document is
already open by another network user, an unexpected dialog box appearsthat promptsthe user to choose
between continuing to open the document in read-only mode or to cancel it. To prevent script failure,
modifications can be made in the script to handle the dialog boxes that appear in this situation.

Generally, to handle unexpected events, you record two scripts. The first script contains arecording of the
expected events. The second script should include the unexpected events. Using the
CtxWindowEventExists and CtxScreenEventExists functions, create a conditional block of code that
handlesthe dialogsthat may appear.

Example

The following script example showsthe additional script linesthat were added to handle a Word
document that isalready open by another user on anetwork. The added lines appear in boldface type.

/*
* capSavelllll-2.cpp
*
* Script Converted on June 21, 2004 at 01:04:17 PM
* CGenerated by Compuware QALoad convert nodule version 5.2.0 build 50
*
* This script contains support for the follow ng m ddl ewares:
* - Citrix
*

/

/* Converted using the follow ng options:

* General :

* Line Split : 132 characters
* Sl eep Seconds 1

* Auto Checkpoints : No
* Citrix

* CGeneral Options :

* W ndow Verification : Yes
* Sessi on Ti neouts : Yes
* Connect Ti meout (s) : 60
* Di sconnect Ti meout (s) : 60
* W ndow Creation Tineout (s) ;30
* Pi ng Tineout (s) 1 20
* Wait Point Tinmeout (s) ;30
* Include Wait Points : Yes
* Enabl e Counters : No
* I ncl ude Unnarmed W ndows : Yes
* Qut put Mode : Nor nal
* | nput Options :

* Conbi ne Keyboard | nput . Yes
* Conbi ne Mouse | nput : Yes
*
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#define C TR X_CLI ENT_VERSI ON " 8. 00. 60000"
#define CI TR X_|CO VERSION  "2.4"
#def i ne SCRI PT_VER 0x00000205UL

#i ncl ude <stdio. h>
#i ncl ude "smacro. h"

#include "do_citrix.h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O

#endi f
extern "C' int rhobot_script(PLAYER | NFO *s_i nf o)
{
/* Declare Variables */
const char *CitrixServer = "gaccitrix";
const int CitrixQutput Mode = OUTPUT_MODE_NORMAL;
[* Citrix Wndow | nformation Objects */
CGxW *CW _1 = new C xW (0x1001lc, "Warning !!", 107, 43, 427, 351);
G xW *CW _2 = new C xW (0x2001c, "Log On to Wndows", 111, 65, 418, 285);
G xW *CW _3 = new Ct xW (0x5001c, "Please wait...", 111, 112, 418, 145);
G xW *CW _4 = new C xW (0x30030, "Citrix License Warning Notice", 125, 198,
397, 127);
G xW *CW _5 = new C xW (0x40030, "Citrix License Warning Notice", 125, 198,
397, 127);
G xW *CW _6 = new C xW (0x4002e, "UsrLogon.Cnd", 0, 456, 161, 25);
G xW *CW _7 = new CxW (0x1003a, "", -2, 452, 645, 31);
G xW *CW _8 = new Ct xW (0x10066, "ICA Seam ess Host Agent", 0, 0, 391, 224);
G xW *CW _9 = new C xW (0x10052, "Program Manager", 0, 0, 641, 481);
CxW *CW_10 = new CtxW (0x1008c, "", 115, 0, 405, 457);
G xW *CW _11 = new Ct xW (0x1005a, "", 2, 49, 205, 408);
CGxW *CW _12 = new CtxW (0x2006a, "", 200, 186, 156, 287);
G xW *CW _13 = new Ct xW (0x10138, "", 112, 116, 416, 248);
G xW *CW _14 = new Ct xW (0x50036, "M crosoft Word", -4, -4, 649, 461);
CtxW *CW _15 = new Ct xW (0x1017e, "Open", 19, 23, 602, 387);
CGxW *CW _16 = new Ct xW (0x20174, "*Mcrosoft Word", -4, -4, 649, 461);
CxW *CW _17 = new CtxW (0x10058, "", 113, 114, 305, 26);
CGxW *CW _18 = new Ct xW (0x2013e, "Calculator", 66, 66, 261, 253);
CxW *CW _19 = new Ct xW (0x1005a, "", 2, 49, 205, 408);
G xW *CW _20 = new Ct xW (0x3006a, "Shut Down W ndows", 111, 96, 418, 193);
G xW *CW _117 = new Ct xW (0x20172, "File In Use", 144, 127, 352, 179);
G xW *CW _118 = new Ct xW (0x30172, "11111111 (Read-Only) - Mcrosoft Wrd", -4,
-4, 649, 461);

SET_ABORT_FUNCTI ON( abort _function);

DEFI NE_TRANS TYPE(" capSavel1111- 2.
Citrixlnit(1);

[* Citrix replay settings */

Ct xSet Connect Ti meout ( 60) ;

Ct xSet Di sconnect Ti neout (60) ;

Ct xSet W ndowTi meout ( 30) ;

Ct xSet Pi ngTi neout (20) ;

Ct xSet Wai t Poi nt Ti meout ( 30) ;

Ct xSet W ndowVeri fi cati on( TRUE) ;
Ct xSet Enabl eCount er s( FALSE) ;

Ct xSet W ndowRet ri es(5, 5000);
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Ct xSet Enabl eW | dcar divat chi ng( TRUE) ;

SYNCHRONI ZE() ;

BEG N_TRANSACTI ON() ;

DO _Set TransactionStart();

Ct xConnect (CitrixServer, CitrixQutputMde);

/1 Wndow CW _1 ("Warning !!") created 1087837356. 454
Ct xWai t For W ndowCr eat e(CW _1, 2125);

DO _MBLEEP( 1891) ;
Ct xPoi nt (246, 267); //1087837358. 797

DO_MBLEEP( 453) ;
Ct xMouseDown( CW _1, L_BUTTON, NONE, 246, 267); // 1087837358.797

Ct xMouseUp(CW _1, L_BUTTON, NONE, 247, 267); //1087837359.032

DO_MSLEEP( 63) ;
/1 Wndow CW _14 ("M crosoft Wrd") created 1087837397. 390

Ct xWai t For W ndowCr eat e( CW _14, 141);

DO_MBLEEP( 78) ;
CW _14->setTitl e("Documentl - Mcrosoft Wrd"); //1087837397. 468

/1 Wndow CW _13 ("") destroyed 1087837397. 468

DO _MBLEEP( 2468) ;
Ct xPoi nt (37, 50); //1087837400. 218

DO _MBLEEP( 282) :
CtxClick(CW _14, 203, L_BUTTON, NONE); //1087837400. 421

/1 Wndow CW _15 ("Open") created 1087837400. 764
Ct xWai t For W ndowCr eat e( CW _15, 344);

DO_MBLEEP( 1656) ;

Ct xPoint (132, 99); //1087837402.671

DO_MBLEEP( 250) ;
Ct xDoubl ed i ck(CW _15); // 1087837402. 874

DO_MSLEEP( 109) ;

DO_MSLEEP( 1953) ;

Ct xPoi nt (247, 197); //1087837404.827

/1 Wndow CW _15 ("Open") destroyed 1087837404. 827

i f(CtxW ndowEvent Exi st s( EVT_STR_CTXW NDOACREATE, 3000, CW _16))

Begi nBl ock() ;
Ct xPoi nt (337, 265); //1087837404.905
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/1 Wndow CW _16 ("11111111 - Mcrosoft Wrd") created
1087837404. 905

Ct xWai t For W ndowCr eat e( CW _16, 31);

/1 Wndow CW _14 ("Documentl - Mcrosoft Word") destroyed
1087837404. 905

DO _MBLEEP( 7547) ;
CtxPoi nt (628, 9); //1087837414.592

DO_MBLEEP(2141) ;
Ctxdick(CW _16, 281, L_BUTTON, NONE); //1087837414.873

DO_MSLEEP(234) ;

[/ Wndow CW _16 ("11111111 - Mcrosoft Wrd") destroyed
1087837415. 108

CtxPoint (113, 93); //1087837418.779

/1 Wndow CW _17 ("") created 1087837418. 779
EndBI ock()

/1] ReadOnly Code Start

el se
Begi nBl ock() ;

/1 Wndow CW _117 ("File In Use") created 1087840076. 599
Ct xWai t For W ndowCr eat e(CW _117, 578);

DO_MSLEEP( 2360) ;

Ct xPoi nt (358, 283); //1087840079.068

DO_MSLEEP( 125) ;
Ctxdick(CW _117, 281, L_BUTTON, NONE); //1087840079. 365

DO_MSLEEP( 109) ;
/1 Wndow CW _117 ("File In Use") destroyed 1087840079. 458

/1 Wndow CW _118 ("11111111 (Read-Only) - Mcrosoft Wrd") created
1087840079. 521

Ct xWai t For W ndowCr eat e( CW _118, 63);

/1 Wndow CW _115 ("Docunmentl - Mcrosoft Wrd") destroyed
1087840079. 521

DO_MBLEEP( 4766) ;
Ct xPoi nt (631, 3); //1087840084. 490

DO _MBLEEP( 203)
CtxClick(CW _118, 250, L_BUTTON, NONE); //1087840084. 740

DO_MSLEEP(93);
[/ Wndow CW _118 ("11111111 (Read-Only) - Mcrosoft Wrd")
destroyed 1087840084. 833

DO_MBLEEP( 2407) ;
Ct xPoi nt (34, 465); //1087840087.333
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EndBl ock();

/1!l ReadOnly Code End

DO _MVBLEEP( 1063) ;

DO _MBLEEP( 484) :
CtxPoint (112, 93); //1087837419. 654

DO _MBLEEP( 406) ;
Ct xDoubl eCl i ck(CW _9); // 1087837419. 904

/1 Wndow CW _9 ("Program Manager") destroyed 1087837440. 122
/1 Wndow CW _7 ("") destroyed 1087837440. 138
DO _Set Transacti onCl eanup() ;

Ct xDi sconnect () ;

END_TRANSACTI ON() ;

delete CW _1; // "Warning !'!"

delete CW_2; // "Log On to W ndows"

delete CW _3; // "Please wait..."

delete CW _4; // "Citrix License Warning Notice"
delete CW _5; // "Citrix License Warning Notice"
delete CW _6; // "UsrlLogon. Crd"

delete CW _7; [/ ""

delete CW _8; // "ICA Seanl ess Host Agent"
delete CW _9; // "Program Manager"

delete CW_10; // ""

delete CW _11; //

delete CW _12; //

delete CW _13; // ""

delete CW _14; // "Mcrosoft Wrd"

delete CW_15; // "Open"

delete CW _16; // "11111111 - Mcrosoft Word"
delete CW _17; // ""

delete CW _18; // "Calcul ator”

delete CW _19; // ""

delete CW _20; // "Shut Down W ndows"

delete CW _117; // "File In Use"
delete CW _118; // "11111111 (Read-Only) - Mcrosoft Word"

CitrixUninit();

REPORT( SUCCESS) ;

EXIT();

return(0);
}
voi d abort_functi on(PLAYER | NFO *s_i nf o)
{

RR_printf("Virtual User ABORTED.");

CitrixUninit();
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EXI T();
}

Moving the Citrix Connect and Disconnect Outside the Transaction Loop

If your load testing requirements for Citrix include creating extended logon sessions, in which the user
remains connected to the Citrix server between transactions, review the following tipsfor recording and
script development.

Recording

Perform the following steps during the recording processin order to prepare for moving the connect and
disconnect actions outside the transaction loop:

1. Insert acomment such as“Logged in to Citrix” after the Citrix logon but before any windows have
been opened.

2. Ensurethat all application windows are closed before disconnecting from the Citrix session.

3. Insert acomment such as“Ready to log off Citrix” before the Citrix logoff sequenceisinitiated.
Ensure that the first comment isadded after the user haslogged on and closed all login-related
dialog boxes, but before any applications are started. Smilarly, the second comment must be
placed after all applications have been closed, but before the user logs off.

Scripting

Comment out the BEGIN_TRANSACTION and END_TRANSACTION callsand add new
BEGIN_TRANSACTION and END_TRANSACTION calls at the location where the comments from steps 1
and 3 above were placed. Comment out the callsinstead of deleting them so that the original location of
these commands can be determined for debugging purposes.

Also comment out the DO_SetTransactionSart and DO_SetTransactionCleanup calls.
Using the CtxWaitForScreenUpdate Command

In some situations, awindow may vary in how long it takesto refresh on the screen. For example, the
Windows Sart menu isan unnamed window that can take varying amounts of time to appear, depending
on system resource usage. To prevent playback problemsin which a mouse click does not synchronize with
itsintended window, insert the CtxWaitForScreenUpdate command in the script after the action that
causesthe window to appear. The parameters for the CtxWaitForScreenUpdate command correspond to
the X and Y coordinates and the width and height of the window. Thiscommand ensuresthat the window
has enough time to display before the mouse click.

Java

Overview—About Java

QALoad does not support recording of Java scripts. Instead, Java scripts are created from script templates
that you useto create a stub script that you can then edit manually. Templates are saved in the

QALoad\ M ddl ewar es\ Java\ Tenpl at es directory. QALoad supplies four default templates. QALoad uses
atoken nameto represent the classpath — when you create a new Java script, QALoad simply replacesthe
token <cl assnaneher e> with the class/script name you assign. You can also install additional templates
using the <cl assnaneher e> token if you wish.

Following isan example of a Javatemplate with the classname token (in bold):

i mport com conpuwar e. qacent er. gal oad. EasyScri pt. *;
public class <cl assnanehere> inpl enents EasyScri pt

{

[** optional - O ass nethod runs once for each script when class is | oaded */
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public static void setup QALoad Test () throws Exception

{
}

Use the Script Development Workbench to create a new EasyScript for Java script from the provided stub
scripts.

Accessing JavaDoc

QALoad provides JavaDoc for your reference. To accessit from the Script Development Workbench menu,
choose Help>Easy Script for Java: JavaDoc from a Java session.

Creating a Java Script

To create a Java script for QALoad :

1. With aJavasession open, choose File>New from the menu.
2. IntheFlearea, click on the Middleware tree item.

3. IntheFlenamefield, type aname for your new Java script. Note that Javafile namesdo have
special requirements, and QALoad enforces those requirements. For example, Java file names
cannot contain spaces. If you try to include a space in your file name, QALoad gives you an error
prompt.

4. Click OK. The Create Java Script dialog box opens.

Under the Script field is a selection box listing all the templates available in your
\ QALoad\ M ddI ewar es\ Java\ Tenpl at es directory. QALoad provides four default templates. If
you click on atemplate name, a sampleisshown in theright pane. The four templates are;

I longformat — Provides all required and optional methods.

! new class— Creates a class associated with the script.

I old format — Shows modifications needed to run legacy scripts.
I short format — Provides only the minimum required methods.

Select the template that best suits your needs and click OK. QALoad creates a stub script by the name
you designated and opensit in the Workbook pane for editing.

6. Edit your script as necessary. You can use QALoad's Java Script Optionsdialog box to edit some
script attributes.

Note: The main call in the script isused for debugging proposes and is hot executed in the Conductor.

Setting Classpaths in QALoad Player for EasyScript for Java

When loading aclassby namein the QALoad Player during runtime, do not use aclassname on the
Enterprise Java Bean (EJB) InitialContext call. Instead, use a classinstance or add aline of code before the
INDI lookup call. Refer to the following examples:

Using a class instance

Replace the InitialContext propertiesand JNDI namesin the following example with the valuesthat are
appropriate for your application.
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Before:

java.util.Hashtable ht = new java.util.Hashtable();

ht . put (j avax. nam ng. Cont ext. | NI TI AL_CONTEXT_FACTCRY,
"org.jnp.interfaces. Nam ngCont ext Factory");

ht . put (j avax. nam ng. Cont ext . PROVI DER_URL, "fh12623:1099");

javax.nam ng. I nitial Context ic = new javax.nami ng.lnitial Context(ht);
nject ref = ic.lookup("AddressMsvc");

After:

org.jnp.interfaces. Nam ngCont ext Factory nf = new
org.jnp.interfaces. Nam ngCont ext Factory();
java.util.Hashtable ht = new java.util.Hashtable();

ht . put (j avax. nam ng. Cont ext . PROVI DER_URL, "fh12623:1099");
javax. nam ng. Context ic = nf.getlnitial Context(ht);

nject ref = ic.lookup("AddressMsvc");

Adding a line of code before the INDI lookup call

Add the following line before the INDI lookup call:
Thr ead. current Thread() . set Cont ext Cl assLoader (get C ass(). get Cl assLoader ());

If it isastatic method, use the following sample, replacing CLASSNAME with the class name of the code.
Thr ead. current Thread() . set Cont ext Cl assLoader ( CLASSNAME. cl ass. get Cl assLoader ());

Executing a Java Applet
Java applets are handled by the following process:

1. Thebrowser makesarequest to a Web server for an HTML document that contains embedded Java
applets.

2. Thebrowser downloadsthe Java applets, in the order in which they appear on the Web page, and
immediately executesthem.

Example Web Page

The following Web page containstwo sectionsthat reference Java applets. Notice the parametersthat
follow the applet. The browser passesthese parameterswhen invoking an applet.

<HTM_>
<HEAD>
<TlI TLE>Java Exanpl e</ Tl TLE></ HEAD>
<BODY>

<cent er ><h2>Java Appl et Exanpl e</ h2><hr >

<appl et code="LScrol | Text. cl ass" wi dt h="500" hei ght="20" >

<PARAM NAME=" MESSAGE" VALUE="Scrolling Text created by Java Applet... >>Cick here to
Downl oad<< Use it FREE">

<PARAM NAME=" FONTHEI GHT" VALUE="14">

<PARAM NAME=" SPEED"' VALUE="2">

<PARAM NAME="PI XELS" VALUE="1">

<PARAM NAME="FONTCOLOR' VALUE="0000FF" >

<PARAM NAME=" BACKCOLOR' VALUE="FFFF00" >

<PARAM NAME="TARGET" VALUE="Iscrolltext.zip">

</ appl et >

<br ><br ><br >

A scrolling nessage, with customcolors, font size, speed, and target URL.<br>
The source (.ZIP) file can be downl oaded by clicking the associated area in text w ndow.

<br ><br ><br ><hr >
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<APPLET CODE="i magef ader. cl ass" W DTH=80 HElI GHT=107>
<PARAM nane="deni cron" val ue="ww. dem cron. se">
<PARAM nane="reg" val ue="A00012">

<PARAM nane="naxi tems" val ue="3">

<PARAM nare="wi dt h" val ue="80">

<PARAM nane="hei ght" val ue="107">

<PARAM nane="bhi t map0" val ue="ani bal . j pg">

<PARAM nane="bi t mapl" val ue="j ak.j pg">

<PARAM nane="bi t map2" val ue="j an.j pg">

<PARAM nane="url 0" val ue=" ">
<PARAM nane="url 1" val ue=" ">
<PARAM nane="url 2" val ue=" ">

<PARAM nane="st ep" val ue="0.05">
<PARAM nane="del ay" val ue="20">
<PARAM nane="sl eepti ne" val ue="2000">

</ APPLET>
<br ><br ><br >

This applet is a very popul ar image fader that displays a series of inmges, and allows URLs
to be associated with each inmage. <br><br><hr>

</center>
</ BODY></ HTM_>

Example script

QALoad does not evaluate Java applets. They appear asmain requests. The example script featuresthe
following elements:

I ADO_Http call to retrieve the main page.
I ADO_Http call to retrieve the scrolling text class.
I ADO_Http call to retrieve the image fader class Java applet.

How It Works: QALoad interacts with the Web server without execution of the Java applet program within
thevirtual browser. The browser acceptsthe pagesthat contain Java applets, but does not execute the
applet as part of the load test. The Java applets are not evaluated by QALoad and appear as main requests
in the script.

DO InitHttp(s_info);

BEG N_TRANSACTI ON() ;

DO Http("GET http://ww. host.com java. ht m HTTP/ 1. O\r\n\r\n");
DO VerifyDocTitl e("Java Exanpl e", TITLE);

/* Request: 2 */
DO Http("GET http://ww. host.com LScrol | Text.class HITP/1.0\r\n\r\n");

/* Request: 3 */
DO Http("GET http://ww. host.com i nagefader.class HTTP/ 1. 0\r\n\r\n");
DO Http("GET http://ww. host.com jak.jpg HITP/1.0\r\n\r\n");

END_TRANSACTI ON() ;
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Oracle

Oracle recording options

User Started: Select thisoption if you would like to start your application manually for recording, either
before or after you start recording. Because this method may fail to record your application’sinitial calls,
Compuware recommendsyou use the Automatic option instead. Select the User Sarted option when you
do not know the full application startup name and command option parameters or when the application
spawns off processes that generate traffic that you want recorded.

El Note: If you choose this option and the application under test generates traffic before the first Windows
screen displays, you must also select the Capture Initialization Phase check box on the Workbench
Configuration tab of the Configure QALoad Script Development Workbench dialog box.

Automatic: Select thisoption for QALoad to automatically start your application when recording, allowing
you to record early application startup activity. Thisisthe recommended method of capturing API calls,
because it takes advantage of QALoad’s enhanced abilitiesto handle various multi-threaded programming
techniques. Select this option to record traffic from just one application. This option limitsthe recording
output to just the traffic generated by the application, not including the traffic that is generated by
processes spawned by the application.

Command Line: If you chose Automatic Program Startup, enter the command line of your Oracle
application. You can also use Browse to locate your application.

Working Directory: Enter the working directory of your Oracle application.
Note: If you entered the full path in the Command Line field, thisfield isfilled in automatically.

Oracle Conversion Options

Database Paths, Includes: Enter the location of the Oracle Call Interface (OCl) include files. These files are
only installed when Oracle Call Interface is selected as part of the Oracle client installation. Usually these
filesare found in the.\ oci \i ncl ude subfolder of the directory where the Oracle client softwareis
installed.

Database Paths, Libraries: Enter the location of the Oracle Call Interface (OCI) library files. These files are
only installed when Oracle Call Interface is selected as part of the Oracle client installation. Usually these
filesare found in the.\ oci \ | i b\ nsvc subfolder of the directory where the Oracle client software is
installed.

Variablization (ActiveData) Enable: Select thisoption to enable ActiveData for Oracle during conversion.
Thisoption isenabled by default. For more information, click ActiveData for Oracle.

Minimum Characters: Enter the minimum number of charactersto match for auto-variablization.

PostCapture: Fetch Iteration Override: Typethe number of fetch iterations allowed while recording a
script to control the amount of data fetched during playback. To fetch all data, type: 2000000.

ActiveData for Oracle
ActiveData for Oracle

Oracle variablization is a powerful scripting assistant that provides automatic correlation of data valuesin
your script (auto-variablization) and letsyou use a datapool asthe source of data values (manual-
variablization).
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Auto-variablization

When you enable auto-variablization, QALoad correlates the data values produced by the execution of
recorded SQL statements and assigns a single source variable to matching bind and static variables that
subsequently use the value. Auto-variablization will only target a capture file's bind variables and
embedded static datain recorded SQL statements as receivers of source variables. Source variables will be
automatically generated based on the capture file's PostBind data, Fetch data, and embedded Satic datain
QL statements. Source variables from PostBind data will be generated only if the PostBind data belongsto
one of these OCI bind datatypes:

OCI7 Bind Data Type OCI8 Bind Data Type

3 QLT INT QLT INT

4 QLT ALT QLT ALT

68 SQLT _UIN SQLT _UIN

1 QLT _CHR QLT CHR

5 QLT _STR QLT STR

96 QLT _AFC QLT _AFC

97 QLT _AFC QLT _AFC

11 QLT RID SQLT_RID Not Applicable

in OCI8

Source variables from Fetch data will be generated only if the Fetch data belongsto one of the above OCI
datatypes or one of the following:

OCI7 Fetch Data Type OCI8 Fetch Data Type ‘

6 QLT _VNU QLT _VNU
2 QLT_NUM QLT_NUM

=l Note: Fetch data is made available in the capture file only when the Oracle Capture Option Use Fetch
data for Variablization is selected.

Satic data embedded in SQL statementswill be used as source variable or receiver of a source variable only
when the SQL statement statesa SELECT, INSERT, UPDATE or DELETE operation. SQL statementsthat
contain stored procedures (e.g. BEGIN...) will be excluded.

Auto-variablization occurs by default in QALoad, but you can turn it off by clearing the conversion option
Variablization (ActiveData) on the Oracle Convert Optionstab. If you choose to use automatic
variablization, you can then use manual-variablization to change a source variable previously determined
by auto-variablization to data from alocal or central datapool.
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Manual Variablization

Manual variablization allowsyou to change the source of variablesidentified through auto-variablization
to use data from central or local datapools. You use the variablization tree-view and the options available
from the tree-view to view and change source variables.

Manual variablization islimited to changing the source variablesto data that was prepared from alocal
datapool or conductor (central) datapool. Once changed, all (but not individual) source variables may be
changed back to the original source variables.

Why use ActiveData for Oracle?

! To avoid duplicate key errorswhich can occur during playback when the data relationships
hidden (implied) within a set of Oracle SQL statements are not recorded. For example, a
recorded Select SQL statement may include the Oracle nextval expression to get the next sequential
unique number in the database. The returned value from the expression isused for the primary key
in asubsequent Insert statement. The primary key is associated with a bind variable. The value of
the bind variable isrecorded and noted in the QALoad script. When the script is played back, the
returned value from nextval will naturally be different from the value of the bind variable. The
Insert SQL execution incursaduplicate key error from the Oracle server.

Oracle variablization preventsthiserror by providing alogical relationship between the returned data
from the Select statement and the data for the Insert bind variable. The datarelationship is established
through a source variable.

I Toreducediagnostic time for playback data issues, especially when dealing with large scripts.
Using asingle source variable for script variablesthat have the same data value reducesthe amount
of debugging time that would have been spent on multiple script variables. Additionally, the
Compare Tool aidsyou in debugging data issues by highlighting SQL and data differencesthat
could influence the load test of two similar capture files.

Variablization menu

Accessthe Variablization menu from the Script Development Workbench's Session menu, or by right-
clicking from the variablization tree-view.

Create/ Edit a source: Opensatree-view of your variablized
statementsand their sources.

Show Capture Difference: Accessesthe Compare Tool, where you
can choose a capture fileto compare to the current capture file and
have the differencesin SQL statementsand bind data highlighted for
your comparison within the variablization tree-view.

Revariablize: Deletes all manually generated source variables and re-
executes auto-variablization. Note that datapool sources may not be
changed back to PostBind, Fetch, or Satic data unless you select this
option.

Remove all sources: Deletes all source variables from the script's.var
file.

Show SQL statement: Provides a detailed view of the highlighted
L statement. The detailed view will display associated Bind and
Column data (from the Execute statement), associated PostBind data, and associated Fetch data.

Hints: Opensthe Oracle Variablization Hintsonline help.
Word wrap: Showsthe complete QL statement in wrapped format. Thisis selected by default.

Display options: Allowsyou to change display optionsto one of the following: Only statementswith bind
variables, Unsourced Bind statements, or Show all SQL statements (default).
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The Refresh the current view option will re-draw the tree-view after a source ismanually changed.
Save the Variablization VAR file: Saves any changesto the script's .var file.
Save and Convert: Saves changesto the .var file and re-convertsthe script.

Save and Convert As. Saves changesto the .var file and promptsyou to save your script under anew name
before re-converting it.

Variablize

Use thisdialog box to variablize a file or to compare two similar files. The results are displayed in atree-
view from which you can manually variablize the file or view the differences between the two files. When
you compare two files, the differencesin SQL statementsand bind data are highlighted within the
Variablization tree-view.

Variablize the following capture file: Liststhe path and name of the currently selected capture file (.cap).

Compare and Variablize with the following file: Navigate to the capture file you'd like to compare to the
currently selected capture file.

Variablize: Variablizesthe file and displaysthe recorded SQL statements, bind variables, static variables
embedded in SQL statements, data values and the sources of data values as determined by auto-
variablization.

Cancel: Closesthe dialog box without making any changes.
Source Details

Displays details about the source of the selected variable, and allows you to replace the source with data
from acentral or local datapool.

Name: Liststhe name of the field in the script that was variablized.
Value: Liststhe value assigned to the variablized field.
Line #: Liststhe script line where the field islocated.

(Default) From Postbind/Fetch/Static data: If thisoption is selected, the source of the variable was
determined by auto-variablization.

Source variable namein Convert script: The name assigned to the variable by auto-variablization, or
when replaced by a datapool variable.

From datapool: Select thisoption to change the sourceto a central or local datapool.
Field Number: Secify the column number in the datapool fileto use asthe source.

Advanced Options: Click to open the ActiveData Advanced Source Options dialog box where you can
format the source before using it, if necessary.

Display values matched by auto-variablization: In thisarea, click the appropriate button to determine
which valuesto display: Sources, Matching values, or Matching names and values.

Match exact: Select if the source must be an exact match, or de-select to use the source for a sub-string
search.

Update Source: Click to update the variable source according to the settingson thisdialog.
Update ALL: Click to usethe newly created source variable for all itemsin the list area.
Delete Source: Click to delete the variable and all itsreferences from the tree-view.

Quit: Click to cancel without saving any changes.
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Comparing Hles

The Oracle Variablization Compare Tool comparestwo similar capture files, identifiesthe differencesin
QL statements and bind data, and highlightsthem in the Variablization Tree View.

Why Use the Compare Tool?

The Compare Tool can help you debug dataissuesin your transaction that may cause load test problems,
especially in large scripts. With the differences highlighted in awindow display, you can quickly determine
if manual variablization iswarranted for specific variables. Manual variablization can help you work
around dataissuesthat influence load tests.

To use the Compare Tool:

1. In the Workspace pane, right-click on the first capture file you want to compare and select
Variablize from the shortcut menu. The Variablize dialog box opens, displaying the path and
name of the selected file.

2. Select the Compare and Variablize with the following file check box, and then navigate to the
capture file you wish to compare against the first selected file.

3. Click the Variablize button. A new tab opensin the Script Development Workbench, presenting a
tree-view of the data. Differencesin SQL statements and bind data are highlighted.

4. View differing values by clicking on a highlighted bind variable or SQL statement. The Show
Capture Difference window opens, listing the value used in each file.

5. If you do not need to change the data, click OK to bereturned to the tree-view. If you need to
change the source of abind item to a datapool variable, click Go to Source Display. The Source
Details (for bind data) window or Show QL Satement (for SQL statements) window opens.

6. Changethe source of any variablesto call datapool items.

7. Savethe.var file and convert your capture file to build an updated script by right-clicking and
selecting Save and Convert or Save and Convert As.

Setting up QALoad to run Oracle scripts on UNIX

After installing the QALoad UNIX Player and utilities, you should ensure that the following environment
variables are set prior to starting the Player Agent (loadagent):

Platform Environment Value
Variable

All Platforms: ORACLE HOME <pat h>/ or acl e/ product/ <ver si on>

TNS ADMIN <l ocation of config files>
ORACLE SD <oracl e instance name
Linux: LD_LIBRARY_PATH <playerdir>/1ib: <ORACLE_HOVE>/1iDb
Solaris: LD _LIBRARY_PATH <playerdir>/1ib: <ORACLE_HOVE>/1iDb

Setting environment variableson UNIX systemsdepends on your login shell. For example:
I For ksh: export ORACLE HOVE=/ or acl e/ product/8.1.6
I Forcsh:setenv ORACLE HOME /oracl e/ product/8.1.6
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The ORACLE HOME environment variable pointsto the directory where the Oracle workstation software
has been installed. The TNS ADMIN environment variable should point to the location of the client
and/or server config files. ORACLE_SID should be set to the name of the Oracle instance. For each UNIX
platform, update the appropriate library path variable to include the library directory for the particular
version of Oracle.

Scripts will automatically be downloaded to the Player machines by the Conductor and compiled, if
necessary, at test execution time.

During the automatic script download and compile, if a script compile error occurs, a scriptname.err file
will be generated in the scripts directory.

To compile a script by hand, use the Rmake command. The syntax is as follows:
Rmake <scriptdir>/<scri ptnane>
or
Rmake <scriptdir>/<scri pt name>
Oracle command reference

QALoad provides descriptions and examples of the various commands available for an Oracle script. For
details, refer to the Language Reference Help section for Oracle OCI Version 7, General Oracle, or Oracle
OCI Version 8.

OFS

Recording from Oracle Forms Server

QALoad supportsrecording Oracle Forms 10g, 9i, and patched 6i (versions 6.0.8.14 and up) applicationsin
HTTP mode (also called Serviet mode), Forms 6.0 and 6i applicationsin socket mode, and SS_-enabled
Oracle Forms 9i and 10g applications. These recording types are described briefly below.

Recording Servlet Mode

Oracle 9iASand Oracle Application Server 10g use HTTP to send Forms data acrossthe network. To record
in Servlet mode, select the appropriate Serviet Mode option in the Record Optionsdialog box before you
start recording your application.

Note: When using server-side recording, you must perform stepsto configure the server. See Using server-
side recording for more information.

Recording SSL Mode

To record an OFS Servlet Mode application in SS. mode, select the appropriate Servliet mode option in the
Record Optionsdialog box, and enter the Jnitiator certDB file that the application uses. The certDB file
verifiesthe SSL Certificate Authority on the client side prior to the Forms connection.

Note: SSL mode is not available with server-side 9i recording.
Recording Socket Mode

For Socket Mode recording, QALoad must start your application for you through your browser. Before
recording, enter the URL of the Forms applet pagein the URL field, and the Forms Server port in the Port
field. If you leave the Port field blank, or enter an incorrect port number, your recording will only result in
an empty capture file. You may leave the URL field blank, but will be prompted for the Forms applet page
on theinitial browser page. From the applet page, click thelink to your Forms application. QALoad will
take over recording at this point.
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Using Server-side Recording

For Forms applicationsrunning in Oracle 9iAS you can use server-side recording, which avoidsissuesthat
can be encountered with some server configurations. Server-side recording creates a script recording by
using the Forms server's own capabilitiesto record transactions.

To enable server-side recording, select the 9i Server-Side Recording check box on the Oracle Forms Server
Record Optionsdialog box and provide the URL of the ListenerServlet in the ListenerServlet field.

Server Setup

Before recording a script using server-side recording, you must first modify the server configuration so that
QALoad can communicate with the server properly. Once the server modifications are complete, recording
and playback are the same as for standard OFSscripts.

To prepare the Forms server for server-side recording:

1. Copytheof snessage. j ar filefrom the\ QALoad\ Cl asses directory of the QALoad installation
on theclient machine to the\ FORMS90\ JAVA directory of the Oracle 9i Application Server
installation on the server machine.

2. Add anew section of configuration parametersto the f or nsweb. cf g filein the\ FORMS90\ ser ver
directory of the Oracle 9i Application Server installation. Use the following format, substituting
your own information for theitemsin boldface type:

[ MsgBI K]

formrtest 1. fnx

userid=scott/tiger@asdb

archive_jini=f90all _jinit.jar, OfsMessage. | ar

archive_i e=f90al | . cab, O sMessage. j ar

archive=f90al |l .jar, O sMessage. | ar

fornsMessageli st ener=oracl e. forns. i server. Messageli st ener
recordFi |l eNane=c:\tenp\is

3. WWen you begin to record, append a config parameter on theinitial browser page's URL, as shown
in boldface typein the following sample URL:
http://ntsap45b: 7779/ f or ns90/ |1 90ser vl et ?confi g=MsgBl k

Oracle Forms Server Recording Options

QALoad recordsthrough your default browser.

Connections

Formsversion: Select your Oracle Forms Server version. This parameter must match the version of
WebFormsyou are using or you will not be able to record. You can select:

I 10g Servlet - for Oracle Application Server 10g
I 9i Servlet - for Oracle 9i Application Server
I 6i Servlet - for version 6i Servlet Applications
I 6i Servlet (11i) - for version 6i Applicationsrunningin the 11i e-BusinessSuite
I 6i Socket - for version 6i Applicationsin Socket mode
I 6.0 Socket - for Forms 6.0
Enable server-side recording: Select to enable Oracle Forms 9i server-side recording.
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Listener servliet URL: Typethe URL of thelistener servlet that isused by the application under test.
Use SSL: Select thisoption if the application uses FormsVersion 9i and the application is S3_-enabled.

Certificate file: For SSL. mode only. Type the name of, or browse for, the Oracle Jnitiator's certDB
filethat islocated on the client machine. The certDB file isused by Oracle 9i to verify the SSL
Certificate Authority on the client side prior to the Forms connection.

Socket URL: For socket connectionswith Oracle Formsversions 6i or 6.0, enter the URL to initiate your
applet. If you are recording from 9i, thisfield isunavailable.

Port: If your Oracle Formsversion isanything other than 9i, type the port number on your Oracle Forms
Server application server for QALoad to listen on. Thisisthe same port asthe Formslistener (usually 9000).

To determine the server port:

1. Sart the WebForms application in the browser.
2. Oncetheapplication has started, choose the menu option View>Source.

3. Look in the source code for aline that resemblesthis:
<PARAM NAME = "serverPort" VALUE ="9000" >.Thisvalueisthe server port.

Additional Jar Files

Override application defaults: If you need to use Java resources other than those that are your
application's defaults, select the check box and then click Add to navigate to the appropriate JAR files and
add them to thelist.

Oracle Forms Server conversion options

General

Stop running when server messages indicate errors: Select to check server messages for errors. If this
option isselected, the script stopsrunning if errorsare encountered. If thisoption isnot selected, the script
ignores errorsand continues.

Stop only if server message matches specified string: Select to allow script failure only if the
specified server message isreceived. Thisoption isavailable only if the Stop running when server
messages indicate errorsis also selected.

Message: Type a string to match against server messages, and select one of the following match
types:

contains: Match based on the specified characters appearing anywhere in the message.
isexactly: Match based on the specified complete error message name.

beginswith: Match based on the specified characters appearing at the beginning of the
message.

endswith: Match based on the specified characters appearing at the end of the message.

Socket Mode only

Send heartbeat every [n] minutes: Type the number of minutes between each Forms 6i heartbeat
message. Compuware recommends using avalue of 4 or more to prevent socket usage issues.

Post Capture Options: Opensthe OFSPost Capture Options dialog box where you can processa WWW
file that ishexadecimal encoded (proxycap). This produces a new cap file, postcapweb file, longcap file,
and sortedcap. This process overwritesthese fileswhen they already exist.
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Note: Before using Post Capture processing, you must select the appropriate Forms version in the Oracle
Forms Server Record Options dialog box.

Checkpointsin Oracle Forms Server scripts

EasyScript for Oracle Forms Server supports QALoad's automatic middleware checkpoint timingsin both
HTTP and socket modes. Default checkpoints (Begin/End Checkpoint pairs) are not supported.

Automatic checkpoints are enabled from the Conductor's Timing Optionscolumn on the Script
Assignment tab and are enabled on a script-by-script basis.

At playback, automatic checkpoints are executed during the ofsSendRecv statement.

Formsvalidation/ playback debugging options
Debug data

When the Debug Data option isenabled on the Configure Script Development Workbench dialog box for
validation, or the Conductor's Debug Trace option isenabled for playback, executed script statements will
be displayed. For example:

VU 0 : Line:90, ofsSetWndowSize( "FORMAN NDOW ,6, OFS _ENDMSG 137, 750, 600 )
VU 0 : Line:91, ofsActivateWndow "W NDOW START_APP" , 11, OFS_ENDMSG 247 )
VU 0 : Line:92, ofsShowW ndow "W NDOW START_APP" , 11, OFS_ENDMSG 173 )

VU 0 : Line:93, ofsFocus( "BUTTON' ,51, OFS ENDVMSG 174 )

VU 0 : Line: 94, ofsSetWndowSi ze( "FORMAN NDOW ,6, OFS _ENDMSG 137, 750, 600 )
VU 0 : Line:95, ofsSendRecv( 1) //dientSegNo=2| MsgCount=6

Oracle Forms Server method reference

QALoad provides descriptions and examples of the various methods and functions available for an Oracle
Forms Server script. For details, refer to the Language Reference Help section for Oracle Forms Server.

Using the certDB Fle for OFS Replay

In some Oracle Forms Server environments, the certificates needed for the SS. handshake with the server
arenot in the default wallet used during replay. This causesthe SS_ handshake to fail.

You can use the certDB file used by Jnitiator for OFSreplay. To do thisfor Script Validation, place the
certdb.txt filein the BinaryFiles directory.

To use the certDB file for OFSreplay in Conductor:

1. Inthe Conductor's Script Assignment tab, select a script in the Script column.

Click Browse = . The External Data dialog box appears.

In Attached Files, click Add. The Add Attached File dialog box displays.
From the BinaryFilesfolder, select certdb.txt, then click Open.

Click OK.

o o N
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Advanced Scripting Techniques
Understanding the C++ Script

Oracle Forms Server scripts are produced for Oracle Forms, 6.0, 6i, and 9i (Release 2 and later) recordings.
The C++ script executes OFSrelated statements by passing the statementsin the script DLL to the OFS Java
enginethat performsthe client activitiesand the client communication with the server. Because the C++
script statements are directly tied to corresponding methodsin the OFSJava engine, modificationsto the
script statementsare limited to changing the property parameter values through variablization.

An OFSC++ script containsthree main sections: Connection, Application Body, and Disconnect. The
QALoad transaction loop includes all three sections by default. The transaction loop can be moved using
the guidelines described in Moving the OFStransaction loop. An internal auto checkpoint iscreated during
connection statementsand transmission statements.

The C++ script statements are a condensed version of the Java-style script statements. The C++ script
statements show the GUI controlsin the OFSapplication and the control properties, which are either
control attributes or activities. For example:

of sCli ckButton( "BUTTON', 52, OFS_ENDMSG 325 );

In thisexample, the user clicks (property 325) a button ( control ID 52). OFS ENDMSG isaflag that
indicatesthat the GUI activity endsthe current OFS M essage.

QALoad also allows OFSand WWW statements from a Universal session to be scripted in the C++ script,
providing the ability to play back WWW and OFSstatements. QALoad automatically extracts ICX tickets
and any necessary cookies from the WWW middleware traffic and passesthem to the OFSmiddleware.

Connection Statements

The connection script linesin the C++ script vary depending on the type of Forms connection mode that is
active. You choose the Forms connection mode on the Oracle Forms Server Recording Options dialog box.
Formsconnection modesinclude server-side recording, HTTP, HTTPS, or socket.

Server-side recording islimited to applicationsthat use Forms9i (applicationsrunning in Oracle 9iAS
Release 2 and above). HTTP connection mode is available for applicationsusing Forms 9i and for
applicationsusing the patched Forms 6i version configured with the HTTP servlet. HTTPS connection
mode isstrictly for SS_-enabled applicationsthat use Forms 9i. Socket connection modeisfor applications
that use Forms 6i and lower versions, such as Oracle 11i.

Server-side recording connections

Server-side recording mode containsonly one connection statement. The function that isused —
ofsSetServietM ode — containsthe listener servlet value that you entered on the Oracle Forms Server
Recording Optionsdialog box. The first parameter definesthe HTTP or HTTPS configuration of the
application environment. The second parameter definesthe name of the Forms Listener Serviet used by the
application. To connect, QALoad internally invokes Oracle’s dispatch callsusing the two parameters.
Oracle’'s proprietary classes provide the implementation for the HTTP or HTTPS connection. For example;

of sSet Ser vl et Mode( OFS_HTTP, "http://ntsap45b: 7779/ forns90/ 1 90servl et" );

HTTP connections

HTTP connection mode contains multiple connection statements. To connect, QALoad internally performs
Java callsto accomplish the following tasks:

I DefineHTTP header properties

I Connect to the Forms Servlet (an HTTP-GET request)

I Set the parameters of the Forms Listener Servlet

I Connect to the Forms Listener Servlet (an HTTP-GET request)
I Set additional HTTP header property for the Listener Servlet
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I Connect to the Forms Listener Servlet (an HTTP-POST request). The last connection statement also
initiatesthe required Forms“handshake” and determinesthe Formsencryption used by the
application environment.

For example:

of SHTTPSet Hdr Pr operty(" User-Agent”, "Javal.3.1.9" );
of sSHTTPSet Hdr Pr operty("Host", "ntsap45b: 7779" );
of SHTTPSet Hdr Property("Accept”, "text/htm , inage/gif, image/jpeg, *; q=.2, "*/*; g=.2"

of SHTTPSet Hdr Pr operty(" Connecti on", "Keep-alive" );

of sHTTPConnect ToFor nsSer vl et (

"http://ntsap45b: 7779/ f or 690/ f 90ser vl et ?i f cnd=st art sessi on" );

of SHTTPSet Li st ener Servl et Par ms( " ?i f cnd=get i nf 0& f host =C104444D01&i fi p= "192. 168. 234. 1"

)

of sHTTPConnect ToLi st ener Servl et ( "http://ntsap45b: 7779/ f orms90/ 1 90servlet");
of sHTTPSet Hdr Pr operty(" Content-type", "application/ x-ww-formurl encoded" );
of SHTTPI ni ti al For msConnect () ;

HTTPSconnections

HTTPSconnection mode usesthe same connection statementsas HTTP mode. To connect, QALoad
internally performsthe same tasksasthe HTTP connection mode plusit performsthe SS_ connection
when the ofsHTTPSDoSSL.Handshake function iscalled. This statement ispositioned in the script before
the ofsHTTPConnectToFormsServlet function.

Socket connections

Socket mode containsonly one connection statement. The function that isused —ofsConnectToSocket —
containsthe port number and the URL you entered on the OFSRecording Optionsdialog box to start OFS
capture. The port value isthe port on which the Forms Server directly listens for Formstraffic. To connect,
QALoad uses Java callsto open a Java socket using the parameters, initiate the required Forms "handshake”,
and determine the Formsencryption used by the application environment. For example:

of sConnect ToSocket (" 10. 10. 0. 167", 9002 );
Application Statements

The application statementsin the C++ script consist of property statementsand transmission statements.
Property statements describe the attributes and activities of GUI controlsin the application. Transmission
statements send the GUI controlsand their properties as Forms Message data to the server. Thereisonly
onetransmission statement: ofsSendRecv. QALoad creates an internal auto checkpoint when this statement
isexecuted. In the following example, the first two (property) statements set the location and size of a
FormWindow GUI control. The ofsSendRecv statement sendsthe GUI control propertiesto the server.

of sSet W ndowLocati on( "FORMA NDOW, 6, OFS _ENDMSG 135, 0, 0); /1 Property
of sSet W ndowSi ze( " FORMA NDOW , 6, OFS_ENDMSG 137, 650, 500); /1 Property
of sSendRecv(1 ); //Transmn ssion

Parameters of a property statement:

The parameters of a property statement are arranged in the following sequence:

1. Captured control name. If the nameisnot available, thisvalueisthe classnameto which the
control belongs.

Captured control ID.

3. Action type. Thisflag indicatesif the property isto be added to the current Forms Message or if the
property endsthe current Forms Message. During playback, each control istreated asa Forms
Message. When the current Message ends, QALoad translates the control and its propertiesto
binary format. The valid values are:

= OFS ADD - add the property to the current Message.
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= OFS ENDMSG —add the property to the current Message and end the Message.

= OFS STARTSUBM SG —add the property of the succeeding nested Message to the current
M essage.

4. Property ID. The Formsversion-specific ID of the property.
5. Property value. Captured value of the property (optional)
6. Property value. Captured value of the property (optional)

For example:
of sSet W ndowSi ze( " FORMA NDOW, 6, OFS_ENDVMSG 137, 650, 500);

In thisexample, control ID 6, which belongsto GUI class FORMWINDOW, isresized (PROPERTY
137) to have coordinates 650 and 500. Thismarksthe end of the current M essage.

Formsenvironment statements:

Theinitial set of statementsin the Forms script describesthe Forms application environment. In this set,
the"version” and the “cmdline” propertiesarethe most important. The version property showsthe Forms
Builder version used by the application. The version indicates the capabilities of the application. For
example, some versions cannot support HTTP connections. The cmdline property showsthe Forms
configuration parameters passed to the server by the Forms applet. The parameter “record=names’
indicatesthat the application enables GUI control namesto be captured. Control names are preferred in
multi-threaded playback. The “ICX” parameter indicatesthat the application uses a Personal Home Page.

In the sample script below, the Forms builder version is 90290 (the version used in Oracle 9iAS Release 2,
unpatched). The cmdline property shows “record=forms” which defaults “record=names’. The cmdline
property does not havethe “ICX” ticket parameter.

of sSetlnitial Version( "RUNFORM', 1, OFS_ADD, 268, "90290" );

of sSet Scr eenResol ution( "RUNFORM', 1, OFS_ADD, 263, 96, 96);

of sSet Di spl aySi ze( "RUNFORM', 1, OFS_ADD, 264, 1024, 768);

of sl nit Sessi onCndLi ne(" RUNFORM', 1, OFS_ADD, 265,

"server nodul e=testl.fnx userid= sso_userid= debug=no buffer_records=no debug_ "
"messages=no array=no query_onl y=no qui et=yes render=no host=ntsap45b. prodti.cont
"puwar e. com port= record=fornms tracegroup=debug | og=runl term=" );

of sSet Col or Dept h( "RUNFORM', 1, OFS_ADD, 266, "256" );

of sCol or Add( "RUNFORM', 1, OFS_ADD, 284, "0" );

of sCol or Add( "RUNFORM', 1, OFS ADD, 284, "8421504" );

of sSet Font Nane( " RUNFORM', 1, OFS_ADD, 383, "Dialog" );

of sSet Font Si ze( "RUNFORM', 1, OFS_ADD, 377, "900" );

of sSet Font Styl e( "RUNFORM', 1, OFS_ADD, 378, "0" );

of sSet Font Wi ght ( "RUNFORM', 1, OFS_ADD, 379, "0" );

of sSet Scal el nfo( "RUNFORM', 1, OFS_ADD, 267, 8, 20);

of sSet NoRequi r edVALi st ( "RUNFORM', 1, OFS_ADD, 291 );

of sSet PropertyString( "RUNFORM', 1, OFS _ENDVMSG, 530, "Anerical/ New _York" );

of sSendRecv(1 );

/1dient SeqNo=1| CapTi mre=1086884188. 281| MsgCount =1

Sending messages to the server:

The ofsSendRecv statement sendsthe accumulated GUI controlsand their propertiesto the Forms Server as
binary data. This statement representsthe point at which the client sendsa Forms Terminal Message to the
server. In Oracle Forms, theclient and the server must end each data block with a Terminal Message before
any transmission occurs.

Internally, QALoad variesthe binary data transmission depending on the connection mode:

I For server-side recording mode, QALoad sendsthe binary data by invoking Oracle’'s dispatch calls.
Oracle’s own classes provide theimplementation for the HTTP transmission.

I For HTTP or HTTPSmode, QALoad wrapsthe binary datainside an HTTP stream and invokes Java's
HTTP calls.
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I For socket mode, QALoad sendsthe binary data directly to the Java socket opened at the
connection point.

The ofsSendRecv statement has one parameter: the response code of the captured Terminal Message. The
possible values for this parameter are 1 (add), 2 (update), and 3 (close). Typically, when the response code
is 3, the Forms Server reacts by removing the GUI controls associated with the client message from the
server cache.

A comment line appears after each ofsSendRecv statement that contains script-tracking information. The
information on the comment lineisalso found in the capture filein each ofsSendRecv capture line. The
comment line showstherelative sequence of each client request, as represented by a Terminal M essage,
from the start of the application (e.g. ClientSegNo=1). The comment line also showsthe timing mark of
the captured Terminal Message (e.g. CapTime=1086884188.281) and the number of Forms messages
contained in therequest (e.g. MsgCount=1). The number of Messages can be verified by counting the
preceding ENDMSG and STARTSUBM SG flagsin the request block. The comment line is useful for
debugging playback issues because it readily showsthe client request sequence number wheretheissueis
occurring.

Getting the server reply:

During the execution of ofsSendRecv, QALoad also obtainsthe server'sreply and translatesthe binary
Formsdatainto Formscontrol values and control properties. The values are also written to the playback
log file (in capture file format) if script logging isenabled. The following sampleisa server reply:

VU 0 : MS|2/0]1

VU 0 : P| S| 322| j ava. | ang. I nt eger| 0| 151000320

VU 0 : P| S| 279] j ava. | ang. Bool ean| 0| f al se

VU 0 : P| S| 525| j ava. | ang. Stri ng| AMERI CAN_AMERI CA. WESMSW N1252
VU 0 : T| S| 1| Ser ver SeqNo=1| MsgCount =76

Thefirst lineindicatesthe start of a Forms Message from the server (M|S). The third parameter isan action
code (1= add, 2= update, 3= delete, 4= get property value). The fourth parameter isthe Class Code of the
control (0 =root class). The fifth parameter isthe Control ID (1= RunForm).

The second, third and fourth lines are property linesrelated to the above Forms Message from the server
(P|S). Thethird parameter of each lineisthe property ID (322). The fourth parameter isthe data type of
this property (java.lang.Integer). The fifth parameter isthe data value. If thevalue is0, the data valueisin
asixth parameter (false).

Thethird lineisthe terminal message line from the server (T|S). The third parameter isthe response code
associated with the terminal message (1= add, 2= update, =close). The fourth parameter istherelative
sequence of the server reply, asrepresented by a Terminal Message, from the start of the application (e.g.
ServerSeqNo= 1). Thefifth parameter isthe number of Forms messages contained in the reply (e.g.
MsgCount = 1). The number of Messages may be verified by counting the preceding M|Sflagsin thereply
block. The fourth and fifth parameters are script-tracking information, which can be useful for debugging
a playback issue. If logging isenabled, the log file shows the tracking information, which can make the
comparison between server responses and captured responses easier.

Processing large data and delayed response scenarios:

When HTTP or HTTPSconnection modeisused, Forms dataiswrapped insidethe HTTP reply stream.
QALoad checksthe HTTP header of the reply before processing the Formsdata. The HTTP header
sometimesindicatesthat the client needsto perform additional HTTP POST requeststo obtain the
complete Formsdata. Thisindication occurswhen the content-length of the reply is 64000 (a large data
scenario), or the content-type is"text/plain” and the HTTP header containsan “iferror: ” string (a delayed
response/re-post scenario). QALoad performsthe necessary POST requeststo obtain the complete reply
data, and then translates the accumulated reply datato Forms controlsand properties.
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Disconnect statements
The disconnect script lines vary depending on the Forms connection mode.

I In server-side recording mode, the ofsServerSdeDisconnect script statement internally invokes
Oracle’'s dispatch callsto disconnect.

I In HTTP mode, the ofsHTTPDisconnect statement internally makes Java callsto disconnect the
main URL connection from the servlet.

I In socket mode, the ofsSocketDisconnect statement closesthe socket on which the Forms Server
listens for traffic.

Using Script Logging as a Debugging tool

You can debug a playback issue in a C++ script by enabling replay logging. The option for enabling replay
logging islocated on the Script Assignment tab of the Conductor. For more information about enabling log
file generation, see Debugging a script.

In Java-based scripts, logging is not enabled by default. To enable logging, change the parameter of the
Logging method to truein the script. For example:

oracl eForns. Loggi ng( true );

When logging isenabled, QALoad writesthe client requests and server repliesto the playback log filein the
same format asthe capture file. The playback log file isfound in the\ QALoad\ LogFi | es directory. When
thereisan issue during playback, such asthe server not responding to aclient request, you can compare
the capture filesand check the differencesin the server reply data. Both the capture file and the log file
contain tracking information appended to the server'sterminal messages. The tracking data containsthe
relative sequence number of the server reply from the start of the Forms session and the timing mark. The
tracking data also showsthe number of Forms messages contained in the reply block. The number of
messages are based on the number of “M|S’ lines prior to the “T|S’ lines.

In the following example, the first set of statementsshowsthe logged statementsand the second set of
statements showsthe captured statements. The ServerSeqNo value showsthat thisisthe 8th reply from the
server. The MsgCount value of 1 showsthat only one Forms Messageisincluded in thisreply block.

1087419810. 000| of sShoww ndow] W NDOW START_APP| 11| OFS_ENDVSQE 173| PROPERTY_VI Sl BLE| j ava. | ang. B
ool ean| true

1087419810.
1087419810.
1087419810.
1087419810.
1087419810.
1087419810.

000| of sSendRecv| 1| d i ent SeqNo=8| CapTi ne=1087419810. 000| MsgCount =1
000| M S| 2] 0] 30

000| P| S| 135 j ava. awt . Poi nt | 0] j ava. awt . Poi nt [ x=0, y=0]

000| P| S| 137| j ava. awt . Poi nt | 0] j ava. awt . Poi nt [ x=706, y=464]

000| P| S| 139] j ava. awt . Poi nt | 0| j ava. awt . Poi nt [ x=0, y=0]

000T| S| 1| Ser ver SeqNo=8| CapTi me=1087419810. 000| MsgCount =1

1087402349. 296| of sShowwW ndow] W NDOW START_APP| 11| OFS_ENDMSQE 173| PROPERTY_VI Sl BLE]| j ava. | ang. B
ool ean|true
1087402349. 296| of sSendRecv| 1| C i ent SeqNo=8| CapTi me=1087402349. 296| MsgCount =1

1087402349.
1087402349.
1087402349.
1087402349.
1087402349.

296/ M S| 2| 0] 30

296| P| S| 135] j ava. awt . Poi nt | O] j ava. awt . Poi nt [ x=0, y=0]

296| P| S| 137| j ava. awt . Poi nt | O] j ava. awt . Poi nt [ x=706, y=464]
296| P| S| 139| j ava. awt . Poi nt | O] j ava. awt . Poi nt [ x=0, y=0]

296| T| S| 1| Ser ver SeqNo=8| CapTi ne=1087402349. 296| MsgCount =1

Moving the OFS Transaction Loop

To enable movement of the QALoad transaction loop in the C++ script, you must first record a full business
transaction and a partial businesstransaction. The business transaction isthe activity that you would like
to repeat during QALoad playback. Insert QALoad capture comments (using the Insert Command button
on the Recording toolbar) at the start and end of a business transaction. These commentswill help you
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find the spotsin the script where you would like to reposition the BEGIN_TRANSACTION() and
END_TRANSACTIONY() statements. Then re-start the business transaction.

QALoad's OFSscript presents a sequence of Forms GUI objects. The GUI objects contain context
dependencies. For example, when awindow isopened, the buttons, text fieldsand edit boxesinside that
window are logically dependent on the state of that window. When only one businesstransaction is
captured and the corresponding script’stransaction loop is moved, the sequence of the GUI objectsis
broken during the second iteration of the transaction loop. The broken sequence resultsin a broken
context, which causesthe server to respond unpredictably during playback on the second and subsequent
iterations of the transaction loop. When the businesstransaction isrestarted during capture, the Forms
GUI objectsthat compose the new transaction are used to anchor into the new transaction loop without
breaking the context dependencies of GUI objects.

When modifying the script, use the comment linesas guidesin moving the END_TRANSACTION() and
BEGIN_TRANSACTION() statements. Ensurethat thereisacontextual flow from the new position of the
END_TRANSACTIONY() statement to the new position of the BEGIN_TRANSACTION() statement. The set of
GUI objectsthat belong to the ofsSendRecv() statement just before the new END_TRANSACTION()
statement must be the same asthe set of GUI objectsthat belong to the ofsSendRecv() statement prior to
the new BEGIN_TRANSACTION() statement.

During playback, modify the Conductor setting for Transaction Pacing on the Script Assignment tab to
allow the database to process each new business transaction.

The following example shows a modified OFStransaction loop:

New position of the BEGIN_TRANSACTION statement

/ *
NewSal es
*/

DO_SLEEP( 13);

of sEdit ( "ORDER _SOLD TO 0", 562, OFS_ADD, 131, "B" );

of sSet Sel ecti on( "ORDER_SOLD TO 0", 562, OFS_ADD, 195, 1, 1);

of sSet Cur sor Posi ti on( "ORDER_SOLD TO 0", 562, OFS_ENDMBG, 193, "1" );
of sl ndexKey( "ORDER SOLD TO 0", 562, OFS_ENDMSG, 175, 97, 0);

DO_SLEEP(6) ;
of sSendRecv(1); //dientSeqNo=31| MsgCount =2| 1093981339. 921
BEG N_TRANSACTI O\() ;

of sEdit ( "ORDER _SOLD TO 0", 562, OFS_ADD, 131, "Business Wrld" );

of sSet Sel ection( "ORDER _SOLD TO 0", 562, OFS_ADD, 195, 14, 14);

of sSet Cur sor Posi ti on( "ORDER_SOLD TO 0", 562, OFS_ENDMSG 193, "14" );

of sRenobveFocus( "ORDER _SOLD TO 0", 562, OFS_ENDMSG, 174 );

of sSet Sel ecti on( "ORDER CUSTOMER _NUMBER 0", 564, OFS_ADD, 195, 0, 0);

of sSet Cur sor Posi ti on( "ORDER_CUSTOVER_NUMBER 0", 564, OFS_ENDVMSG, 193, "0" );
of sFocus( " ORDER_CUSTOMER NUMBER 0", 564, OFS_ENDMSG, 174 );

DO_SLEEP( 6) ;

of sSendRecv(1); //dientSeqNo=32| MsgCount =4| 1093981347. 296
New position of the END_TRANSACTION statement

/*

EndTr ans

*/

DO_SLEEP( 39);
of sSendRecv(1); //dientSeqNo=61] MsgCount =4| 1093981458. 031

of sSet Cur sor Posi ti on( "ORDER SOLD TO 0", 562, OFS_ENDMSG 193, "14" );
of sSel ect Menulten{ "Sal es Orders", 257, OFS_ENDMSG 477, "MENU_11059" );

DO_SLEEP( 26) ;
of sSendRecv(1); //dientSeqNo=62| MsgCount =2| 1093981485. 265
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of sEdi t ( "ORDER _SOLD TO 0", 562, OFS ADD, 131, "B" );

of sSet Sel ecti on( "ORDER SOLD TO 0", 562, OFS_ADD, 195, 1, 1);

of sSet Cur sor Posi ti on( "ORDER _SOLD TO 0", 562, OFS _ENDMSG 193, "1" );
of sl ndexKey( "ORDER SOLD TO 0", 562, OFS_ENDMSG, 175, 97, 0);

DO _SLEEP(3);
of sSendRecv(1); //dientSeqNo=63| MsgCount =2| 1093981488. 437
END_TRANSACTI ON() ;

of sedit( "ORDER SOLD TO 0", 562, OFS _ADD, 131, "Business World" );

of sSet Sel ecti on( "ORDER SOLD TO 0", 562, OFS_ADD, 195, 14, 14);

of sSet Cur sor Posi ti on( "ORDER SOLD TO 0", 562, OFS_ENDMSG 193, "14" );
of sl ndexSKey( "ORDER SOLD TO 0", 562, OFS ENDMSG, 176, 10, 0);

DO_SLEEP(13);
of sSendRecv(1); //dientSeqNo=64| MsgCount =2| 1093981502. 640

OFS and WWW Universal Sessions

QALoad now automatically extracts ICX ticket information from WWW middleware traffic and passesit to
the OFSmiddleware.

If you are using an older version of a script (prior to 5.5.1), you should modify the script manually. Record
with a Universal session to capture both the OFSand WWW transactionsand merge the two sets of
transactionsinto one script. The captured WWW statements contain non-servlet, non-Forms data such as
GIF objects, while the captured OFSstatements contain the Forms data.

When an Oracle Applicationslogin iscaptured, it isscripted using the ofsSetICXTicket statement. The
WWW login executes, extractsthe ICX ticket from the server reply, and passesthe ICX ticket to the Forms
session.

To capture an Oracle Applicationslogin with ofsSetICXTicket, modify the script.

To capture an Oracle Applicationslogin with ofsSetICXTicket:

1. Addthefollowing variable declaration statementsto thetop of the script:
char * pTicket =NULL;

2. Inthe*. post capweb file, find the HTTP request that returnsthe ICX ticket. The reply should
contain astring that indicatesthe ICX ticket value, such as" 1 CX_TI CKET=". Note the left and
right charactersthat delimit the ICX ticket value. In the examplein step 4, the left delimiter is
"icx_ticket="" and theright delimiteris""'".

3. In thescript, find the matching request line for the HTTP request.
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4. After the matching HTTPrequest line, add the DO_GetUniqueString statement using your chosen
delimiters. For example:
pTi cket = DO _Get UniqueString( "icx_ticket="", "'");

5. (optional) Verify the ICX ticket value.
RR_printf("ICX Ticket=\"%\"\n", |CX Ticket);

6. Add thescript line of sSet | CXTi cket (&pTi cket); beforethe ofsinitSessionCmdLine. This passes
the value of the ICX ticket to the ofslnitSessionCmdLine statement.

7. Freethe memory allocated by DO_GetUniqueString and ofsSetICXTicket before the end of the
transaction:

if (pTicket !'=NULL)

free(pTicket);
pTi cket =NULL;
}
Verifying OFS Window Creation

The ofsWindowCreated command doestwo things. First, it ensuresthat for the ofsSendRecv() command
preceding it, the server includesin the response that a FormWindow object with the title specified is
created. The script returns FALSE if the object isnot created. Second, the original (captured) control ID is
associated with the object representing the control in OFSreplay’sinternal list of controls, which isin
addition to the (runtime) control ID that istracked.

This allows better tracking of FormWindow GUI controlsthat exist at runtime by being ableto match up
both the control name and the original control ID.

The ofsWindowCreated command only handles objects of type FormWindow.

Using the ofswWindowCreated Script Command

The following example shows an example from a modified OFSscript:
of sSendRecv(1); //dientSeqNo=1] MsgCount =1| 1137439721. 484
if (!of sWndowCreated(11, "W NDOW LARGE_GRAPH'))

[l Only fail if this wi ndow was not created
RR__Fail edMsg(s_i nfo, "W NDOW LARGE_GRAPH was not created!");

}

of sW ndowCr eat ed( 15, "W NDOW _START_APP") ;

of sSW ndowCr eat ed( 20, "W NDOW CONTROLSTEST") ;
of sSW ndowCr eat ed( 24, "W NDOW GRAPHI CSTEST") ;
of sW ndowCr eat ed( 28, "W NDOW DATABASETEST") ;

SAP

Overview of SAP
Use QALoad's SAP middleware to load test systemsthat run SAP 6.20 and 6.40.
What is SAP?

The SAP GUI front-end isamiddleware that allows usersto access SAP servers from Windows. The SAP
serversrun various SAP business applications, such as applicationsfor customer relationship management,
human resources, and supply chain management.

Connecting to the SAP Server
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Once you have connected to amachinethat isrunning the SAP server, you can log on and interact with
the SAP applications.

Configuring an SAP Client for Load Testing

Before you can record an SAP session, you must have an SAP client that isconfigured to enable QALoad to
accessthe SAP server. Configure the SAP client through the SAP Logon application.

To configure an SAP client for load testing:

1. Sart the SAP Logon application. From the taskbar, click Start>Program s>SAP Front
End>SAPlogon.

2. Click New... on the SAP Logon dialog box. The New Entry dialog box appears.
T

[Suten .~
Desenplion |
Apoicabon Saem

SAF Fioder Shing

SAF Sistam &ArE URE

Speiamm b Advmaed..

¥ |

3. Typevaluesin the Description, Application Server, and System number fields.
El Note: QALoad usesthe value in the Description field to connect to the server.

4. Click OK. The new SAP server entry appearsin thelist in the SAP Logon dialog box.

SAP Recording Options (Versions 6.x)

Save Server Description: Select to specify and save the server description (name) to which you want to
connect during recording. If thischeck box isnot selected, you are prompted for a server description
during thelog on process.

Recording an SAP Session

An SAP server connection must be configured before you can connect with QALoad. See Configuring an
SAP Client for Load Testing for more information. Additionally, your SAP administrator must set the
SAPGUI / User _Scri pti ng security profile parameter to TRUE to successfully record a script. For more
information about SAP security settings, refer to the SAP publication titled "Sapgui Scripting Security”.

To record an SAP session:

1. If you have not already chosen SAP asthe session type, click SAP Session to activate a new SAP
session.

2. In the <ript Development Workbench, click Record on the Session toolbar.

3. If you have not selected the Save Server Description Record option, the SAP Server Description
dialog box appears. Type the name of the SAP server to which you want to connect. Thisvalueis
thesame asthe Description field that displaysin the SAP Logon configuration application. Press
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Enter. A logon dialog box appears.

4. Typeauser ID in the User field and the password in the Password field. Press Enter. The SAP
application starts.

5. In the SAP application, turn off the scripting and notification options. Click Customizing of local
layout and choose Options. The Optionsdialog box appears. On the ripting tab, select Enable
Scripting and clear the two Notify check boxes.

6. Begin recording actionsin SAP.

SAP Convert Options

Save Password: Select to save the encrypted password. If thischeck box isnot selected, you are prompted
for a password during conversion.

VB Script: Select to generate Visual Basic Script for debugging outside QALoad. If thisoption isnot
selected, you receive C++ scriptsthat can be used for playback within QALoad.

Insert SAP control comments: Select one of the following to insert SAP control lists ascommentsin your
script.

I None: Thereisno control information shown asacomment in the script.
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I Textfieldsand Statusbars: Control types GuiTextFHeld or GuiSatusbar will bein the script as
commentswith information: type, name, and id string.

I All controls: All controlswill bein the script ascommentswith information: type, name, and id
string.

Build SAP Libraries: Click Build to generate the QALoad SAP libraries based on your version of SAP. If you
receive linking errors while validating or compiling, you should click this button.

SAP Command Reference (Versions 6.x)

QALoad provides descriptions and examples of the various commands available for an SAP script. For
details, refer to SAP 6.x Language Reference Commands.

Viewing the SAP Control Log

Assist your scripting by using the SAP capture control log file to view the information that was present at
capture . Thelogfileisin XML format.

To open the control log:

1. In the Script Development Workbench Workspace, click the Capturestab or the Scriptstab, then
right-click on an SAP script or capture file.

OR
Open an SAP script or capture file, then right-click on the open file.

2. From theright-click menu, choose View Control Log.

Advanced Scripting Techniques for SAP
Adding Custom Countersto Retrieve Server Information

The following example adds custom countersto obtain and save the SAP Server information that is
available through the SAP Gui Scripting API. Notice that SAPGuiSessionInfo is called before logging off ,
because the dataisnot available after logging off.

int idl, id2, id3, id4;
| ong | RoundTri ps, | Fl ushes;

/1 "Counter Group", "Counter Nane", "Counter Units
/1 (Optional)", Data Type, Counter Type.

i d1 = DEFI NE_COUNTER(" Cunmul ati ve Group", "Cunulative RoundTrips", 0, DATA LONG
COUNTER_CUMULATI VE) ;

i d2 = DEFI NE_COUNTER(" Cunmul ati ve Group", "Cunulative Flushes", 0, DATA LONG
COUNTER_CUMULATI VE) ;

i d3 = DEFI NE_COUNTER("| nstance G oup", "lnstance RoundTrips", 0, DATA LONG
COUNTER _| NSTANCE) ;
i d4 = DEFI NE_COUNTER("I nstance Group", "lnstance Flushes", 0, DATA LONG COUNTER | NSTANCE);

SYNCHRONI ZE() ;
BEG N_TRANSACTI ON() ;
try{
SAPGui Connect ( s_i nfo, "qacsapdb2");
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SAPGui Sessi onl nf o( Get RoundTri ps, | RoundTri ps);

SAPGui Sessi onl nf o( Get Fl ushes, | Fl ushes) ;

SAPGui Propl dStr ("wnd[ 1] / usr/ bt nSPOP- OPTI ON1") ;

SAPGui CdO( Gui Butt on, Press);

SAPCui CheckScreen( "SESSI ON_MANAGER', "SAPLSPOLl", "Log OFf" );

COUNTER_VALUE( id1, | RoundTri ps);
COUNTER _VALUE( id2, | Fl ushes);
COUNTER_VALUE( id3, | RoundTri ps);
COUNTER _VALUE( i d4, | Fl ushes);

} // end try

catch (_comerror e){

char buffer[1024];

sprintf(buffer,"SAP. EXCEPTION Ox% % for VU(%)\n",e.Error(), (char *)e.Description(),
S task_id);

RR__Fai | edMsg(s_i nfo, buffer);
} I/ end catch
END_TRANSACTI ON( ) ;

Required Commands

Certain commands must be present in an SAP script for it to run successfully. These commands are created
automatically during the conversion process. Most of the commands exist before the
BEGIN_TRANSACTION statement. The required commandsinclude:

SET_ABORT_FUNCTI ON( abort function);
DEFI NE_TRANS_TYPE(" capture. cpp");
HRESULT hr = Colnitialize(0);

i f( hr !'= ERROR _SUCCESS )
RR__Fail edMsg(s_info, "ERROR initializing COM);

SAPGui Set CheckScreenW | dcard( ‘*");
SYNCHRONI ZE() ;

Required commands for transaction restarting
When transaction restarting isenabled in the Conductor for an SAP script, the following commands,
which are automatically added by QALoad during script conversion, must exist for the script to run:

SAPGui Appl i cati on(Regi st er ROT) ;
SAPGui Appl i cati on( RevokeRQOT) ;
SAPGui _error_handl er(s_info, buffer);

The SAPGuiApplication command properly registers and removesthe script's SAP GUI usage on the
Runtime Object Table (ROT). If atransaction fails, these actions are taken to start and clean up the SAP
environment.

El Note: Do not call RR _FailedMsg in an SAP script if the script includes a restart transaction operation.
SAPGui_error_handler can be called with the same parametersas RR _FailedM sg to output a fatal error
message while still allowing a proper clean up of the current transaction before restarting the transaction.

Eror Handling and Reporting

A try/catch block isautomatically generated for the commands between the BEGIN_TRANSACTION and
END_TRANSACTION statements. This construct provides error handling and reporting from the script.

BEG N_TRANSACTI ON() ;
try{
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SAPGui Connect ( s_i nfo, "qacsapdb2");
SAPGui Ver CheckStr (" 6204. 119. 32");

/1 Set SapApplication = CreateObject("Sapgui.ScripingCrl.1")
/| SapAppl i cati on. OpenConnection ("qgacsapdb")
/1 Set Session = SapApplication. Children(0). Children(0)

DO _SLEEP(3) ;

SAPGui Propl dStr("wnd[0]");
SAPGUi Cd3( Gui Mai nW ndow, Resi zeWor ki ngPane, 83, 24, false);

DO_SLEEP(6) ;

SAPGui Propl dStr ("wnd[ 0] / usr/t xt RSYST- BNAME") ;
SAPGuUi Cnd1( Gui Text Fi el d, Put Text, "qgal oadl1");

SAPGui Propl dStr ("wnd[ 0] / usr/ pwdRSYST- BCODE" ) ;
SAPGuUi Cnd1Pwd( Gui Passwor dFi el d, Put Text, "~encr~1211616261");

SAPGuUi CndO( Gui Passwor dFi el d, Set Focus) ;
SAPGui Cmd1( Gui Passwor dFi el d, Put Car et Posi tion, 3);

SAPGui Propl dStr ("wnd[ 0] ") ;
SAPGui Crd1( Gui Mai nW ndow, SendVKey, 0) ;
SAPGuUi CheckScreen(" S000", " SAPMSYST", " SAP") ;

DO_SLEEP( 10) ;

SAPGuUi Propl dStr ("wnd[ O] /usr/cnt| | MAGE_CONTAI NER/ shel | cont/shel | /shell cont[0]/shell");
SAPGuUi Cd1( Gui Ctrl Tree, ExpandNode, "0000000003");

SAPGUi Crd1(Gui Ctrl Tree, Put Sel ect edNode, "0000000004");

SAPGuUi Cd1(Gui Ctrl Tree, Put TopNode, "Favo");

SAPQuUi Cmd1( Qui Ctrl Tree, Doubl ed i ckNode, "0000000004");

SAPGuUi CheckScreen(" SESSI ON_MANAGER', "SAPLSMIR_NAVI GATI ON', "SAP Easy Access");
SAPGui Propl dStr ("wnd[ 1] / usr/ bt nSPOP- OPTI ON1") ;

SAPGuUi CndO( Gui Button, Press);

SAPCui CheckScr een(" SESSI ON_MANAGER", " SAPLSPOL", "Log O f");

} I/ end try

catch (_comerror e){
char buffer[1024];
sprintf (buffer,” EXCEPTION Ox% % for VU % )\n",e.Error(),
(char *)e.Description(), S task_id);
RR__Fai | edMsg(s_i nfo, buffer);

} I/ end catch
END_TRANSACTI ON() ;

To include thelog on within thetransaction loop, move the SAPGuiConnect call inside the try block as
shown in the following example:

SET_ABORT_FUNCTI ON( abort _function);
DEFI NE_TRANS_TYPE( " capt ure. cpp");
RESULT hr = Colnitialize(0);

if( hr !'= ERROR_SUCCESS )
RR__Fail edMsg(s_info,"ERROR initializing COM);

SAPGui Set CheckScreenW | dcard('*");
SYNCHRONI ZE() ;
BEG N_TRANSACTI ON() ;

try{

SAPGui Connect ( s_i nfo, "qacsapdb2");
SAPGui Ver CheckStr (" 6204. 119. 32");
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SAPGui Propl dStr ("wnd[ 1] / usr/ bt nSPOP- OPTI ON1") ;
SAPGui CdO( Gui Butt on, Press);
SAPGuUi CheckScreen(" SESSI ON_MANAGER', " SAPLSPOL", "Log OFf");

} // end try
catch (_comerror e){

char buffer[1024];

sprintf(buffer,” EXCEPTION Ox% % for VU(% )\n",e.Error(),
(char *)e.Description(), S task_id);

RR__Fai |l edMsg(s_info, buffer);

} // end catch
END_TRANSACTI ON( ) ;

To include thelog on outside the transaction loop, move the log off section so that it followsthe
END_TRANSACTION statement. However, ensure that the recording within the transaction loop begins
and endsin the same location in the menu system. For example:

SET_ABORT_FUNCTI ON( abort _function);
DEFI NE_TRANS_TYPE( " capt ure. cpp");
HRESULT hr = Colnitialize(0);

i f( hr !'= ERROR _SUCCESS )
RR__Fail edMsg(s_info,"ERROR initializing COM);
SAPGui Set CheckScreenW | dcard('*");

SYNCHRONI ZE() ;
SAPGui Connect ( s_i nfo, "qacsapdb2");

SAPGui Propl dStr("wnd[ 0] / usr/t xt RSYST- BNAME") ;
SAPGui Cd1( Gui Text Fi el d, Put Text, "qal oad1");

SAPGui Propl dSt r (" wnd[ 0] / usr/ pwdRSYST- BCODE") ;

SAPGui Crd1Pwd( Gui Passwor dFi el d, Put Text, " ~encr~1211616261") ;
SAPGuUi CndO( Gui Passwor dFi el d, Set Focus) ;

SAPGui Crd1( Gui Passwor dFi el d, Put Car et Posi tion, 3);

SAPGui Propl dStr("wnd[ 0] ") ;
SAPGui Crd1( Gui Mai nW ndow, SendVKey, 0) ;
SAPGuUi CheckScreen(" S000", " SAPMSYST", " SAP") ;

BEG N_TRANSACTI ON() ;

try{
SAPGui Ver CheckStr (" 6204. 119. 32");

Y /1 end try

catch (_comerror e){
char buffer[1024];
sprintf(buffer,” EXCEPTION Ox% % for VU(% )\n",e.Error(),
(char *)e.Description(), S task_id);
RR__Fai | edMsg(s_info, buffer);

} I/ end catch
END_TRANSACTI ON() ;

SAPGui Propl dSt r ("wnd[ 1] / usr/ bt nSPOP- OPTI ON1") ;
SAPGui CdO( Gui But t on, Press);
SAPGuUi CheckScreen(" SESSI ON_MANAGER", " SAPLSPOL", "Log O f");
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Handling Multiple Logons

You may need to modify your script to handle multiple logonswhen therecording scenario differs from
therun-time scenario. For example, if when you record, no users are logged on to the SAP environment
and when you run the script, users are already logged on, the script may fail. To work around thisissue,
you can use the SAPGuiPropldSrExists and SAPGuiPropldStrExistsEnd commandsto handle either
scenario. Thistechnique works by checking for the multiple logon dialog box from SAP and selecting the
Continue option.

The following example demonstrates the usage of the SAPGuiPropldStrExists and
SAPGuiPropldStrExistsEnd commandsto handle multiple logons:

SAPGUi CheckScr een( " S000" , " SAPVBYST" ) n SAP") :
SAPCui Propl dSt r Exi st s("wnd[ 1] / usr/radMJLTI _LOGON_OPT2") ;

DO_SLEEP( 24) ;

SAPCui Cnd0( Gui Radi oButt on, Sel ect);

SAPGui CdO( Gui Radi oBut t on, Set Focus) ;

SAPCui Propl dStr("wnd[ 1] /tbar[0]/btn[0]");

SAPCui CdO( Cui Butt on, Press);

SAPGuUi CheckScreen(" S000", " SAPMSYST", "Li cense Information for Miultiple Logon");

SAPGuiPropldStrExistsEnd("wnd[1]/usr/radMULTI_LOGON_OPT2");

Checking the SAP Satus Bar
The SAP status bar displays error and status messages, as shown in the following figure.

Maintain PO Supplement : initlal Screen

You can use the SAPGuiCheckSatusbar command to test for certain statusresponsesin the SAP
environment.

The SAPGuiCheckSatusbar command isused in the following script example:

SAPCGui Propl dStr("wnd[0]");

SAPCui Cnd1( Gui Mai nW ndow, SendVKey, 0);

SAPCui CheckScr een("S000", "SAPMSYST", "SAP");

SAPCui Cnd3( Gui Mai nW ndow, Resi zeWor ki ngPane, 94, 24, fal se);

/| SAPCui CheckSt at usbar returns TRUE if the nessage is found
//and FALSE if not found
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BOOL bRet Sts = SAPGui CheckSt at usbar ("wnd[ 0] /sbar", "E: Make an entry in all required
fields");

if (bRetSts)
RR__printf(" True\n");

el se
RR__printf(" False\n");

Object Life Span

Whenever a script isrun, all objects on the SAP GUI window are deleted and re-created. These objects,
which are created in the SAP environment and can disappear without user interaction, can cause script
failure if the script referencesthe objects after they have disappeared.

For more troubleshooting information, refer to SAP's publication titled “ SAP GUI Sripting API for the
Windows and Java Platforms”.

UNIFACE

Uniface recording options

Uniface executable: Enter the full path or browse to the Uniface 7 executable that isused by the
application you want to record. For example: c: \ usys72\ bi n\ UNI FACE. exe.

Working directory: Enter or browse to the working directory of your Uniface application or the directory
of any additional filesyour application may require that do not reside in the application’s path
environment.

Initialization (.ini) file: Enter or browse to the full path to the Uniface application'sinitialization file.

Assignment (.asn) file: Enter or browse to the full path to the application's assignment file. For example:
c:\usys72\ proj ect\ nyapp. asn.

Command line statement: Type command line optionsthat should be used at application startup,
including the command that isused to start the application. For example: war ehouse 1 control
use=control dnp=tcp:

Uniface conversion options
Includes: Typethe full path or browseto the directory that containsthe database include files.
Libraries: Typethe full path or browse to the directory that containsthe database library files.

Generate Uniface lists: Uniface can handleinternal list structures. Select thischeck box to convert strings
containing list itemsto asuccession of DO_URB_xxx callsthat manipulate Uniface lists.

Show output parameters: Select thisoption for the converted script to contain the output parameters of
an operation ascommented lines.

Insert trace messages as comments: Select this option for the converted script to contain the recorded
content of the message frame as commented lines.

Uniface command reference

QALoad provides descriptions and examples of the various commands available for a Uniface script. For
details, refer to the Language Reference Help section for Uniface.
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Winsock

How QALoad handles DO WSK Send commands

QALoad displaysthe contentsof aDO_WSK_Send command asastring in a Winsock script. Some of these
strings are very large, which can cause a compiler error (fatal error C1076: compiler limit: internal heap
limit reached) if there are several large stringsin asingle script.

To avoid thiscompilation error, QALoad does not allow stringsthat are displayed in a Winsock script to be
morethan 12,000 characters. If aDO_W SK_Send command has a send buffer larger than 12,000 characters,
its buffer isbroken into smaller stringsduring the conversion. These smaller strings are then copied into a
char buffer named "SendBuffer”, which issent in the DO_WSK _Send command. The size of the SendBuffer
variable, by default, isdeclared asthe size of the largest DO_W SK_Send + 1000. For example:

int rhobot_script(s_info)

PLAYER | NFO *s_i nf o;

/* Declare Variables */
char SendBuffer[22139]; //Largest send is 21139 + 1000

strcpy(SendBuffer, "$$ ...."); //Assume a large string, shortened for this exanple
strcat (SendBuffer, "$$ ....");

/* 12675 bytes */
DO WSK_Send(S1, SendBuffer);

strcpy(SendBuffer, "$$ ...."); //SendBuffer is reused
strcat (SendBuffer, "$$ ....");
strcat (SendBuffer, "$$ ....");

/* 21139 bytes */
DO WSK_Send( S1, SendBuffer);

REPORT( SUCCESS) ;
EXIT();
return(0);

Handling Winsock application data flow

Frequently, server programsreturn unique values (for example, a session ID) that vary with each execution
of the script and may be vital to the success of subsequent transactions. To create scriptsthat include these
values, you need to substitute the hard-coded valuesreturned by the server with variables. The following
original and modified code examples demonstrate thistechnique.

Original code

In thisscript, the server sends a session ID in response to a connection by the client. Thissession ID is
required to successfully complete subsequent transactions.
/*

* wsk- AdvancedTechni ques_original .c
*

* This script contains support for the follow ng
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* m ddl ewar es:
* - Wnsock
*/

/* Converted using the follow ng options:
* CGeneral :

* Line Split : 80 characters

* Sleep Seconds : 1

* Auto Checkpoints : Yes

*/

#defi ne SCRI PT_VER 0x00000005UL
#i ncl ude <stdi o. h>
#i ncl ude "smacro. h"
#i ncl ude "do_wsk. h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O
#endi f

int rhobot _script(s_info)
PLAYER | NFO *s_i nf o;
{

/* Declare Variables */

SET_ABORT_FUNCTI ON( abort _function);
DEFI NE_TRANS_TYPE( "wsk- AdvancedTech_1.c");

/| Checkpoi nts have been included by the convert process

Def aul t Checkpoi nt sOn() ;

DO WBK I nit(s_info);

Set Ti neout (20); /* WAit up to 20 seconds for each expected pattern */
SYNCHRONI ZE( ) ;

BEG N_TRANSACTI ON() ;

DO WSK_Socket (S1, AF_I NET, SOCK_STREAM | PPROTO | P);
DO WSK_Bi nd(S1, ANY_ADDR, ANY_PORT);
DO WSK_Connect (S1, "172.22.24.125", 2100, AF_INET);

TEETTLEL b r i rrrrrrrg
/1l The session id returned by the server is

/1 unique to each connection

FEEEEEEE b r bbb rrrrrirrng

[* 21bytes: SessionlD=jrt90847\r\n */
DO WBK_Expect (S1, "\n");

NNy
/1 This unique id is then used for subsequent

/'l requests
NNy

[* 34 bytes */
DO WBK_Send(S1, "SessionlD=jrt90847\r\n: "Br@@ @B @@@A @@@);
/* 15 bytes: |D Accepted#*@r\n */

DO WBK_Expect (S1, "\n");
DO WSK_d osesocket (S1) ;

END_TRANSACTI ON() ;
REPORT( SUCCESS) ;
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EXIT();

return(0);
}

voi d abort_functi on(PLAYER | NFO *s_i nf 0)
{

RR_printf("Virtual User % :ABORTED.", S task_id);

EXI T();
}

M odified code

If the original script (wsk-AdvancedTechniques original.c shown above) isreplayed, it will fail because the
session ID will not be unique; rather, it will bethe session ID that iscoded in the script. To use the unique
session ID received from the server, variable substitution must be used.

/*

* wsk- AdvancedTechni ques_nodi fi ed. c

*

* This script contains support for the follow ng
* m ddl ewar es:

* - Wnsock

*/

/* Converted using the follow ng options:
* CGeneral :

* Line Split : 80 characters

* Sleep Seconds : 1

* Aut o Checkpoints : Yes

*/

#defi ne SCRI PT_VER 0x00000005UL
#i ncl ude <stdio. h>
#i ncl ude "smacro. h"
#i ncl ude "do_wsk. h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O
#endi f

int rhobot_script(s_info)
PLAYER | NFO *s_i nf o;

{
/* Declare Variables */

char Buffer[64];
char SendBuffer[64];
i nt nBytesReceived = 0;

SET_ABORT_FUNCTI ON( abort _functi on);

DEFI NE_TRANS_TYPE( "wsk- AdvancedTech_1.c");

/1 Checkpoi nts have been included by the convert process

Def aul t Checkpoi nt sOn();

DO WBK I nit(s_info);

Set Ti neout (20); /* Wait up to 20 seconds for each expected pattern */
SYNCHRONI ZE( ) ;

BEG N_TRANSACTI ON() ;
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DO WBK_Socket (S1, AF_| NET, SOCK_STREAM | PPROTO | P);
DO WBK_Bi nd(S1, ANY_ADDR, ANY_PORT):
DO WBK_Connect (S1, "172.22.24.125", 2100, AF_INET);

LT bbb r bbb irrrr
/1l The reply fromthe server is read into

/1l the Buffer variable. W will then have

/1l the unique Session ID for this connection.

// Also need to null-terminate the buffer

/1 after receiving.

FHEEEEEEErr b r bbb bbb irrrr

DO WBK_Recv(Sl1, Buffer, 64, 0, &nBytesReceived);
Buf f er [ nByt esReci eved] = '"\0';

/* 21lbytes: SessionlD=jrt90847\r\n */
/1 DO_WBK_Expect (S1, "\n");

FIETETETEE i rrrrri
/1 Finally, substitute the Session ID received from
/] the server with the one coded in the script.
FEEEEEErrrrr i rrrrrrrrr

sprintf(SendBuffer, "%:"Br@@@B @@@A @@@, Buffer);
DO WBK_Send(S1, SendBuffer);

/* 34 bytes */
/1 DO WBK_Send(S1, "SessionlD=jrt90847: '"Br@@ @B @@ Q@A @@@);
/* 15 bytes: |D Accepted# @r\n */

DO WBK_Expect (S1, "\n");
DO WBK_Cl osesocket (S1) ;

END_TRANSACTI ON( ) ;
REPORT( SUCCESS) ;
EXIT();

return(0);

}
voi d abort _function(PLAYER | NFO *s_i nf 0)

{
RR__printf("Virtual User % :ABORTED.", S task_id);

EXI T();

Winsock Recording Options

User Started: Select thisoption if you want to start your application manually for recording, either before
or after you start recording. Because thismethod may fail to record your application’sinitial calls,
Compuware recommends you use the Automatic option instead. Select the User Started option when you
do not know the full application startup name and command option parameters or when the application
spawns off processes that generate traffic that you want recorded.
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Automatic: Select thisoption if you want QALoad to automatically start your Winsock-based client,
allowing you to record early application startup activity. Thisistherecommended method of recording
because it takes advantage of QALoad’s enhanced abilitiesto handle various multi-threaded programming
techniques. When you select thisoption, the QALoad Script Development Workbench recordsthe API calls
that occur before the client entersits message loop. Select this option to record traffic from just one
application. This option limitstherecording output to just the traffic generated by the application, not
including the traffic that is generated by processes spawned by the application.

Command Line: Enter the command line of your Winsock-based client. Note that if you enter the full
path, QALoad automatically entersthe path in the Working Directory field.

Working Directory: Enter the working directory of your Winsock-based client, if necessary.
Capture: Select the Winsock version to record.

Set IP Addresses: Click thisbutton to open the Add/Delete IP Addresses dialog box, which you can use to
specify the IP addresses and ports on which you want to record Winsock API calls or that you wish to
exclude from recording.

Winsock Conversion Options

There are no specialized conversion options for Winsock.

Winsock Command Reference

QALoad provides descriptions and examples of the various commands available for a Winsock script. For
details, refer to the Language Reference Help section for Winsock.

Advanced Scripting Techniques for Winsock
Understanding Data representation in the Script

This section describeshow datathat issent and received isdisplayed in aWinsock script. Use this section
as areference when you examine a script.

During the conversion process, QALoad determines how to represent each character in the script. This
conversion process usesthe following rules:

1. Thecharacter iscompared to the “space” character in the ASCII table, which hasa decimal value of
32. If the character'svalueislessthan 32, the following steps are taken:

I If thecharacteris“\r”, “\'n”, “\t", or “\ ", it isrepresented in the script asanormal C escape
character.

I If thecharacter iseither “*\ " or “~" it isrepresented in the script as an octal character. For
example, the values would be “\ 034" and “\ 036", respectively.

I If thecharacter'svalueislessthan 32 and it doesnot meet the descriptionsin a) and b) above,
it isrepresented in the script as a control character. For example, if the character isanull
character, it isrepresented in the script as“ @' .

2. If thecharacter'sdecimal value is between 32 (the “space” character) and 126 (~), it displaysin the
script as a standard readable ASCII character, with the following exceptions:

I If thecharacter is“\ ", which hasadecimal value of 92, it isrepresented as“\\” in the script.

o

I If thecharacter is““", which hasadecimal value of 34, it isrepresented as“\”” in the script.

I If thecharacter is“~”, which hasadecimal value of 94, it isrepresented as“~"" in the script.
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3. Ifthecharacter hasadecimal value of 127, which correspondsto Delete (DEL), it isrepresented as
“A" in the script.

The following table summarizesthe results of rules 1-3.

Dec

cots | v || osans | o |
@ 000 0

NUL
~A 001 1 SOH
"B 002 2 STX
nC 003 3 ETX
D 004 4 EOT
E 005 5 ENQ
"F 006 6 ACK
"G 007 7 BEL
“H 010 8 BS
\t 011 9 HT
\n 012 10 LF
"K 013 11 VT
\ f 014 12 FF
\r 015 13 CR
"N 016 14 SO
"0 017 15 S
P 020 16 SLE
"Q 021 17 SC1
"R 022 18 DC2
"S 023 19 DC3
AT 024 20 DC4
U 025 21 NAK
"V 026 22 SYN
W 027 23 ETB
"X 030 24 CAN
Y 031 25 EM
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\034

g

\\

N2

032

033

034

035
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134

136
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26

27
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31

32

34

92

94

127

SB

ESC

FS

GS
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Script Development Workbench

4. |If thecharacterisnot included in the groupsdefined in steps1-3, it isrepresented as an octal
character in the script. These characters are often referred to ashigh ASCII characters (those with a
decimal value greater than 128), and arerepresented in the script as“\ 000", where OOOQO isthe
octal value for the ASCII character.

Handling Winsock application data flow

Frequently, server programsreturn unique values (for example, a session ID) that vary with each execution
of the script and may be vital to the success of subsequent transactions. To create scriptsthat include these
values, you need to substitute the hard-coded valuesreturned by the server with variables. The following

original and modified code examples demonstrate thistechnique.

Original code

In thisscript, the server sendsa session ID in response to a connection by the client. Thissession ID is
required to successfully complete subsequent transactions.

/*

* wsk- AdvancedTechni ques_original .c

m ddl ewar es:
- W nsock
/

E I

/* Converted using the follow ng options:

* CGeneral :
* Line Split : 80
* Sl eep Seconds :

* Auto Checkpoints :

*/

characters
1
Yes

#defi ne SCRI PT_VER 0x00000005UL

#i ncl ude <stdio. h>

#i ncl ude "smacro. h"
#i ncl ude "do_wsk. h"

/* set function to

voi d abort_functi on(PLAYER | NFO *s_info);

call on abort*/

This script contains support for the follow ng
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#i f ndef NULL
#define NULL O
#endi f

int rhobot_script(s_info)
PLAYER_I NFO *s_i nf o;
{

/* Declare Variables */

SET_ABORT_FUNCTI ON( abort _functi on);
DEFI NE_TRANS_TYPE( "wsk- AdvancedTech_1.c");

/1 Checkpoi nts have been included by the convert process

Def aul t Checkpoi nt sOn();

DO WBK I nit(s_info);

Set Ti neout (20); /* Wait up to 20 seconds for each expected pattern */
SYNCHRONI ZE( ) ;

BEG N_TRANSACTI ON() ;

DO WSK_Socket (S1, AF_I NET, SOCK_STREAM | PPROTO | P);
DO WSK_Bi nd(S1, ANY_ADDR, ANY_PORT);
DO WSK_Connect (S1, "172.22.24.125", 2100, AF_INET);

FEETELLL b r i irrrrrrrrrg
/1l The session id returned by the server is

/1 unique to each connection

FEEEELEE b r b i bbb rrrrriirng

[* 21bytes: SessionlD=jrt90847\r\n */
DO WBK_Expect (S1, "\n");

FEETIELL i b r i brrrrrrirrri
/1 This unique id is then used for subsequent

/'l requests

FEETELEE T r bbb rrririnri

[* 34 bytes */
DO WBK_Send(S1, "SessionlD=jrt90847\r\n: "Br@@@B @@@A @@@);
[* 15 bytes: |D Accepted# @r\n */

DO WBK_Expect (S1, "\n");
DO WSK_d osesocket (S1) ;

END_TRANSACTI ON() ;
REPORT( SUCCESS) ;
EXIT():

return(0);

voi d abort_functi on(PLAYER | NFO *s_i nf 0)
{

RR_printf("Virtual User % :ABORTED.", S task_id);
EXI T();

Modified code

If the original script (wsk-AdvancedTechniques original.c shown above) isreplayed, it will fail because the
session ID will not be unique; rather, it will bethe session ID that iscoded in the script. To use the unique
session ID received from the server, variable substitution must be used.
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/*
* wsk- AdvancedTechni ques_nodi fi ed. c
*

* This script contains support for the follow ng
* m ddl ewar es:

* - Wnsock

*/

/* Converted using the follow ng options:

* Ceneral :

* Line Split : 80 characters

* Sleep Seconds : 1

* Aut o Checkpoints : Yes

*/

#defi ne SCRI PT_VER 0x00000005UL
#i ncl ude <stdi o. h>
#i ncl ude "smacro. h"
#i ncl ude "do_wsk. h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O
#endi f

int rhobot_script(s_info)
PLAYER_I NFO *s_i nf o;

{
/* Declare Variables */

char Buffer[64];
char SendBuffer[64];
i nt nBytesReceived = 0;

SET_ABORT_FUNCTI ON( abort _function);

DEFI NE_TRANS_TYPE( "wsk- AdvancedTech_1.c");

/'l Checkpoi nts have been included by the convert process

Def aul t Checkpoi nt sOn() ;

DO WBK I nit(s_info);

Set Ti neout (20); /* WAit up to 20 seconds for each expected pattern */
SYNCHRONI ZE( ) ;

BEG N_TRANSACTI ON() ;

DO WBK_Socket (S1, AF_I NET, SOCK_STREAM | PPROTO | P);
DO WSK_Bi nd(S1, ANY ADDR, ANY_PORT);
DO WSK_Connect (S1, "172.22.24.125", 2100, AF_|NET);

NNy
/1 The reply fromthe server is read into

/1 the Buffer variable. W will then have

/1 the unique Session ID for this connection.

/1 Al'so need to null-term nate the buffer

/1 after receiving.
NNy

DO WBK_Recv(S1, Buffer, 64, 0, &nnBytesReceived);
Buf f er[ nByt esReci eved] = '\0';

[* 21bytes: SessionlD=jrt90847\r\n */
/1 DO_WBK_Expect (S1, "\n");
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FHOLTEEEEE i irirrrrig
/1 Finally, substitute the Session ID received from
/1l the server with the one coded in the script.
FHLELELEE i rriririrrirg

sprintf(SendBuffer, "%:. "Br@@@B @@ @A @@@, Buffer);
DO WSK_Send( S1, SendBuffer);

[* 34 bytes */
/1 DO_WBK_Send(S1, "SessionlD=jrt90847: '"Br@@ @B @@ @A @@@);
/[* 15 bytes: |D Accepted#*@r\n */

DO WBK_Expect (S1, "\n");
DO WSK_C osesocket (S1) ;

END_TRANSACTI ON() ;
REPORT( SUCCESS) ;
EXIT();

return(0);

}
voi d abort_functi on(PLAYER | NFO *s_i nf 0)

{
RR_printf("Virtual User % :ABORTED.", S task_id);

EXIT();

Modifying QALoad's functionsto incorporate dynamic data

If you need to use dynamic data with your scripts, you can modify some QALoad functionsto handle
dynamic data. The two scenarios below describe specific situationsin which you might need dynamic data,
and how to achievethat in the script.

Scenario 1:

One method of accessing dynamic datais by using a datapool file. However, you might need to read in
datathat isnot in the format of an ASCII string, which isrequired for datapool files.

For example, if the string “\ 121\ 101\ 114\ 157\ 141\ 144" isread in from a datapool file with one of the
datapool functions, the output would be “\\ 121\\ 101\ \ 114\\ 157\ \ 141\ \ 144", which isincorrect. To
work around this problem, you can use the OctalToChar() command to convert any octal sequencesinto
their binary representation. The following examplesillustrates the use of the OctalToChar() command for
this purpose:

Example

In thisexample, the string “\ 121\ 101\ 114\ 157\ 141\ 144" isread in from a central datapool file and
converted to itsbinary representation.

/* Declare variables */
char tenp[40];

BEG N_TRANSACTI ON() ;
GET_DATA() ;

DO WSK_Socket (S1, AF_I NET, SOCK _STREAM | PPROTO | P);
DO WSK_Bi nd(S1, ANY_ADDR, ANY_PORT);
DO WSK_Set sockopt (S1, SOL_SOCKET, SO OOBI NLI NE, 1);

strcpy(tenp, VARDATA(1));
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Cct al ToChar (tenmp); //used to convert octal strings
//to their binary format

DO WBK_Send( S1, t enp) ;
/1 DO_WBK_Send( S1, "\ 121\ 101\ 122\ 165\ 156" ) ;
DO WSK_C osesocket (S1) ;

The DO_WSK _Send() command above sendsthe string “121\ 101\ 114\ 157\ 141\ 144" to the server. This
string isthe octal representation of the string “ QALoad ”.

Scenario 2:

You might find that your capture dataisnot the same datayou need for running atest. For example, you
might need to change the value of auser ID during replay. One method of changing the value isto change
the value through the DO_WSK_Send() command, but that resultsin the value being static only within the
function. To substitute a different value each time, create a dynamic variable, such as a datapool value, to
replace the user ID.

Example

In thisexample, the script includesaDO_WSK_Send() command that sends“name=Jm” to the server as
theuser ID. Then avariableisused to changethe nameto “Mark”.

/* Declare variables */
char buffer[65];
char sendbuffer[65];

BEG N_TRANSACTI ON() ;

DO WBK_Socket (S1, AF_I NET, SOCK_STREAM | PPROTO I P);
DO _WBK_Bi nd( S1, ANY_ADDR, ANY_PORT);

DO WBK_Set sockopt (S1, SOL_SOCKET, SO OOBI NLINE, 1);
DO WBK_Connect (S1, "127.0.0.1", 90, AF_INET);

[l original DO WK Send(S1, "nane=Jin');

strcpy( buffer, "Mark");
sprintf( sendbuffer, "name=%", buffer);
DO WSK_Send(S1, sendbuffer);

[* 2 bytes: ok */

DO WSK_Expect (S1, "ok");
DO WSK_d osesocket (S1) ;

The buffer beforethe DO_WSK_Send() command is modified and a new buffer is passed asthe second
parameter of the DO_WSK_Send() command. This effectively sends“name=Mark” to the server instead of
"name=Jm”.

Saving server replies

There are two methods for saving the entire reply that a server sends back. The following paragraphs
describe each method.

Using the Response() and ResponseLength() commands

The Response() command can be called directly after the DO_WSK_Expect() command. It returns a pointer
to the datathat has been received by DO_W SK_Expect(). To also receive the length of thereplay, call the
ResponseLength() command, which returnsthe number of charactersthat were received. The following
example usesthe Response() and ResponseLength() commands.
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Example

In thisexample, variables are declared to store the results from the two functions. Both functions are also
used to save the buffer that isreceived within the DO_W SK_Expect() command.

/* Declare Variables */
int x = 0;
char *tenp;

BEG N_TRANSACTI ON() ;

DO WSK_Socket (S1, AF_I NET, SOCK_STREAM | PPROTO | P);
DO WSK_Bi nd(S1, ANY_ADDR, ANY_PORT);

DO WSK_Set sockopt (S1, SOL_SOCKET, SO OOBI NLINE, 1);
DO WSK_Connect (S1, "127.0.0.1", 90, AF_INET);

/* 21 bytes: You are now connected */
DO WSK_Expect (S1, "d");

/1 Used to store the data that was received by the
/1 DO _WBK_Expect

temp = Response();

/1l Used to get the size of the response that was received
/'l so far

X = ResponselLengt h();
/* The line beloww Il print the length of the response and the actual response */

RR_printf(“length = %, and response= %", x, tenp);
DO WSK_d osesocket (S1) ;

The message “length=21 response=You are now connected” displaysin the Player buffer window.

Usingthe DO_WSK _Recv() command

To save aresponse based on itssizeinstead of aunique character string that isused within the
DO_WSK_Expect() command, usethe DO_W K_Recv() command. Thiscommand enablesyou to specify
how much datato receive and where to store the data.

You can also usethe DO_WSK Recv() command to storethe reply that isreturned from the server. This
strategy isuseful when you need to retrieve the buffer that isreturned from the server, even though the
returned dataistoo dynamic and causesthe DO_W SK_Expect() command to fail every time.

Example
In thisexample, the DO_W SK_Recv() command isused to save a server reply based on size. Two variables
are declared to store theresults from the DO_WSK_Recv() command.

/* Declare Variables */
int size = 0;
char tenp[45];

BEG N_TRANSACTI ON() ;

DO WBK_Socket (S1, AF_I NET, SOCK_STREAM | PPROTO | P);
DO WSK_Bi nd(S1, ANY_ADDR, ANY_PORT);

DO WBK_Set sockopt (S1, SOL_SOCKET, SO OOBI NLINE, 1);
DO WSK_Connect (S1, "127.0.0.1", 90, AF_INET);

/* 21 bytes: You are now connected */
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menset (tenp, '\0', 45);

DO WBK_Recv( S1, t enp, 45, 0, &si ze) ;
RR__printf("size=% string=%", size,tenp);
DO WBK_Cl osesocket (S1) ;

The message “size=21 string=You are now connected” displaysin the Player buffer window.

El Note: If you use this method as a substitute for the DO_WSK_Expect() command, ensure that you receive
the correct information prior to calling the next function in the script.

Parsing server replies for values

To parse a buffer for a particular value, you can write a parsing routine that searchesthe entire buffer for
the value. However, you can also use one of QALoad 'sWinsock helper commands. The following scenarios
describe two situationsin which you could use the Winsock commandsto solve a parsing problem.

Scenario 1:

To find astring in a server reply, you can use the ipExpr() and ScanExpr() commands. SkipExpr()
searches for the first occurrence of astring in theinternal buffer that containsthe response that was
received within the DO_W SK_Expect() command. Then, use the ScanExpr() command to search for
another string. ScanExpr() saves the buffer from the first occurrence of the string that was used with
XKipExpr() up to and including the string used within ScanExpr(). The first parameter of ScanExpr() isa
UNIX-style regular expression. The following table liststhe most common expressions:

Matchesthe end of astring.

* Matches any number of characters.

? Matches any one character. |

Example In thisexample, the buffer contains “sessionid=1234567890abc”, and the goal isto retrieve
everything after the “=", up to and including “abc”.

/* Declare Variables */
char tenp[35];
int size = 0;

BEG N_TRANSACTI ON() ;

WBK_Socket (S1, AF_I NET, SOCK_STREAM | PPROTO | P);
WBK_Bi nd(S1, ANY_ADDR, ANY_PORT);

DO WBK_Set sockopt (S1, SOL_SOCKET, SO OOBI NLINE, 1);
DO _WSK_Connect (S1, "127.0.0.1", 90, AF_INET);

/* 23 bytes: sessioni d=1234567890abc */

DO WBK_Expect (S1, "c");

Ski pExpr (" sessi oni d=");

si ze=ScanExpr (".*abc" , tenp);

RR_printf("length = % string = %", size, tenp);
DO WBK_Cl osesocket (S1) ;

DO_
DO_

The message “length=13 string=1234567890abc” displaysin the Player buffer window.

Scenario 2:

You may have datareturned from the server that istoo dynamic, that is, you are not able to base parsing
on actual characters. The solution isto base the parsing on character positionsinstead.
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For example, to save the characters 20 through 25, you could use the Scan &ip() and ScanSring()
commands. ScanSkip() skips a specified number of charactersin the internal buffer that storesthe response
that was received within the DO_W SK_Expect() command. ScanSring() scans a number of charactersfrom
the current position within the buffer into a character string.

Example

In thisexample, a buffer containing “xxx123456789yyy” isreturned from the server. The value between
“xxx” and “yyy” isreturned.

/* Declare Variables */

char tenp[15];
BEG N_TRANSACTI ON() ;

DO WBK_Socket (S1, AF_I NET, SOCK_STREAM | PPROTO | P);
DO WSK_Bi nd(S1, ANY ADDR, ANY_PORT);

DO WSK_Set sockopt (S1, SOL_SOCKET, SO OOBI NLI NE, 1);
DO WSK_Connect (S1, "127.0.0.1", 90, AF_INET);

[* 16 bytes: xxx0123456789yyy */

menset (tenp, '\0', 15);

DO WBK_Expect (S1, "yyy"):
ScanSki p(3);
ScanString(10,tenp);
RR_printf("string=%",tenp);
DO WSK_d osesocket (S1) ;

The message “string=0123456789" displaysin the Player buffer window.

WWW

Configuring a Web Browser (WWW)

Before you record the WWW requests your Web browser makes, you must configure the browser to use
QALoad’s proxy server.

To configure a Web browser:

1. Sart your Web browser.
2. Specify proxy settings:

= Inthefield designated to specify the address of the proxy server, enter the machine name
where QALoad Script Development Workbench isinstalled.

= In thePort field, enter the port(s) that you specified on the Sript Development Workbench's
WWW Record Optionswizard (Capture Portsfields).

3. Click OK.

Streaming Media Support

QALoad includes support for audio and video download testing of both Windows Media Player and
RealOne Player and their supported mediaformatsthrough a WWW session. When streaming media
conversion isenabled and you record atransaction that calls streaming media, an additional command
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that requeststhe mediaisinserted into your script . You do not haveto listen to or view the entire media
you are requesting. You simply need to record its URL and ensure that the appropriate media player is
installed on the Player machinesthat plays back the script. At run time, the script invokes your media
player and requeststhe streaming media resource. Sreaming media through afirewall or proxy server is
not supported.

QALoad's streaming media support includesthe following media player(s). The appropriate media player
must beinstalled on the machine you are recording from aswell asany QALoad Player machine that will
be executing the script.

I RealOne Player — The media download isinitiated by requesting afilethat isa datatype
supported by the RealOne Player. Supported data types are RealAudio, RealVideo, Real Text, Real Pix,
and SMIL. Asaresult, the DownloadMediaRP command will be inserted into the script at the
appropriate point. At runtime, thiscommand initiates and waits for completion of the download.
RealOne Player scripts must be executed as process-based scripts.

!  WindowsMedia Player — The media download isinitiated by downloading afile with a content
type of (audiolvideo)/(x-ms-asf|s-ms-asf) in the browser. Currently, only .asx files are supported. As
aresult, the DownloadMediaFrom ASX command isinserted into the script at the appropriate
point.

IEl Note: QALoad does not support scriptsthat have both RealNetworks media and Windows Media in the
same script. To test both typesin a single load test, use a different script for each type.

Please note that asynchronous calls may not be played back exactly asthey were recorded. For example, if
you click on alink in the browser while recording while the mediais playing, during replay that link isnot
requested until the media clip hasfinished being processed.

CX Support in QALoad

QALoad supportsload testing of Chinese, Japanese, and Korean (CJXK) Web applicationsthat use Double
Byte Character Sets (DBCS). DBCSisa character set that usestwo bytes (16 bits) rather than one byte (8
bits) to represent a single character. Some languages, such as Chinese, Japanese, and Korean, have writing
schemes with many different charactersand character setsthat cannot be represented with single-byte
characters such as ASCIl and EBCDIC.

QALoad supportsthe following:
I Smplified Chinese - People's Republic of China (PRC), Sngapore
I Traditional Chinese - Taiwan, Hong Kong, Macau
I Japanese
I Korean

Notes:

CX support only appliesto the WWW middleware. Currently, QALoad only supportsthe CK Double
Byte Character Sets; Web applications that host Bi-Directional (BiDi) characters (which includes Arabic
and Hebrew languages) are not currently supported.

UTR8-encoded characters are treated as an additional character set used on CX platforms. They are
supported when represented on their native operating system. For example, Japanese characters are
displayed properly on a Japanese operating system.

QALoad providestwo methods of support for CXK: native character and encoding. Depending on your
testing requirements and environment, it may be necessary to use both mechanismsto support the load
testing of a Web site that contains CXK characters.

I Native Character: convertsthe CXK charactersto their original charactersin Chinese, Japanese, or
Korean. Native character support isonly possible when using a native operating system (OS) such
asload testing a Japanese Web application from a Japanese version of Microsoft Windows. QALoad
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supportsone CX language's charactersin a script at atime, plus ASCIlI/English. Native character
support isused within test scripts, error messages (generated through system commandsthat use
native characters) and timing files, making script editing easier and timing file analysis quicker.

Encoding: encodes all CXK charactersinto a sequence of printable characters regardless of the
language and exact character set in use. Encoding support isused when load testing multiple
language sites from the same OS, or when load testing a CXK site from that of another CK
platform. For example, testing a site with Japanese characters from a Korean or English/ASCII OS.
The encoding option isused when native character support cannot be used or when script
portability between different CXK language OSisrequired.

EasyScript for Secure WWW
Overview

Easy<cript for Secure WWW supports SS./HTTPSrequests when used in conjunction with the WWW
middleware. Thissupport must be purchased separately and isdistributed in a separately-installed module.

Importing a Client Certificate from a Web Browser (SSL)

You can import and convert a Client Certificate for any Web site you plan to visit.

To import aclient certificate:

1.
2.
3.

9.

Sart your Web browser.
From the browser, select the Client Certificate for the Web site you plan to visit.

Export the Client Certificate (.p12 of .pfx file) to a directory where you can accessit using the
Script Development Workbench.

IEl Note: When the browser promptsyou to enter a password, do not enter a password. If you enter
a password, QALoad cannot processthe file.

Sart aWWW Session in the QALoad Script Development Workbench.
Click Tools>Maintain Certificatesto open the S Certificate Maintenance dialog box.

On the Client Certificatestab, click the browse button [...] to browse for the Client Certificate you
want to convert. The Select the Exported Client Certificate to Convert dialog box opens.

Make sure Files of Type specifies P12 files (*.p12) or PFX files (*.pfx).

Select the appropriate Client Certificate and click Open. The path and file name of the selected
Client Certificate appearsin Enter Certificate to Convert on the Client Certificatestab.

On the Client Certificatestab, click Convert.

10. Click Close to exit the S3_ Certificate Maintenance dialog box.
Creating a Client Certificate in QALoad (SSL)

This procedure assumesyou have a WWW session active.

To create a client certificate:

1.
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4. Click the Create button to create the QALoad Client Certificate. QALoad storesit in the
QALoad\ Certi ficates directory.

El Note: On the Unix player platform, you must create the Certi fi cat es sub-directory in the QALoad
directory. The directory name is case sensitive.

5. If necessary, configure your Web server to accept QALoad asthe Certificate Authority. Refer to your
Web server documentation for more information.

Creating an SSL Certificate Authority

Notethat creating anew CA invalidates all previously created client certificates.

To create an SSL Certificate Authority:

1. Sart aWWW session.

2. From the Toolsmenu, select Maintain Certificates.
3. Click the Certificate Authority tab.
4

Click the Create button to create a new Certificate Authority with the expiration date shown in the
field.

o

Exit and re-start the Script Development Workbench.

After creating a new Certificate Authority, re-import the CA to your Web server and then create
new Client Certificates.

Creating an SSL Server Certificate

To create an SSL Server Certificate:

1. Sart aWWW session.

2. From the Toolsmenu, select Maintain Certificates.
3. Click the Server Certificate tab.
4

Click the Create button to create a new Server Certificate with the expiration date shown in the
field.

WWW Conversion Options
Using the WWW Convert Options Dialog Box

The following topics provide usage tips and resulting script examples for each of the optionsthat are
available on the Convert Optionsdialog box:

Form Feldsas Comments
Anchorsas Comments

Client Image Maps as Comments
Debug Comments

Document Title Verification
Baud Rate

Refresh Timeout

Encode CXK Characters

Enable Visual Navigator

Advanced Options
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Cache

Dynamic Redirect Handling

Dynamic Cookie Handling
Automatically Process Subrequests
Persistent Connections During Replay
Max Concurrent Connections

Max Connection Retries

Server Response Timeout

HTTP Version

Proxy HTTP Version
ActiveData

IP Spoofing

Sreaming Media
Hostnames as |P Addresses
Srip All Cookies from Request

Generate XML Requests for Web Services

Traffic Flters

Playback Options

Rule Filters

Form field as comments

When thisoption isselected, all formsand their fields are placed in comment blocksin the script.

Example Web page
Script example with option selected
Script example with option not selected

Example Web page

<! DOCTYPE HTM. PUBLI C "-// AdvaSoft//DTD HTM. 3.2 extended 961018//EN'>
<HTM_>
<HEAD>
<Tl TLE>For ms Exanpl e</ Tl TLE>
</ HEAD>

<BCDY BGCOLOR="#7093DB" >

<H2 ALl G\=cent er >Exanpl e of HTTP&nbsp; For ns</ H2>
<BR>

<FORM ACTI ON="/ cgi - bi n/ perl _9. pl " net hod=post >
<TABLE>

<TR>
<TD>Narme:
<TD><| NPUT NAME="nane" S| ZE="20" MAXLENGTH=20>

<TR>
<TD>Passwor d:
<TD><I NPUT TYPE =password NAME="password" S| ZE="20" MAXLENGTH=20>

<TR>

<TD>E- Mai | Address:

<TD><| NPUT NAME= "e-mail" SIZE = "40" MAXLENGTH=80>

<TR>

<TD>Addr ess:

<TD><I NPUT TYPE = text NAME = "Address" SIZE = "40" NMAXLENGTH=40>

<TR>
<TD>City:
<TD><| NPUT NAME="city" SIZE="40" MAXLENGTH=40>
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<TD ALI GN\=l ef t >St at e:

<TD ALI G\=l ef t ><| NPUT NAME="st at e" S| ZE="2" MAXLENGTH=2 ALI G\=l ef t >
<TD ALI G\=l ef t >Zi p:

<TD ALI G\=l ef t ><I NPUT NAME="1zi p" SI ZE="5" MAXLENGTH=5>

<TR>

<TD VALI GN=t op>Favorite Col or:
<TD><SELECT NAME="options">
<OPTI ON>Red

<OPTI ON>Or ange

<OPTI ON>Yel | ow

<OPTI ON>Gr een

<OPTI ON sel ect ed=on>Bl ue
<OPTI ON>I ndi go</ OPTI ON\>
<OPTI ON>Vi ol et </ OPTI ON>

</ SELECT>

<TR>

<TR>

<TD VALI G\N=t op>Col or of your noney:
<TD><SELECT NAME="dates" nultiple="nultiple">
<OPTI ON sel ect ed=on>Red

<OPTI ON>Bl ue

<OPTI ON>Gr een</ OPTI ON>

<OPTI ON>Bei ge</ OPTI ON>

</ SELECT>

<TR>

<TD VALI| G\=t op>Conment s:

<TD><TEXTAREA NAME="comment s" COLS=40 ROWS=5></ TEXTAREA>
</ TABLE>

<BR><I NPUT TYPE=checkbox CHECKED NAME="echo">Echo a copy of the result HTM. Page to E-
mai | <BR><BR>

<p>
<TABLE>

<TR>

<TD VALI G\N=t op>Testi ng:

<TD><I NPUT TYPE=r adi o CHECKED NAME="t est" VALUE="capt ure" >Capt ur e<BR>
<I NPUT TYPE=r adi o NAVE="test" VALUE="repl ay" >Repl ay<BR>

<I NPUT TYPE=radi o NAME="t est" VALUE="| oadt est">Loadt est <BR>

<TR>

<TR>

<TD>Wb page to append to reply:
<TD><I NPUT TYPE=fil e NAME="web page">
</ TABLE>

<BR>

There is a hidden field containing data here: <INPUT TYPE=hi dden NAME="hi dden" VALUE="This
rocks!">
Here is another hidden field: <INPUT TYPE=hi dden NAVE="hi ddenl" VALUE="Wb testing is fun">

<BR><BR>

<TABLE ALI GN=cent er >
<TR>
<TD ALI GN=center>Don't dick This

<TR>

<TD><I NPUT TYPE=i mage SRC="col ors.gif" w dth="200" hei ght="100">
</ TABLE>
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<TABLE ALI G\=cent er >
<TR>
<TD ALI GN=center>Don't dick This

<TR>
<TD><I NPUT TYPE=i mage SRC="eye.gif" width="80" hei ght="60">
</ TABLE>

<TABLE ALI G\=cent er >
<TR>
<TD ALI GN=center>Don't dick This

<TR>
<TD><I NPUT TYPE=i mage SRC="devplatformgif" w dth="48" hei ght="43">
</ TABLE>

<TABLE ALI G\=cent er >
<TR>
<TD ALI GN=center>Don't dick This

<TR>
<TD><I NPUT TYPE=i mage SRC="enterprise_smgif" w dth="42" height="41">
</ TABLE>

<BR>

<TABLE ALI GN=cent er >

<TR>

<TD><I| NPUT TYPE=subm t NAME="submt">
<TD><I| NPUT TYPE=r eset >

</ TABLE>

</ FORM>

</ BODY>
</ HTM.>

Script example with Form field ascommentsoption selected

The following example hasthe Form field ascomments check box selected.

/* Declare Variables */
int i;

char *Field[2];

char *ActionURL[ 1];

for(i=0; i<2; i++)
Field[i]= NULL;
for(i=0; i<l; i++)
ActionURL[i]= NULL;

/* Request: 1 */
DO Http("GET http://ww. host.com forns. ht m HTTP/ 1. 0\r\n\r\n");
DO VerifyDocTitl e("Forns Exanple", TITLE);

/* ActionURL[O]="http://ww.host.confcgi-bin/perl_9.pl" */
DO _Get For mAct i onSt at enent (FORM 1), &ActionURL[O0]);

/* Form 1l text Nane: nanme, Value: */

/* Form1l text Nanme: password, Value: */
/* Form1l text Name: e-mail, Value: */
/* Form1l text Nane: Address, Value: */
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/[* Form1l text Nane: city, Value: */

/* Form1l text Nane: state, Value: */

/* Form1l text Name: zip, Value: */

/* Form 1l select Nane: options, Value: */

/* Form 1l select Nane: options, Value: */

/* Form 1l select Nane: options, Value: */

/* Form 1l select Nane: options, Value: */

/* Form 1l select Nane: options, Value: */

/* Form 1l select Nane: options, Value: */

/* Form 1l select Nane: options, Value: */

/* Form 1l select Nane: dates, Value: */

/* Form1l sel ect Nanme: dates, Value: */

/* Form 1l select Nane: dates, Value: */

/* Form 1l select Nane: dates, Value: */

/* Form1l text Nane: comments, Value: */

/* Form 1 checkbox Nanme: echo, Value: */

/[* Form 1l radio Nane: test, Value: capture, */
/* Form 1l radio Nane: test, Value: replay, */
/* Form1l radi o Nane: test, Value: |oadtest, */
/[* Form 1 *unknown* Nane: web page, Value: , */

/* Form 1l hidden Nanme: hidden, Value: This rocks!, */
DO_Get For nval ueByName( FORM 1), "hi dden", "hidden", 1, &Field[0]);

/* Form 1 hidden Nane: hiddenl, Value: Wb testing is fun */
DO_Get For nVval ueByName( FORM 1), "hi dden", "hiddenl", 1, &Field[1]);

/* Form 1l *unknown* Name: , Value: */
/* Form 1 *unknown* Nane: , Value: */
/* Form 1l *unknown* Name: , Value: */
/* Form 1 *unknown* Nane: , Value: */
/* Form1l submt Nanme: submt, Value: */
/* Form 1 *unknown* Nane: , Value: */

/* Request: 2 From Forms Exanple */

DO _Set Val ue("acti on_statenent0", ActionURL[O0]);

DO _Set Val ue("nanme", "joe");

DO _Set Val ue("password", "");

DO Set Val ue("e-mail", "");

DO _Set Val ue(" Address", "");

DO Set Val ue("city", "");

DO Set Val ue("state", "");

DO _Set Val ue("zi p", "");

DO _Set Val ue("options", "Blue");

DO _Set Val ue("dates", "Red");

DO _Set Val ue("conments”, "");

DO _Set Val ue("echo", "on");

DO Set Val ue("test", "capture");

DO _Set Val ue("web+page", "");

DO _Set Val ue("hi dden", Field[0]);

DO _Set Val ue("hi ddenl", Field[1]);

DO Set Val ue("subnmit", "Submt Query");

DO Http("POST {*action_statenent0} HTTP/1.0\r\n"
"Content - Type: application/x-ww-formurl encoded\r\n"
"Content-Length: {*content-length}\r\n\r\n"
"{nane} & passwor d} & e- mai | } & Addr ess} &{city}&{state}&"
"{zi p}& options}&{dat es} & comrents}& echo}&test}&"
"{web+page} & hi dden} & hi ddenl1} & submit}");

Script example Form field ascomments option not selected

The following example hasthe Form field ascomments check box cleared.
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/* Declare Variables */
int i;

char *Field[2];

char *ActionURL[ 1];

for(i=0; i<2; i++)
Field[i]= NULL;
for(i=0; i<l; i++)
ActionURL[i]= NULL;

/* Request: 1 */

DO Http("GET http://ww. host.com forns. ht m HTTP/ 1. 0O\r\n\r\n");

DO VerifyDocTitl e("Forns Exanple", TITLE);

DO _Get For mActi onSt at enent (FORM 1), &ActionURL[0]);

DO_GCet For nVval ueByName( FORM 1), "hi dden", "hidden", 1, &Field[0]);
DO_Get For nVval ueByName( FORM 1), "hi dden", "hiddenl", 1, &Field[1]);

/* Request: 2 From Forms Exanple */

DO _Set Val ue("acti on_statenent0", ActionURL[O0]);

DO _Set Val ue("nanme", "joe");

DO _Set Val ue("password", "");

DO Set Val ue("e-mail", "");

DO _Set Val ue(" Address", "");

DO Set Val ue("city", "");

DO Set Val ue("state", "");

DO _Set Val ue("zi p", "");

DO _Set Val ue("options", "Blue");

DO _Set Val ue("dates", "Red");

DO _Set Val ue("comments”, "");

DO _Set Val ue("echo", "on");

DO Set Val ue("test", "capture");

DO _Set Val ue("web+page", "");

DO _Set Val ue("hi dden", Field[0]);

DO _Set Val ue("hi ddenl", Field[1]);

DO Set Val ue("subnmit", "Submt Query");

DO Http("POST {*action_statement0} HTTP/1.0\r\n"
"Content - Type: application/x-ww-formurl encoded\r\n"
"Content-Length: {*content-length}\r\n\r\n"
"{nane} & passwor d} & e- mai | } & Addr ess} &{city}&{state}"
"&{ zi p} & opti ons} & dat es} & coment s} & echo} & test}"
" & web+page} & hi dden} & hi ddenl1} &{ submit}");

for(i=0; i<2; i++)

{

free(Field[i]);

Fi el d[i]=NULL;

}

for(i=0; i<l; i++)
{
free(ActionURL[i]);
ActionURL[i]=NULL;
}
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When thisoption is selected, all anchors are placed in comment blocksin the script.

Example Web Page

<HTM_>

<HEAD>

<TI TLE> QALoad WAV Capt ure Exanpl es</ Tl TLE>
</ HEAD>

<BODY>

<HR>

<I MG SRC="../lo0go.gif" ALI GN-LEFT wi dt h="127" hei ght ="129">
<IM5 SRC="../lo0go.gif" ALI G\N=RI GHT wi dt h="127" hei ght="129">

<BR><BR>

<CENTER><H2><EM> QALoad WAV Capture Exanpl es</ EM></ H2>
<A HREF=../default. ht m><h3>Return to wel come honepage. </ h3></ A>

<BR></ CENTER><HR>

<CENTER>
<TABLE CELLSPACI NG="10">

<TR>
<TH AL| G\=l ef t >LI NK:
<TH ALI G\=l ef t >DESCRI PTI ON\:

<TR>
<TD><A HREF="../standard. ht n{f >St andard HTM. Homepage</ A></ TD>
<TD>Static page w inmages (.G F 87a, 89a), sound files (.WAV),

<TR>

<TD><a href="../subs. htn>Miltiple Inline |Inmages Page</a></TD>
<TD>Static page with 16 inline images</TD>

</ TABLE>

</ CENTER>
</ BODY>
</ HTM_>

Script example with the Anchorsascomments option selected

The following example hasthe Anchors ascomments check box selected.

/* Declare Variables */
int i;

char *Anchor[ 1];

for(i=0;i<1;i++)

Anchor [i]=NULL;

BEG N_TRANSACTI ON() ;

and assorted |inks</TD>

133



Script Development Workbench

/* Request: 1 */

DO Http("GET http://ww. host.com i ndex. htm HTTP/ 1. 0\r\n\r\n");
DO VerifyDocTitle(" QALoad WMV Capture Exanples", TITLE);

[* Anchors 'http://ww. host.confdefault.htm 'Return to wel cone homepage.' */
/* Anchors 'http://ww. host.conistandard. htmi ' Standard HTM. Homepage' */

DO_Get Anchor HREF( " St andard HTML Honepage", &Anchor[0]);
/* Anchors 'http://ww. host.confsubs.htmi 'Miltiple Inline |Images Page' */

/* Request: 2 To: Standard HTM. Honmepage From QALoad WAV Capture Exanples */

[* Variable: Anchor000 |inks to: Standard HTM. Honmepage on page: QALoad WAV Capture Exanpl es
*/
DO _Set Val ue(" Anchor 000", Anchor[0]);

DO Http("GET {*Anchor000} HTTP/1.0\r\n\r\n");
DO VerifyDocTitle("\"Standard HTM. Exanple\"", TITLE);

for(i=0; i<l; i++)

{
free(Anchor[i]);
Anchor [i]=NULL;
}

Script example with the Anchorsascommentsoption not selected

The following example hasthe Anchorsas comments check box cleared.

/* Declare Variables */
int i;
char *Anchor[1];

for(i=0; i<l; i++)
Anchor [i]= NULL;

BEG N_TRANSACTI ON() ;

/* Request: 1 */

DO Http("GET http://ww. host.comindex. htmHTTP/ 1. 0\r\n\r\n");
DO VerifyDocTitle(" QALoad WAV Capture Exanpl es", TITLE);

DO _Get Anchor HREF( " St andard HTM. Honepage", &Anchor[0]);

/* Request: 2 To: Standard HTM. Homepage From QALoad WMV Capture Exanples */
/* Variable: Anchor000 |inks to: Standard HTM. Honepage on page: QALoad WAV Capture Exanpl es
*/

DO _Set Val ue(" Anchor 000", Anchor[0]);
DO Http("GET {*Anchor 000} HTTP/1.0\r\n\r\n");
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for(i=0; i<l; i++)

{
free(Anchor[i]);
Anchor [ i]=NULL;
}

Client Image Maps as Comments

When thisoption is selected, all client image maps are placed within comment blocksin the script.

Example Web Page

<ht Ml ><head></ head><body>

<cent er ><h2>C i ent - si de versi on of clickabl e i magemap</h2>

Click on one of the fields contained in the inage to access the associated |ink.

<VAP NAME="title">

<AREA SHAPE="rect" COORDS="1, 108, 115, 124" HREF="sup. ht m' ></ AREA>

<AREA SHAPE="rect" COORDS="119, 107, 234, 124" HREF="r eg. ht m' ></ AREA>
<AREA SHAPE="rect" COORDS="235, 107, 352, 124" HREF="f ea. ht ni' ></ AREA>
<AREA SHAPE="rect" COORDS="353, 107, 466, 124" HREF="t ech. ht mi' ></ AREA>
<AREA SHAPE="rect" COORDS="0, 127, 156, 144" HREF="ht nl sam ht n{' ></ AREA>
<AREA SHAPE="rect" COORDS="157, 127,312, 144" HREF="exanpr o. ht m' ></ AREA>
<AREA SHAPE="rect" COORDS="313, 127, 466, 144" HREF="f eedback. ht ' ></ AREA>
<AREA SHAPE="rect" COORDS="0, 0, 466, 143" HREF="i nval i d. ht ni' ></ AREA>

</ VAP>

<p>

<IM5 SRC="title.gif" BORDER="0" ALT="[ Netscape FastTrack Server 2.0]" USEVAP="#title"
wi dt h="468" hei ght ="145">

</center>
</ body></ ht nl >

Script example with the Client Image Mapsas Commentsoption selected

The following example hasthe Client Image Maps as Comments check box selected.

for(i=0;i<1;i++)
Cient MapURL[i]= NULL;

/* Request: 1 */
DO Http("GET http://ww. host.comismap. ht m HTTP/ 1. 0\r\n\r\n");

/* dient Map:1 Region:1 HREF: http://ww.host.conf sup. htm */
/[* dient Map:1 Region:2 HREF: http://ww.host.conmreg. htm */

DO Get i ent MapHREF( MAP(1), REG ON(2), &Cient MapURL[O0]);

/[* dient Map:1 Region:3 HREF: http://ww. host.conffea.htm*/

/* Cient Map: 1l Region:4 HREF: http://ww. host.conmtech. htm*/

/[* Cient Map:1 Region:5 HREF: http://ww. host.com htm sam htm */
/* dient Map: 1l Region:6 HREF. http://ww. host.com exanpro. htm */
/[* Cient Map:1 Region:7 HREF: http://ww. host.con feedback. ht nt/
/* Cdient Map:1l Region:8 HREF: http://ww. host.cominvalid. htm?*/

/* Request: 2 */
DO _Set Val ue("d i ent Map000", dient MapURL[O0]);
DO Http("GET {*Cient Map000} HTTP/1.0\r\n\r\n");
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for(i=0; i<1; i++)

{

free(dient MapURL[i]);
Cl i ent MapURL[ i ] =NULL;

END_TRANSACTI ON() ;

Script example with the Client Image Mapsas Comments optionsnot selected

The following example hasthe Client Image Maps as Comments check box cleared.

for(i=0; i<l; i++)
Client MapURL[i]= NULL;

/* Request: 1 */

DO Http("GET http://ww. host.comismap. ht m HTTP/ 1. 0\r\n\r\n");
DO Get i ent MapHREF( MAP(1), REG ON(2), &Cient MapURL[O0]);

/* Request: 2 */

DO _Set Val ue("d i ent Map000", dient MapURL[O0]);
DO Http("GET {*Cient Map000} HTTP/1.0\r\n\r\n");

for(i=0; i<l; i++)

{
free(Cient MapURL[i]);
Client MapURL[i]= NULL;
}

END_TRANSACTI ON() ;

Debug Comments

When thisoption isselected, someitems, such asreceived replies are placed in comment blocksin the
script.

Script example with the Debug comments option selected

The following example hasthe Debug Comments check box selected.

DO Http("GET http://ww. host.comindex. htmHTTP/ 1. 0\r\n\r\n");

/* Received reply: < QALoad WMV Capt ure Exanpl es> */
DO VerifyDocTitle(" QALoad WMV Capture Exanples", TITLE);

Script example with the Debug Comments option not selected
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The following example hasthe Debug Comments check box cleared.

DO Http("GET http://ww. host.comindex. htmHTTP/ 1. 0\r\n\r\n");

DO VerifyDocTitle(" QALoad WAV Capture Exanples", TITLE);

Document Title Verification

There are three supported methods for verifying a document title, which are shown in the following
sections. Document title verification can be a good tool for detecting and handling error messagesthat are
returned in an HTML page. You can verify a document title by searching for the Entire Document Title,
the Prefix of the document title, or the Suffix of the document title. The following isan example of a
search for the Entire document title.

Example Web Page

<HTM_>

<HEAD>

<title>Wel cone to The Main Page</title>
</ head>

<body>

<p>

<A href="index. ht ' >WNV Capt ure Exanpl es</ A> (relative |ink)

</ p>
</ body>
</ HTML>

Script example with the Document Title Verification option selected

The following example hasthe Document Title Verification check box selected and compares by the
entire document title.

DO Http("GET http://ww. host.com HTTP/1.0\r\n\r\n");
DO VerifyDocTitl e("Wel come to The Main Page", TITLE);

Script example that matchesthe first 5 characters

The following example com pares by prefix.

DO Http("GET http://ww. host.com HTTP/1.0\r\n\r\n");
DO VerifyDocTitl e("Wel co", PREFIX);
DO _Set Transact i onCl eanup() ;

Script example that matchesthe last 4 characters

The following example compares by suffix.
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DO Http("CGET http://ww. host.com HTTP/1.0\r\n\r\n");
DO VerifyDocTitl e("Page", SUFFIX);
DO _Set Transacti onC eanup() ;

Document Title Verification —No

The following example hasthe Document Title Verification check box cleared.

DO Http("CGET http://ww. host.com HTTP/1.0\r\n\r\n");
DO _Set Transact i onCl eanup() ;

Baud Rate

Use this option to simulate slower connectionsto a Web server, such as 56 Kbps modem or DSL. Specify a
baud rate when enabling baud rate emulation in the Convert Options dialog box.

The DO_SetBaudRate command isinserted into the script with the specified baud rate asitsonly
parameter. If baud rate emulation must be asymmetric (the upload rate isdifferent than the download
rate), use the DO_SetBaudRateEx command. DO_SetBaudRateEx takes two parameters: the upload baud
rate and the download baud rate.

Baud Rate (57600) — Yes

In the following example, the Baud Rate check box is selected and set to 57600.

BEG N_TRANSACTI O\() ;
DO _Set TransactionStart();
DO_Set BaudRat e( 57600) ;

DO Http("GET http://ww. host.com HTTP/1.0\r\n\r\n");

END_TRANSACTI ON() ;

Baud Rate Emulation —No

In the following example, the Baud Rate check box is cleared.

BEG N_TRANSACTI O\() ;
DO _Set TransactionStart();

DO Http("GET http://ww. host.com HTTP/1.0\r\n\r\n");
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END_TRANSACTI ON() ;

Refresh Timeout

When thisoption isselected, the time value that you specify in the secondsfield iscompared to a Web
page’'s META Refresh value (e.g. <META HTTP-EQUIV=Refresh CONTENT="10";
URL="http://www.compuware.com”>). If the META Refresh tag’'s CONTENT field valueislessthan the
time value specified, the page istreated as aredirected page. If the CONTENT field value is greater than the
time you specify, the page istreated as a regular page.

Thisoption isuseful for avoiding infinite loopsin the script. Infinite loops can occur if a page refreshes
periodically to update data.

Example Web page

<htm >

<head>

<title>Just Wait</title>

<nmeta http_equi v=refresh content="5;url =/ path/to/real page. pl 7>
</ head>

<body>

<h2>Loadi ng the real page</h2>

</ body>

</htm >

Script example with the Refresh Timeout option selected

The following example hasthe Refresh Timeout check box selected and is set to avalue greater than 5.

DO Set TransactionStart();
DO _Set Ref r eshTi neout (10) ;
DO_Set MaxBr owser Thr eads( 2) ;

/* Request: 1 */
DO Http("GET http://host/path/to/page.pl HTTP/1.0\r\n\r\n");
DO VerifyDocTitl e("You have reached the final page!!", TITLE);

Script example with Refresh Timeout option not selected

The following example hasthe Refresh Timeout check box cleared. The example also appliesto having
the option selected and set to avalue lessthan 5.

BEG N_TRANSACTI O\() ;
DO _Set TransactionStart();
DO_Set MaxBr owser Thr eads(2) ;

/* Request: 1 */

DO Http("GET http://host/path/to/page.pl HTTP/1.0\r\n\r\n");
DO VerifyDocTitle("Just Wait", TITLE);

DO_SLEEP(5);
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/* Request: 2 */
DO Http("GET http://host/path/to/real page.pl HTTP/1.0\r\n\r\n");
DO VerifyDocTitl e("You have reached the final page!!", TITLE);

Encode CXK Characters

When thisoption isselected, the double-byte characters used for Chinese, Japanese, and Korean (CXK)
scripts are converted into octal format. Snce CXK characters use Double Byte Character Sets (DBCS),
encoding must be enabled for a capture with CXK characters, so that the double-byte characters can be
viewed in alegible format.

Example Web page

<htm >

<head>

<title>?H T T it es

<neta http-equiv="Content-type" content="text/htm ; charset=euc-kr">
<neta http-equi v="Cache-Control" content="no-cache">

<nmeta http-equi v="Pragma" content="no-cache">

<neta http-equi v="Expires" content="Wed, 04 Jul 1973 16:00: 00 GVI">

<!l--CSS-->
<style type='text/css'>
</styl e>

<I--/CSS-->
</ head>
<body onl oad="docunent. search. p.focus();" topmargi n=8>

</ body>
</htm >
Script example with the Represent CJK as Octal Charactersoption selected

The following example hasthe Represent CJK as Octal Characters check box selected.

/* Request: 1 */
DO Http("GET http://kr.yahoo.com HTTP/1.0\r\n\r\n");
DO VerifyDocTitle("\276\ 337\ 310\ 304!\ 304\ 332\ 270\ 256\ 276\ 306", TI TLE);

Script example with the Represent CJK as Octal Charactersoption not selected

The following example hasthe Represent CJK as Octal Characters check box cleared.

/* Request: 1 */
DO Http("GET http://kr.yahoo.com HTTP/1.0\r\n\r\n");
DO VerifyDocTitle( "4f=f TEUM"  TITLE);

Enable Visual Navigator

The Enable Visual Navigator option enablesthe Visual Navigator. The Visual Navigator renders your
recorded C-based transaction in atri-paned, browser-like environment similar to popular visually-oriented
development tools, with iconsthat represent all the elements of your script.
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Script example with the Enable Visual Navigator option selected

When the Enable Visual Navigator check box is selected, the following conversion options are not
available because they do not apply to Visual Navigator:

Comment Options

Form field ascomments
Anchorsascomments

Client Image Maps ascomments
Debug comments

Dynamic Redirect Handling
Dynamic Cookie Handling
Automatically Process Sub-Requests
ActiveData

IP Spoofing
Hostnames as |P Addresses

Script example with the Enable Visual Navigator option not selected

If you do not select the Enable Visual Navigator check box, QALoad generates a standard C script. All
normal and advanced conversion options apply to the script.

Cache

When thisoption isenabled, requested images are cached at playback time. Theimage cache is cleared by
the next iteration of the DO_Clear command.

Script example with the Cache option selected

In the following example, the Cache option is selected.

BEG N_TRANSACTI O\() ;
DO _Cache(TRUE); /* Enabl e cache */

END_TRANSACTI ON() ;

Script example with the Cache option not selected

In the following example, the Cache check box iscleared.

BEG N_TRANSACTI ON( ) ;
DO _Cache(FALSE); /* Disable cache */

END_TRANSACTI ON() ;

141



Script Development Workbench

Dynamic Redirect Handling

Thisisaplayback option. When Dynamic redirect handling is enabled, playback automatically handlesthe
redirection.

Consider aWeb page with alink to 'Redirected Webpage' (http://www.host.com/cgi-bin/dynredir.exe).
When thislink isclicked, the server generates a 302 return value with a new redirected location of
http://172.22.24.39/cgi-bin/aperl_8.pl.

Script example with the Dynamic Redirect Handling option selected

When thisoption is selected, the script only containstherequest for http://www.host.com/cgi-
bin/dynredir.exe and replay handlesthe 302 return value and calls http://172.22.24.39/cgi-bin/aper|_8.pl
automatically.

The following example hasthe Dynamic Redirect Handling check box selected.

/* Declare Variables */
int i;
char *Anchor[ 1];

for(i=0;i<1;i++)
Anchor [i]=NULL;

BEG N_TRANSACTI ON( ) ;
DO Dynam cRedi r ect Handl i ng( TRUE) ;

DO Http("GET http://ww. host.conmindex. htm HTTP/""1.0\r\n\r\n");
DO VerifyDocTitle(" QALoad WMV Capture Exanples", TITLE);

DO_Get Anchor HREF( " Redi rect ed Webpage", &Anchor[0]);

DO _Set Val ue(" Anchor 000", Anchor[0]);
DO Http("GET {*Anchor 000} HTTP/1.0\r\n\r\n");
DO VerifyDocTitle("Successful Test of Dynamic Redirect Sanple", TITLE);

for(i=0; i<l; i++)

{
free(Anchor[i]);
Anchor [i]=NULL;
}

END_TRANSACTI O\() ;
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Script example with the Dynamic Redirect Handling option not selected

In thisexample, the script containsthe request for http://www.host.com/cgi-bin/dynredir.exe as well as
http://172.22.24.39/cgi-bin/aperl_8.pl. The following example hasthe Dynamic Redirect Handling check
box cleared.

/* Declare Variables */
int i;
char *Anchor[ 1];

for(i=0;i<1;i++)
Anchor [i]=NULL;

BEG N_TRANSACTI O\() ;
DO _Dynani cRedi r ect Handl i ng( FALSE) ;

DO Http("GET http://ww. host.comindex. htmHTTP/ 1. 0\r\n\r\n");

DO VerifyDocTitle(" QALoad WAV Capture Exanpl es", TITLE);

DO_Get Anchor HREF( " Redi rect ed Webpage", &Anchor[0]);

DO_Set Val ue(" Anchor 000", Anchor[O0]);

DO Http("GET {*Anchor 000} HTTP/1.0\r\n\r\n");

DO VerifyDocTitl e("Docunment Mved", TITLE);

DO Http("GET http://ww. host.comredir/frmpl HTTP/1.0\r\n\r\n");

DO VerifyDocTitl e("Successful Test of Dynami c Redirect Sanple", TITLE);
DO _Set Transacti onC eanup() ;

/[* Clear up sonme internal storage used for DO _SetVal ue() */
DO Htt pd eanup();
for(i=0; i<l; i++)

{
free(Anchor[i]);
Anchor [i]=NULL;

END_TRANSACTI ON() ;

Dynamic Cookie Handling

Thisisaplayback option. When this option is selected, the script does not have any cookie-specific
information and playback deals with dynamic cookiesat run time.

Example Web page

The cookies for this site are:

Set - Cooki e: Sanel D=172. 22. 24. 180- 4728804960004
Set - Cooki e: S| TESERVER=I D=f 0544199a6¢5970a7d087775f 83b23af

<htm >

<head></ head>

<body>

<br >RELOAD PAGE TO | NCREMENT COUNTER<br ><br >

143



Script Development Workbench

</ body>
</htm >
Script example with the Dynamic Cookie Handling option selected

The following example hasthe Dynamic Cookie Handling check box cleared.

BEG N_TRANSACTI ON( ) ;
DO _Dynam cCooki eHandl i ng( TRUE) ;

DO Http("GET http://ww. host.com cgi -bi n/cooki es5.pl HTTP/1.0\r\n\r\n");
DO Http("GET http://ww. host.com cgi -bi n/cooki es5.pl HTTP/1.0\r\n\r\n");

END_TRANSACTI O\() ;

Script example with the Dynamic Cookie Handling option not selected

The following example hasthe Dynamic Cookie Handling check box cleared.
char *Cooki e[ 4];

for(i=0;i<2;i++)
Cooki e[ i ] =NULL;

BEG N_TRANSACTI ON( ) ;
DO _Dynam cCooki eHandl i ng( FALSE) ;

DO Http("GET http://ww. host.com cgi -bi n/ cooki es5.pl HTTP/1.0\r\n\r\n");

/ *Set - Cooki e: NUME1 */

DO_Get Cooki eFr onRepl yEX("NUM', &Cookie[0], '*');

[ *Set - Cooki e: SQUARE=1 */

DO_Get Cooki eFr onRepl yEx( " SQUARE", &Cookie[1l], '*');

/* Request: 2 */

DO _Set Val ue( " cooki e000", Cookie[0]); /* NUMEL */

DO _Set Val ue(" cooki e001", Cookie[1]); /* SQUARE=1 */

DO Http("GET http://ww. host.com cgi - bi n/ cooki es5. pl HTTP/ 1. 0\r\n Cookie: {*cookie000};
{*cooki e001}\r\n\r\n");

DO Htt pd eanup();
for(i=0; i<2; i++)

{
free(Cookie[i]);
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Cooki e[ i] =NULL;
}

END_TRANSACTI ON() ;

Automatically Process Subrequests

Thisisaplayback option. When thisoption is selected, subrequests (such as.jpg, .gif, .css, and .js) are not
included in the script during conversion, and playback makesthe requests at run time.

Example Web page

<htm >

<head>

<title>Page O Subs</title>

</ head>

<body>

<p>The page of subrequests</p>

<p>.<i mg border="0" src="wi n2000.gif" w dt h="456" hei ght="124"><i ng bor der="0"
src="APACHE. A F' wi dt h="259" hei ght ="32"><i ng border="0" src="banner.gif" w dth="470"
hei ght ="64"><i ng border="0" src="COLORS. d F' w dt h="200" hei ght ="100"></p>

</ body>

</htm >

Script example with the Automatically Process Subrequests option selected

In the following example, the Automatically Process Subrequests check box is selected.

BEG N_TRANSACTI O\() ;
DO_Aut omat i cSubRequest s( TRUE) ;

DO Http("GET http://ww. host.com subs. ht m HTTP/ 1. O\r\n\r\n");
DO VerifyDocTitl e("Page O Subs", TITLE);

END_TRANSACTI ON() ;

Script example with the Automatically Process Subrequests option not selected

In the following example, the Automatically Process SubRequests check box is cleared.

BEG N_TRANSACTI ON() ;

DO_Aut omat i cSubRequest s( FALSE) ;

DO Http("GET http://ww. host.com subs. ht m HTTP/ 1. O\r\n\r\n");

DO VerifyDocTitl e("Page O Subs", TITLE);
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/* Request: 2 From Page OF Subs */
DO Http("GET http://ww. host.com wi n2000. gi f HTTP/ 1.0\r\n\r\n");

/* Request: 3 From Page O Subs */
DO Http("GET http://ww. host.com web.gif HTTP/1.0\r\n\r\n");

/* Request: 4 From Page OF Subs */
DO Http("GET http://ww. host.com APACHE. G F HTTP/ 1. 0\r\n\r\n");

/* Request: 5 From Page O Subs */
DO Http("GET http://ww. host.com COLORS. G F HTTP/ 1. 0\r\n\r\n");

END_TRANSACTI ON( ) ;

Persistent Connections During Replay

Thisisan option placed in the script to be used at replay time. During replay, QALoad attemptsto keep the
connection to the Web server open for each DO_Http request that is sent to the server.

Script example with the Persistent Connections During Replay option selected

The following example hasthe Persistent connections during replay check box selected.

BEG N_TRANSACTI O\() ;
DO _UsePer si st ent Connect i ons( TRUE) ;

END_TRANSACTI ON( ) ;

Script example with the Persistent Connections During Replay option not selected

The following example hasthe Persistent connectionsduring replay check box cleared.

BEG N_TRANSACTI ON() ;
DO _UsePer si st ent Connect i ons( FALSE) ;

END_TRANSACTI ON() ;

Max Concurrent Connections

Thisfield indicatesthe maximum number of connectionsthat a DO_Http or DO_Httpscommand will
open to the server at any time. These simultaneous connections are only used if sub-requesting is enabled.

The following example hasthe Max Concurrent Connectionsfield set at 4.
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BEG N_TRANSACTI O\() ;
DO _Set TransactionStart();
DO_Set MaxBr owser Thr eads(4) ;

/* Request: 1 */
DO Http("CGET http://ww. host.com HTTP/1.0\r\n\r\n");
DO VerifyDocTitl e("Wel comre to QAWEBSERV', TITLE);

END_TRANSACTI ON() ;

Max Connection Retries

Thisfield specifiesthe number of timesduring replay that QALoad will attempt to connect to the server
after timing out. The following example hasthe Max Connection Retriesfield set at 4.

BEG N_TRANSACTI ON() ;

DO _Set Maxi munRetri es(4);

/* Request: 1 */
DO Http("CGET http://ww. host.com HTTP/1.0\r\n\r\n");
DO VerifyDocTitl e("Wl comre to QAWEBSERV', TITLE);

Server Response Timeout

Thisfield specifies, in seconds, the length of time during replay that QALoad will wait for data from the
server before timing out. The following example hasthe Server Response Timeout field set at 120.

DO InitHtp(s_info);
DO _Set Ti meout (120); /* Maximumtime to wait for HITP Reply */

BEG N_TRANSACTI ON() ;

/* Request: 1 */
DO Http("CGET http://ww. host.com HTTP/1.0\r\n\r\n");
DO VerifyDocTitl e("Wel comre to QAWEBSERV', TITLE);

HTTP Version

A WWW script can be set to 1.1 or 1.0. When set to 1.1, all requests and subrequests are sent asHTTP/1.1.
When set to 1.0, all HTTPrequests and subrequests are sent asHTTP/1.0.
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The following example hasthe HTTP Version field set to 1.0.

BEG N_TRANSACTI ON( ) ;
DO HTTPVersion("1.0");

END_TRANSACTI ON() ;

Proxy HTTP version

A WWW script can be set to 1.1 or 1.0. When set to 1.1, all proxy HTTP requests and subrequests are sent
asHTTP/1.1. When set to 1.0, all proxy HTTP requests and subrequests are sent asHTTP/1.0.

The following example hasthe HTTP Version field set to 1.0.

BEG N_TRANSACTI ON( ) ;
DO _ProxyHTTPVersi on("1.0");

END_TRANSACTI ON() ;

ActiveData

When thisoption isenabled, the generated script isautomatically variablized. Otherwise, all requests are
not modified after the capture. The following example shows a capture of aform, how it isvariablized by
the ActiveData option, and not variablized when the ActiveData option is cleared.

Example Web page

<! DOCTYPE HTM. PUBLI C "-//AdvaSoft//DTD HTM. 3.2 extended 961018//EN'>
<HTM_>

<HEAD>

<TI TLE>For ms Exanpl e</ Tl TLE>

</ HEAD>

<BODY BGCOLOR="#7093DB" >

<H2 ALl GN=cent er >Exanpl e of HTTP&nbsp; For ns</ H2>
<BR>

<FORM ACTI ON="/ cgi - bi n/ perl _9. pl " net hod=post >
<TABLE>

<TR>

<TD>Nane:

<TD><| NPUT NAME="nane" S| ZE="20" MAXLENGTH=20>

<TR>
<TD>Passwor d:
<TD><I NPUT TYPE =password NAME="password" S| ZE="20" MAXLENGTH=20>

<TR>

<TD>E- Mai | Address:
<TD><| NPUT NAME= "e-mai | " SIZE = "40" MAXLENGTH=80>
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<TR>
<TD>Addr ess:
<TD><I NPUT TYPE = text NAME = "Address" SIZE = "40" NMAXLENGTH=40>

<TR>

<TD>City:

<TD><| NPUT NAME="city" SIZE="40" MAXLENGTH=40>

<TD ALI G\=| ef t >St at e:

<TD AL| G\=l ef t ><| NPUT NAME="state" S| ZE="2" MAXLENGTH=2 AL| G\=| ef t >
<TD ALI G\=l ef t >Zi p:

<TD AL| G\=l ef t ><| NPUT NAME="1zi p" S| ZE="5" MAXLENGTH=5>

<TR>

<TD VALI GN=t op>Favorite Col or:
<TD><SELECT NAME="opti ons">
<OPTI ON>Red

<OPTI ON>Or ange

<OPTI ON>Yel | ow

<OPTI ON>Gr een

<OPTI ON sel ect ed=on>Bl ue
<OPTI ON>I ndi go</ OPTI ON>
<OPTI ON>Vi ol et </ OPTI ON>

</ SELECT>

<TR>

<TR>

<TD VALI GN=t op>Col or of your noney:
<TD><SELECT NAME="dates" multiple="nultiple">
<OPTI ON sel ect ed=on>Red

<OPTI ON>BI ue

<OPTI ON>Gr een</ OPTI ON>

<OPTI ON>Bei ge</ OPTI ON>

</ SELECT>

<TR>

<TD VALI| G\=t op>Conment s:

<TD><TEXTAREA NAME="conmment s" COLS=40 ROWS=5></ TEXTAREA>
</ TABLE>

<BR><I NPUT TYPE=checkbox CHECKED NAME="echo">Echo a copy of the result HTM. Page to E-
mai | <BR><BR>

<pP>

<TABLE>

<TR>

<TD VALI GN=t op>Test i ng:

<TD><I NPUT TYPE=r adi o CHECKED NAME="t est" VALUE="capt ure" >Capt ur e<BR>
<I NPUT TYPE=r adi o NAME="test" VALUE="repl ay" >Repl ay<BR>

<I NPUT TYPE=radi o NAME="t est" VALUE="| oadt est">Loadt est <BR>

<TR>

<TR>

<TD>Web page to append to reply:
<TD><I NPUT TYPE=fil e NAME="web page">
</ TABLE>

<BR>

There is a hidden field containing data here: <INPUT TYPE=hi dden NAME="hi dden" VALUE="This
rocks!">

Here is another hidden field: <INPUT TYPE=hi dden NAVE="hi ddenl" VALUE="Wb testing is fun">
<BR>

<BR>
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<TABLE ALI G\=cent er >
<TR>
<TD ALI GN=center>Don't dick This

<TR>
<TD><I NPUT TYPE=i mage SRC="col ors.gif" w dth="200" hei ght="100">
</ TABLE>

<TABLE ALI G\=cent er >
<TR>
<TD ALI GN=center>Don't dick This

<TR>
<TD><I NPUT TYPE=i mage SRC="eye.gif" width="80" hei ght="60">
</ TABLE>

<TABLE ALI GN=cent er >
<TR>
<TD ALI GN=center>Don't dick This

<TR>
<TD><I NPUT TYPE=i mage SRC="devplatformgif" w dth="48" hei ght="43">
</ TABLE>

<TABLE ALI GN=cent er >
<TR>
<TD ALI GN=center>Don't dick This

<TR>
<TD><I NPUT TYPE=i mage SRC="enterprise_smgif" w dth="42" height="41">
</ TABLE>

<BR>

<TABLE ALI GN=cent er >

<TR>

<TD><I| NPUT TYPE=subm t NAME="submt">
<TD><I| NPUT TYPE=r eset >

</ TABLE>

</ FORV>

</ BODY>

</ HTM_>

Script example with the ActiveData option selected

When thisoption isenabled, variablizations are donein the script based on the settings of other
conversion optionsthat become available. The following example hasthe ActiveData check box selected.

/* Declare Variables */
int i;

char *Field[2];

char *ActionURL[ 1];

for(i=0; i<2; i++)
Field[i]= NULL;

for(i=0; i<l; i++)
ActionURL[i]= NULL;
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/* Request: 1 */

DO Http("GET http://ww. host.com forns. ht m HTTP/ 1. 0\r\n\r\n");

DO VerifyDocTitl e("Forns Exanple", TITLE);

DO _Get For mAct i onSt at enent (FORM 1), &ActionURL[O0]);

DO_Get For nval ueByName( FORM 1), "hi dden", "hidden", 1, &Field[0]);
DO_Cet For nVval ueByName( FORM 1), "hi dden", "hiddenl", 1, &Field[1]);

/* Request: 2 From Forns Exanple */

DO _Set Val ue("acti on_statenent0", ActionURL[O0]);

DO _Set Val ue("nanme", "joe");

DO _Set Val ue(" password”, "");

DO Set Val ue("e-mail", "");

DO _Set Val ue(" Address", "");

DO Set Val ue("city", "");

DO Set Val ue("state", "");

DO _Set Val ue("zi p", "");

DO _Set Val ue("options", "Blue");

DO _Set Val ue("dates", "Red");

DO _Set Val ue("comments”, "");

DO _Set Val ue("echo", "on");

DO Set Val ue("test", "capture");

DO _Set Val ue("web+page", "");

DO _Set Val ue("hi dden", Field[0]);

DO _Set Val ue("hi ddenl", Field[1]);

DO Set Val ue("subnmit", "Submt Query");

DO Http("POST {*action_statement0} HTTP/1.0\r\n"
"Cont ent - Type: application/x-ww-formurl encoded\r\n"
"Content-Length: {*content-length}\r\n\r\n"
"{nane} & password} & e- mai | } & Address} &{city}&{state}&"
"{zi p} & options}&f dat es} & comrent s} & echo} & test}&"
"{web+page} & hi dden} &{ hi ddenl1} &{submt}");

for(i=0; i<2; i++)
{

free(Field[i]);
Field[i]= NULL;

}

for(i=0; i<l; i++)
{
free(ActionURL[i]);
ActionURL[i]=NULL;
}

Script example with the ActiveData option not selected

When thisoption isnot selected, variablizations are not donein the script regardless of the other options.
The following example hasthe ActiveData check box cleared.

BEG N_TRANSACTI ON() ;

DO Http("GET http://ww. host.com forns. ht m HTTP/ 1. 0\r\n\r\n");

DO VerifyDocTitl e("Forns Exanple", TITLE);

DO Http("POST http://ww. host.conml cgi-bin/perl_9.pl HITP/1.0\r\n"
"Cont ent - Type: application/x-ww-formurl encoded\r\n"
"Content-Length: {*content-length}\r\n\r\n"
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"nanme=j oe&passwor d=&e- mai | =&Addr ess=&ci t y=&st at e=&zi p=&"
"opti ons=Bl ue&dat es=Red&oment s=&echo=0né&t est =capt ur e&"
"web+page=&hi dden=Thi s+rocks%21&"

"hi ddenl1=Web+t est i ng+i s+f un&subni t =Subm t +Query");

DO VerifyDocTitl e("Forns Exanple - Results", TITLE);

END_TRANSACTI ON() ;

IP Spoofing

By default, QALoad searchesfor thefile ipspoof.dat in the Datapoolsdirectory. You can override this
behavior by providing a different file name asthe parameter to the DO_IPSpoofEnable command in the
converted script. For example:

DO _I PSpoof Enabl e( " nyaddr esses. dat");

Script example with the IP Spoofing option selected

The following example hasthe IP Spoofing check box selected.

nitH tp(s_info);
PSpoof Enabl e("");

DO |
DO |
BEG N_TRANSACTI ON() ;

END_TRANSACTI ON( ) ;

Script example with the IP Spoofing option not selected

The following example hasthe IP Spoofing check box cleared.
DO InitHtp(s_info);
BEG N_TRANSACTI ON( ) ;

END_TRANSACTI ON() ;

Streaming Media

QALoad supportstwo types of streaming media:
! RealOne Player
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I Windows Media Player

When streaming media conversion isenabled and you record atransaction that calls streaming media, an
additional command isinserted into the script that requeststhe media. You do not have to listen to or
view the entire mediayou are requesting; just record its URL and ensure that the appropriate media player
isinstalled on the QALoad Player machinesthat will execute playback of the script. At run time, the script
invokesthe media player and requeststhe streaming media resource.

Note: Sreaming media is not supported through firewalls and across proxies.

Advanced RealOne Player media options

The following statements are examples of how additional RealOne Player streaming media commands can
be used in a script.

I void ShowMedi aRP(BOOL di spl ayAudi o, BOOL di spl ayVi deo);
Enable/disable client audio and video for RealNetworks Sreaming Media.

I void EnableStatisticsRP(int statisticFlags, int interval, BOOL traceQutput);
Enable client-side performance statistics for RealNetworks Sreaming Media.

I void DisableStatisticsRP(void);

Disable client side performance statistics for RealNetworks Streaming Media.
Script exampleswith Streaming Media option selected

The following example hasthe Streaming Media check box selected and uses RealOne Player.

#i ncl ude "do_www. h"
#i ncl ude "RPLayer. h"

BEG N_TRANSACTI ON() ;

DO Http("GET http://ww. host.comindex. htm HTTP/ 1. 0\r\n\r\n");
DO VerifyDocTitle(" QALoad WMV Capture Exanples", TITLE);
Downl oadMedi aRP("http://rm host.com 8099/ rangen/ deno. rni, 0);

END_TRANSACTI ON() ;

The following example hasthe Streaming Media check box selected and uses Windows Media Player.

#i ncl ude "do_www. h"
#i ncl ude " SMPLayer. h"

BEG N_TRANSACTI ON() ;
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DO Http("GET http://ww. host.comindex. htmHTTP/ 1.0\r\n\r\n");

DO VerifyDocTitle(" QALoad WAV Capture Exanpl es", TITLE);

DO Http("GET http://ww. host.com wrp-test.asx HTTP/ 1. 0\r\n\r\n");
Downl oadMedi aFr omASX( 0) ;

END_TRANSACTI ON() ;

Script exampleswith Streaming Media option not selected

The following example hasthe Streaming Media check box cleared and uses RealOne Player.

#i ncl ude "do_www. h"

BEG N_TRANSACTI ON() ;

DO Http("GET http://ww. host.com i ndex. htm HTTP/ 1. 0\r\n\r\n");
DO VerifyDocTitle(" QALoad WMV Capture Exanples", TITLE);
DO Http("GET http://rm host.com 8099/ rangen/deno.rm HTTP/ 1. O\r\n\r\n");

END_TRANSACTI ON() ;

The following example hasthe Streaming Media check box cleared and uses Windows Media Player.

#i ncl ude "do_www. h"

BEG N_TRANSACTI ON() ;

DO Http("GET http://ww. host.comindex. htmHTTP/ 1.0\r\n\r\n");
DO VerifyDocTitle(" QALoad WAV Capture Exanples", TITLE);
DO Http("GET http://ww. host.com wrp-test.asx HTTP/ 1. 0\r\n\r\n");

END_TRANSACTI ON( ) ;
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Hostnames as IP Addresses

When thisoption isselected, DO_Http and DO_Httpsrequestsinclude IP addresses for the requests instead
of hostnames. Thisoption only worksif the hosts can bereached directly. If a host must be reached
through a proxy, the IP address cannot be determined.

Script example with the Hostnames as |P Addresses options selected

The following example hasthe Hostnames as |P Addresses check box selected.

BEG N_TRANSACTI ON() ;

DO Htt p("GET http://172.22.24.39/ HTTP/1.0\r\n\r\n");
DO VerifyDocTitl e("Wel conme to The Main Page", TITLE);

END_TRANSACTI ON() ;

Script example with the Hostnames as |P Addresses option not selected

The following example hasthe Hostnames as |P Addresses check box cleared.

BEG N_TRANSACTI ON() ;

DO Http("CGET http://ww. host.com HTTP/1.0\r\n\r\n");
DO VerifyDocTitl e("Wel come to The Main Page", TITLE);

END_TRANSACTI ON() ;

Strip All Cookies from Request

When thisoption is selected, no cookieswill be sent in the DO_Http requests.

Script example with the Strip All Cookies From Request option selected

The following example hasthe Strip All Cookies From Request check box selected.

DO Http(" GET http://gawebserv. conpuwar e. com cgi - bi n/ cooki es5. pl HTTP/1.0\r\n\r\n");
DO Http("GET http://ww. host.com cgi -bi n/ cooki es5.pl HTTP/1.0\r\n\r\n");
DO Http("GET http://ww. host.com cgi -bi n/cooki es5.pl HTTP/1.0\r\n\r\n");

Script example with the Strip All Cookies From Request option not selected
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The following example hasthe Strip All Cookies From Request check box cleared.

DO Http("GET http://ww. host.con cgi -bi n/cooki es5. pl HTTP/ 1.0\r\n Cooki e:
user nane=usernane\r\n\r\n");

Traffic Rlters

The Traffic Filtersdialog box enablesyou to determine which traffic should be included or blocked from
your script. Thisdialog box is accessed by the Traffic Filtersbutton on the WWW Advanced dialog box.

Script example with atraffic filter set

In the following example, a traffic filter has been set to exclude requestswith URLsthat contain the string
“www.host.com”.

DO InitHttp(s_info);

/* Exclude requests with URLs containing */
DO Bl ockRequest sFrom( " www. host . com ") ;

BEG N_TRANSACTI ON() ;

DO Http("GET http://rm host.com 8099/ rangen/real mp3. mp3 "
"HTTP/ 1.0\ r\n"
"Referer: http://wwmv host.conlindex. htmr\n\r\n");

END_TRANSACTI ON() ;

Script example without a traffic filter set

The following example does not use traffic filters.

DO InitHttp(s_info);

BEG N_TRANSACTI ON() ;

DO Http("GET http://ww. host.com HTTP/1.0\r\n\r\n");
DO VerifyDocTitl e("Wel come to The Main Page", TITLE);
DO Http("GET http://ww. host.com i ndex. htm HTTP/ 1.0\r\n\r\n");
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DO VerifyDocTitle(" QALoad WMV Capture Exanples", TITLE);
DO Http("GET http://rm host.com 8099/ rangen/real np3. np3 HITP/ 1. 0\r\n\r\n");

END_TRANSACTI ON() ;

WWW Playback Options Dialog Box

Set optionson thisdialog box to control how much automated processing is performed during test
execution.

Typical (Regular) Processing: Thisoption uses more processor cycles and memory during test execution,
but requiresless scripting. Use thismode if you are:

testing aweb site that makes little use of Javascript and creates pages with few HTML options on
them

anovicetester and wish to work with scriptsthat more closely resemble the user'sinteractions with
the application under test

only testing with alow number of virtual users or have significant hardware resources available for
load testing execution

You can finetune memory usage with the following options.

Manually select subrequeststo be made during playback: Select to prevent QALoad from
automatically selecting which subrequests are made during playback. If this option is selected, you
can choose individual subrequests and additional subrequestsin the tree-view that should be sent
with the main request.

Choose which content-type repliesto process: Specify which content typesto process during
playback.

= Any "text/" and "application/x-javascript” content types: Choose to process all content
types.

= Replieswith the specified content type: Choose to specify which content type to process.
Typethe name of the content typein the Entries can also include subtypes, e.g., "text/htm|"
field (for example, t ext/ ht m ), and click Add. The content typesyou add appear in the
Content field.

Minimized Processing: Thisoption instructs QALoad to disable itsautomatic HTML handling engine
during replay, and it also affects how the script isgenerated. Use thismode if you are:

testing aweb site that uses complex Javascript with complex HTML pagesthat contain significant
number of links, tablesor HTML objects

an experienced load tester and wish to work with scriptsthat more closely resemble the
applicationsHTTP interactionswith the server under test

you are testing for high virtual user throughput or simulating high numbers of concurrent virtual
users from limited hardware resources

If you select thisoption, the following settings take effect:

During conversion, actions are represented in the visual script by NavigateTo or PostTo tree items
instead of Click On or Fill In Form treeitems.

Java script parsing isnot performed.
The setting for Sgnificant Content Typesisignored.

QALoad does not automatically select which subrequests are made during playback. You must
manually select them in the bottom pane of the form-view. All subrequests and additional
subrequests are selected by default during the convert.
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Rule Flters

Selectsthe Rule Foldersthat are scanned for matching ruleswhen converting a WWW capturefileinto a
Visual Navigator script. Rules are sets of parametersthat are established to substitute certain pre-
established variables for system generated variables. Parameters and Rules are established using the Variable
Replacement Wizard.

Visual Navigator (WWW)

The Visual Navigator

The visual scripting interface, called the Visual Navigator, hasthree panesthat represent different aspects
of your script, and menu itemsthat offer you additional functionality. Using the Visual Navigator to
develop your scripts makes your job easier. For example, searching through lines of code to locate a
particular button you clicked on a particular page can take alongtime, but using the Visual Navigator you
can simply click through the pagesto locate that button. In fact, you can develop your whole script —
recording, variablizing, converting, compiling, and running it —all from the Visual Navigator'sinterface
without ever writing aline of code.

For a brief explanation of each Visual Navigator pane, click on the panesin the graphic below. For more
information about a pane, usethe linkslisted after the graphic.

El Note: To make the following graphic fit better in this help window, we've turned off the Script
Development Workbench toolbars and panesthat are not directly related to this help topic. You can
hide/show many of the Script Development Workbench toolbars and panes using commands available from
the View menu.
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Visual Navigator Menus

The Visual Navigator has a number of special menu commandsto help you develop your script.

Visual Navigator Menu

The Visual Navigator menu isthe main menu for Visual Scripting. Accessthe Visual Navigator menu from
the Script Development Workbench's main menu, or right-click on any item in the Visual Navigator tree-
view (left pane).

Datapaoals and Wariables., ..

Wiew Script File
Create Editable Script File, .

Show Hidden Fields
Show Redirected Pages (Sx)
Show Client Ervor Pages (g

[<<]

Show Server Error Pages (S

Insert Tree Ikem L

View Source

Compile F7
YWalidate Script

Datapoolsand Variables: Opensthe Datapoolsand Variables dialog box, where you can add, delete, or
modify datapool files or variables.

View Script File: Opensawindow showing the C++ (.cpp) file based on what is currently showingin the
Visual Navigator'stree-view. Thisisaread-only script.

Create Editable Script File: Creates an editable C++ (.cpp) script based on the current Visual Script. You
can modify thisscript directly; however, any changes made to the script will not be reflected in the tree
and vise-versa.

Show Hidden Fields: Displays form fieldsthat are hidden by the browser.

Show Redirected Pages (3xx):Toggleswhether or not redirected pages are displayed. These are pages that
come back with areply status code of 3xx, for example: 302 Not Found.

Show Client Error Pages (4xx): Toggleswhether or not Client Error pages are displayed. These are pages
that come back with areply status code of 4xx, for example: 407 Proxy Aut hori zation Required.

Show Server Error Pages (5xx): Toggleswhether or not Server Error pages are displayed. These are pages
that come back with areply status code of 5xx, for example: 503 Servi ce Unavail abl e.

Insert Tree Item: Opensasub-menu where you can chooseto insert certain treeitemsinto your script. For
details, see Inserting script items.

Delete Tree Item: Deletesthe currently selected tree item. If the selected item may not be deleted from the
script, thiscommand is unavailable.

View Source: Opensatext window displaying the source code of the currently active HTML Page or
Subrequest in the tree view.
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Edit Menu

The Script Development Workbench Edit menu provides special commands for Visual Navigator
functionality aswell ascommon Edit menu commands. Access the Edit menu from the main menu, or
right-click on an edit box that can be variablized in the Visual Navigator form-view (bottom pane). Felds
that can be variablized are denoted with a Var button.

The commandson the Edit menu are dynamic and the availability of certain commands dependsupon
whether you have text selected and where your cursor is. The following graphicsillustrate the difference:

# o Cut Chrl+¥
By Copy ChrHC
Paste Chrl+y Paste Chel+y
Select Al Chrl+a Select Al Chrl+A
4% Fird... Chl+F #% Find... CtH+F
Replace. .. Ckrl+H Replace. .. Ckrl4+H
Select Al Select Al
Bookmarks k Bookmarks »
Insert vWariable, ., Substitute with Yariable. ..
Insert Random Yalue. .. Substitute with Random Yalue. ..
Insert WU Mumber (absaolute) Substitute with YU Mumber {Absolute)
Insert WU Mumber (Relative) Substitute with Y Mumber (Relative)
Revert to Original String Revert bo Original String

Insert Variable/Substitute with Variable: Opensthe Datapools and Variables dialog, allowing you to
insert avariable or replace the selected text with a variable. Substituted text will refer to alocal variable or
datapool variable and will look similar to one of the following examples:

{$ VAR Custoner Number $}
{$ VAR Last Nane: Custoner Data $}

These commands are only available when the cursor is placed in an edit box on atree-view item that can
be variablized (you will see Var or Var Wiz next to it).

Insert Random Value/ Substitute with Random Value: Opensthe Random Number Tag dialog box where
you can specify arange within which arandom number should be generated for thisvalue. The substituted
text lookslike this:

{$ RANDOM 0: 100 $}
and it producesarandom number between the lower and upper limit each time it is executed.

These commands are only available when the cursor is placed in an edit box on atree-view item that can
be variablized (you will see Var next to it).

Insert VU Number/Substitute with VU Number (Absolute): Inserts or replacesthe highlighted text with
the following text:

{$ VU ABS $}

Thisisthevirtual user number at runtime. The absolute virtual user number is assigned depending on the
number of Playersin use. For example, two Player machines with 50 virtual users on each, would assign
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numbers 0 through 49 for Player 1 and 50 through 99 for Player 2. Typically, the VU number is combined
with other text to form alarger string, such as:

Custoner{$ VU ABS $}
In thisexample, Player 1 has values of CustomerQ through Customer49, and Player 2 has values of

Customer50 through Customer99. These commands are only available when the cursor isplaced in an edit
box on atree-view item that can be variablized (you will see Var or Var Wiz next to it).

Insert VU Number/Substitute with VU Number (Relative): Insertsor replacesthe highlighted text with
the following text:

{$ VU REL $}

Thisisthevirtual user number at runtime. The relative virtual user number isassigned to each Player in
use. Each Player hasrelative numbersfrom 0 to N, where N isthe total number of VUsrun on that Player.

For example, two Player machineswith 50 virtual users on each, would assign numbers 0 through 49 to
each Player. Typically, the VU number iscombined with other text to form alarger string, such as:

Custoner{$ VU REL $}
In thisexample, Player 1 hasvalues of CustomerQ through Customer49, and Player 2 has values of

Customer0 through Customer49. These commands are only available when the cursor is placed in an edit
box on atree-view item that can be variablized (you will see Var next to it).

Revert to Original String: Rollsthe contents of the selected edit box back to when it wasfirst created,
usually when the recording was converted to a Visual Script.

Thismenu item isenabled only if the edit box within the form can be variablized and it has been changed
at some point.

Delete Variable Reference: Deletesthe variable from the selected edit box. Note that you can also
highlight avariable and pressthe Delete key to delete avariable within an edit box.

Thismenu item becomes enabled when you highlight avariable inside of an edit box.

Tools Menu

The Script Development Workbench Tools menu provides accessto the Rule Library for parameterization,
the ZipFile wizard for collecting filesneeded by the Technical Support team to analyze and resolve a
problem, and common Tools menu commands. Accessthe Tools menu from the Script Development
Workbench main menu.

Il analyze

3 Conduckor

@ web Browser
Rule Library
ZipFile wizard

ETP... Chrl+T
WinDiff ...

Rule Library: Opensthe Rule Library dialog box, where you can add, delete, or modify saved Variable
Replacement Rules.

161



Script Development Workbench

Visual Navigator's Find and Replace Feature

Visual Navigator hasan enhanced Find/Replace feature that allows you to find occurrences of strings
within thetree-view, allowing you to quickly locate and/or replace text. For example, you could find
occurrences of Smith and replace them all with the datapool variable {$ Last Name:User Info $}.

Access Find and Replace from the Edit menu, or pressCt r | +F.
Find tab

Find what: Type the string to search for, or click the var... button to select a variable to search for. The
appropriate tree item will be selected and the found text will be highlighted in the form-view (bottom
pane).

Case Sensitive: Select if Visual Navigator should only find strings with case matching that of the string to
locate.

var...: Click to accessthe Select Variable dialog box, where you can choose alocal variable or datapool
variable to search for.

Find Next: Click to find the next occurrence of the string.
Cancel: Click to cancel the search and close the dialog box.
Replace tab

Find what: Typethestring to search for, or click the var... button to select a variable to search for. The
appropriate tree item will be selected and the found text will be highlighted in the form-view (bottom
pane).

Replace with: Typethe string to replace the search string, or click the var... button to select a variable to
replace the search string. The replacement string can be acombination of regular text and one or more
variables.

var...: Click to accessthe Select Variable dialog box, where you can choose alocal variable or datapool
variable to search for.

Case Sensitive: Select if Visual Navigator should only find strings with case matching that of the string to
locate.

Allow read-only fieldsto be changed: Select to replace text in read-only fields without a confirmation
dialog box. If thisoption isnot selected, a confirmation dialog box appears for each occurrence of astring
in aread-only field from which you can choose whether to replace the field.

Replace: Click to replace the string in the Find what field with the string in the Replace with field.

Replace All: Click to replace all occurrences of the string in the Find what field with the string in the
Replace with field. Matching stringsthat are found in read-only fields will not be replaced.

Find Next: Click to locate the next occurrence of the search string.

Cancel: Click to cancel the search and close the dialog box.

Visual Scripting Concepts

Introducing Visual Scripting

Visual Navigator for WWW is QALoad's easy-to-use visual interface to QALoad's powerful script
development tools. Visual Navigator for WWW rendersyour recorded C++-based transaction in atri-paned,
browser-like environment similar to popular visually-oriented development tools, with iconsrepresenting
all the elements of your script. In fact, you could set up and run a WWW script without ever having to
modify a C++-based script.
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With Visual Navigator's advanced editing features, you don't have to know the syntax of QALoad's
command set or your HTML requests or responsesto customize your script. You can quickly and easily:

I Seewhat URL callswere made and what type they were (for example a POST or GET statement)
I Seewhat information was passed in a call

I Seewhat replies/pages were returned

! Add checkpointsor commentsinto your script

I Movethebegin/end transaction statement

I Movethesynchronize statement

! Edit an HTTP header

I Set particular flagsand commands

I Add datapools

I Parameterizing your script

I Extract information from areply to use in subsequent calls

I Saveyour script and go back to it at any time for further editing
I Create a C++-based script file, if you like

Looking at a Transaction Loop

The transaction loop isthe portion of your script that is played back repeatedly, representing multiple
users making requests. The elementsin your transaction loop depend on what was originally recorded on
each page you requested. You can move the transaction loop up or down in the tree-view using the arrow
buttons, to allow certain requeststo be moved in or out of the Transaction Setup area, where they will be
executed before beginning the transaction loop.

El Note: The following graphic does not show all the possible script elements, but gives a good
representation of what your transaction loop might look like in the Visual Navigator.

High-level script items

There are three high-level script itemsin thetransaction loop that represent the web pages you've
recorded. NavigateTo, HTML Pages, and XML Requests:

NavigateTo: Thisisalwaysthefirst item under the Transaction Loop element, and is always denoted with
an arrow icon. It liststhe URL that wastyped into the web browser at the start of recording. This specifies
thefirst request to be made. The result of thisrequest isthe next item in thetree, which isgenerally an
HTML Page item.

If thefirst item isan HTTP request for XML data, it will appear asan XML Request item in the tree.

Page (HTML): Following NavigateTo there will typically be a set of HTML Page items, which are always
denoted with a globeicon underneath the Transaction Loop element. These represent pagesvisited while
the transaction was being recorded.

The form-view (bottom pane) liststhe request'sreply status, the requested URI, and the associated
checkpoint name for the page returned.

HTML Page items can be parent to a number of script itemsin the tree-view, such as Action items. For
moreinformation about sub-itemsthat can exist under a Page item, see HTML Page sub-items.

XML Request: Requests for XML documents are denoted by adocument/arrow icon underneath the
Transaction Loop element. These represent the requests for XML data made during the transaction that
wasrecorded. XML Request items can be parent to a number of lower-level script sub-itemsin the tree-
view, such as Header and Cookie itemsand the XmIReply document item. See XML requeststo learn about
sub-itemsthat can exist under an XML Request item.
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XML Support

QALoad's XML support ishandled through the Script Development Workbench's Visual Navigator, which
displaysyour script'sHTTP or XML requestsin an easy-to-use, visually-based interface that offersyou
point-and-click script editing. Although XML issupported through the Visual Navigator, Compuware
recommendsyou read through thishelp topic aswell asthe Visual Navigator help topicsto become
familiar with the featuresthat are unique to QALoad's XML support.

When an HTTP request is made for an XML document, either in the form of an HTTP GET request or an
HTTP POST request with an XML document asthe post data, the dataisdisplayed in the three Visual
Navigator panes asillustrated below. Click on apanein the graphic for a description of its contents and
functionality.

=l Note: To make the following graphic fit better in this help window, the Script Development Workbench
toolbars and panesthat are not directly related to this help topic are not displayed. You can hide/show many
of the Script Development Workbench toolbars and panes using commands available from the View menu.
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Streaming Media in Visual Navigator

If you selected the Sreaming Media option on the WWW Advanced conversion optionsdialog box before
recording your script, and the recorded transaction contains RealOne Player or Windows Media streaming
requests, your streaming mediarequest will be presented as a Page in the tree-view, similar to the following
graphic:

The form-view (bottom pane) for a streaming media page will show the title Real Media Request or Windows
Media Request to indicate the type of request you recorded, and will list the following fields:

Requested URI: Liststhe requested URI that invoked the media player. For Real Media the file typically will
be an RM file, while for Windows Media it will typically be an ASX file.
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Play Media Request: Select this check box for the virtual user to processthe RM or ASX file that is received
and make the necessary requeststo duplicate what the client performed while receiving the streaming
media. If this checkbox isnot selected, then no further processing is performed after receiving the RM or

ASX file.

Play Requested Media for N seconds: You can specify how much of the streaming mediafile the virtual
user should play, in seconds, before moving on to the next request. A value of zero indicatesthat the entire

media stream should be played.

CX and Visual Navigator

The Visual Navigator handles both native and encoded Chinese, Japanese, and Korean (CJX) characters.
(See CXK Support in QALoad for more information about CX support.)

The following graphic shows how the Visual Navigator provides native character support. Both English and
Chinese characters are displayed in the Workbook Pane.
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The same capture file, Shanghai.cap, isopen in the graphic below. Here, the Visual Navigator displaysthe

Chinese charactersin encoded format.
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Primary Script Elements

Blements of a Visual Navigator Script

When you open aVisual Navigator script, you'll see standard elements of your script listed in the left pane.
Each element can contain a number of script items, which in turn have attributesthat are editable in some
cases. Thistopic liststhe major elements of a script, and linksto additional help topics describing each
element's associated script items:

The main elements of a Visual Navigator script are:
Playback Options

Web Playback Options
Traffic Flters

Variables
Parameterization Rules
Datapool Files

Common Http Headers
Common Content Checks
Transaction Setup
Transaction Loop

Transaction Cleanup

166



Script Development Workbench

Playback Options

Lists various settings related to playback. Settings are contained in the Web Playback Optionsand Traffic
Fltersitems.

Web Playback Options

Thisitem contains settingsrelated to playback such as proxy settings, time out value, number of
concurrent connections, baud rate emulation, and filters. Thisform isdivided into three areas: Proxy
Settings, Miscellaneous Playback Settings, and Playback Options.

Proxy Settings

This section of the form showsthe proxy settings asthey were originally recorded. Thisisthe same
information you could enter into the Internet Explorer or Netscape browsersto configure them.

Use Auto Configuration Script: If an auto-configuration script was used while recording, then this
checkbox is selected and the address of the auto configuration script isshown. If an auto
configuration script was not used, then the other proxy setting fields are enabled.

HTTP Proxy: The address of the proxy server machine and its port number.

SSL Proxy: The address of the SSL proxy server machine and its port number.

Exceptions: Separate entries with acomma, for example: company.sample.com,
company2.company.com

Basic Authorization

Username: A valid user ID to useif the proxy server requires authorization.
Password: A valid password corresponding to the user ID in the previousfield, to useif the proxy
server requires authorization. The password will be encrypted when recording.

Proxy Http Version: Specifieswhich protocol to use when making requests through a proxy.
Optionsare 1.0 or 1.1. The version affects whether or not replies may come back chunked. Only
HTTP 1.1 requests receives chunked replies.

Miscellaneous Playback Settings

This section containsvarious settings used for playback. The values on thisform initially originate from
the WWW Convert Optionsdialog box; however, you can change some of the values on this form.

Http Version: Specifieswhich protocol to use when making HTTP and SSL requests during playback.
Optionsare 1.0 or 1.1. The version affects whether or not replies may come back chunked. Only
HTTP 1.1 requests receives chunked replies.

Server Response Timeout: The number of secondsto wait for aresponse from the server before
considering it to be timed out.

Max Connection Retries: Specifieshow many timesa connection istried before it fails.

Max Concurrent: The maximum number of concurrent connectionsthat can be opened to request
documents. QALoad supportsfrom 1 to 4 connections. Thisoption allows QALoad to better simulate
a browser’s behavior while playing back a script.

Persistent Connection During Playback: When selected, QALoad triesto maintain an open
connection to the server during playback. An open connection may better simulate the recorded
transaction.

Cache: When Auto isselected, QALoad simulatesthe browser’s caching behavior.

Reuse SSL Session ID: When selected, QALoad reusesthe current session’scommunication
information (session ID) for all page requests within the transaction.

Use Transmission Baud Rate Emulation: Select to simulate a specific baud rate for transmission of
requests, and then select arate from the drop-down field. QALoad then slowd the transmission of
requests appropriately in order to emulate the transaction rate of amodem.

Use Reception Baud Rate Emulation: Select to simulate a specific baud rate for reception of
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requests, and then select arate from the drop-down field. QALoad then slowsthe reception of
requests appropriately in order to emulate the transaction rate of amodem.

Playback Options

Virtual User Processing Mode: Indicateswhether the current setting isfor Typical or Minimized
Processor Mode. Click Playback Optionsto open the WWW Playback Options dialog box.
Manually Select Subrequests: Indicateswhether the current setting is Active or Not Active. This
option can be modified on the WWW Playback Options dialog box. When the option is Active, the
following buttons are also available.

Select All Subs: Click to select all subrequests.
Clear All Subs: Click to clear all subrequests.

Javascript Execution Level: Thisfield isread only and displaysthe selection you made when you set
conversion optionson the WWW Advanced dialog box for the level of JavaScript execution.

Traffic Flters

Traffic Filtersallowsyou to filter out certain requests while playing back a script. For example, you may
want to eliminate advertisement requeststhat are being made of Web servers other than the one you are
testing.

Thefirst time you convert a capture file, it will use the filters specified on the WWW Advanced conversion
optionsdialog box and will eliminate any pagesindicated as being filtered. Filter information entered on
that dialog will be written to the Traffic Filterstree item. Any changes you make to thistree item will not
affect itemsin the Visual Navigator tree but will be strictly for filtering subrequests at playback time.

Note: Traffic filters do not affect which XML requests are written to the tree when a capture file is
converted.

Two types of filters may be specified:
I Allowed Traffic

Thislist specifies a set of substrings for the type of URLsyou will allow to be requested. The URL of
every request made must include at least one of the specified substrings. The filter only appliesto
subrequests.

For example, if thelist contained the strings "compuware" and "compuweb" then QALoad would allow
the URLs "www.compuware.com\ info.htm" and "http://mycom puweb/weather.htm" to be requested,
but not "www.google.com".

! Blocked Traffic

Thislist specifies a set of substrings for the type of URLs which should not be requested. If a URL to be
requested contains any of the substringsin thislist, then the request will not be sent. The filter only
appliesto subrequests.

For example, if thislist contained the terms"doubleclick" and "popup_source" then QALoad would not
allow the following URL to berequested: "http://www.doubleclick.com/myAdvertisesment.htm".

The traffic filters form-view also liststhe substringsthat were converted to Additional Subrequests during
conversion under the Traffic converted to Subrequests heading. Thislist isread-only and displaysthe
settings from the WWW Advanced conversion options dialog box.

Variables

Listslocal variablesthat have been created for this script. For information about parameterization, see
About Parameterization.
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Form View Helds
When you highlight avariablein the tree view, the form view displays fields related to the variable type.
Variable Name: The name you provided to identify the variable.

Initial: The initial value for thisfield, before parameterization takes place.

El Note: Variables that are saved in the Parameterization Rule Library can be changed only from the Rule
Library.

Datapool Fles

Lists datapool filesbeing called by the script. Each datapool listed has a list of variablesunder it
representing columnsin the datapool file. Datapools can be Local (specific to asingle Player) or Central
(available to all Players).

Common Http Headers

Listsheadersthat were recorded from at least 50% of your requests. These headers will be sent out with
every request that ismade at playback unlessthey are overwritten by a header of the same name
underneath an individual request action.

You can insert new header items from the tree-view by clicking Visual Navigator>Insert Tree Item>Http
Header. In addition, you can modify the valuesin the Http Header form in theright pane.

Common Content Checks

Listscommon content checks, which apply to all replies sent by the server. Content checks enable you to
verify whether the correct page was returned based on the existence or absence of a specific search string.
You can also set content checks at the page level. Click the Add New Content Check Item button in the
form-view to add new common content checks.

Common content checks can include variables. Common content checks enable you to generate an error
code on aset condition even if no individual page-level content checks are enabled. The search string is
compared to theraw HTML returned by the server, so you may need to include HTML tagsin your search
to match thetext that appearsin the browser.

Transaction Setup

Listsany actionsthat occurred before the main transaction loop. Any items/actionsthat occur under this
heading will be executed after the Synchronize but before the BEGIN_TRANSACTION(); statement at
playback. For example, you may have logged in to a particular Web site and do not want to log in and out
with every transaction at playback. You can movethe Transaction Setup item in the tree-view by
highlighting it and clicking the Move UP/Move DOWN buttons. The Transaction Setup can contain client
certificate tree items.

Client Certificate Tree Item

If the recorded transaction containsaline with a ssl-clientcert command, then Visual Navigator will create a
Client Certificate treeitem and place it directly beneath the Transaction Setup treeitem.

The Client Certificate string can be modified or variablized in the form-view.
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The Client Certificate item can also be moved up and down thetreelike other treeitems, such as
checkpoints. Thisallowsyou to move it into the Transaction Loop areaif you wish to change the
certificate with each transaction.

A Client Certificate item will generate a script line similar to the following:
Set (EVERY_REQUEST, CERTIFI CATE, “gal oad_cl ”);

If the Requires Password check box is selected, the generated script lineissimilar to the following:
Set (EVERY_REQUEST, CERTI FI CATE_PASSWORD, " ~encr ~250F7641455876") ;

Transaction Loop

Liststhe requestsin your transaction. All items/actionsthat occur under this heading are placed between
the BEGIN_TRANSACTION and END_TRANSACTION statements, causing them to be repeated for as many
timesasthe Conductor tellsthem to be. The transaction loop hasanumber of possible sub-elements,
depending on the Web site you tested. For detailed descriptions of the elementsthat can belisted in a
transaction loop, see Looking at atransaction loop.

Transaction Cleanup

Listsactionsthat occur after the script has finished executing the appropriate number of transactions. Any
itemsthat occur under thisheading will be placed after the END_TRANSACTION statement. For example,
you may want to log out of a particular Web site after completing the appropriate number of transactions.
You can move the Transaction Cleanup item in the tree-view by highlighting it and clicking the Move
UP/Move DOWN buttons.

Parameterization Rules

Lists Parameterization Rulesthat you create when you define avariable to substitute for a value. Saving the
variable asarule enables you to reuse it for other instances of the variable.

When you click Parameterization Rulesin the Visual Navigator tree-view, details of the rules stored in the
Rule Library appearsin theright-hand pane.

El Notes:
= Propertiesfor therulesare defined using the Rule Library Wizard or the Variable Replacement
Wizard.

= An exclamation mark (!) in the first column, signifiesthat the rule matches the same parameter
asanother rule defined in the script. Therule applied first preventsthe other rules from being
applied. Rules are applied in the order they are displayed in the table.

Rule Name: Name of the rule.

Matching Item: Name of the item within the script that matchesthe parameters defined in the rule and
that will be replaced with the rule.

Matching Type: Thetype of item within ascript that isreplaced by thisrule. Item typesinclude:
I CGI Parameter
I Cookie
! Header
| EditBox
! RadioButton
I TextBox
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Fields Replaced: Felds of the matching item that are replaced by thisrule. Fields may be:
! Name
I Value
! Both name and value

Apply: Apply the selected rule.

Apply All: Apply theruleto all matchingitemsin the script.

Undo Apply: Removethe rule from matchingitemsin the script.

Edit: Opensthe Rule Library Wizard so you can edit the rule.
Duplicate: Duplicatesthe selected rulein thelist.

Delete: Deletestherule from the script. Theruleremainsin the library.

Add to Library: Addsthe ruleto the Rule Library. Only rulesin the Rule Library can be applied to future
scripts.

Note: You can create a rule using the Variable Replacement Wizard without adding it to the library.
Goto Rule: Displays details for the selected rule.

Get from Library: Opensthe Get Rule from Library dialog box. Select aruleto add to the visual tree.

Rules Details

When you click an individual rulein the Parameterization Rule item in the Visual Navigator tree-view,
the form-view displaysinformation for that rulein three tabs.

&l Note: Properties for the rules are defined using the Rule Library Wizard or the Variable Replacement
Wizard.

Apply Rule: Appliestheruleto all itemsin the ltemsto Replace table.
Undo Apply: Removestherule from all itemsin the ltemsto Replace table to which it hasbeen applied.
Edit: Opensthe Rule Library Wizard so you can edit the rule.

Add to Library: Addsthe ruleto the Rule Library. Only rulesin the Rule Library can be applied to future
scripts.

Note: You can create a rule using the Variable Replacement Wizard without adding it to the library.

General Tab

Details Section:
Rule Name: Displaysthe name of therule. You cannot edit thisfield.

Description: Displaysthe description of the rule. Thisisgenerated by the Variable Replacement Wizard or
supplied by the user.

Status: Displayswhether theruleisapplied to itemsin the script.
Folder: Displaysthe name of the folder where therule islocated.

Last Modified: Displaysthe date the rule was last modified.

Rule Summary Section:

Gives a descriptive summary of the parameters established for thisrule. The rule parameters are defined
using the New Library Rule Wizard or the Variable Replacement Wizard.
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Matching Items Tab

Matching Item Properties

Item Name: Displaysthe name by which the parameter isidentified in the script.
Example: Shows an example of the parameter.

Item Type: Thetype of item within the script that ismatched by thisrule

Host URL: Identifiesthe URL where the parametersreside that are replaced by thisrule.

Itemsto Replace

Note: When a different rule has been applied to an individual item, an red exclamation mark (!) appears
next to the item in the table. Only one rule can be applied at a time. Click Go to Item and review the
information in the Matching Parameter Rules area of the form-view to view the rule applied to the item.

Name: Displaysthe name by which the parameter isidentified in the script.
Type: Displaysthetype of variable in which it isused. This can be:

I CGI Parameter
I Cookie

I Editbox

I TextArea

! Radio button

I Header

Found In: The name of Host URL where this parameter isfound.
Apply to Item: Appliesthe ruleto the matching itemsin the ltemsto Replace table that you have selected.

Undo Apply: Removestherule from the matching itemsyou have selected in the table to which it has
been applied.

Edit: Opensthe Variable Replacement Wizard, where you can make changesto the variable and save it
again to therule.

Go to Item: Takesyou to the individual occurrence of theitem in the script.
Variables Tab

Name field variable

Thisarea displayswhen you select Name asthe field to replace when you created the rule.
Variable Name: Displaysthe name of the variable to which thisrule applies.

Frequency: Showsthe frequency with which theruleisapplied to the script.
Calculation: Showsthe calculation used for the variable.

Example: Shows an example of the value returned from the calculation.

Details: Displaysthe Calculation Details dialog box.

Value field variable
This area displayswhen you selected Value asthe field to replace when you created the rule.
Variable Name: Displaysthe name of the variable to which thisrule applies.

Frequency: Showsthe frequency with which theruleisapplied to the script. Thiscan be: Once per test,
Once per transaction, or Every usage.
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Calculation: Showsthe calculation used for the variable.
Example: Shows an example of the value returned from the calculation.

Details: Displaysthe Calculation Details dialog box.

Transaction Loop Items

Synch

Insertsa Synch item immediately after the currently selected HTML Page. A Synch item represents a spot
where all virtual userswill pause during replay until all active virtual users have reached the same point.
Oncethevirtual usersare synchronized thisway, the Conductor will instruct them all to continue.

A Synch item can be moved up or down thetree using Up/Down in the form-view.

IP Spoof
Insertsan IP Spoof item immediately after the currently selected HTML page.

In order for IP Spoofing to work with Visual Navigator, it isnecessary to create or insert an existing local
datapool file called QALOAD_IPSPOOF in the Visual Navigator tree-view. For more information about
creating thisdatapool file and inserting it, see Setting Up IP Spoofing.

Read Datapool

Opensthe Datapool and Variables dialog box, allowing you to choose which datapool to use, and then
inserts a Read Datapool item immediately after the currently selected HTML Page.

You can move thisitem up or down the tree-view by clicking Up/Down in the form-view.

Form View Fields
The form-view (bottom pane) for a Read Datapool item displaysthe following information:

Datapool Name: The name of the datapool file that will be used. To use a different file, click Select file...
and then choose or create another.

Datapool Variables: Liststhe variables (fields) associated with this datapool file.

Checkpoint Pair

Insertsa Begin Checkpoint item beforethe currently selected HTML Page and an End Checkpoint after
the currently selected HTML Page.

Checkpointsare used to measure duration times for certain actionsto be completed. You can move either
the Begin or End checkpoint item to encompass several requests, if necessary. To move either item,
highlight it and then click Move Up/Move Down in the form-view.

Form View Fields

The form-view fieldsfor a Begin/End Checkpoint item liststhe following information:

Name: The unique name of the checkpoint. When a checkpoint item isinserted, it isgiven adefault name
such as User Checkpoi nt 1. Thisname can be changed. Changing the name of the Begin or End
Checkpoint item automatically changesthe name of the corresponding Begin or End item. In addition,
deleting a Begin or End Checkpoint item automatically deletesthe corresponding Begin or End item.
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Show End/Begin Checkpoint: Click thisbutton to quickly locate the Begin or End Checkpoint item that
correspondsto theitem currently selected.

Increment Variable/ Decrement Variable/ Reset Variable
Increments, decrements, or resetsthe value of alocal variable.

Opensthe Datapools and Variables dialog box, which allowsyou to select which variable to increment,
decrement, or reset. It then insertsthe appropriateitem (Increment Variable, Decrement Variable, Reset
Variable) after the currently selected HTML page.

Form View Fields

The form-view (bottom pane) for an Increment, Decrement, or Reset Variable item liststhe following
information:

Variable Name: The name of the variable being modified. To use a different variable, click Select Var...
and then choose or create a different local variable.

Action: Describesthe type of action to perform on thelocal variable. Options are:
I Increment —incrementsthe value by 1.
! Decrement — decrementsthe value by 1.
I Reset Value — Type avalueto replace the current variable with in the New Value field.

Print Values (debugging)

Insertsa Debug Print item after the currently selected HTML Page. This causes a string to be output to the
Player window during playback. This can be useful for debugging a script while you are trying to variablize
it so that it replays correctly with multiple virtual users.

Form View Field

Debug Print Statement: If you simply type astringin thisfield, it isprinted in the Player’s output window
just asyou typed it. If you insert avariableinto the string, the value of the variable is printed to the
Player'swindow at playback so you can seeitsvalue. For example, to print the value of a datapool variable
you might enter astring like the following:

Customer Name is {$ First Name: Custonmer Data $} {$ Last Name: Customer Data $}

Thisprintsastatement like the following to the Player window at runtime: Cust omer Nane is Ci ndy
Nel son.

You can move the statement within the tree by clicking Move Up/Move/Down in the form-view.

Comment

Insertsa Comment item after the currently selected HTML page. Type your comment into the form-view
(bottom pane).

HTML Pages

HTML Page form-view

The form-view (bottom pane) for an HTML Page tree item containsthe following information:
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Reply Status: The code designating the status of the reply. For most pagesthat were returned correctly, this
will be 200 OK.

Requested URI: Thisread-only field liststhe URI which wasrequested that resulted in this page being
displayed.

Checkpoint Name: If the page has atitle, then it will be used asthe checkpoint name. If not, the word
Checkpoint will be used. To make sure all checkpoint names are unique, anumber may be appended to the
end of the checkpoint name.

Meta Refresh Required [ ] Seconds Before Redirection: If the Refresh Timeout option was selected on the
WWW Conversion Optionsdialog box, thisfield displaysthe number of secondsthat QALoad waits before
it treatsa META refresh request asanormal request. Thisfield only appearswhen refresh timeouts are
enabled.

HTML Page sub-items

The following script items can exist under a Page (HTML) item in the Visual Navigator's tree-view. Each
possible page sub-item islisted below, along with descriptionsfor the fieldsthat appear in the form-view in
theright pane when you select the item in the tree-view.

In addition, a Page item can contain the following sub-itemsthat you insert manually after recording the
transaction:

Content Check sub-item
PageCheck sub-item
AdditionalSubRequests sub-item
SubRequests sub-item

Cookies Set by Server sub-item
Seep sub-item

Fill In Form sub-item

Action sub-items

Content Check sub-item

Insertsa Content Check item for the currently-selected HTML page. Thisverifiesthat the correct page was
returned based on the existence or absence of a particular search string in the server'sreply for that page.
Content checks can include variables. The search string iscompared to the raw HTML returned by the
server, so you may need to include HTML tagsin your search to match the text that appearsin the
browser.

The top pane displaysthe source for the HTML page. You can easily select text in thetop pane and add it
to the content check definition by clicking the Copy from Source button.

Form-view fields

The form-view (bottom pane) includesthe following fields:

Enable thiscontent check: Select to enable the content check for the page. Content checks are disabled
by default. After checking thisbox, choose whether the check succeedsif the string is contained or not
contained in the page. Then typethe string text in the box.

String: Enter the string that definesthe content check. You can type astring or click the Var... button to
select variables for the string.
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Var...: Opensthe Select Variable dialog box where you can select the variable to add to the string.

Copy from Source: Select text in thetop pane and click thisbutton to copy the selected text in the top
paneto thetext box.

Verify: Click to test whether the check succeeds for the text shown in the top pane.

PageCheck sub-item

Allowsyou to verify that thetitle of the page that wasrequested is correct.

Form View Fields
The form-view (bottom pane) includesthe following fields:

Original Title: Thisread-only field displaysthe title of the recorded page.

Verify Page Title: Select this checkbox to enable/disable title verification at playback, then select the
appropriate option:

Complete Title: Thetitle of the page that isrequested must match exactly with the original title.
Prefix: Matchesthe first characters of the title. Specify how many charactersto match. At playback time
QALoad will then compare thefirst N charactersto the original title, allowing you to verify titleswhich
might change slightly.

Suffix: Matchesthe last characters of the title. Soecify how many charactersto match. At playback time
QALoad will then compare the last N charactersto the original title, allowing you to verify titleswhich
might change slightly.

AdditionalSubRequests Sub-item

Some requests are contained in applets, ActiveX components, or other objectsthat are captured, but not
played back by QALoad . These subrequests, which are not recognized asnormal subrequests, are listed in
the AdditionalSubRequests tree item.

Each additional subrequest item appearsin the script asa pre-loaded subrequest just before the main
action. Asaresult, the playback engine requeststhe main page, regular subrequests, and then the pre-
loaded subrequests.

For example:
[ REQUEST # 2 ---------

/1 current page url is http://c96852d01/ pda/

I/l Pre-load the follow ng i nage requests before the next request is made

/'l These requests seemto have been nmade by javascript or applets associated
/1 with the next page but will not be nade autonatically by the replay engine
/1 hence they are here in the script.

Set (NEXT_REQUEST_ONLY, ADDI TI ONAL_SUBREQUEST,
"http://c96852d01/ pda/ i mages/ Left Backgrnd. j pg");

Set (NEXT_REQUEST_ONLY, ADDI TI ONAL_SUBREQUEST,

"http://c96852d01/ pda/ nenuopen. gi f");
Set (NEXT_REQUEST_ONLY, ADDI TI ONAL_SUBREQUEST
"http://c96852d01/ pda/ nenucl ose. gi f");
Set (NEXT_REQUEST_ONLY, ADDI TI ONAL_SUBREQUEST
"http://c96852d01/ pda/ nenucl ose. gi f");
Set (NEXT_REQUEST_ONLY, ADDI TI ONAL_SUBREQUEST
"http://c96852d01/ pda/ i nages/ browsex. gi f");

Click _ On(I MAGE, 1, SRC ATTRIBUTE, "http://c96852d01/ pda/i nages/ browse.gif");
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SubRequests sub-item

Lists all subrequests (such asimages) that the page performed in order to be fully rendered in the browser.
Subrequests cannot be changed and are shown strictly to provide detailed information about the requests
that were made during the recording session.

Form View Fields

The form-view (bottom pane) for subrequests containsthe following fields:

URI: Liststhe URI of the subrequest that was made.

View Source: Click to open the source file associated with the reply of the subrequest in atext format.
Image files will show up as mostly unreadable characters, but cascading stylesheet and JavaScript requests
will be readable.

Cookies set by Server sub-item

If thereply from the server for the requested page contains a Set-Cookie command, it islisted here. This
item cannot be modified, it islisted for your information only.

Form View Fields
The form-view (bottom pane) for cookiesliststhe following information:

Name: The name of the cookie.

Value: The value that the cookie should be set to.

Path: The path within the domain to which this cookieisassigned. This cookie will only be sent to the
server if future request URIshave the same domain and this path. The path can be deeper but it must start
with thispath.

Domain: The domain to which this cookie isassigned. This cookie will only be sent to the server if future
request URIs have thisdomain and the path specified above.

Expires: The cookie's expiration date, if it hasone.

Sleep sub-item

Every page will have a Seep item immediately beforeits Action item. The sleep value specifieshow many
seconds were spent viewing this page (or filling out aform) before an action wastaken (such asclicking on
alink or button).

FlIl In Form sub-item

If arequested page containsa Form (html element) that wasfilled in by the user, then aFill In Form item
and itsassociated elementswill be created in the tree-view. When thistree item is selected, a blinking
frame will appear around the form in the browser-view (top pane).

Form View Fields

The form-view (bottom pane) for a Form element liststhe following information:

Form Action String: The Action String associated with thisform. For example, the URI which will be
requested.
Form Number: The number assigned to the form, indicating which form will be used.

A Fll In Form item in thetree-view can include a number of sub elements. For details, see Form sub-items.
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Extract String sub-item

Inserts an Extract Sring item when you need to extract information from the script and storeit in a
variable to use later in the script.

When an Extract Sring item isinserted into the tree-view, the browser-view displaysthe HTML source for
the pagein which the item isinserted. The string to extract isrecognized by the text preceding it and the
text following it. The test string in between isextracted and saved into alocal variable. You must specify
thelocal variable that receivesthe extracted string at run time by clicking on Select Var.
Form View Fields
The form-view (bottom pane) for an Extract Sring item liststhe following information:
Search for: Type the text you want to extract.
Find prev: Identifiesthe previous occurrence of the selected text in the source window (upper pane).
Find next: Identifiesthe next occurrence of the selected text in the source window (upper pane).

Match Case: Enables you to make your search case-sensitive.

Variable to receive string: The local variable that receivesthe string extracted from thereply. The initial
valueisNone.

Select Var: Click to accessthe Datapoolsand Variables dialog box where you can select or create a local
variable to use with the Extract Sring item.

Preceded by: The text preceding the string you want to extract. Thisisfilled in automatically when you
select the text to extract and click Copy from Source. Use the spin controlsto increase or decrease the size
of the string.

Extracted: The string to be extracted on this particular reply. Thisisfilled in automatically when you
select the text to extract and click Copy from Source.

Followed by: Thetext following the string to be extracted. Thisisfilled in automatically when you select
thetext to extract and click Copy from Source. Use the spin controlsto increase or decrease the size of the
string.

Copy from Source: Copiesthe selected text from the source window and placesit in the edit boxes.

Enter String Manually: Thisoption allowsyou to cut and paste the text you select in the source window
into the Preceded by, Extract, and Followed by edit boxes.

Frames

If an HTML page that isrecorded contained frames, they will be represented in the tree-view (left pane)
with acircleicon containing a capital F. A frame page will be indented beneath the page that isits parent.
If you click on aframeicon in thetree-view, the corresponding frame will be highlighted in the browser-
view (top pane) with ablinking frame around it for identification.

Duplicated frameset pages

Sometimeswhen a user clickson alink or takes some other action inside of aframe, the new page that was
requested simply replacesthe contents of one of the frames already shown in the browser. To indicate that
the frameset page (the main page that holdsthe frames) has not changed, Visual Navigator renames it
Duplicated Frameset n. Where n isan identifying number for the frameset that isincremented as more
frameset pages are duplicated.

Form view fields

The form-view (bottom pane) for a Frame Page item liststhe following information:
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Requested URI: The URI which was used to request the frame page
Frame Name: The name of the frame asindicated in the source HTML.

Action Sub-ltems

Action Sub-items
An Action item appearsunder each HTML Page except the last one in the script. Thisrepresentsthe action
that the user took to get to the next page. Action itemsinclude:

I NavigateTo — Visual Navigator could not determine how the user accessed the next page (they may
have typed a URL directly into the address bar, or a JavaScript may have caused the jump).

Note: A NavigateTo item isthe first element that appears under the Transaction Loop element.
This is because when the browser is launched during recording, the user must specify a starting
address (typically by typing it into the Address bar).

I Click On Link —The user clicked on atext link

I Click On Image — The user clicked on an image link

I Click On Button — The user clicked on a Submit type button.

I PostTo —Datawas sent to the server with a POST command but a matching submit button was not

found. Thismay have been caused by a JavaScript.

Action items can contain various sub-elements. For details, see Action item sub-elements.

NavigateTo sub-item

Secifiesa URI to berequested. If the Script Development Workbench cannot determine how the next
page was requested (typically due to a JavaScript making therequest) then it will use a NavigateTo tree
item instead of something more specific such asa Click On Link.

Form View Field
The form-view (bottom pane) for a NavigateTo item liststhe following information:

URI: The URI that wasrequested. Thisvalue can be variablized.

Use Link Encoding for CGI Parameters: If an HTTP GET request isthe result of a direct request that
includesthe CGI parameterswithin thelink, the parameters must be sent to the server in a different
encoding called Link Encoding. In most cases, the Script Development Workbench automatically detects
thistype of request and selectsthisoption. However, you can manually change this setting for
troubleshooting. Generally, If a Navigate To isassociated with aform, use form encoding (do not select
thischeck box); if a Navigate To isassociated with an anchor, use link encoding (select this check box).

Click On Link sub-item

When the user clickson atext link or an image link, then a Click On Link action item isinserted under
that page. Thisisused to describe the action that was taken while on this page that resulted in the next
page being requested.

When aClick On Link tree-view item is selected, the text or image in the browser-view (top pane) is
highlighted by a blinking frame to make it easier to locate. There are several types of Click On Links:

= Text Links—One of the more common linksin web pages are Text based links. These usually
appear asunderlined text.

= Image Links—An image can have alink, similar to text.
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= Client-Sde Image Map — A Client-Sde Image Map isan image on a page that has multiple
links associated with it. Each link is associated with aregion, which can be any shape. When
the user clickson theimage, the browser determines which region was clicked on and requests
the page linked to that region.

= Server-Side Image Map — A Server-Sde Image Map isan image on apage that has multiple
links associated with it. Unlike Client-Sde Image Maps, these links are stored on the server
rather than the client. When a user clickson theimage, the browser sendsthe server the mouse
coordinate relative to the top-left corner of the image. The server then replieswith the

appropriate page.

Form View Fields
The form-view (bottom pane) for Click On Link itemslist the following information:

Link Type: Specifiesthe type of link found. For example, Text, Image, Client Sde Image Map, or Server
Sdelmage Map.

Link Text: Only available for text links. Showsthe text associated with thelink, asdisplayed in the
browser-view (top pane). During playback, the script searchesfor alink using thistext and then requests
the page specified by the link.

Image: Image linksonly. Showsthe URL of the image that was clicked. When playing back the script,
QALoad searchesfor an image with alink that originated from this URL and requests the page specified by
thelink.

If multiple matchesto Target URI are found, use match: It ispossible to have multiple linksto asingle
URI. Usethe spin control to moveto the next or previouslink that matchesthe target URI. Selected links
are framed and the Link Text, Image, or Image Region edit box isupdated. (The edit box available depends
on thetype of link.)

Target URI: Displaysthe URI that isrequested when thislink isclicked on.

X and Y Coordinates: Server Sde Image Mapsonly. The mouse coordinates, relative to the upper left of
theimage, that were clicked on while recording.

Click On Button sub-item

Clicking on Submit isusually associated with entering valuesinto aform (Fill In Form item). When the
Click On Button tree-view item is selected, the associated button in the browser window (top pane) will be
highlighted with ablinking frame, making it easier to locate.

Form View Fields
The form-view (bottom pane) for Click On Buttons (submits) liststhe following information:

Identify by: Click the appropriate button to choose whether to identify the button by Name (internal
name asindicated in the HTML), by Label (the text on the button), by Occurrence (e.g. the 3rd button), or
by Image Source (in case thissubmit button isreally an image). The edit Identify by buttonswill change
appropriately, depending upon which option you choose.

Prev Button/Next Button: If there are other submit buttonson the page, use Prev Button/Next Button to
chooseto use one of those other submit buttons. The name, label, or occurrence will be updated
automatically.

Label: The Label field (or Name, Occurrence, or Image Source field) can be modified or variablized. If you
variablize the field, clicking Next Button or Prev Button will not affect its contents. However if you choose
to use one of the other options, different text will be displayed because variablization is specific to each
method of identification.

If multiple matchesto URL are found, use match: If QALoad finds multiple matches (for example, two
buttonslabeled Buy Me) then you can use thisfield to specify which match to use. For example you could
specify that you want to click on the 4th button with alabel of Buy Mewhen looking at a page with alot of
items for sale.
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Original Label: The original label associated with the button that was clicked while recording.
Original Name: The original name (from the HTML source) for this button.

Form Action: The URL associated with aform. Thisisthe address for the request that will sent when the
submit button isclicked.

Submit Method: Whether thissubmit item was a GET or POST.

Convert ClickOn: Convertsthe ClickOnSubmit action to a PostTo or NavigateTo action, depending on
whether the ClickOnSubmit will be converted into a PostTo or NavigateTo action.

d} Caution: Thisaction isnot reversible. If you convert the ClickOnSubmit action, it is
permanently changed. You must create a new capture file with a ClickOnSubmit action if you want
thisaction in your script.

PostTo sub-item

If the recorded request was a POST request rather than a GET request and the Script Development
Workbench could not find amatching Submit type button, then a PostTo tree action item will be inserted
under the page. Thiscan sometimes happen if the request isinitiated by Javascript.

Form View Fields

The form-view (bottom pane) for a PostTo item liststhe following information:

URI: The URI which isbeing posted to.
Content Type: One of the following: DEFAULT, TEXT_PLAIN, or MULTIPART_FORM_DATA. Thisfield is
read-only.

Action Item Sub-ltems

Http Headers sub-item

If aheader existsunder an Action item, then it will be sent for that request only. If the header hasthe same
name as one of the common headers, then it will override the common header for thisrequest only. It is
possible to insert additional HTTP headers.

Form View Felds

The form-view (bottom pane) for an HTTP Header liststhe following information:

General

Name: The name of the HTTP header.
Value: The value of the HTTP header.
Matching Parameter Rules

Rule: Liststherulesthat have been created for thisvariable type. These rules may or may not have been
placed in the Rule Library.

Applied to Item: Indicateswhether the rule isapplied to thisvariable.

GoTo Rule: Goesto theindividual rule under the Parameterization Rulestree item. In the right-hand pane,
information on therule displaysin the Matching Item tab of the Rule Details dialog box.

Previous Match: Goesto the next matching variable immediately preceding the current item in the script.

Next Match: Goesto the next matching variable immediately following the current item in the script.
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Apply: Appliestherule highlighted in thelistbox to thisvariable. Only onerule can be applied to an
instance of a variable.

Undo Apply: Removes application of therule highlighted in thelistbox from thisvariable. Other
matching variablesto which thisrule isapplied are not affected.

Cookies sub-item

When a Cookieitem isasub-element of an Action item, it containsalist of cookieitemsthat were sent in
the header of the request that the Action item made when recording. Cookies are added automatically by
the browser based on the URI that isbeing requested. They are either set as a result of the previous reply

(the server returned a Set-Cookie command), or they are set by JavaScript contained in the previousreply.

If the Cookie shown hasa matching Set-Cookieitem, then nothing will display in the script since the
cookieiscreated automatically during playback. If thereisno matching Set-Cookie item, then a Set-Cookie
type statement will be generated in the script.

You can insert additional cookiesinto the Cookies section of a page as another means of variablizing the
playback. How?

Form View FHelds

The form-view (bottom pane) for a cookie item liststhe following information. Both of these items are can
be edited and variablized. You can also insert additional cookie items.

General

Name: The name of the cookie.

Value: The value of the cookie.

Matching Parameter Rules

Rule: Liststherulesthat have been created for thisvariable type. These rules may or may not have been
placed in the Rule Library.

Applied to Item: Indicateswhether the rule isapplied to thisvariable.

GoTo Rule: Goesto theindividual rule under the Parameterization Rulestree item. In the right-hand pane,
information on therule displaysin the Matching Item tab of the Rule Details dialog box.

Previous Match: Goesto the next matching variable immediately preceding the current item in the script.
Next Match: Goesto the next matching variable immediately following the current item in the script.

Apply: Appliestherule highlighted in thelistbox to thisvariable. Only onerule can be applied to an
instance of a variable.

Undo Apply: Removes application of therule highlighted in thelistbox from thisvariable. Other
matching variablesto which thisrule isapplied are not affected.

CGI Parameters Sub-item
Lists CGl parameters sent along with the request made by the Action item.
Form View Helds

The form-view (bottom pane) for CGl Parameter itemsliststhe following information.

General

Override checkbox: For Click On Link sub-item only. When selected, this check box to overridesthe
name-value pair sent by the Click On Link. When you select thisoption, the Var Wiz... button appears.
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Click the Var Wiz... button to accessthe Variable Replacement wizard and create a variable for this
parameter.

El Note: When you override the original CGI Parameter, the script contains a Navigate To statement instead
of a Click On Link statement.

Name: Name of the CGl Parameter.

Value: Value of the CGI Parameter.

Matching Parameter Rules

This section displays only when matching parameter rules are discovered.

Rule: Liststherulesthat have been created for thisvariable type. These rules may or may not have been
placed in the Rule Library.

Applied to Item: Indicateswhether the rule isapplied to thisvariable.

GoTo Rule: Goesto theindividual rule under the Parameterization Rulestree item. In the right-hand pane,
information on therule displaysin the Matching Item tab of the Rule Details dialog box.

Previous Match: Goesto the next matching variable immediately preceding the current item in the script.
Next Match: Goesto the next matching variable immediately following the current item in the script.

Apply: Appliestherule highlighted in thelistbox to thisvariable. Only onerule can be applied to an
instance of a variable. When you apply aruleto a CGI parameter under Click On Link, the CGI Parameter
override checkbox isautomatically selected and the original parameter isreplaced with the variable defined
in therule.

Undo Apply: Removes application of therule highlighted in thelistbox from thisvariable. Other
matching variablesto which thisrule isapplied are not affected. For CGI parametersunder Click On Link,
clicking Undo Apply removesthe check in the CGI Parameter override checkbox. The CGI parameter
returnsto itsoriginal value.

NTLM Authentication Sub-item

Sometimesthe pages being requested require NTLM Authentication, that is, the user will be presented with
adialog box asking for a UserID, Password, and Domain. Thisinformation isrecorded and listed in the
tree-view under the Action item that requiresit.

Form View Fields

The form-view (bottom pane) for NTLM Authentication itemsliststhe following information:

User: User name typed into the authentication dialog.
Password: Password typed into the authentication dialog.
Domain: Domain typed into the authentication dialog.

Basic Authentication Sub-item

Sometimesthe pages being requested require Basic Authentication, that is, the user is presented with a
dialog box asking for a UserID and Password. Thisinformation isrecorded and presented in the tree-view
under the Action item that requiresit.

Form View Fields

The form-view (bottom pane) for Basic Authentication itemsliststhe following information:

User: User name typed into the authentication dialog.
Password: Password typed into the authentication dialog.
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Action item sub-elements

The following items can exist under Action itemsin the tree-view:
Http Headers sub-item

Cookies sub-item

CGI Parameters sub-item

NTLM Authentication sub-item

Basic Authentication sub-item

Forms

Forms

Many pagesthat are used during a WWW load testing session contain formsthat a user must fill out and
submit buttonsthat get clicked. QALoad identifiesformsand the elementswithin them, aswell as
determining which submit button was clicked if thereismore than one.

When a page containsaform that will be submitted, then a Fill In Form item isinserted into that page’s
list of itemsin thetree-view (left pane). Underneath the Fill In Form item are Form Element items, such as
Edit Boxes, Radio Buttons, and Check Boxes. Following the Fill In Form item iseither a Click On Button
item or aPostTo item. For details about Form Elements, see Form sub-items.

When aFill In Form item isselected in the tree-view (left pane), Visual Navigator highlightsthe form with
ablinking frame in the browser-view (top pane).

Form sub-items

A Fill In Form item in thetree-view can contain a number of sub-items, representing elementsthat can
appear in formson HTML pages.

The following sub-items can appear under a Fll In Form item:
Hidden sub-item

Editbox sub-item

Selectbox sub-item

TextArea sub-item

Checkbox sub-item

Radio sub-item

Hidden sub-item

Formscan contain hidden fieldsthat do not show up on the page. These fields are not visibleto the end
user interacting with the browser, but they may need to be variablized for aload test, for example afield
that containsa session ID may need to be variablized.

Form View Fields

The form-view (bottom pane) for aHidden Feld element liststhe following information:

Name: The name of the hidden field
Value: The value of the hidden field.
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Allow thishidden field to be variablized: Select to variablize thisfield. Click the var... button to select a
variable.

Editbox sub-item

Oneof themorecommon elementsin aform isan edit box. When thistreeitem is selected, QALoad will
draw ablinking frame around the appropriate edit box in the browser-view (top pane). The edit box in the
browser-view will show the value that was originally typed in when the transaction was recorded.

Form View FRelds

The form-view (bottom pane) for an Edit Box element liststhe following information:

General

Name: The name of the edit box.

Value: The value of the edit box. Any changes made to thisfield will be reflected in the edit box in the
browser window.

Matching Parameter Rules

Rule: Liststherulesthat have been created for thisvariable type. These rules may or may not have been
placed in the Rule Library.

Applied to Item: Indicateswhether the rule isapplied to thisvariable.

GoTo Rule: Goesto theindividual rule under the Parameterization Rulestree item. In the right-hand pane,
information in the Matching Item tab of the Rule Details dialog box displays.

Previous Match: Goesto the next matching variable immediately preceding the current item in the script.
Next Match: Goesto the next matching variable immediately following the current item in the script.

Apply: Appliestherule highlighted in thelistbox to thisvariable. Only onerule can be applied to an
instance of a variable.

Undo Apply: Removes application of therule highlighted in thelistbox from thisvariable. Other
matching variablesto which thisrule isapplied are not affected.

Selectbox sub-item

A select box is often called a drop down selection box or list box. The form-view will appear slightly
different depending upon whether the Select Box is capable of supporting multiple selections or not.

Form View Fields
The form-view (bottom pane) for a Select Box element liststhe following information:

Name: The name (in the HTML) of the select box.

Itemsfrom the Select Box: Liststhe itemspresent in the Select Box in the browser-view. An item hasa
checkbox next to it to indicate if it has been selected. To change a selection, select or clear the checkbox.
Your choiceswill bereflected in the browser. If the Select Box only supportsone selection, then only the
most recent selection is selected.

Variablized Selections: Edit boxesthat allow the use of variables (local or from a datapool) to specify what
optionsare chosen from the Select Box. For a multiple selection Select Box, it ispossible to add up to six
variablesin addition to any item chosen using the check boxes.

For asingle selection Select Box, a single edit box is provided to allow you to use avariable (local or from a
datapool) to specify the option you want chosen from the Select Box.
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TextArea sub-item
A Text Areaitem isa multi-line text box.
Form View FRelds

The form-view (bottom pane) for a TextArea element liststhe following information:

General

Name: The name of the Text Areafield.

Value: The value of the Text Areafield. Any changesyou enter into this edit box are reflected in the
browser-view (top pane). To enter alinefeed, pressCtr| +Ent er.

Matching Parameter Rules

Rule: Liststherulesthat have been created for thisvariable type. These rules may or may not have been
placed in the Rule Library.

Applied to Item: Indicateswhether the rule isapplied to thisvariable.

GoTo Rule: Goesto theindividual rule under the Parameterization Rulestree item. In the right-hand pane,
information in the Matching Item tab of the Rule Details dialog box displays.

Previous Match: Goesto the next matching variable immediately preceding the current item in the script.
Next Match: Goesto the next matching variable immediately following the current item in the script.

Apply: Appliestherule highlighted in thelistbox to thisvariable. Only onerule can be applied to an
instance of a variable.

Undo Apply: Removes application of therule highlighted in thelistbox from thisvariable. Other
matching variablesto which thisrule isapplied are not affected.

Checkbox Sub-item

The form-view (bottom pane) for a Checkbox element liststhe following information:

Name: Name of the Checkbox.

Value: Value of the Checkbox.

State: Reflectswhether the box ischecked (selected) or not. If the Sateis 1 (checked), then the Name and
Value are passed along in the request to the server. If the Sateis0 (not checked) then the Name and Value
are not passed along. You can change the value of the Sate by clicking on the checkbox control in the
browser-view (top pane).

Radio sub-item
Form View Felds

The form-view (bottom pane) for a Radio Button element liststhe following information:

General

Group Name: The Group Name isshared by all radio buttonsthat belong to the same group.

Value: The Value field iswhat differentiates one radio button from another. The group name and value of
the selected radio button will be sent along with therequest to the server. The Value of aradio button can
be, and often is, different than the text shown in the browser.

usethisvalue button: When you select aradio button in the browser-view (top pane) itsvalue will display
in thistext box. Click thisbutton to transfer thisvalue into the above Value field.

Matching Parameter Rules
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Rule: Liststherulesthat have been created for thisvariable type. These rules may or may not have been
placed in the Rule Library.

Applied to Item: Indicateswhether the rule isapplied to thisvariable.

GoTo Rule: Goesto theindividual rule under the Parameterization Rulestree item. In the right-hand pane,
information in the Matching Item tab of the Rule Details dialog box displays.

Previous Match: Goesto the next matching variable immediately preceding the current item in the script.
Next Match: Goesto the next matching variable immediately following the current item in the script.

Apply: Appliestherule highlighted in thelistbox to thisvariable. Only onerule can be applied to an
instance of a variable.

Undo Apply: Removes application of therule highlighted in thelistbox from thisvariable. Other
matching variablesto which thisrule isapplied are not affected.

XML Requests

XML Document-view

When you click on an XML Request item in the tree-view (left pane) theright pane becomes a document-
view displaying a tree-view of details about the XML document requested or returned astheresult of an
XML request. Each individual XML item appearsasanodein the XML document tree. XML elements can
have child elementsand these appear as child nodes of the XML element. Attributes of an element appear
aschild nodes of the element, with the attribute value appearing as a child of the attribute name.

What if no XML data is associated with a request?

If thereisno XML document associated with the XML request (for example, an HTTP GET) a message
indicating that thereisno XML to be displayed isshown in the XML document-view.

How doesthe document-view relate to the form-view?

Selecting an item in the XML document tree displaysthe form-view details corresponding to that XML
element typein the bottom pane.

XML Form-view

When an XML request isdisplayed in the document-view (top pane) — asaresult of an XML request item
or XML reply child item being selected in the Visual Navigator tree-view — you can click on itemsin the
document-view to display information about each in the form-view (bottom pane). If no XML item is
selected in the document-view, the XML Page form-view displaysinstead. For XML items, the form view
display optionsdepend on two things:

I what type of XML item isselected in the Visual Navigator tree-view (left pane): an XML request or
an XML reply

I what type of XML item issubsequently selected in the XML document-view (top pane)

When an XML item isselected in the XML document-view, the value of that XML item isdisplayed in an
edit box in the form-view. Some values — attribute values and text values — can be edited or variablized
(that is, substituting one or more variables for the value in an XML request or selecting the return value
from an XML reply item to be received by a variable for later use in the script). Text items, which are values
between element tags, and attribute valuesrepresent volatileitemsin an XML document structure, used for
passing valuesto and from Web Services, for example.
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The following tableslist the possible actions for XML items displayed in aform-view. Valid actions are
determined by the XML item type and whether the item isfrom an HTTP POST request or from an HTTP

reply.
In the following tables:
I If an item iseditable the valuein the form-view can be changed and the new value isused during
replay.

I If avalue can be variablized, a variable can be substituted for all or part of the value. The variable's
valueisplaced in the variable's location at replay. An exampleisavalue received from an item
from a previous XML document reply.

I If avariable can receive areplay value, the return value for the item can be placed into a selected
variable during replay. The variable can then be substituted for an input valuein alater XML
request.

XML Request Item Editable? Can the Value
be Variablized?

Declaration No No
DTD (Document No No
Type Definition)

Pl (Processing No No
Instruction)

Comment No No
Element No No
Attribute (Name) No No
Attribute (Value) Yes Yes
Text Yes Yes

XML Request Item Can Variable
Receive Replay
Value

Declaration No

DTD (Document Type = No

Definition)
Pl (Processing No
Instruction)
Comment No
Element No
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Attribute (Name) No
Attribute (Value) Yes
Text Yes

Parameterization in the Visual Navigator

Parameterization

Parameterization isthe process of substituting certain valuesin a script with variables you define.
Parameterization isused in Visual Scripting for WWW scripts.

When you modify QALoad scripts before replaying them, the modifications usually are repetitive and
consistent. Parameterization providesthe meansfor replacing values with system-generated variables
throughout your scripts. The values for variables are derived from a datapool, an extract string, or a
calculated value.

Methods for Parameterizing a Script

Valuesin ascript that you can parameterize are noted in the form-view (bottom pane) with thevar...
button next to the field. This gives you accessto the Datapool and Variables dialog box, where you can
define values for variables.

Certain valuesin the script support the Variable Replacement Wizard. The Variable Replacement Wizard
simplifiesthe process of parameterization by taking you through the necessary stepsfor defining variables
for the fieldsyou want to replace. Fields for which the Variable Replacement Wizard is available are shown
in the form-view with Var Wiz... button next to the field.

Saving Parameters as Rules

You can create and maintain atable of the variables you define by storing them asrulesin the Rule
Library. Once stored, the script looks for these rules and replacesthe value with the parameters you assign
to that rule.

Using Variables with Visual Navigator
Overview of Variables

When you record atransaction, the resulting script isarecording of the actions of asingle end-user. When
you play back that script multiple timesduring aload test, you probably want it to emulate the actions of
multiple users making differing requests of your server instead of the single user that wasrecorded. One way
to achieve that isto replace certain data with a variable that drawsitsvalue from alist of valuesthat you
provide. Here are some examples of why and how you might use variablesin a script:

I If your original script recorded a user logging on to asiteusing an ID and password, you can
replace the ID and password with variablesin the script. At test time, those variables draw their
values from a datapool file of acceptable values, using a different set of values for each transaction
run. In other words, that one script could emulate anumber of different users by utilizing a
different user ID/password combination for each transaction.

I If your script inserted new recordsinto a customer database, you might want the namesto be
unique each timethe script isrun (each transaction). You could create a datapool file of names,
and then insert avariableinto the script wherethe name wastyped. At test time, the variable
inserts adifferent name from the datapool file with each transaction.
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I If an ID string isreturned from the server and that ID isthen used as part of future requeststo the
server, and each virtual user may get back a different ID from the server, you can use avariable to
use a specific ID. You could extract an ID from thereply, placeit into avariable, and then usethe
valuein that variable in place of the actual ID for future requests, ensuring you only use the ID you
specify.

There are anumber of valuesin your script that can be replaced with variables. Those values are noted in
the form view (bottom pane) with var.... Valuesthat use the Variable Replacement Wizard are shown in
the form view with Var Wiz. Typically variables derive their values from a datapool an extracted string, or
acalculated value.

Naming Variables

When you first create a datapool file, theincluded variables are automatically assigned the default names
Varl, Var2, Var3, and so forth.

QALoad allowsyou to rename those variables with meaningful namesthat can even include spaces. This
makesit much easier to work with datapools. For example, you could name a datapool variable something
logical like City, rather than trying to remember that Var4 in your datapool isthe City variable.

Renaming Variables

You can quickly and easily rename local or datapool variables from the tree-view. Smply highlight the
variable under the Datapool Filesor Variables tree-view item, and then change the variable namein the
resulting form-view (bottom pane).

You can also edit from the Datapoolsand Variables dialog box. To accessit, right-click anywhere in the
tree-view and then choose Datapoolsand Variables from the shortcut menu. Highlight the variable to
rename and click Rename.

Datapools and Variables

Datapools and variables can be added or modified by several methods. To simply create, delete, or modify
datapool filesand variables at any time while a script isopen in the editor, choose Visual
Navigator>Datapoolsand Variables from the menu to accessthe Datapools and Variables dialog box.

Alternately, the same dialog box will open automatically whenever you are asked to choose a variable or
datapool file while working with the script, allowing you to create the variables you need on-the-fly.

Datathat can be variablized isdenoted in the form-view (bottom pane) by the var... button. Clicking
thevar... button will open the Datapoolsand Variables dialog box.

Types of Variables

Types of Variables

When valuesin ascript are replaced with variables, the variablestypically are derived from extract strings,
datapools, or calculated variables.

Extract Srings

Insert an Extract Sring item when you need to extract information from areply and store it in avariable to
use in futurerequests or simply for logging the information. For example, if astringislocated inside a
JavaScript or in ahidden tag that isnot visible in the browser, and it might change each time this pageis
requested, use an Extract Sring to extract the value. Extract strings search on the text preceding and the
text following the string you want to extract.

Datapools

Datapoolsdraw values from afile of acceptable values and use a different set of values each time a
parameter isreplaced. You can select an existing datapool file or create a new datapool fileto add to your
script from your datapool directory. Each datapool hasalist of variablesunder it representing columnsin
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the datapool file. When you create a datapool, you specify the number of columns (variables) and rows
(values) it contains.

The datapool file you chooseisadded to your script and islisted under Datapool Filesin the Visual
Navigator tree-view. You can choose to add a central or local datapool to a script.

El Note: You can have only one central datapool file associated with a script, but can have any number of
local datapool files.
Central
Central datapoolsare Conductor-based. They reside on the same workstation asthe QALoad Conductor,
and are available to any Player system on the network that requestsit from the Conductor. You can apply
only one central datapool fileto a script.
Local
Local datapools are Player-based. They reside on a Player workstation, and are only available to that Player.
You can apply any number of local datapool filesto a script.
Calculated Variables

Calculated variables are generated dynamically at runtime and are based on aformulayou define. For
example, you might want each virtual user to have aunique string, such as Smith1, Smith2, and so forth,
or you may want to calculate anew value each time through the transaction loop.

Calculated variables are strings built from one or more elements. These can include datapoaols, local
variables, and text, aswell asthe following:
Dateand Time

Insert the date and timein the format you select.

Random Alphanumeric

Substitutesthe value with random alphanumeric characters at runtime. Secify the type and length of
charactersto use. You can select: lettersonly, numbersonly, or both lettersand numbers.

Thevalue can be afixed length, where you specify the number of characters, or variable length, where you
specify the minimum and maximum number of characters.
Random Numeric

Substitutesthe value with arandom number at runtime. You specify the minimum value, maximum value,
the number of decimal places, and the number of leading digits. Numbers generated with fewer leading
digits are padded with zeros.

Local Variable

A variable with a static value that you set when you create it.

Virtual User Number

The number used to identify the virtual usersduring atest. You can include a virtual user number (VU) in
the calculation. VUs may be absolute (assigned by the Conductor) or relative (assigned by the Player at
runtime).

Absolute

The absolute virtual user number isassigned by the Conductor based on the total number of virtual users
on all Players. Each virtual user isassigned a number and no numbers are repeated. Insert an absolute
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virtual user number when it isnecessary to use a completely unique virtual user number in place of a
variable.

Relative

Therelative virtual user number isthe number assigned to the virtual user by its Player. Because atest has
multiple Players and each Player assignsvirtual user numbersfrom 0-n, arelative virtual user number is
only unique on asingle Player.

Local Variable

A local variable isa static value that you can substitute wherever variables can be used. You can quickly
add local variablesto your script from the Visual Navigator tree-view. Insert Increment Variable,
Decrement Variable, and Reset Variable itemsinto the tree-view to manipulate the value of any variables.

About Calculated Variables

Calculated variables generate their valuesdynamically at runtime based on the formulayou define for
them. They can generate stringsthat contain any combination of text, random alphanumeric characters,
time and date values, and values from other variables, such as datapool values, extract strings, or other
alphanumeric and numeric elements.

Build a calculated variable by choosing the elementsyou want to include and inserting them in the
calculation. For example, you might want to calculate a new value dynamically each time through the
transaction loop rather than use a datapool file of different values. Another exampleiswhen you want
each virtual user (VU) to have aunique ID string, such as Smith1, Smith2, and so forth. Using calculated
variables servesthis purpose.

About Datapool Variables

Datapools are text files containing data recordsthat you can usein place of variable datain your script.
Each datapool comprises alist of variables representing columnsin the datapool file.

For datathat you can parameterize, the var... button appearsin the form-view (bottom pane). Clicking the
var... button opensthe Datapoolsand Variables dialog box. Datapools can be Local (specificto asingle
Player) or Central (available to all Players).

Note: You can parameterize certain variables using the Variable Replacement Wizard.

Central Datapool

A central datapool isadatapool that resides on the same workstation asthe QALoad Conductor. It is
availableto any Player system on the network that requestsit from the Conductor. A central datapool is
controlled by the Conductor, and you use the Conductor to set any optionsrelating to it. You can apply
only one central datapool fileto a script.

Local Datapool

A local datapool isadatapool that resides on a Player workstation, and isonly available to that Player.
Because a local datapool resideslocally and isonly available to the local Player, it does not generate any
network traffic. You can apply any number of local datapool filesto a script.

About Extract Strings

Insert an Extract Sring item in your script when you need to replace a system-generated value or reuse a
system-created value later in a script. You can extract information from areply and store it in avariable to
use in futurerequests. For example, if a system-created order number isassigned during atransaction that
must be used again later in the transaction, you can use an Extract Sring to store the value and insert it
into the script at the appropriate point.

192



Script Development Workbench

When you select text to storein an extract string, Visual Navigator uses 10 or more characters on either
side of the extracted text to make the search string unique and find this copy of the extracted text. You can
increase or decrease the size of the strings.

About Local Variables

A local variable has a constant value that you assign when you create the variable. It can be substituted
wherever variables can be used. You can quickly add local variablesto your script by right-clicking in the
Visual Navigator tree-view and selecting Datapoolsand Variables.

Note: You can insert Increment Variable, Decrement Variable, and Reset Variable itemsinto the tree-view
to manipulate the value of any variables.

Editing Variables

Adding a Variable

Add variablesto the script from the Visual Navigator tree-view. Types of variables are:
I Local variables
I Datapools
I Calculated variables

I Extract Srings
Note: You can insert Increment Variable, Decrement Variable, and Reset Variable itemsinto the tree-
view to manipulate the value of any variables.
Creating a Calculated Variable

The following procedure provides step-by-step instructions for creating and editing a new calculated
variable using the Datapoolsand Variables dialog box.

Note: You can also use the Variable Replacement Wizard to create calculated variables.

To create a calculated variable:

1. Accessthe Datapoolsand Variables dialog box by doing one of the following:
= Click Visual Navigator>Datapoolsand Variables.
= Right-click in the Visual Navigator tree-view, then select Datapoolsand Variables.

= In the Visual Navigator tree-view, click the value you want to replace, and then click var... in
the form-view.

2. Click New Calc Variable. A new calculated variable name appearsin thelist box with all the other
variables assigned to the script. The new variable isadded to the Variables section in the Visual
Navigator tree-view (left pane).

Type aname for the variable, then click OK.

e

In the Visual Navigator tree-view, scroll to the Variables section and select the name of the variable
you just created. Details of the calculation variable display in theright-hand pane.

Click Edit Calculation. The Edit Calculation Variable dialog box displays.
Build the calculation variable by clicking aform in the Templates area.

Select or type the associated information in the Details area.

© N o o

Click Insert into Calculation, then click OK to save the changes.
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Adding a Variable to a Datapool

Add datapool variablesto the script from the Visual Navigator tree-view.

El Note: You can insert Increment Variable, Decrement Variable, and Reset Variable itemsinto the tree-view
to manipulate the value of any variables.

To add a variable to a datapool:

1.
2.

6.

Right-click anywhere in the Visual Navigator tree-view.

From the shortcut menu, select Datapoolsand Variables. The Datapoolsand Variables dialog
box displays.

Select a Datapool in the tree-view.

Click the New Variable button. A variable with the default name Var# isadded to the list of
variablesin the selected datapool. Rename the new variable or accept the default name.

Click OK. In the Visual Navigator, the new variable isadded to the datapool in the tree-view,and a
new column for the variable displaysin the form-view.

Type avalue for the variable in each cell of the column.

Creating, Editing, and Importing Datapools

The following sections provide step-by-step instructions for creating and editing datapools, and for
importing a datapool fileinto a script.

To create a new datapool:

1.

With a script open, choose Visual Navigator>Datapoolsand Variablesfrom the menu. The
Datapoolsand Variables dialog box displays.

Click New Datapool File.

If this script doesn't have a central (Conductor-based) datapool assigned, the Choose Datapool
Type dialog box opens. Specify whether the datapool you are about to create should be central
(Conductor-based) or local (Player-based), then click OK. The Create New Datapool File dialog box

appears.
In the Filename field, type the name for the new datapool.

Type the number of rows and columns for the datapool file.

Click OK to create the datapool. You arereturned to the Datapoolsand Variables dialog box. The
Datapools and Variables dialog box now displays any datapool files assigned to the script,
including the one you just created. The new datapool isadded to the Datapool Fles section in the
Visual Navigator tree-view (left pane).

Click OK.

In the Visual Navigator tree-view, scroll to the Datapool Files section of the script and click the
name of the datapool file you just created.

In theright-hand pane, type valuesinto the datapool fieldsto be used at test time.
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To import a datapool file:

1. Copy your datapool file, which must bein .dat format, to the Dat apool s directory of the QALoad
installation.

2. Insert the datapool into a script as described below.

To edit a datapool file:

If you need to make changesto a datapool file, Compuware recommendsthat you make a backup copy of
thefilefirst. If a backup copy isnot available, you may need to check all other scriptsthat use that
datapool file and make appropriate changes.

{!} Caution: Because it is possible for more than one script to use the same datapool file, care should be taken
when modifying a datapool file's contents. Doing so for one script may cause errorsin other scriptsthat use
the datapool file.

1. With your script open, scroll to the Datapool Files section in the Visual Navigator tree-view (left
pane).

2. Select the datapool file you want to edit. A table opensin theright-hand pane displaying the
contents of the datapool file.

3. Perform any of the following functions:
I Edit acell'scontents: Click in acell and type over the existing contentsto edit the value.

I Insert columnsor rows: Right-click on arow or column header and choose Insert Row or
Insert Column from the menu. Choose whether to insert the new item before or after the
selected item, and type the number of itemsto insert.

I Delete columnsor rows: Right-click on arow or column and choose Delete Row or Delete
Column from the menu. (Press SHIFT to select multiple contiguousitemsor CTRL to select
multiple non-contiguousitems.)

I Rearrange columnsor rows: Select one or more columns or rows by clicking on the headers
(press SHIFT first to select multiple items). Drag the rows or columnsto a new position. Asyou
drag them, athin red lineindicates where the selection are moved.

I Rename acolumn header (variable):Click on the column name and then type the new namein
the Variable Name field.

4. Click File>Save to save your changes.

Inserting Datapool Variablesinto a Script

You can quickly add an existing datapool to your script from the Visual Navigator tree-view.

To insert a datapool:

1. Right-click anywherein thetree-view. From the shortcut menu, choose Datapoolsand Variables.

2. Click Insert Datapool File.

El Note: Data that can be parameterized is denoted in the form-view (bottom pane) by the var... button or
the Var Wiz... button. Clicking the var... button opensthe Datapools and Variables dialog box. Clicking the
Var Wiz... button opensthe Parameterization Wizard.

3. If your script doesn't yet include a central datapool file, the Choose Datapool Type dialog box
opens, where you can designate your datapool file asa central or local datapool. If your script
already includes a central datapool, the Open dialog box appears.
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4. From the Open dialog box, navigate to the datapool file to add to your script. Datapool files are
normally located in the directory \ Conpuwar e\ QALoad\ Dat apool s.

5. Select the appropriate file and click Open.

Thefile you selected isadded to your script and islisted in your Datapoolsand Variables dialog box,
where you can edit or delete it as necessary. If you expand the view of thefilein the Datapoolsand
Variables dialog box, you can see the variables (columns) saved in the file. The names for those columns
are stored in the datapool file asa comment line. If they are not named, Visual Navigator assignsthem the
default name Var #.

Creating Extract Strings

You can extract avalue from the web page whereit first occursand placeit into avariable using an
ExtractSring treeitem. When you insert the tree item, the HTML source for the page appearsin the
browser-view so that you can highlight the text to extract. When you highlight the string, some of the text
preceding and following the string is selected to identify where the string occurs during playback.

To create an extract string by inserting atreeitem:

1. Right-click in the Visual Tree where you want to place the extract string. The HTML source for the
page appearsin theright-hand pane.

In the shortcut menu, click Insert Tree Item>ExtractString.

w

In the form_view (bottom pane), type the text you want to extract in the Search for field. Select
Match Case to make your search case-sensitive.

Click Find prev and Find next to select the occurrence of the variable you want to replace.
Click Select variable. The Datapool and Variable dialog box displays.

Select the variable in which to store the extract string, and click OK.

N oo g &

Do one of the following:

I Click Copy from source. This copiesthe selected text from the source window into the edit
boxes. The text immediately before the selected text appearsin the Preceded by field. The text
immediately after the selected appearsin the Followed by field.

IEl Note: Use the arrows next to the fields to include more or less of the preceding and following
text.

= Click Enter stringsmanually and type the text before and after the string in the Preceded by
and Followed by fields.

8. In the Extracted field, click Next to view each instance of the variable in the page. The extracted
string isadded to the Visual Tree.
Adding a Local Variable

Add local variablesto the script from the Visual Navigator tree-view. A local variable can be substituted
wherever variables can be used.

Note: Insert Increment Variable, Decrement Variable, and Reset Variable itemsinto the tree-view to
manipulate the value of any variables.
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To add a local variable:

1. Right-click anywherein the Visual Navigator tree-view.

2. From the shortcut menu, select Datapoolsand Variables. The Datapoolsand Variables dialog
box displays.

Select the Variablesitem in the tree-view.
Click New Variable. An unnamed variable isadded to your list of local variables.
Type aname for the new variable.

In thelnitial Value field, type the value for the variable.

N o g s~ ow

Click OK. Thelocal variable isadded to the Visual Navigator tree-view under Variables.

Using the Variable Replacement Wizard
Using the Variable Replacement Wizard

The Variable Replacement Wizard guides you through the process of defining variables and substituting
them for parametersin the script. Using the wizard, you choose which fields of a parameter to replace with
variables, define the variable that replacesthe field, and select additional parametersto replace with the
variable.

When you use the Variable Replacement Wizard, the variable you defineissaved asarule. When you save
therulein the Rule Library, you can apply the same parametersto future scripts. Subsequent captures use
the stored rules during the convert processto identify matching parameters.

The Variable Replacement Wizard is available for the Visual Navigator tree itemsthat have a Var Wiz...
button associated with them in the form-view (bottom pane). These include:

I CGI Parameter

I Cookie

I Editbox

I TextArea

! Radio button

! Header

Accessing the Variable Replacement Wizard

The Variable Replacement Wizard guides you through the process of defining variables and substituting
them for parametersin the script.

To accessthe Variable Replacement Wizard:

1. IntheVisual Navigator, click the tree item you want to parameterize.

2. Click Var Wiz... in the form-view. The Welcome dialog box of the Variable Replacement Wizard
displays.
3. Click Next to start the parameterization process.

El Note: To edit CGI parameters under Click On Link, click the checkbox at the top of the form-view to
override the name-value pair, then click the Var Wiz... button to access the Variable Replacement wizard.
Next >
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Sep 1: Choose the Heldsto Replace

To choose the fieldsto replace:

1. Select thefieldsthat in theitem should get their values from variables. You can select:
= Name field
=  Valuefield
= Both name and value fields

2. Click thedown arrow on the ltem Name box to display optionsfor how the item you are replacing
isidentified in the script. Thisallowsthe wizard to find and replace similar matching itemsin the
Visual Tree. You can select:

= isequal to (variableto replace)

= startswith (variableto replace XXX)

= endswith (YYY_variableto replace)

= contains(YYY_variableto replace XXX)

The name and current value of the item you select displaysin the details area at the bottom of the
dialog box.

3. Review your selectionsin the Details area, and click Next to proceed to the next step, where you
definethe variable.

Sep 2: Define the Variable that Replaces the Name or Value Feld

To define the variable that replacesthe Name or Value field:

El Notes:
= Thevariableyou define can replace the entire original value or portions of it.

= When you chooseto replace Both name and value fieldsin the previous step, the current step
becomes Step 2.1: Define the variable to replace the Name field. When you complete this
step and click Next, the dialog box appears again as Step 2.2: Define the variable to replace
the Value field. Complete this step for the Value field and click Next to proceed to Sep 3.

1. IntheVariable Name box, typeaname for the variable or accept the default name. The default
nameisnamet#, where # isthe number incremented by one for each new variable.

2. Click thedown arrow on the Frequency box to display selectionsfor when the original valueis
replaced with the variable. You can select:

= Once per test
= Once per transaction (default)
= Every usage

3. Dooneofthefollowing:
I Typeavaluefor the variablein the Calculation field.

I IntheTemplatesarea, click the type of value you want to use, then select or typethe
associated detailsin the Details area of the dialog box. Click atemplate below to display the
associated detail fields:

o Dateand Time
0 Random Alphanumeric

o Random Number
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o Datapool Variable
o0 Local Variable
o Virtual User Number

0 Extract Sring

El Note: The text you type or the template you select can represent the entire variable, or you can combine it
with other elements.

4. Repeat Sep 3 until you include all elementsfor the calculation.
5. Click Insert into Calculation.

6. Click Next to proceed to the next step, where you select additional parametersto replace. Click
Back to edit fieldsin the preceding dialog box.

Sep 3: Select Additional Parametersto Replace

Once you identify the item to replace, the Variable Replacement Wizard lists all occurrences of the same
item in the Visual Tree. Select the parametersthat you want to replace with this variable definition.

To select additional parametersto replace with thisvariable definition:

1. Click one or both of the following to select the type of parametersto replace:

= Match only [variabletype] parameters - Select this option to display only matching parameters
of the same variable type asthe original. For example, if the original parameter you are
replacing is a cookie, selecting this option replaces only cookie-type parameters.

= Match only parametersfrom the host URL - Select this option to display only matching
parametersfrom the same host URL asthe original parameter.

2. Inthelistbox, select the parametersthat should be replaced with the variable definition. Click
Select All to select all the listed parameters.

3. Click Next to proceed to the next step, where you save the variable asarule.

Summary

To review and create the variable:

1. IntheSummary dialog box, review the information you entered for the variable. The information
appearsin three tabs:

= Variable Properties- Showsthe elementsyou used to define the variable and its
frequency of use. Clicking Details displaysthe Calculation Details dialog box.

= Itemsto Replace - Showsthe parameterswith the same namein the script that you
chose to replace with thisvariable definition.

= Rule Properties- Shows details of the variable and rule.
2. Click Back to return to the appropriate dialog box to edit information.

3. Click Finish to createthe variable, apply it asarule, and useit in the script.

Using the Rule Library
Overview of the Rule Library

You can save variable replacementsyou define asrules. These are stored in the Rule Library, where you can
use them in future recordings and reduce repetitive parameterization tasks.
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When subsequent captures are converted, the Visual Navigator scansthe Rule Library for matching
parameters. For example, if arule parameterizesthe value of a CGIl Parameter named Session|D, the Visual
Navigator scansthrough the Visual Tree for any CGl Parametersthat match the description defined in the
rule. If amatch isfound, theruleisadded to the Visual Tree, where you can apply it to the script.

From the Rule Library, you can create rules, edit rules, and view details of individual rulesand the folders
in which they are stored.

Hements of the Rule Library Dialog Box

Create or modify parameter rules from the Rule Library dialog box. The dialog box containsthe following
areas:

! Menus
I Treeview
! Details

Rule Library Menus

File New Rule - Opensthe Rule Creation Wizard. Use the wizard to
define arulethat you can useto parameterize future scripts.

New Folder - Creates a new folder in the tree-view.
Edit Use the Edit menu to cut, copy, paste, delete, or rename rules.

Rule Edit Rule - Opensthe Rule Creation Wizard so you can edit a
rule you select in the Rule Library.

Help Displays QALoad help.

Rule Library Tree-View

The Rule Library tree-view displays a hierarchical view of all rulesand folderswithin the Rule Library.
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Rule Library Dialog Box Details

The Details area of the Rule Library dialog box displaysinformation on therulesdefined in the Rule
Library. There are two levels of detail:

! Folder - When you select afolder name in the Rule tree, the Details area of the dialog box displays
information for each rulein the folder.

I Individual Rule - When you select arulein afolder in the Rule tree, the Details area of the dialog
box displaysinformation for the individual rule in three tabs.

Applying a Rule

When you define valuesto replace variablesin a script, you can save them asrulesand apply them to other
scripts.

To apply arule from the Visual Tree:

1. Inthe Visual Navigator vistree, click the Parameterization Rules script item and select theruleto
apply. A description of the rule displaysin the form-view.

2. Clickthe Matching Itemstab. The propertiesthat determine the matching itemsand each
matching item found in the script display.

3. Do oneof thefollowing:
I Click Apply Rule on theleft-hand side of the dialog box to apply theruleto all the
matching items.
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I Select an item or itemsin the table and click Apply to Item on theright-hand side of the
dialog box.

Note: When a different rule has been applied to an individual item, a red exclamation mark (!) appears
next to the item in the table. Only one rule can be applied at a time. Click Go to Item and review the
information in the Matching Parameter Rules area of the form-view to view the rule applied to the item.

To apply arule from the form-view for a variable:

1. IntheVisual Navigator vistree, select the variable to which you want to apply therule.

2. IntheMatching Parameter Rules area at the bottom of the form-view (right-hand pane), select
therule you want to apply.

3. Click Apply. Theruleisapplied to the variable.
Editing a Rule

Follow these stepsto edit rules stored in the Rule Library.

To edit a rule:

1. Select arulein the Rule Library visual tree, and click Rule>Edit Rule. The Rule Creation Wizard
opensand displaystheinformation on therule you selected.

2. Follow the procedure for creating arule to make changesto therule elements.
Creating Rules from the Rule Library

Create anew rule from the Rule Library using the Rule Creation Wizard.

To open the Rule Library Wizard:

1. Select Tools>Rule Library. The QALoad Rule Library opens.
2. Select thefolder in the tree-view where you want to storethe new rule.

3. Click File>New Rule. The Welcome dialog box of the Rule Creation Wizard displays.

Using the Rule Library Wizard
Sep 1 of 3: Choose the Heldsto be Replaced

To choose the fieldsto replace:

1. Choose which fields of the matching item get their values from thisrule. You can select:
I Namefield
I Valuefield
I Both name and value fields

2. Click thedown arrow on the Item Name box to display optionsfor how the item you are replacing
isidentified in the script. Thisenablesthe wizard to find and replace similar matching items. You
can select:

I isequal to (variableto replace)
I startswith (variableto replace XXX)
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I endswith (YYY_variableto replace)
I contains (YYY_variableto replace XXX)

3. Select the parameter type to which you want the rule applied. Choose:
! Only itemsof the specified type
I All parameter types
4. Select the URLsfrom which theitem should be matched. Choose:
I Match any items of the specified host URL and type the name of the URL.
! Any host
5. Click Next to proceed to the next step, where you define the variable.

Sep 2 of 3: Define the Variable

To define the variable:
El Note: The variable you define can replace the entire original value or portions of it.

1. IntheVariable Name box, type aname for the variable or accept the default name. The default
name dependson the field you choseto replacein the previous step. The default nameiis:

I NameVar - if you choseto replace the Name field in the previous step.

I ValueVar - if you choseto replace the Value field in the previous step.

=] Note: When you choose to replace both the Name and Value in the previous step, the default is
NameVar. When you complete this step and click Next, the dialog box displays again with
ValueVar in the Variable Name field. Complete Sep 1 through Step 5 for the Value variable.

2. Click thedown arrow on the Frequency box to display selectionsfor when the original valueis
replaced with the rule. You can select:

= Once per test
= Once per transaction (default)
= Every usage

3. IntheTemplates area, click the type of value you want to use, then select or type the associated
detailsin the Details area of the dialog box. Click atemplate below to display the associated detail
fields:

! Dateand Time

! Random Alphanumeric
I Random Numeric

I Datapool Variable

I Local Variable

I Virtual User Number

I Extract Sring

Z] Note: The text you type or the template you select can represent the entire variable, or you can
combine it with other elements from the templates.

4. Repeat Sep 3 and Sep 4 until you include all elementsfor the calculation.

Click Insert into Calculation.
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6. Click Next to proceed to the next step, where you select additional parametersto replace. Click
Back to edit fieldsin the preceding dialog box.

El Note: When you choose to replace Both name and value fields in the previous step, clicking Next repeats
the current step so you can define the variable for the Value field. Complete Step 1 through Step 5 for the
Value field and click Next to proceed to the next step.

Sep 3 of 3: Rule Description

Review the rule you created.

To view the rule:

1. Review thedetailsin the Description box. Thisisasummary of the elementsyou used to define
therule.

El Note: A default name is provided in the Rule Name field. You can type a new, descriptive name
for the rule or accept the default.

2. Soretherulein afolder by doing one of the following:

! Click thedown arrow in the Rule Folder list and select the folder name where the rule will be
stored.

I Click New Folder. The Create New Rule Folder dialog box appears. In the Folder Nam e field,
type the name of the new folder, then click OK.

3. Click Next to proceed to the Summary dialog box.

Summary

To review and create the rule:

1. IntheSummary dialog box, review the information you entered for the rule. The information is
displayed in two tabs:

I Variable Properties - Showsthe elementsyou used to definethe rule and its frequency of use.
Clicking Details displaysthe Variable Details dialog box.

! Rule Properties - Shows details of the variable and rule.
2. Click Back to return to the appropriate dialog box and edit any elementsof therule.

3. Click Finish to createtherule and storeit in the Rule Library.

Developing a Script Using the Visual Navigator (WWW)

Creating a Visual Navigator Script
Creating a Visual Navigator Script

Using the Script Development Workbench, you can quickly and easily:
I Convert an old script to a Visual <ript How?
I Record anew Visual Script How?
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Converting Previously-Recorded Scripts

You can convert an existing C-based script to a Visual Navigator script.

To convert a previously-recorded script:

1. With aWWW session open, choose Options>Convert.

2. On the WWW tab, select the option Enable Visual Navigator.
3. Click OK.
4

On the Workspace Pane's Capture tab, right-click on the capture file to convert to a script. From
the context menu, choose Convert (or Convert As).

5. You may be prompted to overwrite an existing script file. Click Yes.

The Script Development Workbench converts your capture file to a Visual Navigator script, opening it in
the Workbook Pane.

Recording a Visual Navigator Script

You record a Visual Navigator script the same way you record a regular QALoad script — by setting options
to determine the behavior of QALoad while recording, and then clicking through atransaction to mimic a
user. QALoad will record all sent and received HTTP and SS_ callsusing the Script Development
Workbench's Web proxy and write the activity to a capture file.

After recording, the capture file must be converted to an editable, C-based script. Thisisthe point where
Visual Scripting differs from a regular WWW script. By setting a single option before converting the capture
file to an editable script, you can turn your capture file datainto a Visual Script that allowsyou to view the
actual Web pages you recorded in a browser-like interface, where you can manipulate the transaction and
easily insert variableinformation into your script without directly editing aline of code.

To record a Visual Script:

If you arerunning your application on Windows XP SP2, Compuware recommends you turn the 'pop-up
blocker' feature off before recording atransaction. The feature can be disabled viathe browser window's
Toolsmenu in Internet Options>Privacy.

1. Open aWWW session in the Script Development Workbench.
2. Click Options>Record. The WWW Record Options dialog box opens. Set any relevant options.
3. Click OK.
4

For convenience, set conversion optionsnow also. (You can set conversion options after recording
your transaction, if you prefer, or even change pre-set optionsat any time after recording and then
re-convert the capture file to apply the changes.):

a. Click Options>Convert. The Universal Convert Optionsdialog box opens.
b. Set any applicable optionson the General Convert and WWW tabs.

c. Onthe WWW tab, select the Enable Visual Navigator check box, which will ensure your
capture fileis converted to a Visual Script later.

d. Click OK.

5. From thetoolbar, click the Start Record button. QALoad launches your application and any
proxies, if necessary, and beginsrecording calls.

6. Record thetransaction.
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7. When you are finished, click the Stop Record button. You will be prompted to save your capture
file. By default, capture files (.cap) are saved in the directory
QALoad\ M ddl ewar es\ WNN capt ur es.

8. If you previously set optionsto prompt automatic conversion, your capture file will be converted to
a Visual Script and will open automatically in the editor. For more information about setting up
automatic conversion, see Configuring the Script Development Workbench.

If not, you will be prompted to save and name your file. When you are finished, click OK.
9. Click the Script Development Workbench's Capturestab and locate the capture file you just saved.

10. Right-click the file and choose Convert. QALoad will convert your capture file to a Visual Navigator
script and open it in the editor.

Visual Navigator Fles

When you create a script using Visual Navigator, QALoad savesimportant information about your script in
the following files. These files are saved in the directory \ Conpuwar e\ QALoad\ M dd| ewar es\ WAVin the
subdirectories\ Scri pt s and \ Capt ur es. Some of these files can be modified, and can be opened from the
Script Development Workbench's Workspace pane, if necessary.

Filename Description

Files Generated From Recording

<fil ename>. cap A file containing all of the requests
and responsesthat were recorded.

<filename>.rfd Replies to subrequests, which mostly
consist of images, style sheets, and
javascripts. Thisdataisused to
visually recreate the pages asthey
appeared when recording.

Files Generated From Conversion to a Visual Script

<filename>. vistree = Containsmost of the elements of the
Visual Navigator tree, including any
elementsthat you modify later or
add to your script.

<filename> VisHm | Containsthe HTML pages of all the
main requests as well asimages,
stylesheets, and other subrequested
pages. Thisdataisused to visually
recreate the pages asthey appeared
when recording.

<filename>. Vi sXn Containsany XML/SOAP
information that was recorded.

<filename>. cpp A C++ representation of your script.

206



Script Development Workbench

Inserting Script Items
Inserting tree items

You can insert anumber of script itemsinto your converted script.

To insert tree items:

1. Do oneof thefollowing:

= From the Script Development Workbench main menu, choose Visual
Navigator>Insert Tree Item.

= Right-click in the tree-view (left pane) and choose Insert Tree Item.
2. Choosetheitem to insert.

Most of the inserted items can be moved up and down the tree using the Up/Down arrowsin the form-
view (bottom pane) for that item. You can also delete an item highlighted in the tree-view by choosing
Delete Tree Item from the menu.

The following script items can be inserted from the Visual Navigator menu:
Extract Sring

Cookie

Http Header

Content Check

CGI Parameter

Synch

IP Spoof

Read Datapool

Checkpoint pair

Increment Variable/Decrement Variable/Reset Variable
Print Values (debugging)

Comment

Inserting cookiesinto a script

Cookie itemscan be added directly to the Htm| Page item they apply to, under the Action item (for
example, a Click on Link item).

To insert a cookie item:

1. In the Visual Navigator tree-view (left pane), navigate to the Htm| Page item requiring the cookie
and then click on it to select it.

2. From the menu, choose Visual Navigator>Insert Tree Item>Cookie. A Cookie form-view opensin
the bottom pane.

3. IntheNamefield, typeaname for the new Cookie or click Var Wiz... to accessthe Select Variable
dialog box where you can select a value from a datapool file or create a variable for thisfield.

4. IntheValuefield, type avalue for the new Cookie or click Var Wiz... to accessthe Select Variable
dialog box where you can select avalue from a datapool file or create a variable for thisfield.
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5. Click Save to save your changes.
The Cookie item isadded to the script for the selected Htm| Page item.
Inserting HTTP headersinto a Visual Navigator script

You can insert HTTP headersunder the Common Http Headerstree item.

To insert a new Http Header item:

1. Inthe Visual Navigator tree-view (left pane), navigate to the Common Http Headers script item,
and then click on it.

2. From the menu, choose Visual Navigator>Insert Tree Item>Http Header. An Http Header form-
view opensin the bottom pane.

3. IntheNamefield, typeaname for the new header or click Var Wiz... to access the Select Variable
dialog box where you can select a value from a datapool file or create a variable for thisfield.

4. IntheValuefield, type avalue for the new header or click Var Wiz... to access the Select Variable
dialog box where you can select avalue from a datapool file or create a variable for thisfield.

5. Click Save to save your changes.

The header item isadded to the script, and will be used for all requests at playback unlessit is overwritten
by a header with the same name underneath an individual request action.

XML Support
XML Support

QALoad's XML support ishandled through the Sript Development Workbench's Visual Navigator, which
displaysyour script'sHTTP or XML requestsin an easy-to-use, visually-based interface that offersyou
point-and-click script editing. Although XML issupported through the Visual Navigator, Compuware
recommends you read through thishelp topic aswell asthe Visual Navigator help topicsto become
familiar with the featuresthat are unique to QALoad's XML support.

When an HTTP request is made for an XML document, either in the form of an HTTP GET request or an
HTTP POST request with an XML document asthe post data, the dataisdisplayed in the three Visual
Navigator panes asillustrated below. Click on apanein the graphic for adescription of itscontentsand
functionality.

Note: To make the following graphic fit better in this help window, the Script Development Workbench
toolbars and panesthat are not directly related to this help topic are not displayed. You can hide/show many
of the Script Development Workbench toolbars and panes using commands available from the View menu.
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When an HTTP request is for an XML document, either in the form of an HTTP GET request, or an HTTP
POST request with an XML document asthe post data, then an XML Request tree item isdisplayed in the
tree-view (left pane). The form-view (bottom pane) for an XML Request item includesthe following fields:

Reply Status: Thereply status code. The status code is 200 OK for most pagesthat return correctly.
Request URI: Thisread-only field showsthe URI requested, which resulted in this page being displayed.

Checkpoint Name: If the page has atitle, it isused asthe checkpoint name. If not, the word Checkpoint is
used. To make sure all checkpoint names are unique, QALoad addsa number to the beginning of the
checkpoint name.

XML Request Sub-items

An XML Request item can contain the following sub-items.

XML Reply

The URI of the document returned as aresult of the XML request. XML data corresponding to thereply is
displayed in the browser-view.

HTTP Headers

If aheader existsunder an action item, it issent for that request only. If the header hasthe same name as
one of the common headers, it overridesthe common header for thisrequest only. The form-view (bottom
pane) for an HTTP header listsitsname and value. Because thereisno XML datarecorded for a header, the
browser-view remains empty. It ispossible to insert additional HTTP Headers.
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Cookies CGIl Parameter

The Cookiestree item containsalist of Cookieitemsthat were sent in the header of the request that this
item made while being recorded. Cookies are added automatically by the browser based on the URI that is
being requested. They are either set asaresult of the previousreply (server returned a Set-Cookie
command), or they are set by JavaScript contained in the previousreply. The form-view for a cookie item
listsitsname and value. Because thereisno XML datarecorded for a header, the browser-view remains
empty.

XML Document-view

When you click on an XML Request item in the tree-view (left pane) theright pane becomes a document-
view displaying a tree-view of details about the XML document requested or returned asthe result of an
XML request. Each individual XML item appearsasanodein the XML document tree. XML elements can
have child elementsand these appear aschild nodes of the XML element. Attributes of an element appear
aschild nodes of the element, with the attribute value appearing as a child of the attribute name.

What if no XML dataisassociated with a request?
If thereisno XML document associated with the XML request (for example, an HTTP GET) a message
indicating that thereisno XML to be displayed isshown in the XML document-view.

How doesthe document-view relate to the form-view?

Selecting an item in the XML document tree displaysthe form-view details corresponding to that XML
element typein the bottom pane.

Following isan example of XML request data displayed in a portion of the XML document-view:

o1 &P wml version="1,0"
- @ HTML
El@ wmins: sl
L= b w3,
= ® BODY
...@ STYLE
& Sl
- @ xshifor-sach

XML Form-view

When an XML request isdisplayed in the document-view (top pane) — as aresult of an XML request item
or XML reply child item being selected in the Visual Navigator tree-view — you can click on itemsin the
document-view to display information about each in the form-view (bottom pane). If no XML item is
selected in the document-view, the XML Page form-view displaysinstead. For XML items, the form view
display optionsdepend on two things:

I what type of XML item isselected in the Visual Navigator tree-view (left pane): an XML request or
an XML reply

I what type of XML item issubsequently selected in the XML document-view (top pane)

When an XML item isselected in the XML document-view, the value of that XML item isdisplayed in an
edit box in the form-view. Some values — attribute values and text values — can be edited or variablized
(that is, substituting one or more variables for the valuein an XML request or selecting the return value
from an XML reply item to be received by a variable for later use in the script). Text items, which are values
between element tags, and attribute valuesrepresent volatileitemsin an XML document structure, used for
passing valuesto and from Web Services, for example.
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The following tableslist the possible actions for XML items displayed in aform-view. Valid actions are
determined by the XML item type and whether the item isfrom an HTTP POST request or from an HTTP

reply.
In the following tables:
I If an item is editable, the value in the form-view can be changed and the new value isused during
replay.
I If avalue can be variablized, a variable can be substituted for all or part of the value. The variable's

valueisplaced in the variable's location at replay. An exampleisavalue received from an item
from a previous XML document reply.

I If avariable can receive areplay value, the return value for the item can be placed into a selected
variable during replay. The variable can then be substituted for an input valuein alater XML
request.

XML Request Item Editable? Can the Value
be Variablized?

Declaration No No
DTD (Document No No
Type Definition)

Pl (Processing No No
Instruction)

Comment No No
Element No No
Attribute (Name) No No
Attribute (Value) Yes Yes
Text Yes Yes

XML Request Item Can Variable
Receive Replay
Value

Declaration No

DTD (Document Type = No

Definition)
Pl (Processing No
Instruction)
Comment No
Element No

211



Script Development Workbench

Attribute (Name) No
Attribute (Value) Yes
Text Yes

Sample Scripts

Overview — Sample Scripts

This section shows examples of how you can manipulate converted scriptsto address specific situations or
resolve certain problems. Samplesinclude examples of variablization, changesto transaction logic, and
detailed descriptions of commonly used commands. Sample scripts are shown for these middlewares:

Citrix

Oracle Forms Server
SAP

Winsock

WWW

Citrix Scripts

Citrix Script Samples

You can address specific situations or resolve certain problems by modifying converted Citrix scripts.

The scriptslisted below include a description of the problem, the procedure for implementing the
modification, and samples of a modified script.

Handling Citrix Server Farms

Handling Dynamic Window Titles

Handling Intermittent Windows

Handling Unexpected Events

Moving Citrix Connect and Disconnect Outside the Transaction Loop
Scripting Mouse Actions

Using the CtxWaitForScreenUpdate Command

Flushing Past Eventsfrom the Internal Queue

Handling Citrix Server Farms

Handling Citrix Server Farms
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Citrix serverscan be grouped in farms. When load testing, you may want to connect to a Citrix server farm
rather than to a specific server. Load testing requirements may include connecting to a Citrix server farm,
where the load balancing feature supports dynamic redirection to a given server at connection time. This
load teststhe server farm and Citrix load balancing rather than a single server, which can provide amore
realistic load test.

To record a script that connectsto afarm, you must use an ICA file to connect. However, when a capture
takes place, a specific server (in the farm) must have a connection. Secify the correct ICA file to connect
to the server farm as well as a specific server within that server farm.

To verify that your script isconnecting to a server farm and not a specific server, assign the server name to
one blank space when validating the script. In order to record a script that connectsto afarm, you must
use an ICA file specified in the Citrix Record Optionsdialog. Snce the ICA file should contain all the
necessary connection information, the server field should be left blank when recording.

When converted, the CitrixServer variable has a blank space:

/* Declare Variables */
const char *Citri xServer ;
"citrix";

const char *CitrixUsernanme =
const char *CitrixPassword = "~encr~657E06726F697206";
const char *Citri xDomain = "gacitrix2";

const int CitrixQutputMde OQUTPUT_MODE_NORVAL;

SET_ABORT_FUNCTI ON( abort _function);
DEFI NE_TRANS_TYPE(" Orders. cpp");
Citrixlnit(4);

[* Citrix replay settings */

Ct xSet Connect Ti meout (90) ;

Ct xSet Di sconnect Ti meout (90) ;

Ct xSet W ndowTi neout ( 30) ;

Ct xSet Pi ngTi neout (20) ;

Ct xSet Wi t Poi nt Ti meout ( 30) ;

Ct xSet W ndowVeri fi cati on( TRUE) ;

Ct xSet Domai nLogi nl nfo(GitrixUsernane, CitrixPassword, Citrix-Domain);
Ct xSet | CAFi | e("PRD desktop.ica");
Ct xSet Enabl eCount er s( TRUE) ;

Ct xSet W ndowRet ri es(5, 5000);

Ct xSet Enabl eW | dcar divat chi ng( TRUE) ;

SYNCHRONI ZE() ;
The Citrix client ignoresthisvalue and usesthe ICA file to dynamically retrieve the server name at
playback time.

Conclusion

When you use these techniquesto set up a Citrix server farm test script, you allow for dynamic server
redirection at playback as part of testing aload balanced Citrix server farm.
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Sample Script for Handling Citrix Server Farms

The following sample shows a snippet of a Citrix script that setsup a server farm test script.

Sample Script

/* Converted using the follow ng options:
* General :
* Line Split : 80 characters
* Sl eep Seconds B
* Auto Checkpoints : No
* Ctrix
* Ceneral Options :
* Repl ay Qut put Mde : Nor nal
* Enabl e Counters : No
*  Tinmeout Value Options :
* Connect Ti meout (S) : 60
* Di sconnect Ti meout (s) : 60
* W ndow Creation Tineout (s) : 30
* Pi ng Tineout (s) ;20
* Wait Point Timeout (S) : 30
* | nput Options :
* Conbi ne Keyboard | nput : Yes
* Conbi ne Mouse | nput . Yes
* W ndow Options :
* W ndow Verification : Yes
* W ndow Max Retries 5
* W ndow WAit Retries (ms) : 5000
* Enable Wldcard Title Match : Yes
*

/

#define Cl TRI X_CLI ENT_VERSI ON " 8. 100. 29670"
#define Cl TRI X_| CO_VERSI ON "2.4"
#defi ne SCRI PT_VER 0x00000505UL

#i ncl ude <stdio. h>
#i ncl ude "smacro. h"

#include "do_citrix.h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O
#endi f

extern "C' int rhobot_script(PLAYER | NFO *s_i nf o)
{

/* Declare Variables */

NNy
/1l Convert sets the Citrix server nanme to a single blank
/1l space. This is only necessary to verify that the script actually is connecting to a
server farm
NNy
const char *CitrixServer =" ",

const char *CitrixUsernanme = "test";
const char *Citri xPassword = "~encr ~657E06726F697206" ;
const char *CitrixDomain = "test";

const int Ci trixQut put Mode OQUTPUT_MODE_NORVAL;

/* Citrix Wndow Infornation Objects */

CxW *CwW_1 new Ct xW (0x1001c, "Warning !'!", 107, 43, 427, 351);

G xW *CW_2 new Ct xW (0x5001c, "Please wait...", 111, 112, 418, 145);
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G xW *CW _3 = new CtxW (0x40030, "Citrix License Warning Notice", 125, 198, 397, 127);
G xW *CW _4 = new Ct xW (0x4002e, "UsrLogon.Cnd", 0, 456, 161, 25);

G xW *CW _5 = new CtxW (0x1003a, "", -2, 452, 645, 31);

G xW *CW _6 = new Ct xW (0x10066, "I CA Seam ess Host Agent", 0, 0, 391, 224);

G xW *CW _7 = new Ct xW (0x10052, "Program Manager", 0, 0, 641, 481);

CxW *CW_8 = new Ct xW (0x1008c, "", 115, 0, 405, 457);

G xW *CW _9 = new Ct xW (0x2006c, "Cal culator", 66, 66, 261, 253);

SET_ABORT_FUNCTI ON( abort _function);
DEFI NE_TRANS_TYPE( " capCt xSer ver Farm cpp") ;

Ctrixlnit(1l);

/* Citrix replay settings */

Ct xSet Connect Ti meout ( 60) ;

Ct xSet Di sconnect Ti neout (60) ;

Ct xSet W ndowTi nmeout ( 30) ;

Ct xSet Pi ngTi meout (20) ;

Ct xSet Wi t Poi nt Ti meout ( 30) ;

Ct xSet W ndoweri fi cati on( TRUE) ;

Ct xSet Dorai nLogi ninfo(CitrixUsernane, G trixPassword, CitrixDomain);
Ct xSet | CAFi | e("PRD desktop.ica");
Ct xSet Enabl eCount er s( FALSE) ;

Ct xSet W ndowRet ri es(5, 5000);

Ct xSet Enabl eW | dcar divat chi ng( TRUE) ;

SYNCHRONI ZE( ) ;

.rest of script..

Handling Dynamic Window Titles
Modifying the Script to Handle Dynamic Window Titles

Window titles can vary based on the state of the application. For example, Microsoft Word windows may
appear with the name of a default document title as part of the window name. Other window titles may
contain theuser’'sname, or the day or time. When awindow namein the record session varies from the
namein avalidation or playback session, the script failswith awindow title mismatch error.

When thiserror occursduring validation or playback, you must modify the script to recognize the base
pattern of the window title name rather than an exact window title. You can do thisduring conversion by
adding CtxWaitForWindowCreate callsto the script for each named window creation event.

When you modify a script for these occurrences, you must:
I Modify therecording process
I Perform an initial validation
I Ildentify a Match Pattern
I Modify the script
! Revalidate the script
Note: You may need to configure the workbench and player for validation.

To modify the recording process:

1. Record the Citrix session with the proper options selected.

2. Click Options>Convert, then click the Citrix tab.
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3. Ensurethat the Enable Wildcard Title Match check box is selected.
4. Click OK to convert therecording.

To perform an initial validation after script record and conversion:

1. Click Session>Validate Script.

2. When the validation session generatesthe window title mismatch error, compare the actual
window title nameto the expected window title name.

El Note: Repeated validations should generate a list of one or more window titles that differ from the
expected title.

To perform a Match Pattern identification:

Identify a match pattern that compares all actual window titlesto original window titlesusing thelist of
window titlesfrom validations.

Note: Thisregular-expression style match pattern usesthe normal character set. Asterisks (*) denote O to n
wildcard characters. Question marks denote one wildcard character.

To modify the script:

Make the script changes when you identify aworkable match pattern for the dynamic window.

1. Inthescript, ensurethat the CtxSetEnableWildcardMatching command exists before the
SYNCHRONIZE command.

2. Ensurethat the CtxSetEnableWildcardMatching parameter valueis set to TRUE.

El Note: This statement isinserted when you set the Enable Wildcard Title Match option in
Options>Convert before converting the recording.

3. Insert aCtxSetWindowMatchTitle command before the CtxWaitForWwindow Create call for each
window creation wait event for the dynamic window. The parametersinclude the Citrix window
identifier and theidentified match pattern for the dynamic window.

To revalidate the script:

1. Click Session>Validate Script.
2. If the CtxWaitForwindow Create wait event call fails, identify the actual window title returned.
3. Perform the match pattern identification step and re-create a valid wildcard string to match all
expected window values.
Conclusion

Following these techniques, you can modify window creation eventsto recognize dynamic window titles.
The sample scriptsillustrate how to determine a base pattern for the window title by sequential validations
of the script and how to make relevant changesto the script. The first example uses a substring match to
recognize the dynamic window title. The second example uses awildcard match to accomplish this.
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Example One

Script Samples: Example One - Using a Substring Match

In thisexample, the Microsoft Word application generatesa dynamic title. Thedynamic nameisa
concatenation of the default document that Word creates at application startup with the name of the
application.

Original Window Title (Record)  “Microsoft Word”

Actual Window Title (Validation) “documentl - Microsoft Word”

|Actual Window Title (Validation) “document 2 - Microsoft Word”

The script isaltered to reflect the fact that the string “Microsoft Word” is always part of the window title.
The asterisk (*) wildcard is substituted for the default document name.

“Match Pattern” from window “* - Microsoft Word”
titles

Sample: Original Citrix Script

Thisisan example of an original Citrix script converted from capture. In this example, the Microsoft Word
application generates adynamic title. The dynamic nameisaconcatenation of the default document that
Word creates at application startup with the name of the application. Points of interest in the script are
highlighted in bold.

Sample Script
/*
* dynam cwi ndow. cpp
*
* Script Converted on April 18, 2005 at 12:13:47 PM
* CGenerated by Compuware QALoad convert nodul e version 5.5.0 build 256
*
* This script contains support for the follow ng niddl ewares:
* - Gtrix
*/
/* Converted using the follow ng options:
* General :
* Line Split : 80 characters
* Sl eep Seconds 1
* Auto Checkpoints : No
* Citrix
*  CGeneral Options :
* Repl ay Qut put Mde : Nor mal
* Enabl e Counters : No
*  Tinmeout Value Options :
* Connect Ti meout (s) : 60
* Di sconnect Ti meout (s) : 60
* W ndow Creation Tineout (s) ;30
* Pi ng Tineout (s) ;20
* Wait Point Tinmeout (S) : 30
* | nput Options :
* Conbi ne Keyboard | nput : Yes
* Conbi ne Mouse | nput . Yes
* W ndow Options :
* W ndow Verification . Yes
* W ndow Max Retries 5
* W ndow Wait Retries (ms) : 5000
* Enabl e Wldcard Title Match : Yes
*
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#define Cl TRI X_CLI ENT_VERSI ON "7.100.21825"
#define Cl TRI X_| CO_VERSI ON "2.3"
#defi ne SCRI PT_VER 0x00000505UL

#i ncl ude <stdio. h>
#i ncl ude "smacro. h"

#include "do_citrix.h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O
#endi f

extern "C' int rhobot_script(PLAYER | NFO *s_i nf o)
{
/* Declare Variables */
const char *Citri xServer
const char *CitrixPassword
const int CitrixQut put Mbde

"qaccitrix";

QUTPUT_MODE_NORMAL

[* Citrix Wndow I nformation Objects */

G xW *CW _1 = new C xW (0x1001lc, "Warning !!", 107, 43, 427, 351);

G xW *CW _2 = new C xW (0x2001c, "Log On to Wndows", 111, 65, 418, 285);

G xW *CW _3 = new C xW (0x5001c, "Please wait...", 111, 112, 418, 145);

CGxW *CW _4 = new C xW (0x30030, "Citrix License Warning Notice", 125, 198, 397, 127);
G xW *CW _5 = new C xW (0x40030, "Citrix License Warning Notice", 125, 198, 397, 127);
CGxW *CW _6 = new C xW (0x4002e, "UsrLogon.Cnd", 0, 456, 161, 25);

CxW *CW _7 = new CtxW (0x1003a, "", -2, 452, 645, 31);

G xW *CW _8 = new Ct xW (0x10066, "ICA Seanml ess Host Agent", 0, 0, 391, 224);

CtxW *CW _9
CtxW *CW _10
CtxW *CwW _11

/!l Note the initia
CtxW *CW _12
CtxW *CW _13

new Ct xW (0x10052, "Program Manager", 0, 0, 641, 481);
new Ct xW (0x1008c, "", 115, 0, 405, 457);
new Ct xW (0x20068, "", 112, 116, 416, 248);
window title of “Mcrosoft Wrd” is set here in the script..
new Ct xXW (0x2006e, "M crosoft Wrd", -4, -4, 649, 461);
new Ct xW (0x7001c, "Please wait...", 111, 112, 418, 145);

SET_ABORT_FUNCTI ON( abort _function);
DEFI NE_TRANS_TYPE( " dynami cwi ndow. cpp");
Citrixlnit(1);

[* Citrix replay settings */

Ct xSet Connect Ti meout (60) ;

Ct xSet Di sconnect Ti meout ( 60) ;

Ct xSet W ndowTi neout ( 30) ;

Ct xSet Pi ngTi neout (20) ;

Ct xSet Wai t Poi nt Ti neout (30) ;

Ct xSet W ndowVeri fi cati on( TRUE) ;

Ct xSet Enabl eCount er s( FALSE) ;

Ct xSet W ndowRet ri es(5, 5000);
Ct xSet Enabl eW | dcar divat chi ng( TRUE) ;

SYNCHRONI ZE() ;

BEG N_TRANSACTI ON( ) ;

DO _Set TransactionStart();

Ct xConnect (CitrixServer, CitrixQutputMde);
Ct xPoint (164, 61); [//1113840775.516

218



Script Development Workbench

/1 Wndow CW _1 ("Warning !!") created 1113840775.516
Ct xWai t For W ndowCr eat e(CW _1, 1969);

DO_NMSLEEP( 2046) ;
Ct xPoi nt (332, 359); //1113840777.629

DO_MSLEEP( 63) ;
Ctxdick(CW _1, 94, L_BUTTON, NONE); //1113840777.723

/1 Wndow CW _2 ("Log On to Wndows") created 1113840777. 817
Ct xWai t For W ndowCr eat e(CW _2, 93);

DO_MSLEEP( 16) ;
/1 Wndow CW _1 ("Warning !!") destroyed 1113840777.833

CtxType(CW 2, "citrix"); //1113840786.615

DO_MBLEEP( 8547) ;
CtxTypeVK(CW 2, VK _TAB, NONE); //1113840786.678

DO _MBLEEP(281)
CtxType(CW 2, "citrix"); //1113840788.650

DO VBLEEP(1672) ;
Ot xTypeVK(CW 2, VK _TAB, NONE); //1113840788.713

DO _MBLEEP( 359)
CtxType(CW _2, "g"); //1113840789.683

DO_MSLEEP( 438) ;

DO _MBLEEP(1078) ;
Ct xPoi nt (231, 325); //1113840790. 309

DO_MBLEEP( 78) ;
Ct xMouseDown( CW _2, L_BUTTON, NONE, 231, 325); // 1113840790.309

Ct xMouseUp(CW _2, L_BUTTON, NONE, 232, 325); //1113840790. 388

Ct xPoi nt (232, 325); //1113840790.544

/1 Wndow CW _3 ("Please wait...") created 1113840790. 544

Ct xWai t For W ndowCr eat e( CW _3, 204);

/1 Wndow CW _2 ("Log On to Wndows") destroyed 1113840790. 544

/1 Wndow CW _4 ("Citrix License Warning Notice") created 1113840790. 591
Ct xWai t For W ndowCr eat e(CW _4, 46);

DO_MSLEEP( 16) ;
/[l Wndow CW _3 ("Please wait...") destroyed 1113840790. 607

/1 Wndow CW _5 ("Citrix License Warning Notice") created 1113840790. 654
Ct xWai t For W ndowCr eat e( CW _5, 47);

DO_MSLEEP( 16) ;
/1 Wndow CW _4 ("Citrix License Warning Notice") destroyed 1113840790. 669

/1 Wndow CW _6 ("UsrLogon. Crd") created 1113840790. 716
Ct xWai t For W ndowCr eat e(CW _6, 46);
DO_MSLEEP( 16) ;
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/1 Wndow CW _6 ("UsrLogon. Cnmd") destroyed 1113840790. 732
/1 Wndow CW _7 ("") created 1113840790. 967

DO_MSLEEP( 234) ;
/1 Wndow CW _8 ("I CA Seam ess Host Agent") created 1113840791. 014

Ct xWai t For W ndowCr eat e( CW _8, 47);

/1 Wndow CW _9 ("Program Manager") created 1113840791. 030
Ct xWai t For W ndowCr eat e(CW _9, 16);

Ct xPoi nt (347, 249); //1113840793. 080

/1 Wndow CW _10 ("") created 1113840793. 080

DO_MSLEEP( 16) ;

DO_MBLEEP( 1203) ;
CtxPoi nt (571, 256); //1113840796.133

DO_MSLEEP(1844) ;
/1 Wndow CW _10 ("") destroyed 1113840796. 133

DO_NMSLEEP( 1828) ;
Ct xPoi nt (446, 208); //1113840798. 309

DO_MSLEEP( 344) ;
Ctxdick(CW _5, 78, L_BUTTON, NONE); //1113840798.387

DO_MBLEEP( 437) ;
Ct xPoi nt (311, 303); //1113840798.935

DO_MSLEEP( 110) ;
Ctxdick(CW _5, 109, L_BUTTON, NONE); //1113840799. 045

DO_MSLEEP( 94) ;
/1 Wndow CW _5 ("Citrix License Warning Notice") destroyed 1113840799. 138

DO_MSLEEP( 390) ;
CtxPoint (275, 1); //1113840799.718

DO _VBLEEP( 188) ;
CtxClick(CW _8, 62, L_BUTTON, NONE); //1113840799. 780

DO _MBLEEP( 703)
Ct xPoi nt (200, 187); //1113840800.579

DO_MBLEEP( 94) ;
Ctxdick(CW 8, 78, L_BUTTON, NONE); //1113840800.657

DO MVBLEEP( 110) ;
Ct xPoi nt (209, 192); //1113840800. 766

/1 Wndow CW _8 ("I CA Seanm ess Host Agent") destroyed 1113840800. 766

DO _MBLEEP(5328) ;
CtxPoi nt (115, 175); //1113840806. 245

DO _MBLEEP( 140) ;
Ct xDoubl eCl i ck(CW _9); // 1113840806. 621

Ct xMouseUp(CW _7, L_BUTTON, NONE, 114, 174); //1113840806.512
DO_MSLEEP( 16) ;
CtxPoint (114, 174); //1113840806. 621
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DO_MSLEEP( 359) ;
Ct xPoi nt (284, 205); //1113840807.028

// Wndow CW _11 ("") created 1113840807.028

DO _MBLEEP( 16) ;
Ct xPoi nt (309, 208); //1113840807.326

/1 Wndow CW _12 ("M crosoft Wrd") created 1113840807. 326

/1! The wi ndow create wait event. |If the windowtitle at replay
/1] is any different that “Mcrosoft Wrd~”, this wait event wll FAIL.
Ct xWai t For W ndowCr eat e(CW _12, 266);

DO_MSLEEP( 46) ;
CW _12->setTitl e("Docurmentl - Mcrosoft Wrd"); //1113840807. 388

DO_MSLEEP( 16) ;
/1 Wndow CW _11 ("") destroyed 1113840807. 388

DO _MBLEEP( 4188) ;
CtxPoi nt (626, 8); //1113840811.693

DO _MBLEEP(109) ;
CtxClick(CW _12, 94, L_BUTTON, NONE); //1113840811.787

DO _MVBLEEP( 218) ;
Ct xPoi nt (623, 40); //1113840812. 006

/1 Wndow CW _12 ("Documentl - Mcrosoft Word") destroyed 1113840812. 006

DO_NMSLEEP( 2204) ;
Ct xPoi nt (385, 1): //1113840815. 262

DO_MBLEEP( 1046) ;
/1 Wndow CW _9 ("Program Manager") destroyed 1113840815. 262

/1 Wndow CW _7 ("") destroyed 1113840815. 262

/1 Wndow CW _13 ("Please wait...") created 1113840815.513
Ct xWai t For W ndowCr eat e(CW _13, 0);

DO _Set Transacti onC eanup() ;

Ct xDi sconnect ();

END_TRANSACTI ON() ;

delete CW _1; // "Warning !!"

delete CW_2; // "Log On to W ndows"

delete CW _3; // "Please wait..."

delete CW _4; // "Citrix License Warning Notice"
delete CW _5; // "Citrix License Warning Notice"
delete CW _6; // "UsrlLogon. Crd"

delete CW _7; [/ ""

delete CW _8; // "ICA Seanl ess Host Agent"
delete CW _9; // "Program Manager"

delete CW _10; // ""

delete CW _11; // ""

delete CW _12; // "Mcrosoft Wrd"

delete CW _13; // "Please wait..."

CitrixUninit();

EXI T();
return(0);

221



Script Development Workbench

voi d abort_functi on( PLAYER | NFO *s_i nf 0)

{
RR_printf("Virtual User ABORTED.");

CitrixUninit();

EXIT();

Sample One: Modified Citrix Script

In thisexample, the Microsoft Word application generates dynamic title that isaconcatenation of the
default document that Word creates at application startup with the name of the application. This script is
altered to reflect the fact that the string “Microsoft Word” is always part of the window title. The asterisk
(*) wildcard is substituted for the default document name. Changesto the original script are highlighted in
bold.

Sample Script

/*

* dynam cwi ndow. cpp

*

* Script Converted on April 18, 2005 at 12:13:47 PM

* CGenerated by Compuware QALoad convert nodule version 5.5.0 build 256
*

* This script contains support for the follow ng niddl ewares:

* - Ctrix

*

~

/* Converted using the follow ng options:

* Ceneral :

* Line Split : 80 characters
* Sl eep Seconds B

* Auto Checkpoints : No

* Citrix

* Ceneral Options :

* Repl ay Qut put Mde : Nor ral
* Enabl e Counters : No

*  Tinmeout Value Options :

* Connect Ti meout (S) : 60

* Di sconnect Ti meout (s) : 60

* W ndow Creation Tineout (s) : 30

* Pi ng Tineout (s) ;20

* Wait Point Tinmeout (S) : 30

* | nput Options :

* Conbi ne Keyboard | nput : Yes
* Conbi ne Mouse | nput . Yes
* W ndow Options :

* W ndow Verification . Yes
* W ndow Max Retries 5

* W ndow Wait Retries (ms) : 5000
* Enabl e Wldcard Title Match : Yes
*

/
#define CI TRI X_CLI ENT_VERSI ON "7.100.21825"
#define Cl TRI X_| CO_VERSI ON "2.3"
#defi ne SCRI PT_VER 0x00000505UL

#i ncl ude <stdi o. h>
#i ncl ude "smacro. h"

#include "do_citrix.h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);
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#i f ndef NULL
#define NULL O
#endi f

extern "C'" int rhobot _script (PLAYER | NFO *s_i nfo)
{
/* Declare Variables */
const char *CitrixServer
const char *Citri xPassword
const int Ci trixQut put Mbde

"qaccitrix";

QUTPUT_MODE_NORMAL

[* Citrix Wndow | nformation Cbjects */

G xW *CW _1 = new C xW (0x1001lc, "Warning !!", 107, 43, 427, 351);

CGxW *CW _2 = new C xW (0x2001c, "Log On to Wndows", 111, 65, 418, 285);

G xW *CW _3 = new C xW (0x5001c, "Please wait...", 111, 112, 418, 145);

CGxW *CW _4 = new C xW (0x30030, "Citrix License Warning Notice", 125, 198, 397, 127);
G xW *CW _5 = new C xW (0x40030, "Citrix License Warning Notice", 125, 198, 397, 127);
G xW *CW _6 = new C xW (0x4002e, "UsrLogon.Cnd", 0, 456, 161, 25);

CxW *CW _7 = new CtxW (0x1003a, "", -2, 452, 645, 31);

CGxW *CW _8 = new Ct xW (0x10066, "ICA Seanm ess Host Agent", 0, 0, 391, 224);

G xW *CW_9 new Ct xW (0x10052, "Program Manager", 0, 0, 641, 481);
G xW *CW _10 = new Ct xW (0x1008c, "", 115, 0, 405, 457);
CGxW *CW _11 = new CtxW (0x20068, "", 112, 116, 416, 248);
/1 The initial windowtitle of “Mcrosoft Wrd” does not change
G xW *CW _12 = new Ct xW (0x2006e, "M crosoft Word", -4, -4, 649, 461);
CGxW *CW _13 = new Ct xW (0x7001c, "Please wait...", 111, 112, 418, 145);

SET_ABORT_FUNCTI ON( abort _function);

DEFI NE_TRANS_TYPE( " dynam cwi ndow. cpp");
Citrixlnit(1);

[* Citrix replay settings */

Ct xSet Connect Ti meout ( 60) ;

Ct xSet Di sconnect Ti neout (60) ;

Ct xSet W ndowTi meout ( 30) ;

Ct xSet Pi ngTi neout (20) ;

Ct xSet Wai t Poi nt Ti meout ( 30) ;

Ct xSet W ndowVeri fi cati on( TRUE) ;

Ct xSet Enabl eCount er s( FALSE) ;

Ct xSet W ndowRet ri es(5, 5000);

Ct xSet Enabl eW | dcar divat chi ng( TRUE) ;
SYNCHRONI ZE() ;

BEG N_TRANSACTI ON() ;

DO _Set TransactionStart();

Ct xConnect (CitrixServer, CitrixQutputMde);
Ct xPoint (164, 61); //1113840775.516

/1 Wndow CW _1 ("Warning !!") created 1113840775.516
Ct xWai t For W ndowCr eat e(CW _1, 1969);

DO_NMSLEEP( 2046) ;
Ct xPoi nt (332, 359); //1113840777.629

DO_MBLEEP( 63) ;
Ctxdick(CW _1, 94, L_BUTTON, NONE); //1113840777.723

/1 Wndow CW _2 ("Log On to Wndows") created 1113840777. 817

Ct xWai t For W ndowCr eat e(CW _2, 93);
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DO_NMSLEEP( 16) ;
/1 Wndow CW _1 ("Warning !!") destroyed 1113840777.833
CtxType(CW _2, “citrix"); //1113840786.615

DO_MBLEEP( 8547) ;
CtxTypeVK(CW 2, VK _TAB, NONE); //1113840786.678

DO _MVBLEEP( 281) ;
CtxType(CW 2, "citrix"); //1113840788.650

DO_MBLEEP(1672) ;
CtxTypeVK(CW 2, VK _TAB, NONE); //1113840788.713

DO _MBLEEP( 359) ;
CtxType(CW 2, "g"); //1113840789.683

DO MVBLEEP( 438) ;

DO MVBLEEP(1078) ;
Ct xPoi nt (231, 325); //1113840790. 309

DO_MBLEEP( 78) ;
Ct xMouseDown( CW _2, L_BUTTON, NONE, 231, 325); // 1113840790.309

Ct xMbuseUp(CW _2, L_BUTTON, NONE, 232, 325); //1113840790. 388
Ct xPoi nt (232, 325); //1113840790.544

/1 Wndow CW _3 ("Please wait...") created 1113840790. 544

Ct xWai t For W ndowCr eat e( CW _3, 204);

/1 Wndow CW _2 ("Log On to Wndows") destroyed 1113840790. 544

/1 Wndow CW _4 ("Citrix License Warning Notice") created 1113840790. 591
Ct x\\ai t For W ndowCr eat e(CW _4, 46);

DO_MSLEEP( 16) ;
/[l Wndow CW _3 ("Please wait...") destroyed 1113840790. 607

/1 Wndow CW _5 ("Citrix License Warning Notice") created 1113840790. 654
Ct xWai t For W ndowCr eat e( CW _5, 47);

DO_MSLEEP( 16) ;
/1 Wndow CW _4 ("Citrix License Warning Notice") destroyed 1113840790. 669

/1 Wndow CW _6 ("UsrLogon. Crd") created 1113840790. 716
Ct xWai t For W ndowCr eat e(CW _6, 46);

DO_MSLEEP( 16) ;
/1 Wndow CW _6 ("UsrLogon.Crd") destroyed 1113840790. 732

/1 Wndow CW _7 ("") created 1113840790. 967

DO_MBLEEP(234) ;
/1 Wndow CW _8 ("I CA Seam ess Host Agent") created 1113840791. 014

Ct xWai t For W ndowCr eat e(CW _8, 47);

/1 Wndow CW _9 ("Program Manager") created 1113840791. 030
Ct xWai t For W ndowCr eat e(CW _9, 16);

Ct xPoi nt (347, 249); //1113840793. 080
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/1 Wndow CW _10 ("") created 1113840793. 080
DO_MSLEEP( 16) ;

DO_MSLEEP( 1203) ;
Ct xPoi nt (571, 256); //1113840796. 133

DO_NMBLEEP( 1844) ;
/1 Wndow CW _10 ("") destroyed 1113840796. 133

DO_NMSLEEP( 1828) ;
Ct xPoi nt (446, 208); //1113840798. 309

DO_MSLEEP( 344) ;
Ctxdick(CW _5, 78, L_BUTTON, NONE); //1113840798.387

DO_MBLEEP( 437) ;
Ct xPoi nt (311, 303); //1113840798. 935

DO MVBLEEP( 110) ;
CtxClick(CW _5, 109, L_BUTTON, NONE); //1113840799.045

DO_MSLEEP( 94) ;
/1 Wndow CW _5 ("Citrix License Warning Notice") destroyed 1113840799. 138

DO _MBLEEP( 390) ;
CtxPoi nt (275, 1); //1113840799. 718

DO _MBLEEP( 188)
CtxClick(CW _8, 62, L_BUTTON, NONE); //1113840799. 780

DO_MSLEEP( 703) ;
Ct xPoi nt (200, 187); //1113840800.579

DO_MBLEEP( 94) ;
CtxClick(CW_8, 78, L_BUTTON, NONE); //1113840800. 657

DO_MSLEEP( 110) ;
Ct xPoi nt (209, 192); //1113840800. 766

/1 Wndow CW _8 ("ICA Seam ess Host Agent") destroyed 1113840800. 766

DO MBLEEP(5328) ;
CtxPoi nt (115, 175); //1113840806. 245

DO _MBLEEP( 140) ;
Ct xDoubl eCl i ck(CW _9); // 1113840806. 621

Ct xMouseUp(CW _7, L_BUTTON, NONE, 114, 174); //1113840806.512

DO_MSLEEP( 16) ;
CtxPoint (114, 174); //1113840806. 621

DO_MSLEEP( 359) ;
Ct xPoi nt (284, 205); //1113840807.028

// Wndow CW _11 ("") created 1113840807.028

DO _MBLEEP( 16) ;
Ct xPoi nt (309, 208); //1113840807.326

/1 Wndow CW _12 ("M crosoft Wrd") created 1113840807. 326

JHLEEELEEEE i rriririrrln
/1l The C xSet Wndowivat chTitle command is inserted before the

/11 CtxWaitForWndowCreate call. Note that the window identifier is the
/1l same for both calls, and the “match pattern” for the command is from

225



Script Development Workbench

/11 Exanple One in the Match Pattern ldentification section above.
NNy

Ct xSet W ndowivat chTitl e(CM_12, "*M crosoft Wrd"" );

/1] The wi ndow create wait event call does not change.
Ct xWai t For W ndowCr eat e(CW _12, 266);

DO_MSLEEP( 46) ;
CW _12->setTitl e("Docurmentl - Mcrosoft Wrd"); //1113840807. 388

DO_MSLEEP( 16) ;
/1 Wndow CW _11 ("") destroyed 1113840807. 388

DO_MBLEEP(4188) ;
Ct xPoi nt (626, 8); //1113840811.693

DO _MBLEEP( 109) ;
CtxClick(CW _12, 94, L_BUTTON, NONE); //1113840811.787

DO _MVBLEEP( 218) ;
Ct xPoi nt (623, 40); //1113840812.006

/1 Wndow CW _12 ("Documentl - Mcrosoft Word") destroyed 1113840812. 006

DO_NMSLEEP( 2204) ;
Ct xPoi nt (385, 1): //1113840815. 262

DO_MBLEEP( 1046) ;
/1 Wndow CW _9 ("Program Manager") destroyed 1113840815. 262

/1 Wndow CW _7 ("") destroyed 1113840815. 262

/1 Wndow CW _13 ("Please wait...") created 1113840815.513
Ct xWai t For W ndowCr eat e(CW _13, 0);

DO _Set Transacti onC eanup() ;

Ct xDi sconnect ();

END_TRANSACTI ON() ;

delete CW _1; // "Warning !'!"

delete CW_2; // "Log On to W ndows"

delete CW _3; // "Please wait..."

delete CW _4; // "Citrix License Warning Notice"
delete CW _5; // "Citrix License Warning Notice"
delete CW _6; // "UsrlLogon. Crd"

delete CW _7; [/ ""

delete CW _8; // "ICA Seanl ess Host Agent"
delete CW _9; // "Program Manager"

delete CW_10; // ""

delete CW _11; // ""

delete CW _12; // "Mcrosoft Wrd"

delete CW _13; // "Please wait..."

CitrixUninit();

EXI T();

return(0);
}
voi d abort_functi on(PLAYER | NFO *s_i nf o)
{

RR_printf("Virtual User ABORTED.");
CitrixUninit();
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EXIT();

}
Example Two

Script Samples: Example Two - Using a Wildcard Match

In thisexample, the Sample Application generates a dynamic title. The dynamic nameisthe name of the
application followed by thetime the script is created.

IOriginal Window Title (Record)  “Sample Application —09:01:23 AM”
Actual Window Title (Validation) “Sample Application —11:00:04 AM”

Actual Window Title (Validation) “Sample Application —12:20:52 PM”

The question mark (?) wildcard issubstituted for a given time.

“Match Pattern” from window “Sample Application — ?2:?22:?72 2M”
|tit|es

Sample Two: Original Citrix Script

The following sampleisan original Citrix script converted from capture. In thisexample, the Sample
Application generates a dynamic title. The dynamic nameisthe name of the application followed by the
time the script is created. Points of interest in the script are highlighted in bold.

Sample Script
/*
* dynam cwi ndow2. cpp
*
* Script Converted on April 18, 2005 at 12:13:47 PM
* CGenerated by Compuware QALoad convert nodule version 5.5.0 build 256
*
* This script contains support for the follow ng niddl ewares:
* - Gtrix
*/
/* Converted using the follow ng options:
* General :
* Line Split : 80 characters
* Sl eep Seconds 1
* Auto Checkpoints : No
* Citrix
*  CGeneral Options :
* Repl ay Qut put Mde : Nor mal
* Enabl e Counters : No
* Tinmeout Value Options :
* Connect Ti meout (s) : 60
* Di sconnect Ti meout (s) : 60
* W ndow Creation Tineout (s) ;30
* Pi ng Tineout (s) ;20
* Wait Point Tineout (s) ;30
* | nput Options :
* Conbi ne Keyboard | nput . Yes
* Conbi ne Mouse | nput . Yes
* W ndow Options :
* W ndow Verification . Yes
* W ndow Max Retries 5
* W ndow Wait Retries (ms) : 5000
* Enabl e Wldcard Title Match : Yes
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*/

#define Cl TRI X_CLI ENT_VERSI ON "7.100.21825"
#define Cl TRI X_| CO_VERSI ON "2.3"
#defi ne SCRI PT_VER 0x00000505UL

#i ncl ude <stdio. h>
#i ncl ude "smacro. h"

#include "do_citrix.h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O
#endi f

extern "C'" int rhobot _script (PLAYER | NFO *s_i nfo)
{
/* Declare Variables */
const char *Citri xServer
const char *CitrixPassword
const int CitrixQut put Mbde

"qaccitrix";

QUTPUT_MODE_NORMAL

[* Citrix Wndow I nformation Objects */

CGxW *CW _1 = new C xW (0x1001lc, "Warning !!", 107, 43, 427, 351);

CGxW *CW _2 = new C xW (0x2001c, "Log On to Wndows", 111, 65, 418, 285);

G xW *CW _3 = new C xW (0x5001c, "Please wait...", 111, 112, 418, 145);

CGxW *CW _4 = new C xW (0x30030, "Citrix License Warning Notice", 125, 198, 397, 127);
G xW *CW _5 = new C xW (0x40030, "Citrix License Warning Notice", 125, 198, 397, 127);
G xW *CW _6 = new C xW (0x4002e, "UsrLogon.Cnd", 0, 456, 161, 25);

CxW *CW _7 = new CtxW (0x1003a, "", -2, 452, 645, 31);

G xW *CW _8 = new Ct xW (0x10066, "ICA Seanml ess Host Agent", 0, 0, 391, 224);

G xW *CW_9 new Ct xW (0x10052, "Program Manager", 0, 0, 641, 481);

CtxW *CW_10 = new CtxW (0x1008c, "", 115, 0, 405, 457);
CGxW *CW _11 = new CtxW (0x20068, "", 112, 116, 416, 248);
/1 Note the initial window title of “Sanple Application 09:01:23 AM’ is set here..
G xW *CW _12 = new Ct xW (0x2006e, "Sanple Application 09:01:23 AM", -4, -4, 649, 461);
CxW *CW _13 = new CtxW (0x7001c, "Please wait...", 111, 112, 418, 145);

SET_ABORT_FUNCTI ON( abort _function);
DEFI NE_TRANS_TYPE( " dynam cwi ndow. cpp");
Citrixlnit(1);

[* Citrix replay settings */

Ct xSet Connect Ti meout (60) ;

Ct xSet Di sconnect Ti meout ( 60) ;

Ct xSet W ndowTi neout ( 30) ;

Ct xSet Pi ngTi neout (20) ;

Ct xSet Wai t Poi nt Ti neout (30) ;

Ct xSet W ndowVeri fi cati on( TRUE) ;

Ct xSet Enabl eCount er s( FALSE) ;

Ct xSet W ndowRet ri es(5, 5000);

Ct xSet Enabl eW | dcar divat chi ng( TRUE) ;

SYNCHRONI ZE() ;
BEG N_TRANSACTI ON() ;
DO _Set TransactionStart();

Ct xConnect (CitrixServer, CitrixQutputMde);
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Ct xPoint (164, 61); //1113840775.516
/1 Wndow CW _1 ("Warning !!") created 1113840775.516
Ct xWai t For W ndowCr eat e(CW _1, 1969);

DO_NMSLEEP( 2046) ;
Ct xPoi nt (332, 359); //1113840777.629

DO_MSLEEP( 63) ;
Ctxdick(CW _1, 94, L_BUTTON, NONE); //1113840777.723

/1 Wndow CW _2 ("Log On to Wndows") created 1113840777. 817
Ct xWai t For W ndowCr eat e(CW _2, 93);

DO_MSLEEP( 16) ;
/1 Wndow CW _1 ("Warning !!") destroyed 1113840777. 833

CtxType(CW _2, "citrix"); //1113840786.615

DO _MBLEEP( 8547) ;
Ot xTypeVK(CW 2, VK _TAB, NONE); //1113840786.678

DO _MBLEEP( 281)
CtxType(CW 2, "citrix"); //1113840788.650

DO VBLEEP(1672) ;
Ot xTypeVK(CW 2, VK _TAB, NONE); //1113840788.713

DO _MBLEEP( 359)
CtxType(CW 2, "g"); //1113840789.683

DO_MSLEEP( 438) ;

DO_MBLEEP(1078) ;
Ct xPoi nt (231, 325); //1113840790. 309

DO _MBLEEP( 78) ;
Ct xMbuseDown( CW _2, L_BUTTON, NONE, 231, 325); // 1113840790.309

Ct xMbuseUp(CW _2, L_BUTTON, NONE, 232, 325); //1113840790. 388

Ct xPoi nt (232, 325); //1113840790. 544

/1 Wndow CW _3 ("Please wait...") created 1113840790. 544

Ct xWai t For W ndowCr eat e( CW _3, 204);

/1 Wndow CW _2 ("Log On to Wndows") destroyed 1113840790. 544

/1 Wndow CW _4 ("Citrix License Warning Notice") created 1113840790. 591
Ct xWai t For W ndowCr eat e( CW _4, 46);

DO_MSLEEP( 16) ;
/1 Wndow CW _3 ("Please wait...") destroyed 1113840790. 607

/1 Wndow CW _5 ("Citrix License Warning Notice") created 1113840790. 654
Ct xWai t For W ndowCr eat e(CW _5, 47);

DO_MSLEEP( 16) ;

/1 Wndow CW _4 ("Citrix License Warning Notice") destroyed 1113840790. 669
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/1 Wndow CW _6 ("UsrLogon. Crd") created 1113840790. 716
Ct xWai t For W ndowCr eat e(CW _6, 46);

DO_MSLEEP( 16) ;
/1 Wndow CW _6 ("UsrLogon.Crd") destroyed 1113840790. 732

/1 Wndow CW _7 ("") created 1113840790. 967

DO_MBLEEP( 234) ;
/1 Wndow CW _8 ("I CA Seam ess Host Agent") created 1113840791. 014

Ct xWai t For W ndowCr eat e(CW _8, 47);

/1 Wndow CW _9 ("Program Manager") created 1113840791. 030
Ct xWai t For W ndowCr eat e(CW _9, 16);

Ct xPoi nt (347, 249); //1113840793. 080

/1 Wndow CW _10 ("") created 1113840793. 080

DO_MSLEEP( 16) ;

DO_MBLEEP( 1203) ;
CtxPoi nt (571, 256); //1113840796. 133

DO_MSLEEP( 1844) ;
/1 Wndow CW _10 ("") destroyed 1113840796. 133

DO MVBLEEP( 1828) ;
Ct xPoi nt (446, 208); //1113840798. 309

DO_MSLEEP( 344) ;
Ctxdick(CW _5, 78, L_BUTTON, NONE); //1113840798.387

DO _MBLEEP( 437) :
CtxPoi nt (311, 303); //1113840798.935

DO_MSLEEP( 110) ;
Ctxdick(CW _5, 109, L_BUTTON, NONE); //1113840799. 045

DO_MSLEEP( 94) ;
/1 Wndow CW _5 ("CGitrix License Warning Notice") destroyed 1113840799. 138

DO_MSLEEP( 390) ;
CtxPoint (275, 1); //1113840799.718

DO_MSLEEP( 188) ;
Ctxdick(CW _8, 62, L_BUTTON, NONE); //1113840799. 780

DO _MBLEEP( 703)
Ct xPoi nt (200, 187); //1113840800.579

DO_MBLEEP( 94) ;
Ctxdick(CW 8, 78, L_BUTTON, NONE); //1113840800.657

DO MVBLEEP( 110) ;
Ct xPoi nt (209, 192); //1113840800. 766

/1 Wndow CW _8 ("I CA Seanm ess Host Agent") destroyed 1113840800. 766

DO_NMSLEEP(5328) ;
Ct xPoi nt (115, 175); //1113840806. 245
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DO _MBLEEP( 140) ;
Ct xDoubl eCl i ck(CW _9); // 1113840806. 621

Ct xMouseUp(CW _7, L_BUTTON, NONE, 114, 174); //1113840806.512

DO_MSLEEP( 16) ;
CtxPoint (114, 174); //1113840806. 621

DO _MSLEEP( 359) ;
Ct xPoi nt (284, 205); //1113840807.028
/1 Wndow CW _11 ("") created 1113840807.028

DO _MBLEEP( 16) ;
Ct xPoi nt (309, 208); //1113840807.326

/1 Wndow CW _12 ("M crosoft Wrd") created 1113840807. 326
/1l The wi ndow create wait event. |f the windowtitle at replay
/1l is any different that “Sanple Application 09:01:23 AM’, this wait event
[ will FAIL.

Ct xWai t For W ndowCr eat e(CW _12, 266);

DO_NMSLEEP( 46) ;
CW _12->setTitl e("Docunmentl - Mcrosoft Wrd"); //1113840807. 388

DO_MSLEEP( 16) ;
/1 Wndow CW _11 ("") destroyed 1113840807. 388

DO _MBLEEP( 4188) ;
CtxPoi nt (626, 8); //1113840811.693

DO_MSLEEP( 109) ;
Ctxdick(CW _12, 94, L_BUTTON, NONE); //1113840811.787

DO MVBLEEP( 218) ;
Ct xPoi nt (623, 40); //1113840812.006

/1 Wndow CW _12 ("Documentl - Mcrosoft Wrd") destroyed 1113840812. 006

DO _MBLEEP( 2204) ;
CtxPoi nt (385, 1); //1113840815. 262

DO_MSLEEP( 1046) ;
/1 Wndow CW _9 ("Program Manager") destroyed 1113840815. 262

/1 Wndow CW _7 ("") destroyed 1113840815. 262
/1 Wndow CW _13 ("Please wait...") created 1113840815. 513
Ct xWai t For W ndowCr eat e( CW _13, 0);

DO _Set Transacti onCl eanup() ;

Ct xDi sconnect () ;

END_TRANSACTI ON( ) ;

delete CW_1; // "Warning !'!"

delete CW_2; // "Log On to W ndows"

delete CW_3; // "Please wait..."

delete CW _4; // "Citrix License Warning Notice"
delete CW_5; // "Citrix License Warning Notice"
delete CW _6; // "UsrLogon. Crd"
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delete CW _7; [/

delete CW _8; // "ICA Seanl ess Host Agent"
delete CW _9; // "Program Manager"

delete CW_10; // ""

delete CW _11; // ""

delete CW _12; // "Mcrosoft Wrd"

delete CW _13; // "Please wait..."

CitrixUninit();

EXIT();
return(0);
zloi d abort _function(PLAYER_|I NFO *s_i nfo)
{ RR_printf("Virtual User ABORTED.");
CitrixUninit();
} EXIT();

Sample Two: Modified Citrix Script

The following isan example of a Citrix script modified to handle adynamic window title. In thisexample,
the Sample Application generates adynamic title. The dynamic name isthe name of the application
followed by thetime the script iscreated. The question mark (?) wildcard is substituted for a given time.
Changesto the original script are highlighted in bold.

Sample Script

/*

* dynam cwi ndow2. cpp

*

* Script Converted on April 18, 2005 at 12:13:47 PM

* CGenerated by Compuware QALoad convert nodule version 5.5.0 build 256
*

* This script contains support for the follow ng m ddl ewares:

* - Gtrix

*

~

/* Converted using the follow ng options:

* Ceneral :

* Line Split : 80 characters
* Sl eep Seconds B

* Auto Checkpoints : No

* Citrix

*  CGeneral Options :

* Repl ay Qut put Mde : Nor mal
* Enabl e Counters : No

* Tinmeout Value Options :

* Connect Ti meout (s) : 60

* Di sconnect Ti meout (s) : 60

* W ndow Creation Tineout (s) ;30

* Pi ng Tineout (s) 1 20

* Wait Point Tinmeout (s) ;30

* | nput Options :

* Conbi ne Keyboard | nput . Yes
* Conbi ne Mouse | nput : Yes
* W ndow Options :

* W ndow Verification : Yes
* W ndow Max Retries .5

* W ndow WAit Retries (ms) : 5000
* Enabl e Wldcard Title Mtch . Yes
*
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#define Cl TRI X_CLI ENT_VERSI ON "7.100.21825"
#define Cl TRI X_| CO_VERSI ON "2.3"
#defi ne SCRI PT_VER 0x00000505UL

#i ncl ude <stdio. h>
#i ncl ude "smacro. h"

#include "do_citrix.h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O
#endi f

extern "C'" int rhobot _script (PLAYER | NFO *s_i nfo)

{

/* Declare Variables */

const char *Citri xServer
const char *CitrixPassword
const int CitrixQut put Mbde

[* Citrix Wndow I nformation Objects */
CtxW *CW _1

G xW *CW _2 = new Ct xW (0x2001lc, "Log On to W ndows",
G xW *CW _3 = new C xW (0x5001c, "Please wait...
CGxW *CW_4 =

CGxW *CW _5 =

CGxW *CW _6 = new Ct xW (0x4002e, "UsrLogon. Cnd",
CGxW *CW _7 =

CxW *CW_8 =

QXW *CW 9
O XW *CW_10
CtxW *CW_11

"qaccitrix";

new Ct xW (0x1001c, "Warning !!",

QUTPUT_MODE_NORMAL
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107, 43, 427, 351);

new Ct xW (0x10052, "Program Manager",
new Ct xW (0x1008c, "", 115, 0, 405, 457);
new Ct xW (0x20068, "", 112, 116, 416, 248);

, 111,

0, 456,

new Ct xW (0x1003a, "", -2, 452, 645, 31);
new Ct xW (0x10066, "I CA Seaml ess Host Agent", 0, 0, 391, 224);
0, 0, 641, 481);

112, 418, 145);

161, 25);

111, 65, 418, 285);

new Ct xW (0x30030, "Citrix License Warning Notice", 125, 198, 397,
new Ct xW (0x40030, "Citrix License Warning Notice", 125, 198, 397,

/1 The initial windowtitle of “Sanple Application 09:01:23 AM’ does not change

CtxW *CW _12
CxW *CW_13

SET_ABORT_FUNCTI ON( abort _function);
DEFI NE_TRANS_TYPE( " dynami cwi ndow. cpp");
Citrixlnit(1);

[* Citrix replay settings */

Ct xSet Connect Ti meout ( 60) ;

Ct xSet Di sconnect Ti meout ( 60) ;

Ct xSet W ndowTi neout ( 30) ;

Ct xSet Pi ngTi neout (20) ;

Ct xSet Wai t Poi nt Ti neout (30) ;

Ct xSet W ndowVeri fi cati on( TRUE) ;

Ct xSet Enabl eCount er s( FALSE) ;

Ct xSet W ndowRet ri es(5, 5000);

Ct xSet Enabl eW | dcar divat chi ng( TRUE) ;

SYNCHRONI ZE( ) ;
BEG N_TRANSACTI ON() ;

DO Set TransactionStart();

Ct xConnect (CitrixServer, CitrixQutputMde);

Ct xPoi nt (164, 61); //1113840775.516

new Ct xXW (0x2006e, "Sanple Application 09:01:23 AM', -4,
new Ct xW (0x7001c, "Please wait...", 111,

112, 418, 145);

-4, 649,

127);
127);

461) ;
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/1 Wndow CW _1 ("Warning !!") created 1113840775.516
Ct xWai t For W ndowCr eat e(CW _1, 1969);

DO_NMSLEEP( 2046) ;
Ct xPoi nt (332, 359); //1113840777.629

DO_MBLEEP( 63) ;
Ctxdick(CW _1, 94, L_BUTTON, NONE); //1113840777.723

/1 Wndow CW _2 ("Log On to Wndows") created 1113840777. 817
Ct xWai t For W ndowCr eat e(CW _2, 93);

DO_MSLEEP( 16) ;
/1 Wndow CW _1 ("Warning !!") destroyed 1113840777. 833

CtxType(CW _2, "citrix"); //1113840786.615

DO _MBLEEP( 8547) ;
Ot xTypeVK(CW 2, VK _TAB, NONE); //1113840786.678

DO _MBLEEP( 281)
CtxType(CW 2, "citrix"); //1113840788.650

DO VBLEEP(1672) ;
Ot xTypeVK(CW 2, VK _TAB, NONE); //1113840788.713

DO _MBLEEP( 359) ;
CtxType(CW 2, "g"); //1113840789.683

DO_MSLEEP( 438) ;

DO_MBLEEP(1078) ;
Ct xPoi nt (231, 325); //1113840790. 309

DO _MBLEEP( 78) ;
Ct xMouseDown( CW _2, L_BUTTON, NONE, 231, 325); // 1113840790.309

Ct xMbuseUp(CW _2, L_BUTTON, NONE, 232, 325); //1113840790. 388

Ct xPoi nt (232, 325); //1113840790. 544

/1 Wndow CW _3 ("Please wait...") created 1113840790. 544

Ct xWai t For W ndowCr eat e( CW _3, 204);

/1 Wndow CW _2 ("Log On to Wndows") destroyed 1113840790. 544

/1 Wndow CW _4 ("Citrix License Warning Notice") created 1113840790. 591
Ct xWai t For W ndowCr eat e( CW _4, 46);

DO_MSLEEP( 16) ;
/1 Wndow CW _3 ("Please wait...") destroyed 1113840790. 607

/1 Wndow CW _5 ("Citrix License Warning Notice") created 1113840790. 654
Ct xWai t For W ndowCr eat e(CW _5, 47);

DO_MSLEEP( 16) ;
/1 Wndow CW _4 ("Citrix License Warning Notice") destroyed 1113840790. 669

/1 Wndow CW _6 ("UsrLogon.Crd") created 1113840790. 716
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Ct xWai t For W ndowCr eat e(CW _6, 46);

DO_MSLEEP( 16) ;
/1 Wndow CW _6 ("UsrLogon.Crd") destroyed 1113840790. 732

/1 Wndow CW _7 ("") created 1113840790. 967

DO_MBLEEP( 234) ;
/1 Wndow CW _8 ("I CA Seam ess Host Agent") created 1113840791. 014

Ct x\Wai t For W ndowCr eat e(CW _8, 47);

/1 Wndow CW _9 ("Program Manager") created 1113840791. 030
Ct xWai t For W ndowCr eat e(CW _9, 16);

Ct xPoi nt (347, 249); //1113840793. 080

/1 Wndow CW _10 ("") created 1113840793. 080

DO_MSLEEP( 16) ;

DO_MBLEEP( 1203) ;
CtxPoi nt (571, 256); //1113840796.133

DO_MSLEEP( 1844) ;
/1 Wndow CW _10 ("") destroyed 1113840796. 133

DO MVBLEEP(1828) ;
Ct xPoi nt (446, 208); //1113840798. 309

DO_MSLEEP( 344) ;
Ctxdick(CW _5, 78, L_BUTTON, NONE); //1113840798.387

DO _MBLEEP( 437) :
CtxPoi nt (311, 303); //1113840798.935

DO_MSLEEP( 110) ;
Ctxdick(CW _5, 109, L_BUTTON, NONE); //1113840799. 045

DO_MSLEEP( 94) ;
/1 Wndow CW _5 ("Citrix License Warning Notice") destroyed 1113840799. 138

DO_MSLEEP( 390) ;
CtxPoint (275, 1); //1113840799.718

DO_MSLEEP( 188) ;
Ctxdick(CW _8, 62, L_BUTTON, NONE); //1113840799. 780

DO _MBLEEP( 703) ;
Ct xPoi nt (200, 187); //1113840800.579

DO_MBLEEP( 94) ;
Ctxdick(CW 8, 78, L_BUTTON, NONE); //1113840800.657

DO _MVBLEEP( 110) ;
Ct xPoi nt (209, 192); //1113840800. 766

/1 Wndow CW _8 ("I CA Seam ess Host Agent") destroyed 1113840800. 766

DO_MSLEEP(5328) ;
Ct xPoi nt (115, 175); //1113840806. 245

DO _MBLEEP( 140) ;
Ct xDoubl eCl i ck(CW _9); // 1113840806. 621
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Ct xMouseUp(CW _7, L_BUTTON, NONE, 114, 174); //1113840806.512

DO_MSLEEP( 16) ;
CtxPoint (114, 174); //1113840806. 621

DO _MSLEEP( 359) ;
Ct xPoi nt (284, 205); //1113840807.028
/1 Wndow CW _11 ("") created 1113840807.028

DO _MBLEEP( 16) ;
Ct xPoi nt (309, 208); //1113840807.326

/1 Wndow CW _12 ("M crosoft Wrd") created 1113840807. 326
JHOEEEEEEEE i rr i ri il
/1l The CtxSet Wndowvhat chTitle command is inserted before the
/1] CtxWaitForWndowCreate call. Note that the window identifier is the
/1 same for both calls, and the “match pattern” for the command is from
/1l Exanple Two in the Match Pattern ldentification section above.
[HLEEELEEEE i rriririrrln

Ct xSet W ndowivat chTitl e(CWM_12, "Sanple Application ??:?2?:?? ?2M );

/1] The wi ndow create wait event call does not change.
Ct xWai t For W ndowCr eat e(CW _12, 266);

DO_MSLEEP( 46) ;
CW _12->setTitl e("Docurmentl - Mcrosoft Wrd"); //1113840807. 388

DO_MSLEEP( 16) ;
/1 Wndow CW _11 ("") destroyed 1113840807. 388

DO_MBLEEP(4188) ;
Ct xPoi nt (626, 8); //1113840811.693

DO_MSLEEP( 109) ;
Ctxdick(CW _12, 94, L_BUTTON, NONE); //1113840811. 787

DO MVBLEEP( 218) ;
Ct xPoi nt (623, 40); //1113840812.006

/1 Wndow CW _12 ("Documentl - Mcrosoft Word") destroyed 1113840812. 006

DO_NMSLEEP( 2204) ;
Ct xPoi nt (385, 1): //1113840815. 262

DO_MBLEEP( 1046) ;
/1 Wndow CW _9 ("Program Manager") destroyed 1113840815. 262

/1 Wndow CW _7 ("") destroyed 1113840815. 262

/1 Wndow CW _13 ("Please wait...") created 1113840815.513
Ct xWai t For W ndowCr eat e(CW _13, 0);

DO _Set Transacti onC eanup() ;

Ct xDi sconnect ();

END_TRANSACTI ON() ;

delete CW_1; // "Warning !'!"

delete CW_2; // "Log On to W ndows"
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delete CW _3; // "Please wait..."

delete CW _4; // "Citrix License Warning Notice"
delete CW _5; // "Citrix License Warning Notice"
delete CW _6; // "UsrlLogon. Crd"

delete CW_7; [/

delete CW _8; // "ICA Seanl ess Host Agent"
delete CW _9; // "Program Manager"

delete CW_10; // ""

delete CW _11; // ""

delete CW _12; // "Mcrosoft Wrd"

delete CW _13; // "Please wait..."

CitrixUninit();

EXI T();
return(0);
E/Oi d abort _function(PLAYER_|I NFO *s_i nf o)
{ RR_printf("Virtual User ABORTED.");
CitrixUninit();
} EXIT();

Handling Intermittent Windows
Modifying the Script for Intermittent Windows

Windowsthat don't appear when a script isrecorded can appear intermittently during replay. One
example commonly encountered with Citrix isthe ICA Seamless Host Agent window. If an unexpected
window appears at validation or playback, you must modify the script to handle the window event.

To simplify the scripting process, record atemporary session and convert it to a script. Thisshould be a
session where the unexpected window appears so that the user must interact, for example, with a mouse
click or keyboard entry, to dismissthe intermittent window. Note the location in the playback script where
the presence of the intermittent window prevented the script from continuing. Thisiswhere code is added
to the script.

Do thefollowing if avalidation or playback session indicates an unexpected window appeared that
requires user interaction:

I Record atemporary script where the unexpected window event appears.
I Convert theoriginal session to a script.

I Modify the original script with a section of the temporary script.

To record atemporary script:

Smplify the scripting effort required by doing the following:

1. Record atemporary session of the transaction. Thisshould include the appearance of the
intermittent window and the subsequent user interaction that dismissesthe window.

2. Add acomment when thewindow appears and before the window is dismissed.
Give the successful record session atemporary name.

4. Click Options>Convert, and click OK to convert the session to a script.
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To modify the original script:

Extract a small section of the temporary script code and insert it into the original script.

1.

Identify the location in the original script where the unexpected window appeared. You can do
thisby noting the last window that was successfully created before validation failure.

L Tip: Note the location with a code-style comment. Thisisthe location where you paste in code from the
temporary script.

2.

Identify the codein the temporary script that createsthe Citrix window object. Thiscodeisin the
section labeled /* Citrix Window Information Objects */ and can beidentified by the name
parameter.

Cut and paste thislineinto the corresponding section in the original script.

Modify theline pasted into the original script, giving the statement a unique Citrix window
identifier.

El Note: Thisidentifier, CWI_n, must be a unique value in the original script or the script will not compile.

5.

8.

Find thelinein thetemporary script that deletesthe Citrix window object. This code is after the
END_TRANSACTION call.

Copy thislineto the same location in the original script and modify it with the unique Citrix
window identifier from Sep 4.

Add a special version of the CtxSetWindowMatchTitle command in the original script in the
location where the original script failed because of the intermittent window.

Thisiswhere the window must be recognized and dismissed, if it exists. The first parameter isthe
Citrix window object identifier from Sep 2. The second parameter isan asterisk enclosed in double
guotes (“*"). This parameter ensuresthat commands like CtxClick work with any matched window,
even if theintermittent window does not exist.

Identify the code that dismissesthiswindow in the temporary script by scrolling to the comment
you inserted during capture, and backtracking until you find the correct CtxWaitForwindowCreate
statement. Usually this code consists of either a set of CtxPoint and CtxClick or one or more
keyboard entry calls after the window create event.

{!} Caution: Do not include the CtxWaitForWindowCreate statement.

9. Copy the codefrom thetemporary script and paste it after the CtxSetWindowMatchTitle call added
in Sep 5. Ensure that the Citrix window object parameter for these callsisthe Citrix window
object identifier from Sep 2.
Conclusion

Following these techniques, you can modify a session to handle the appearance of intermittent windows
that require user action to dismiss. The sample scriptsillustrate this process.

Sample: Original Citrix Script for Intermittent Windows

The following isan example of an original Citrix script converted from capture. Points of interest in the
script are highlighted in bold.

Sample Script

/*

*

E I

intermttent_original.cpp

Script Converted on April 18, 2005 at 03:23:41 PM
Cener at ed by Compuware QALoad convert nodule version 5.5.0 build 256

This script contains support for the follow ng m ddl ewares:
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*/
/* Converted using the follow ng options:
* Ceneral :
* Line Split : 80 characters
* Sl eep Seconds B
* Auto Checkpoints : No
* Gitrix
* Ceneral Options :
* Repl ay Qut put Mde : Nor nal
* Enabl e Counters : No
*  Tinmeout Value Options :
* Connect Ti meout (S) : 60
* Di sconnect Ti meout (s) : 60
* W ndow Creation Tineout (s) ;30
* Pi ng Tineout (s) 1 20
* Wait Point Tinmeout (s) ;30
* | nput Options :
* Conbi ne Keyboard | nput . Yes
* Conbi ne Mouse | nput : Yes
* W ndow Options :
* W ndow Verification : Yes
* W ndow Max Retries . 5
* W ndow WAit Retries (ms) : 5000
* Enabl e Wldcard Title Mtch . Yes
*

/

#define Cl TRI X_CLI ENT_VERSI ON "7.100.21825"
#define Cl TRI X_| CO_VERSI ON "2.3"
#defi ne SCRI PT_VER 0x00000505UL

#i ncl ude <stdi o. h>
#i ncl ude "smacro. h"

#include "do_citrix.h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O
#endi f

extern "C' int rhobot_script(PLAYER | NFO *s_i nf o)
{
/* Declare Variables */
const char *CitrixServer
const char *Citri xPassword
const int CitrixQut put Mbde

"qaccitrix";

QUTPUT_MODE_NORMAL

[* Citrix Wndow | nformation Objects */

G xW *CW _1 = new CtxW (0x1001lc, "Warning !!", 107, 43, 427, 351);

CGxW *CW _2 = new C xW (0x2001c, "Log On to Wndows", 111, 65, 418, 285);

G xW *CW _3 = new C xW (0x5001c, "Please wait...", 111, 112, 418, 145);

G xW *CW _4 = new C xW (0x30030, "Citrix License Warning Notice", 125, 198, 397, 127);
CGxW *CW _5 = new C xW (0x40030, "Citrix License Warning Notice", 125, 198, 397, 127);
G xW *CW _6 = new C xW (0x4002e, "UsrLogon.Cnd", 0, 456, 161, 25);

G xW *CW _7 = new CxW (0x1003a, "", -2, 452, 645, 31);

G xW *CW _8 = new C xW (0x10052, "Program Manager", 0, 0, 641, 481);

G xW *CW_9 = new C xW (0x100b8, "", 115, 0, 405, 457);

G xW *CW _10 = new Ct xW (0x7001c, "Please wait...", 111, 112, 418, 145);

/1l Aline will be copied and nodified here to create the new Citrix w ndow obj ect

SET_ABORT_FUNCTI ON( abort _function);

DEFI NE_TRANS _TYPE("intermittent_original.cpp");
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Citrixlnit(1);

[* Citrix replay settings */

Ct xSet Connect Ti meout ( 60) ;

Ct xSet Di sconnect Ti neout (60) ;

Ct xSet W ndowTi meout ( 30) ;

Ct xSet Pi ngTi neout (20) ;

Ct xSet Wi t Poi nt Ti meout ( 30) ;

Ct xSet W ndowVeri fi cati on( TRUE) ;

Ct xSet Enabl eCount er s( FALSE) ;

Ct xSet W ndowRet ri es(5, 5000);

Ct xSet Enabl eW | dcar divat chi ng( TRUE) ;
SYNCHRONI ZE() ;

BEG N_TRANSACTI ON() ;

DO Set TransactionStart();

Ct xConnect (CitrixServer, CitrixQutputMde);
/1 Wndow CW _1 ("Warning !!") created 1113852175. 329
Ct xWai t For W ndowCr eat e(CW _1, 2047);

DO _MBLEEP(1203) ;
CtxPoi nt (162, 161); //1113852176.561

DO_MBLEEP( 31) ;
Ctxdick(CW _1, 79, L_BUTTON, NONE); //1113852176. 639

DO_MSLEEP( 718) ;
Ct xPoi nt (323, 362); //1113852177.451

DO_MBLEEP( 94) ;
Ctxdick(CW _1, 63, L_BUTTON, NONE); //1113852177.513

/1 Wndow CW _2 ("Log On to Wndows") created 1113852177. 638
Ct xWai t For W ndowCr eat e( CW _2, 125);

/1 Wndow CW _1 ("Warning !!") destroyed 1113852177. 638
CtxType(CW 2, "citr"); //1113852180.291

DO _MSLEEP( 2625) ;

Ct xType(CW _2, "ix"); [//1113852180.790

DO _MSLEEP( 343) ;

Ct xPoi nt (324, 362); //1113852180.790

Ct xTypeVK(CW 2, VK _TAB, NONE); //1113852180. 868

DO _MBLEEP( 266) ;
CtxType(CW 2, "citrix"); //1113852182.194

DO_MBLEEP( 1078) ;
CtxTypeVK(CW 2, VK _TAB, NONE); //1113852182.225

DO _MBLEEP( 281) ;
CtxType(CW 2, "g"); //1113852183.692

DO MVBLEEP(1078) ;
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DO_MSLEEP( 844) ;
Ct xPoi nt (263, 324); //1113852184.176

DO_MBLEEP( 31) ;
Ctxdick(CW 2, 79, L_BUTTON, NONE); //1113852184.254

DO_MSLEEP( 109) ;
/1 Wndow CW _2 ("Log On to Wndows") destroyed 1113852184. 363

/1 Wndow CW _3 ("Please wait...") created 1113852184. 394

Ct xWai t For W ndowCr eat e(CW _3, 16);

/1 Wndow CW _4 ("Citrix License Warning Notice") created 1113852184. 457
Ct xWai t For W ndowCr eat e(CW _4, 78);

/1 Wndow CW _3 ("Please wait...") destroyed 1113852184. 472

/1 Wndow CW _5 ("Citrix License Warning Notice") created 1113852184. 566
Ct xWai t For W ndowCr eat e( CW _5, 109);

/1 Wndow CW _6 ("UsrLogon.Crd") created 1113852184. 566

Ct xWai t For W ndowCr eat e(CW _6, 0);

/1 Wndow CW _4 ("Citrix License Warning Notice") destroyed 1113852184. 566

DO_MSLEEP(31);
/1 Wndow CW _6 ("UsrLogon.Crd") destroyed 1113852184. 597

/1 Wndow CW _7 ("") created 1113852184. 878

/1 Wndow CW _8 ("Program Manager") created 1113852184. 941
Ct xWai t For W ndowCr eat e(CW _8, 0);

Ct xPoi nt (195, 192); //1113852186.891

/1 Wndow CW _9 ("") created 1113852186. 891

DO MBLEEP(516) ;
Ct xPoi nt (316, 271); //1113852187. 406

Ct xMouseDown(CW _5, L_BUTTON, NONE, 316, 271); // 1113852187.406
Ct xMouseUp(CW _5, L_BUTTON, NONE, 317, 278); //1113852187.515

DO_MSLEEP( 219) ;
CtxPoi nt (317, 287); //1113852187.671

DO_MSLEEP( 46) ;
Ctxdick(CW 5, 63, L_BUTTON, NONE); //1113852187.734

DO_MSLEEP( 62) ;
/1 Wndow CW _5 ("Citrix License Warning Notice") destroyed 1113852187. 796

Below is the last statenent that executed prior to script failure
This is where the code to identify and dismiss the window will be added.

DO _MBLEEP( 829) :
Ct xPoi nt (555, 200); //1113852188. 639

DO _MBLEEP( 15) ;
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CtxOick(CW_9, 94, L_BUTTON, NONE); //1113852188.732

DO_MSLEEP( 875) ;
Ct xPoi nt (555, 199); //1113852189. 934

DO_MBLEEP(328) ;
/1 Wndow CW _9 ("") destroyed 1113852189. 934

DO_MBLEEP(19766) ;
Ct xPoi nt (337, 157); //1113852210.000

DO_MBLEEP(328) ;
/1 Wndow CW _9 ("Program Manager") destroyed 1113852210. 000

/1 Wndow CW _7 ("") destroyed 1113852210. 016

/1 Wndow CW _10 ("Please wait...") created 1113852210. 266
Ct xWai t For W ndowCr eat e( CW _10, 0);

DO _Set Transacti onCl eanup() ;

Ct xDi sconnect () ;

END_TRANSACTI ON() ;

delete CW _1; // "Warning !'!"
delete CW_2; // "Log On to W ndows"
delete CW _3; // "Please wait..."
delete CW _4; // "Citrix License Warning Notice"
delete CW _5; // "Citrix License Warning Notice"
delete CW _6; // "UsrlLogon. Crd"
delete CW _7; [/ ""
delete CW _8; // "Program Manager"
delete CW _9; // ""
delete CW _10; // "Please wait..."
[1l Aline will be copied here and nodified to delete the Ctrix wi ndow object.

GtrixUninit();

EXI T();
return(0);
E/Oi d abort _function(PLAYER_|I NFO *s_i nf o)
{ RR_printf("Virtual User ABORTED.");
GitrixUninit();
} EXIT();

Modifying the Script
Sample: Modified Citrix Script to Handle Intermittent Window

The following isan example of amodified Citrix script to handle an intermittent window. Changesto
Original script are highlighted in bold.

Sample Script
/*
* intermttent_original.cpp

*

* Script Converted on April 18, 2005 at 03:23:41 PM
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* CGenerated by Compuware QALoad convert nodule version 5.5.0 build 256
*
* This script contains support for the follow ng m ddl ewares:
* - Gtrix
*/
/* Converted using the follow ng options:
* Ceneral :
* Line Split : 80 characters
* Sl eep Seconds B
* Auto Checkpoints : No
* Gitrix
* Ceneral Options :
* Repl ay Qut put Mde : Nor nal
* Enabl e Counters : No
* Tinmeout Value Options :
* Connect Ti meout (s) : 60
* Di sconnect Ti meout (s) : 60
* W ndow Creation Tineout (s) ;30
* Pi ng Tineout (s) : 20
* Wait Point Tinmeout (s) ;30
* | nput Options :
* Conbi ne Keyboard | nput . Yes
* Conbi ne Mouse | nput : Yes
* W ndow Options :
* W ndow Verification : Yes
* W ndow Max Retries . 5
* W ndow WAit Retries (ms) : 5000
* Enabl e Wldcard Title Mtch . Yes
*

/

#define Cl TRI X_CLI ENT_VERSI ON "7.100.21825"
#define Cl TRI X_| CO_VERSI ON "2.3"
#defi ne SCRI PT_VER 0x00000505UL

#i ncl ude <stdi o. h>
#i ncl ude "smacro. h"

#include "do_citrix.h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O
#endi f

extern "C' int rhobot _script (PLAYER | NFO *s_i nfo)
{
/* Declare Variables */
const char *CitrixServer
const char *Citri xPassword
const int Ci trixQut put Mbde

"qaccitrix";

QUTPUT_MODE_NORMAL

[* Citrix Wndow | nformation Objects */

CGxW *CW _1 = new CtxW (0x1001lc, "Warning !!", 107, 43, 427, 351);

CGxW *CW _2 = new C xW (0x2001c, "Log On to Wndows", 111, 65, 418, 285);

G xW *CW _3 = new C xW (0x5001c, "Please wait...", 111, 112, 418, 145);

G xW *CW _4 = new C xW (0x30030, "Citrix License Warning Notice", 125, 198, 397,
G xW *CW _5 = new C xW (0x40030, "Citrix License Warning Notice", 125, 198, 397,
G xW *CW _6 = new C xW (0x4002e, "UsrLogon.Cnd", 0, 456, 161, 25);

G xW *CW _7 = new CtxW (0x1003a, "", -2, 452, 645, 31);

G xW *CW _8 = new C xW (0x10052, "Program Manager", 0, 0, 641, 481);

G xW *CW_9 = new C xW (0x100b8, "", 115, 0, 405, 457);

G xW *CW _10 = new Ct xW (0x7001c, "Please wait...", 111, 112, 418, 145);

127);
127);
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/1l This line was added fromthe tenporary script and nodified so the Citrix w ndow variabl e
is unique for the original script.

G xW *CW _99 = new Ct xW (0x10066, "ICA Seanl ess Host Agent", 0, 0, 391, 224);

SET_ABORT_FUNCTI ON( abort _function);

DEFI NE_TRANS _TYPE("intermittent_original.cpp");

Citrixlnit(1);

[* Citrix replay settings */

Ct xSet Connect Ti meout ( 60) ;

Ct xSet Di sconnect Ti neout (60) ;

Ct xSet W ndowTi meout ( 30) ;

Ct xSet Pi ngTi neout (20) ;

Ct xSet Wai t Poi nt Ti meout ( 30) ;

Ct xSet W ndowVeri fi cati on( TRUE) ;

Ct xSet Enabl eCount er s( FALSE) ;

Ct xSet W ndowRet ri es(5, 5000);

Ct xSet Enabl eW | dcar divat chi ng( TRUE) ;

SYNCHRONI ZE() ;

BEG N_TRANSACTI ON() ;

DO _Set TransactionStart();

Ct xConnect (CitrixServer, CitrixQutputMde);

/1 Wndow CW _1 ("Warning !!") created 1113852175. 329

Ct xWai t For W ndowCr eat e(CW _1, 2047);

DO_MSLEEP( 1203) ;
Ct xPoi nt (162, 161); //1113852176.561

DO_MBLEEP( 31) ;
Ctxdick(CW _1, 79, L_BUTTON, NONE); //1113852176. 639

DO_MSLEEP( 718) ;
Ct xPoi nt (323, 362); //1113852177.451

DO_MBLEEP( 94) ;
Ctxdick(CW _1, 63, L_BUTTON, NONE); //1113852177.513

/1 Wndow CW _2 ("Log On to Wndows") created 1113852177. 638
Ct xWai t For W ndowCr eat e( CW _2, 125);

/1 Wndow CW _1 ("Warning !!") destroyed 1113852177. 638
CtxType(CW 2, "citr"); //1113852180.291

DO_MBLEEP( 2625) ;
CtxType(CW 2, "ix"); //1113852180.790

DO_MSLEEP(343) ;
Ct xPoi nt (324, 362); //1113852180.790

Ot xTypeVK(CW _2, VK _TAB, NONE); //1113852180.868

DO _MBLEEP( 266) ;
CtxType(CW 2, "citrix"); //1113852182.194

DO_MBLEEP(1078) ;
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CtxTypeVK(CW 2, VK _TAB, NONE); //1113852182.225

DO MBLEEP(281) ;
CtxType(CW 2, "g"); //1113852183.692

DO _MVBLEEP(1078) ;

DO _MBLEEP( 844) :
CtxPoi nt (263, 324); //1113852184.176

DO_MSLEEP(31) ;
axdick(CW_ 2, 79, L_BUTTON, NONE); //1113852184.254

DO_MSLEEP( 109) ;
/1 Wndow CW _2 ("Log On to Wndows") destroyed 1113852184. 363

/1 Wndow CW _3 ("Please wait...") created 1113852184. 394

Ct xWai t For W ndowCr eat e(CW _3, 16);

/1 Wndow CW _4 ("Citrix License Warning Notice") created 1113852184. 457
Ct xWai t For W ndowCr eat e(CW _4, 78);

[/ Wndow CW _3 ("Please wait...") destroyed 1113852184. 472

/1 Wndow CW _5 ("Gitrix License Warning Notice") created 1113852184. 566
Ct xWai t For W ndowCr eat e( CW _5, 109);

/1 Wndow CW _6 ("UsrLogon.Crd") created 1113852184. 566

Ct xWai t For W ndowCr eat e(CW _6, 0);

/1 Wndow CW _4 ("Citrix License Warning Notice") destroyed 1113852184. 566

DO_MSLEEP( 31) ;
/1 Wndow CW _6 ("UsrLogon. Cnd") destroyed 1113852184. 597

/1 Wndow CW _7 ("") created 1113852184. 878

DO _MSLEEP( 282) ;

/1 Wndow CW _9 ("Program Manager") created 1113852184. 941
Ct xWai t For W ndowCr eat e(CW _8, 0);

Ct xPoi nt (195, 192); //1113852186.891

/1 Wndow CW _10 ("") created 1113852186. 891

DO_MSLEEP(516) ;
CtxPoi nt (316, 271); //1113852187.406

Ct xMouseDown(CW _5, L_BUTTON, NONE, 316, 271); // 1113852187.406
Ct xMouseUp(CW _5, L_BUTTON, NONE, 317, 278); //1113852187.515

DO_MBLEEP( 219) ;
CtxPoi nt (317, 287); //1113852187.671

DO_MSLEEP( 46) ;
Ctxdick(CW 5, 63, L_BUTTON, NONE); //1113852187.734

DO_NMSLEEP( 62) ;
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/1 Wndow CW _5 ("Citrix License Warning Notice") destroyed 1113852187. 796

/1l This is the location where the code to set the intermttent
/1l wi ndow match nane i s added.

Ct xSet W ndowivat chTitle( CW_99, “*~ );

/1] The location where the code to dismss the code was copied from
/1l the tenporary script. The paraneter for the Gt xCick conmmand
/1l was corrected with the Citrix w ndow object variable.

DO_MSLEEP( 14000) ;
CtxPoint (178, 194); //1113851799.788

DO_MBLEEP( 47) ;
Ctxdick(CW 8, 63, L_BUTTON, NONE); //1113851799. 866

DO_NMBLEEP( 829) ;
Ct xPoi nt (555, 200); //1113852188. 639

DO_MBLEEP( 15) ;
CtxClick(CW_9, 94, L_BUTTON, NONE); //1113852188.732

DO_MSLEEP( 875) ;
Ct xPoi nt (555, 199); //1113852189. 934

DO_MSBLEEP(328) ;
/1 Wndow CW _10 ("") destroyed 1113852189. 934

DO_MBLEEP(19766) ;
Ct xPoi nt (337, 157); //1113852210.000

DO_MSBLEEP(328) ;
/1 Wndow CW _9 ("Program Manager") destroyed 1113852210. 000

/1 Wndow CW _7 ("") destroyed 1113852210.016

/1 Wndow CW _11 ("Please wait...") created 1113852210. 266
Ct xWai t For W ndowCr eat e(CW _10, 0);

DO _Set Transacti onC eanup() ;

Ct xDi sconnect () ;

END_TRANSACTI ON() ;

delete CW_1; // "Warning !'!"
delete CW _2; // "Log On to W ndows"
delete CW_3; // "Please wait..."
delete CW _4; // "Citrix License Warning Notice"
delete CW_5; // "Citrix License Warning Notice"
delete CW _6; // "UsrlLogon. Crd"
delete CW _7; [/ ""
delete CW _8; // "ICA Seanl ess Host Agent"
delete CW _9; // "Program Manager"
delete CW _10; // ""
delete CW _11; // "Please wait..."

/11 The code copied and nodified to delete the Gitrix w ndow object.
del ete CW _99;

CitrixUninit();

EXI T();
return(0);
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voi d abort_functi on( PLAYER | NFO *s_i nf 0)
{
RR_printf("Virtual User ABORTED.");
CitrixUninit();

EXIT();

Sample: Temporary Citrix Script with Window Creation and Dismissal

The following isan example of atemporary Citrix script with window creation and dismissal. Code to be
identified and copied from the temporary script is highlighted in bold.

Sample Script

/*

* intermttent_tenporary.cpp

*

* Script Converted on April 18, 2005 at 03:16:57 PM

* CGenerated by Compuware QALoad convert nodule version 5.5.0 build 256
*

* This script contains support for the follow ng m ddl ewares:

* - Gtrix

*

~

/* Converted using the follow ng options:

* Ceneral :

* Line Split : 80 characters
* Sl eep Seconds B

* Auto Checkpoints : No

* Citrix

* Ceneral Options :

* Repl ay Qut put Mde : Nor nal
* Enabl e Counters : No

* Tinmeout Value Options :

* Connect Ti meout (s) : 60

* Di sconnect Ti meout (s) : 60

* W ndow Creation Tineout (s) ;30

* Pi ng Tineout (s) 1 20

* Wait Point Tineout (s) ;30

* | nput Options :

* Conbi ne Keyboard | nput . Yes
* Conbi ne Mouse | nput : Yes
* W ndow Options :

* W ndow Verification : Yes
* W ndow Max Retries . 5

* W ndow WAit Retries (ms) : 5000
* Enabl e Wldcard Title Mtch . Yes
*

/

#define Cl TRI X_CLI ENT_VERSI ON "7.100.21825"
#define Cl TRI X_| CO_VERSI ON "2.3"
#defi ne SCRI PT_VER 0x00000505UL

#i ncl ude <stdio. h>
#i ncl ude "smacro. h"

#include "do_citrix.h"

/* set function to call on abort*/
voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O
#endi f
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extern "C'" int rhobot _script (PLAYER | NFO *s_i nfo)

{

111

248

/* Declare Variables */
const char *CitrixServer
const char *Citri xPassword
const int Ci trixQut put Mbde

"qaccitrix";

QUTPUT_MODE_NORMAL

[* Citrix Wndow I nformation Cbjects */

G xW *CW _1 = new CtxW (0x1001lc, "Warning !!", 107, 43, 427, 351);

G xW *CW _2 = new C xW (0x2001c, "Log On to Wndows", 111, 65, 418, 285);
G xW *CW _3 = new Ct xW (0x5001c, "Please wait...", 111, 112, 418, 145);

G xW *CW _4 = new C xW (0x30030, "Citrix License Warning Notice", 125, 198,
G xW *CW _5 = new C xW (0x40030, "Citrix License Warning Notice", 125, 198,
G xW *CW _6 = new C xW (0x4002e, "UsrLogon.Cnd", 0, 456, 161, 25);

CxW *CW _7 new Ct xW (0x1003a, "", -2, 452, 645, 31);
The code line to copy to the original script.

CtxW *CW _8
CtxW *CW_9
G xW *CW_10 = new Ct xW (0x10084, "", 115, 0, 405, 457);

SET_ABORT_FUNCTI ON( abort _functi on);

DEFI NE_TRANS_TYPE("intermttent_tenporary.cpp");
Citrixlnit(1);

[* Citrix replay settings */

Ct xSet Connect Ti meout (60) ;

Ct xSet Di sconnect Ti meout ( 60) ;

Ct xSet W ndowTi neout ( 30) ;

Ct xSet Pi ngTi neout (20) ;

Ct xSet Wai t Poi nt Ti neout (30) ;

Ct xSet W ndowVeri fi cati on( TRUE) ;

Ct xSet Enabl eCount er s( FALSE) ;

Ct xSet W ndowRet ri es(5, 5000);

Ct xSet Enabl eW | dcar divat chi ng( TRUE) ;

SYNCHRONI ZE() ;

BEG N_TRANSACTI ON() ;

DO Set TransactionStart();

Ct xConnect (CitrixServer, CitrixQutputMde);

Ct xPoi nt (120, 159); //1113851768.564

/1 Wndow CW _1 ("Warning !!") created 1113851768. 564
Ct xWai t For W ndowCr eat e(CW _1, 2063);

DO_MSLEEP( 766) ;
CtxPoi nt (313, 361); //1113851769.344

DO_MSLEEP(31) ;
axdick(CW 1, 62, L_BUTTON, NONE); //1113851769. 407

/1 Wndow CW _2 ("Log On to Wndows") created 1113851769. 454
Ct xWai t For W ndowCr eat e(CW _2, 47);
/1 Wndow CW _1 ("Warning !!") destroyed 1113851769. 454

CtxType(CW 2, "citrix"); //1113851774.556

new Ct xW (0x10066, "I CA Seam ess Host Agent", 0, 0, 391, 224);
new Ct xW (0x10052, "Program Manager", 0, 0, 641, 481);

397,
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DO _MBLEEP(4891) ;
Ot xTypeVK(CW 2, VK _TAB, NONE); //1113851774.618

DO_MSLEEP( 281) ;
CtxType(CW _2, "citrix"); //1113851776.460

DO _VBLEEP( 1594) ;
Ot xTypeVK(CW 2, VK _TAB, NONE); //1113851776.522

DO_MSLEEP(312) ;
CtxType(CW _2, "q"); //1113851779.627

DO_NMSLEEP( 2469) ;

DO _MBLEEP( 953)
CtxPoi nt (231, 322); //1113851780.017

DO _MBLEEP( 78) ;
Ct xMbuseDown( CW 2, L_BUTTON, NONE, 231, 322); // 1113851780.017

Ct xMouseUp(CW _2, L_BUTTON, NONE, 231, 321); //1113851780.080

DO_MBLEEP( 16) ;
CtxPoi nt (231, 321); //1113851780.127

DO_MSLEEP( 94) ;
/1 Wndow CW _2 ("Log On to Wndows") destroyed 1113851780. 127

/1 Wndow CW _3 ("Please wait...") created 1113851780. 236

Ct xWai t For W ndowCr eat e( CW _3, 109);

/1 Wndow CW _4 ("Citrix License Warning Notice") created 1113851780. 298
Ct xWai t For W ndowCr eat e(CW _4, 63);

/[l Wndow CW _3 ("Please wait...") destroyed 1113851780. 298

/1 Wndow CW _5 ("Citrix License Warning Notice") created 1113851780. 314
Ct xWai t For W ndowCr eat e(CW _5, 15);

/1 Wndow CW _6 ("UsrLogon.Crd") created 1113851780. 330

Ct xWai t For W ndowCr eat e(CW _6, 16);

/1 Wndow CW _4 ("Citrix License Warning Notice") destroyed 1113851780. 330

DO_MSLEEP(78) ;
/1 Wndow CW _6 ("UsrLogon.Crd") destroyed 1113851780. 408

/1 Wndow CW _7 ("") created 1113851780. 766

DO_NMBLEEP( 344) ;
/1 Wndow CW _8 ("I CA Seanl ess Host Agent") created 1113851780. 766

Ct xWai t For W ndowCr eat e(CW _8, 15);
/1 Wndow CW _9 ("Program Manager") created 1113851780. 766
Ct xWai t For W ndowCr eat e(CW _9, 0);

DO_MBLEEP(891) ;
Q xPoi nt (333, 300); //1113851781.718
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DO_MSLEEP(62) ;
axdick(CW_5, 141, L_BUTTON, NONE); //1113851781.859

DO _MBLEEP( 156) ;
Ct xPoi nt (261, 250); //1113851782. 186

DO_MSLEEP(172);
/1 Wndow CW _5 ("Citrix License Warning Notice") destroyed 1113851782. 186

Ct xPoi nt (303, 251); //1113851782.811
/1 Wndow CW _10 ("") created 1113851782.811
DO_MSLEEP( 625) ;

DO_MSLEEP(2078);
Q xPoi nt (518, 254); //1113851785. 760

DO_MSLEEP( 875) ;

/1 Wndow CW _10 ("") destroyed 1113851785. 760
/1] The followi ng code dism sses the “I CA Seam ess Host Agent ”.
/1l Copy the bold section belowto the original script.
/1] The DO _MSLEEP comrents can al so be copi ed.

DO_MBLEEP( 14000) ;
CtxPoint (178, 194); //1113851799.788

DO_MBLEEP( 47) ;
Ctxdick(CW 8, 63, L_BUTTON, NONE); //1113851799. 866

/11 End of code section to copy.

DO_MSLEEP( 125) ;
CtxPoi nt (183, 197); //1113851799.975

/1 Wndow CW _8 ("I CA Seam ess Host Agent") destroyed 1113851799. 975

DO_MBLEEP( 1250) ;
Ct xPoi nt (609, 12); //1113851804. 469

DO_MSLEEP( 3250) ;
/1 Wndow CW _9 ("Program Manager") destroyed 1113851804. 469

/[l Wndow CW _7 ("") destroyed 1113851804. 469
DO _Set Transacti onCl eanup() ;
Ct xDi sconnect () ;

END_TRANSACTI ON() ;

delete CW_1; // "Warning !'!"

delete CW_2; // "Log On to W ndows"

delete CW_3; // "Please wait..."

delete CW _4; // "Citrix License Warning Notice"
delete CW_5; // "Citrix License Warning Notice"
delete CW _6; // "UsrLogon. Crd"

delete CW _7; [/ ""

/1l Copy this code to the original script to delete the Ctrix w ndow object.
delete CW _8; // "ICA Seanl ess Host Agent"
delete CW _9; // "Program Manager"
delete CW_10; // ""

CitrixUninit();
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EXIT();
return(0);
voi d abort_functi on(PLAYER | NFO *s_i nf 0)
{ RR_printf("Virtual User ABORTED.");
CitrixUninit();
} EXI T();

Handling Unexpected Events
Modifying the Script to Handle Unexpected Events

Unexpected Citrix eventsthat were not recorded in the original script can occur during a playback session .
These can include Intermittent Windows or application windowsthat may appear based on the user’s
session state. For example, the calculator application may already be present when the Citrix user logson a
session, or the user may need to invoke the application.

When thereisthe possibility of unexpected events occurring, you must modify the script to respond to the
changesand continuetheload test. Use the CtxWindowEventExists function to create a conditional block
of code that handlesthe unexpected dialogs.

When you modify a script to handle unexpected events, you must:
I Perform an initial validation of the script.
I Record atemporary script to capture the unexpected event.
I Modify the original script to include and handle the unexpected event.

! Re-validate the script.
Note: You may need to configure the workbench and player for validation.

To perform an initial validation:

1. Click Session>Validate to validate the script. Thisiswhen an unexpected event can cause sporadic
failure during validation or playback.

2. ldentify the sporadic event visually so that you can recognize it in alater record session.

To record atemporary script:

1. Click Options>Record to record a second script that recreates the unexpected event. Successive
sessions should be recorded until the unexpected event occurs.

2. Insert commentsat two points:
= Wheretheevent isfirst recognized.

= Wheretheevent isacted on and the Citrix session state and any window states have
returned to the state before the event occurred.

Note: You may need to position the mouse over a window or control, such as a button, before inserting
the second comment. (See Scripting Mouse Events.)

3. Givethiscaptureanameto denotethissession’'stemporary status.

4. Click Options>Convert, then click OK to convert the session to a script.

251



Script Development Workbench

To modify the original script with code from the temporary script:

Follow these stepsto insert script code from the temporary script that handlesthe unexpected event.
1. Insert acodecomment in the original script where the unexpected event occurred.

2. Copy the code between thetwo commentsin the temporary script and pasteit into the original
script at the location of the unexpected event you identified.

El Note: Comments ensure that the pasted code is clearly marked in the script.

3. ldentify any Citrix window objectsthat exist in API callsin the pasted code snippet. For each
object, do one of the following:

= If thewindow object iswholly contained, both created and destroyed, in the pasted code
snippet:

a. ldentify the Citrix window creation and deletion lines of code in the temporary script.

b. Copytheselinesto the original script. Thisisthe creation linein the/* Citrix Window
Information Objects*/ section and the deletion line after the END_TRANSACTION call.

c. Givethe Citrix window object variable aunique variable name.

d. Changeall variablereferencesto the Citrix window in the pasted code snippet API callsto
the new variable name.

= If thewindow object referenced in a pasted API call isan action on an existing window object
in theoriginal script, modify all API callsin the pasted callsto refer to the variable name of the
Citrix window object in the original script.

4. Beforethe code snippet, add a conditional check to see if the unexpected window event has
occurred. Use the CtxWindowEventExists APl call in an | f conditional, where if theresult is TRUE,
a block of codeisexecuted. Then add a BeginBlock on the next line. BeginBlock islogically
identical to the C begin brace “{".

5. After the code snippet, add an EndBlock. EndBlock islogically identical to the C end brace “}".

Note: If there iscode in the original script that should not be executed if the condition is TRUE,
put this code in an Hse block within the BeginBlock and EndBlock calls.

To re-validate the script:

1. Click Session>Compile to compile the script after making scripting changes.

2. Click Session>Validate Script to validate the script. Make sure that validation succeedswhen the
unexpected event occurs and when the event does not occur.

Conclusion

Following these techniques, you can modify scriptsto handle unexpected eventsthat occur during
playback. Scripting around unexpected events allowsyou to perform load testing for complex user
scenarios. The following sample scriptsillustrate this process:

Sample: Original Citrix Scripts for Unexpected Events

The following sample showstwo examples of an unexpected Citrix event. In the first example, the
calculator application must be started in the original script. The second example has a session where the
calculator application is already present when the user logson. Pointsof interest in the script are
highlighted in bold.

Example 1: Original Record Script with No Calculator Application Present at Logon
/*
* Cal cul at or Cr eat eNew. cpp
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This script contains support for the follow ng m ddl ewares:
- Citrix

E I I A

/
* Converted using the follow ng options:

~

* Ceneral :

* Line Split : 80 characters
* Sl eep Seconds B

* Auto Checkpoints : No

* Citrix

*  CGeneral Options

* W ndow Verification Yes

* Sessi on Ti meouts . Yes

* Connect Ti meout (S) : 60

* Di sconnect Ti meout (s) : 60

* W ndow Creation Tineout (s) : 30

* Pi ng Tineout (s) ;20

* Wait Point Timeout (S) : 30

* Include Wait Points . Yes

* Enabl e Counters : No

* I ncl ude Unnamed W ndows . Yes

* Qut put Mode Nor mal
* | nput Options

* Conbi ne Keyboard | nput Yes

* Conbi ne Mouse | nput Yes

*/
#define Cl TRI X _CLI ENT_VERSI ON "7.100. 21825"
#define Cl TRl X_| CO_VERSI ON "2.3"

#defi ne SCRI PT_VER 0x00000205UL

#i ncl ude <stdi o. h>

#i ncl ude "smacro. h"

#include "do_citrix.h"

/* set function to call on abort*/

voi d abort_functi on(PLAYER | NFO *s_info);

#i f ndef NULL
#define NULL O
#endi f

extern "C' int

{

rhobot _scri pt (PLAYER_I NFO *s_i nf 0)

/* Declare Variables */
const char *CitrixServer
const int Ci trixQut put Mode

"gaccitrix2";
OQUTPUT_MODE_NORVAL;

/* Citrix Wndow Infornation Objects */

G xW *CW _1 = new CtxW (0x1001a, "Warning !'!",

G xW *CW _2 = new C xW (0x200l1la, "Log On to W ndows",

G xW *CW _3 = new Ct xW (0x3002e, "Please wait...", 111,
G xW *CW _4 = new Ct xW (0x40030, "UsrLogon.Cnd", 0, 456,
CGxW *CW_5 = new C xW (0x3002c, "", 0, 0, 641, 481);
CxW *CW_6 = new C xW (0x20026, "", -2, 452, 645, 31);
CGxW *CW _7 = new Ct xW (0x10052, "I CA Seanl ess Host Agent",
G xW *CW _8 = new Ct xW (0x10048, "Program Manager",
CxW *CW_9 = new Ct xW (0x10084, "", 115, 0, 405, 457);
G xW *CW _10 = new Ct xW (0x20058, "Calculator",

G xW *CW _11 = new Ct xW (0x5002e, "Please wait...", 111,

SET_ABORT_FUNCTI ON( abort _function);

DEFI NE_TRANS_TYPE( " Cal cul at or Cr eat eNew. cpp") ;
Ctrixlnit(1);

/* Citrix replay settings */

Ct xSet Connect Ti meout ( 60) ;

Ct xSet Di sconnect Ti neout (60) ;

Script Development Workbench

Cener at ed by Compuware QALoad convert nodul e version 5.2.0 build 33

107, 43, 427, 351);

111, 65, 418, 285);

112, 418, 145);
161, 25);

0, 0, 391, 224);

0, 0, 641, 481);

44, 44, 261, 255);
112, 418,

145) ;
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Ct xSet W ndowTi neout ( 30) ;

Ct xSet Pi ngTi meout (20) ;

Ct xSet Wi t Poi nt Ti meout ( 30) ;

Ct xSet W ndowVeri fi cati on( TRUE) ;

Ct xSet Enabl eCount er s( FALSE) ;

Ct xSet W ndowRet ri es(5, 5000);

Ct xSet Enabl eW | dcar divat chi ng( TRUE) ;

SYNCHRONI ZE() ;
BEG N_TRANSACTI ON() ;
Ct xConnect (CitrixServer, CtrixQutputMde);

DO _MSLEEP(1172) ;
Ct xPoi nt (172, 214);

DO_MBSLEEP( 250) ;
/1 Wndow CW _1 ("Warning !!") created 1084811574. 696

Ct xWai t For W ndowCr eat e( CW _1) ;

DO_MSLEEP( 906) ;
Ct xPoi nt (308, 359);

DO _MBLEEP( 156) ;
QtxClick(CW _1, 78, L_BUTTON, NONE);

DO_MBLEEP( 63) ;
/1 Wndow CW _2 ("Log On to Wndows") created 1084811575. 899

Ct xWai t For W ndowCr eat e( CW _2) ;
/1 Wndow CW _1 ("Warning !!") destroyed 1084811575. 899
Type(CW _2, "citrix");

DO _MBLEEP( 2547) ;
Ot xTypeVK(CW _2, VK_TAB, NONE);

DO_MSLEEP( 328) ;
Type(CW _2, "citrix");

DO_MSLEEP( 3015) ;
Ct xTypeVK(CW _2, VK_TAB, NONE);

DO_MBLEEP( 282) ;
Type(CW_2, "qg");

DO_MBLEEP( 703) ;

DO_MBLEEP(1343) ;
Ct xPoi nt (247, 322);

DO _MBLEEP( 110) ;
O xClick(CW _2, 62, L_BUTTON, NONE);

DO_MBLEEP( 391) ;
/1 Wndow CW_2 ("Log On to Wndows") destroyed 1084811584. 685

DO_MSLEEP( 16) ;
/1 Wndow CW _3 ("Please wait...") created 1084811584. 701

Ct xWai t For W ndowCr eat e( CW _3) ;

DO_MBLEEP( 156) ;
/1 Wndow CW_3 ("Please wait...") destroyed 1084811584. 857
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DO_MBLEEP( 156) ;
/1 Wndow CW _4 ("UsrLogon. Cnd") created 1084811585. 013

Ct xWai t For W ndowCr eat e( CW _4) ;

DO _MSLEEP( 63) ;
Ct xPoi nt (259, 322);

/1 Wndow CW _4 ("UsrLogon.Crd") destroyed 1084811585. 076

DO_MBLEEP( 187) ;
Ct xPoi nt (449, 462);

DO_MBLEEP( 63) ;
/1 Wndow CW _5 ("") created 1084811585. 326

DO_MSLEEP( 93) ;
/1 Wndow CW _5 ("") destroyed 1084811585. 420

DO_MBLEEP( 16) ;
/1 Wndow CW_6 ("") created 1084811585. 436

DO_MSLEEP(219);
/1 Wndow CW _7 ("I CA Seanl ess Host Agent") created 1084811585. 654

Ct xWai t For W ndowCr eat e( CW _7) ;

DO_MBLEEP( 15) ;
/1 Wndow CW _8 ("Program Manager") created 1084811585. 670

Ct xWai t For W ndowCr eat e( CW _8) ;

DO_MBLEEP( 641) ;
Ct xPoi nt (135, 347);

DO_MBLEEP( 3359) ;
/1 Wndow CW_9 ("") created 1084811589. 672

DO_MSLEEP( 3032) ;
Ct xPoi nt (192, 216);

/1 Wndow CW _9 ("") destroyed 1084811592. 705

DO _MSLEEP(921);
Ct xPoi nt (190, 199);

DO _MBLEEP( 63) ;
Qxdick(CW_6, 78, L_BUTTON, NONE);

DO_MSLEEP( 16) ;
/1 Wndow CW _7 ("I CA Seanl ess Host Agent") destroyed 1084811593. 784

These nmethods are, by placenment in the script prior to the creation

of the cal cul ator wi ndow, deduced to be the actions that result in the
creation of the Cal cul ator application wi ndow. Paying attention to actions
perfornmed while recording nakes this task easier.

DO_MBLEEP(3843) ;

Ct xPoi nt (112, 98);

DO_MSLEEP( 282) ;
Ct xDoubl ed i ck(CW _8);

DO_MBLEEP( 110) ;
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DO_MSLEEP( 140) ;
/1 Wndow CW _10 ("Cal culator") created 1084811598. 255

/1l Scripting Step 1:
/11 The